




Droits d’auteur

Ce document est protégé par Copyright © 2020 par l’Équipe de Documentation de LibreOffice. Les
contributeurs sont nommés ci-dessous. Vous pouvez le distribuer et/ou le modifier sous les termes 
de la Licence Publique Générale GNU (https://www.gnu.org/licenses/gpl.html), version 3 ou 
ultérieure, ou de la Licence Creative Commons Attribution
 (https://creativecommons.org/licenses/by/4.0/), version 4.0 ou ultérieure.

Toutes les marques déposées citées dans ce guide appartiennent à leurs légitimes propriétaires.

Contributeurs

Ont contribué à cette édition

Peter Schofield Claire Wood Regina Henschel

Ont contribué aux éditions précédentes

Jean Hollis Weber Peter Schofield Martin Fox
John Cleland John A Smith Vipul Gupta
Kees Kriek Hazel Russman Martin Saffron
Michele Zarri T. Elliot Turner Low Song Chuan
Ron Faile Jr.

Traduction

De cette édition

Traducteurs Jean-Luc Vandemeulebroucke
Relecteurs Philippe Clément

Retours

Veuillez adresser tout commentaire ou suggestion concernant ce document à la liste de diffusion 
de l’Équipe de Documentation : doc@fr.libreoffice.org

Remarque

tout ce que vous envoyez à la liste de diffusion, y compris votre adresse mail et toute autre 
information personnelle incluse dans le message, est archivé publiquement et ne peut pas 
être effacé.

Date de publication et version du logiciel

Publié en décembre 2020. Basé sur LibreOffice 6.4.

La documentation française de LibreOffice est disponible à
https://wiki.documentfoundation.org/Documentation/Publications/fr

mailto:doc@fr.libreoffice.org
https://creativecommons.org/licenses/by/4.0/
https://www.gnu.org/licenses/gpl.html


Utiliser LibreOffice sur un Mac

Sur Mac, certaines touches et certains éléments de menu sont différents de ceux utilisés sous 
Windows ou Linux. Le tableau ci-dessous donne quelques substitutions courantes pour les 
instructions de ce chapitre. Pour une liste plus détaillée, voyez l’Aide de l’application.

Windows ou Linux Équivalent Mac Effet

Sélection du menu 
Outils > Options

LibreOffice > Préférences Accès aux options de configuration

Clic droit
Ctrl+clic ou clic droit selon
la configuration de l’ordinateur

Ouvre un menu contextuel

Ctrl (Control) ⌘ (Command) Utilisé avec d’autres touches

F5 Shift+⌘+F5 Ouvre le Navigateur

F11 ⌘+T Ouvre l’onglet Styles du volet latéral
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À qui s’adresse ce livre ?

Quiconque désire progresser rapidement avec LibreOffice Draw trouvera ce guide précieux, qu’il 
soit novice en logiciel de dessin ou déjà familiarisé avec un autre programme.

Qu’est-ce que ce livre ?

Ce livre présente les fonctions principales de LibreOffice Draw. Draw est un outil de dessin 
vectoriel, bien qu’il puisse aussi effectuer quelques opérations sur des images matricielles (par 
pixels) comme des photographies. Avec Draw, vous pouvez créer rapidement une grande variété 
d’images.

Voici quelques exemples de fonctions de dessin : la gestion des couches, une grille de points 
magnétique, le tracé de cotations associatives, des connecteurs pour la réalisation 
d’organigrammes, des fonctions 3D qui permettent de créer des petits dessins en trois dimensions 
(avec texture et effets d’éclairage), l’intégration des styles de dessin et de page et le tracé de 
courbes de Bézier.

Le Guide Draw n’est pas un manuel à étudier du début à la fin. Il s’agit plutôt d’un ouvrage de 
référence où chercher des conseils sur des sujets précis.

Où trouver de l’aide supplémentaire ?

Ce livre, les autres guides de l’utilisateur de LibreOffice, les systèmes d’Aide intégrée et de support
aux utilisateurs supposent que vous êtes familiarisé avec votre ordinateur et ses fonctions de base
telles que le lancement d’un programme, l’ouverture et l’enregistrement de fichiers.

Système d’aide

LibreOffice propose un système d’Aide étendu qui est votre première ligne de soutien dans 
l’utilisation du logiciel. Les utilisateurs de Windows et de Linux peuvent télécharger et installer une 
aide intégrée utilisable sans être connectés à Internet ; celle-ci est installée avec le programme 
sous macOS.

Pour afficher le système d’Aide, appuyez sur la touche F1 ou cliquez sur Aide de LibreOffice 
dans le menu Aide. Si vous n’avez pas installé l’aide intégrée sur votre ordinateur, votre 
navigateur par défaut s’ouvrira à une page de l’aide en ligne de LibreOffice si vous êtes connecté à
Internet.

Le menu Aide propose des liens vers d’autres fonctions d’information et de soutien de LibreOffice.

Remarque

Les options marquées du symbole ↕ dans la liste suivante ne sont accessibles que si votre 
ordinateur est relié à internet.

• Qu’est-ce que c’est ? Pour une brève information, placez le pointeur de la souris au-dessus
d’une des icônes pour faire apparaître une petite boîte (« Infobulle ») donnant une courte 
explication de la fonction de cette icône. Pour une information plus détaillée, cliquez sur Aide
> Qu’est-ce que c’est ? et placez le pointeur au-dessus de l’icône. En supplément, vous 
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pouvez activer les Infoballons donnant une aide plus étendue grâce dans la page LibreOffice
– Général de la boîte de dialogue Options qui s’ouvre par le menu Outils > Options ;

• Guides utilisateur… ↕ ouvre votre logiciel de navigation par défaut à la page de 
Documentation du site web de LibreOffice https://documentation.libreoffice.org/fr/
documentation-en-francais/. Vous y trouverez les Guides de l’utilisateur (à télécharger 
gratuitement sous forme de fichiers PDF) et d’autres informations utiles ;

• Afficher l’astuce du jour ouvre une petite fenêtre avec une astuce sur l’utilisation de 
LibreOffice.

• Obtenir de l’aide en ligne… ↕ ouvre votre logiciel de navigation à la page Poser une 
question sur le forum d’aide de la communauté de LibreOffice https://ask.libreoffice.org/fr/
questions/ ;

• Envoyer un retour… ↕ ouvre votre logiciel de navigation à la page Retour d’expérience du 
site web de LibreOffice https://fr.libreoffice.org/get-help/feedback/ d’où vous pourrez signaler 
un bogue, suggérer de nouvelles fonctionnalités et communiquer avec les autres membres 
de la communauté de LibreOffice ;

• Redémarrer en mode sans échec… ouvre une boîte de dialogue qui vous permet de 
redémarrer LibreOffice en lui redonnant ses paramètres par défaut ;

• Faire un don à LibreOffice ↕ ouvre votre logiciel de navigation par défaut à la page Support 
LibreOffice https://fr.libreoffice.org/donate/ où vous pouvez faire un don pour soutenir 
LibreOffice ;

• Informations de licence affiche les licences sous lesquelles LibreOffice est mis à votre 
disposition ;

• Vérifier les mises à jour ↕ ouvre une boîte de dialogue et cherche sur le site web de 
LibreOffice si des mises à jour sont disponibles pour votre version du logiciel ;

• À propos de LibreOffice ouvre une boîte de dialogue qui affiche des informations sur la 
version de LibreOffice et le système d’exploitation que vous utilisez. Celles-ci seront souvent 
nécessaires si vous demandez l’aide et l’assistance de la communauté pour le logiciel. Sous 
macOS, cette entrée se trouve sous LibreOffice dans la barre de menu. (Sur macOs, cette 
entrée est dans le menu LibreOffice.)

Support en ligne gratuit

La communauté de LibreOffice ne se contente pas de développer le logiciel, mais elle offre aussi 
un support gratuit basé sur le volontariat. Voyez le Tableau 1 et cette page web : https://
fr.libreoffice.org/get-help/feedback/

Tableau 1 : Support gratuit pour les utilisateurs de LibreOffice

Support gratuit pour LibreOffice

Poser une question
Questions et réponses de la communauté des utilisateurs
https://ask.libreoffice.org/fr/questions/

Documentation
Guides de l’utilisateur, tutoriels et autre documentation https://
wiki.documentfoundation.org/FR/La_documentation_de_l'utilisateur et
https://wiki.documentfoundation.org/Documentation/Publications/fr
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Support gratuit pour LibreOffice

FAQ
Réponses aux questions souvent posées
https://wiki.documentfoundation.org/Faq/fr

Listes de discussion
Un soutien gratuit de la communauté est offert par un réseau 
d’utilisateurs expérimentés : 
https://fr.libreoffice.org/get-help/mailing-lists/

Support international

Le site web de LibreOffice en français :
https://fr.libreoffice.org/
Les sites web de LibreOffice en diverses langues :
https://www.libreoffice.org/community/nlc/
Listes de diffusions en langues maternelles :
https://wiki.documentfoundation.org/Local_Mailing_Lists

Options d’accessibilité
Informations sur les options d’accessibilité disponibles https://
fr.libreoffice.org/get-help/accessibility/

Support et formations payants

Vous pouvez aussi acheter un support par des contrats de service auprès d’un revendeur ou d’une
société de consultants spécialisés dans LibreOffice : http://fr.libreoffice.org/get-help/professional-
support/.

Ce que vous voyez est peut-être différent

LibreOffice fonctionne sous les systèmes d’exploitation Windows, Linux et macOS, chacun d’eux 
possède plusieurs versions et peut être personnalisé par les utilisateurs (polices, couleurs, 
thèmes, gestionnaires de fenêtres).

Illustrations

Les illustrations de ce guide peuvent provenir d’un grand nombre d’ordinateurs et de systèmes 
d’exploitation différents. Certaines ne ressembleront donc pas exactement à ce que vous voyez 
sur l’écran de votre ordinateur.

Icônes

La communauté de LibreOffice a créé plusieurs ensembles d’icônes : Breeze, Breeze (SVG), 
Breeze (dark), Colibre, Colibre (SVG), Elementary, Elementary (SVG), Karasa Jaga, Sifr, Sifr 
(dark) et Tango. Les icônes utilisées pour illustrer certains des nombreux outils disponibles dans 
LibreOffice peuvent être différentes de celles utilisées dans ce guide. Celles-ci ont été extraites 
d’une installation de LibreOffice sous Windows 10 qui a été configurée pour afficher le jeu d’icônes
Colibre.

Pour changer le jeu d’icônes utilisé, ouvrez la page LibreOffice – Affichage de la boîte de dialogue 
Options (Outils > Options sous Windows et Linux, LibreOffice > Préférences sous macOS). 
Dans la section Interface utilisateur, sélectionner Colibre ou Colibre (SVG) parmi les options 
disponibles dans la liste déroulante Style d’icône.
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Remarque

Certaines distributions Linux incluent LibreOffice comme élément de l’installation et peuvent 
ne pas comporter tous les jeux d’icônes indiqués ci-dessus. Vous devriez pouvoir 
télécharger d’autres jeux d’icônes à partir du dépôt logiciel de votre distribution Linux si vous
désirez les utiliser.

Remarque

Les icônes Galaxy et Oxygen ne font plus partie du paquet d’installation standard. Ils 
peuvent être ajoutés par la suite en téléchargeant et en installant les extensions suivantes :
 https://extensions.libreoffice.org/extensions/galaxy-icon-theme
https://extensions.libreoffice.org/extensions/oxygen-icon-theme.
Certains arrière-plans auparavant inclus dans la galerie sont désormais disponibles comme 
extension à https://extensions.libreoffice.org/extensions/legacy-gallery-backgrounds

Utiliser LibreOffice sur un Mac

Sur Mac, certaines touches et certains éléments de menu sont différents de ceux utilisés sous 
Windows ou Linux. Le tableau ci-dessous donne quelques substitutions courantes pour les 
instructions de ce chapitre. Pour une liste plus détaillée, voyez l’Aide de l’application.

Windows ou Linux Équivalent Mac Effet

Sélection du menu 
Outils > Options

LibreOffice > Préférences Accès aux options de configuration

Clic droit
Ctrl+clic ou clic droit selon
la configuration de l’ordinateur

Ouvre un menu contextuel

Ctrl (Control) ⌘ (Command) Utilisé avec d’autres touches

F5 Shift+⌘+F5 Ouvre le Navigateur

F11 ⌘+T Ouvre l’onglet Styles du volet latéral

Comment s’appellent toutes ces choses ?

Les termes utilisés dans LibreOffice pour la plupart des éléments de l’interface utilisateur (les 
parties du programme que vous voyez et utilisez par opposition au code qui fait réellement le 
travail en coulisse) sont les mêmes que pour la plupart des programmes.

Une boîte de dialogue est un type de fenêtre particulier qui a pour but de vous informer ou de vous
demander de saisir quelque chose ou les deux. Elle offre des contrôles qui vous permettent de 
préciser comment réaliser une action. Les noms techniques des contrôles communs sont indiqués 
sur la Figure 1. Dans la plupart des cas, nous n’utiliserons pas les termes techniques dans ce livre,
mais il est utile de les connaître, car l’Aide et les autres sources d’information les utilisent souvent.
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Figure 1: Boîte de dialogue (depuis Calc) montrant les contrôles courants

 1) Page à onglet (ce n’est pas strictement parlant un contrôle).

 2) Boutons radio (un seul peut être sélectionné à la fois).

 3) Cases à cocher (plusieurs peuvent être sélectionnées à la fois).

 4) Sélecteur numérique (cliquez sur les flèches pour modifier le nombre qui apparaît dans la 
boîte de texte à côté d’elles ou tapez-y directement le nombre voulu).

 5) Miniature ou vignette.

 6) Liste déroulante pour sélectionner un élément.

 7) Bouton qui permet d’effectuer une action.

Dans la plupart des cas, vous ne pouvez interagir qu’avec la boîte de dialogue (pas le document 
lui-même) tant que celle-ci reste ouverte. Quand vous la refermez après utilisation (habituellement 
cliquer sur OK ou un autre bouton enregistre vos modifications et ferme le dialogue), vous pouvez 
de nouveau travailler sur votre document.

Certaines boîtes de dialogue peuvent rester ouvertes pendant que vous travaillez, pour vous 
permettre de faire des aller-retours entre celles-ci et votre document. La boîte de dialogue 
Rechercher & Remplacer en est un exemple.
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Qui a écrit ce livre ?

Ce livre a été écrit par des bénévoles de la communauté de LibreOffice. Les bénéfices tirés des 
ventes de l’édition imprimée (en anglais) seront utilisés au profit de la communauté.

Questions fréquentes

Quelle licence s’applique à LibreOffice ?

LibreOffice est distribué sous la Mozilla Public License (MPL) approuvée par l’Open Source 
Initiative (OSI). La licence MPL est disponible à l’adresse https://fr.libreoffice.org/about-us/
licenses/.

Il est basé sur le code d’Apache OpenOffice rendu accessible sous la Licence Apache 2.0 
mais il comporte aussi des logiciels, qui diffèrent d’une version à l’autre, sous diverses autres
licences Open Source. Le nouveau code est accessible sous LGPL 3.0 et MPL 2.0.

Puis-je distribuer LibreOffice à tout le monde ? Puis-je le vendre ? Puis-je utiliser 
LibreOffice dans mon travail ?

Oui.

Sur combien d’ordinateurs puis-je l’installer ?

Autant que vous voulez.

LibreOffice est-il disponible dans ma langue ?

LibreOffice a été traduit (localisé) en plus de 110 langues, donc la vôtre est probablement 
supportée. En plus, il existe plus de 70 dictionnaires orthographiques, de coupure de mot ou 
de synonymes pour les langues et les dialectes qui n’ont pas d’interface de programme 
traduite. Les dictionnaires sont disponibles sur le site des extensions de LibreOffice à 
l’adresse suivante : 
https://extensions.libreoffice.org/extensions?getCategories=Dictionary&getCompatibility=any.

Comment pouvez-vous le faire gratuitement ?

LibreOffice est développé et entretenu par des bénévoles et il a le soutien de plusieurs 
organisations.

J’écris un logiciel. Puis-je utiliser le code de LibreOffice dans mon programme ?

Vous le pouvez dans les limites imposées par la MPL et/ou la LGPL. Lisez les licences à 
l’adresse https://www.mozilla.org/MPL/2.0/.

Pourquoi ai-je besoin de Java pour exécuter LibreOffice ? Est-il écrit en Java ?

LibreOffice n’est pas écrit en Java mais en langage C++. Java est un des nombreux 
langages qui peuvent servir à étendre le logiciel. Le JDK/JRE Java n’est nécessaire que pour
certaines fonctions. La principale est le moteur de base de données relationnelle HSQLDB.

Java est disponible gratuitement. Vous trouverez plus d’informations et des liens pour le 
téléchargement de l’édition convenant à votre système d’exploitation à https://java.com/fr/
download/manual.jsp.
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Remarque

Si vous ne désirez pas utiliser Java, vous pourrez quand même utiliser pratiquement toutes 
les fonctions de LibreOffice. Sinon, il est important d’utiliser l’édition 32 bits ou 64 bits qui 
correspond à la version de LibreOffice que vous avez installée. Voir les Options Avancées 
dans le chapitre 2 du Guide du débutant.

Comment puis-je contribuer à LibreOffice ?

Vous pouvez aider au développement et au soutien aux utilisateurs de LibreOffice de 
nombreuses façons, et vous n’avez pas besoin d’être programmeur. Pour commencer, 
regardez cette page web : https://fr.libreoffice.org/community/get-involved/.

Vous pouvez aussi apporter une contribution financière en vous rendant à la page https://
fr.libreoffice.org/donate/.

Puis-je distribuer le PDF de ce livre ou en imprimer et en vendre des copies ?

Oui, tant que vous remplissez les conditions d’une des licences de la déclaration de 
copyright au début de ce livre. Vous n’avez pas besoin de demander une permission 
spéciale. En outre, nous demandons que vous partagiez avec le projet une partie des profits 
que vous tirez de la vente des livres, en contrepartie de tout le travail que nous avons 
effectué pour les produire.

Qu’y a-t-il de nouveau dans LibreOffice 6.4 ?

Les notes de version de LibreOffice 6.4 (modifications par rapport à la version 6.3) sont ici : 
https://wiki.documentfoundation.org/ReleaseNotes/6.4/fr.

Vous pouvez aussi avoir envie de lire les notes de version de LibreOffice 6.3 (modifications par 
rapport aux versions précédentes) :  https://wiki.documentfoundation.org/ReleaseNotes/6.3/fr
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Introduction

LibreOffice Draw est un outil de dessin vectoriel, qui peut également effectuer quelques opérations
sur des images matricielles (pixels). Avec Draw, vous pouvez réaliser rapidement une grande 
variété d’images graphiques.

Un outil de dessin vectoriel permet de stocker et d’afficher une image en tant qu’ensemble 
d’éléments géométriques simples, comme des lignes, des cercles et des polygones, plutôt qu’un 
ensemble de pixels (éléments d’images ou points à l’écran). Ceci permet un stockage plus simple 
et un changement de dimension plus précis des éléments de l’image.

Draw est complètement intégré à la suite LibreOffice, ce qui simplifie les échanges de dessins 
vectoriels avec tous les modules de la suite. Par exemple, si vous créez un dessin dans Draw et 
que vous voulez l’utiliser dans un document Writer, il vous suffit de le copier et de le coller. Vous 
pouvez également travailler sur des dessins directement dans Writer ou dans Impress en utilisant 
un sous-ensemble de fonctions et d’outils de Draw.

Les fonctionnalités de Draw sont très complètes et, bien qu’il n’ait pas été conçu pour rivaliser 
avec des applications graphiques spécialisées, il possède néanmoins plus de fonctions que les 
outils de dessin habituellement intégrés dans les suites bureautiques.

On peut citer de manière non exhaustive parmi les fonctions de dessin la gestion de couches, un 
système complet de points magnétiques, le tracé de cotations associatives, des connecteurs 
facilitant la réalisation d’organigrammes, des fonctions 3D permettant de réaliser de petits dessins 
tridimensionnels (avec gestion des textures et des éclairages), l’intégration de styles de dessin et 
de pages et le tracé de courbes de Bézier.

Ce Guide Draw n’est pas un cours que vous devez parcourir du début à la fin. Il s’agit surtout d’un 
ouvrage de référence que vous pouvez parcourir pour une aide sur des points particuliers.

Ce document ne décrit que les fonctions associées à Draw. Certains concepts, comme la gestion 
de fichiers ou l’environnement de travail de LibreOffice, ne sont mentionnés que brièvement. Ils 
sont couverts plus en détail dans le Guide du Débutant.

La fenêtre principale de Draw

Les principaux composants de l’espace de travail de Draw sont indiqués Figure 2.

L’espace de travail

La zone la plus large au centre de la fenêtre (Espace de travail) est l’endroit où vous créez vos 
dessins. Elle peut être entourée de barres d’outils et d’espaces d’information. Le nombre et 
l’emplacement des outils visibles varient avec la tâche en cours et les préférences de l’utilisateur, 
donc la disposition de votre fenêtre peut être différente de celle de la Figure 2.

Dans LibreOffice Draw, la taille maximum d’un dessin est limitée par les réglages de votre 
ordinateur et la taille de la page que vous pouvez définir et utiliser sur votre imprimante.

Par défaut, l’espace de travail est constitué de trois couches (Mise en page, Contrôles et Lignes 
de côte) dont les onglets sont situés en bas à gauche de cet espace. Ces couches par défaut ne 
peuvent pas être supprimées ni renommées, mais vous pouvez en ajouter de nouvelles autant que
nécessaire.
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Volet Pages Espace de travail

Barre de menu Barre d’outils Standard

Volet latéral

Onglets des couchesBarre d’état

Barre d’outils Dessin

Barre d’outils Ligne et remplissage

Figure 2 : La fenêtre principale de Draw

Le volet Pages

Vous pouvez disposer des dessins dans Draw sur plusieurs pages. Celles-ci sont surtout utilisées 
pour des présentations. Le volet Pages, situé à gauche de la fenêtre principale, donne un aperçu 
des pages que vous avez créées dans votre dessin. Si ce volet n’est pas visible, sélectionnez 
Affichage dans la barre de menu et cliquez sur Volet Page. Pour modifier l’ordre des pages, faites
glisser et déposez une ou plusieurs pages.

Les onglets des couches

Une couche est un espace où vous pouvez insérer des éléments et des objets de votre dessin. La 
barre de couches est située en bas de l’espace de travail et contient les onglets et les outils pour la
sélection et la commande des couches. Pour plus d’information sur les couches, voyez le chapitre 
11, Techniques avancées, page 259.

Le volet latéral

Le volet latéral possède cinq onglets. Pour en afficher un, cliquez sur son icône ou sur le bouton 
Paramètres du volet latéral (⁞) au-dessus des icônes et choisissez un onglet dans la liste 
déroulante. Un seul onglet peut être ouvert à la fois. Si le volet latéral n’est pas visible, 
sélectionnez Affichage dans la barre de menu et cliquez sur Volet latéral.

Propriétés 
Ouvre des sections pour les propriétés de l’objet que vous pouvez modifier à votre 
convenance. Ces sections sont Page (si aucun objet n’est sélectionné), Caractère, 

12 | Chapitre 1 Présentation de Draw



Paragraphe, Liste (si un texte est en cours d’édition), Zone, Ombre, Ligne et Position et 
taille. Les sections visibles dépendent de l’objet sélectionné.

Formes 
L’onglet Formes vous permet de sélectionner par un simple clic la forme que vous allez 
dessiner sur votre page : lignes et flèches, courbes et polygones, connecteurs, formes de 
base, symboles, flèches pleines, organigrammes, légendes, étoiles et bannières et objets 
3D.

Styles et formatage 
Ici, vous pouvez modifier et appliquer des styles d’image aux objets de votre dessin. Quand 
vous modifiez un style, les changements sont automatiquement appliqués à tous les 
éléments de votre dessin mis en forme avec ce style. Les styles de Présentation ne sont pas
disponibles dans Draw.

Galerie 
Ouvre la galerie d’images à partir de laquelle vous pouvez insérer un objet dans votre 
dessin, soit comme copie, soit comme lien. Une copie d’un objet est indépendante de l’objet 
d’origine. Les modifications de celui-ci n’ont aucun effet sur la copie. Un lien reste dépendant
de l’objet d’origine. Les modifications de celui-ci se reflètent aussi sur l’objet lié.

Navigateur 
Ouvre le navigateur de Draw où vous pouvez rapidement atteindre une autre page de votre 
dessin ou sélectionner un objet dans une figure. Il est recommandé de donner aux pages et 
aux objets de votre dessin des noms significatifs pour pouvoir facilement les identifier dans le
navigateur.

Les règles

Vous pouvez voir les règles (des barres graduées) en haut et à gauche de la zone de dessin de 
Draw. Si elles ne sont pas visibles, vous pouvez les faire apparaître en sélectionnant Affichage > 
Règles depuis la barre de menus.

Les règles montrent la taille de l’objet sélectionné sur la page au moyen de lignes doubles 
(entourées en vert dans la Figure 3). Quand aucun objet n’est sélectionné, elles montrent la 
position du pointeur de la souris pour vous aider à positionner plus précisément les objets 
dessinés.

Vous pouvez également utiliser les règles pour manipuler les poignées des objets et les lignes de 
capture. Vous pouvez ainsi cliquer et faire glisser une ligne double pour modifier la taille de l’objet 
sélectionné.

Figure 3 : Règles montrant la taille de l’objet sélectionné
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Les marges sont représentées par la surface grise au-delà des règles visibles sur la Figure 3. Vous
pouvez modifier les marges directement dans les règles en les faisant glisser avec la souris.

La position par défaut du zéro pour chacune des règles est située dans le coin supérieur gauche 
de la page, après les marges gauche et supérieure (voir Figure 3). Cette position du zéro peut être
modifiée en cliquant sur l’endroit où les règles horizontale et verticale se rejoignent ( ) et en 
faisant glisser jusqu’à la position désirée.

Pour modifier l’unité de mesure, qui peut être définie séparément, faites un clic droit sur la règle 
désirée, comme sur la Figure 4, et choisissez une unité de mesure dans la liste déroulante.

Figure 4 : Les unités possibles pour les règles.

La barre d’état

La barre d’état est située au bas de la fenêtre Draw comme dans tous les modules LibreOffice. 
Elle comprend plusieurs zones spécifiques à Draw (Figure 5).

Nombre et 
numéro de diapo

Informations sur 
la sélection

Nom de la diapo 
maîtresse

Signature électroniqueDocument modifié

Position et taille de 
l’objet sélectionné

Réglage 
du zoom

Pourcentage 
de zoom

Adapter la diapo à 
la fenêtre active

Position du curseur

Figure 5 : La barre d’état de Draw

Il est possible de masquer, ou de faire réapparaître, la barre d’état en cliquant sur Barre d’état 
dans le menu Affichage.

Remarque

Les nombres des positions et tailles sont exprimés dans l’unité de mesure en cours définie 
dans la page LibreOffice Draw – Général de la boîte de dialogue Options (Outils > Options 
dans la barre de menu). Elle peut être différente de l’unité de mesure définie pour la règle.
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Nombre et numéro de diapo
Ce champ affiche le numéro de la page active et le nombre de pages créées.

Informations sur la sélection
Cet emplacement affiche le type d’objet sélectionné ou l’action en cours d’exécution.

Position et taille de l’objet sélectionné
Ce champ affiche différentes informations selon que des objets sont sélectionnés ou non.

– Quand aucun objet n’est sélectionné, les deux nombres de gauche indiquent les 
coordonnées de l’emplacement courant du pointeur de la souris.

– Quand un objet est sélectionné, les deux nombres de gauche indiquent les coordonnées 
du sommet supérieur gauche et les deux nombres de droite les dimensions du contour de
sélection, non de l’objet lui-même ; le contour de sélection est le plus petit rectangle qui 
peut contenir les parties visibles de l’objet ; voir le chapitre 3, Manipuler les objets et les 
points des objets, page 41, pour plus d’informations.

– Quand un objet est sélectionné et que sa taille est en cours de modification avec la souris,
les deux nombres de droite indiquent la taille de l’objet (largeur et hauteur).

– Quand un objet est sélectionné, cliquer dans ce champ ouvre la boîte de dialogue 
Position et taille, voir le chapitre 4, Modifier les attributs d’un objet, page 73, pour plus 
d’informations.

Document modifié
L’icône change pour indiquer que le document doit être enregistré. Cliquer sur celle-ci ouvre 
la boîte de dialogue Enregistrer sous si le fichier n’a encore jamais été enregistré, sinon il est
sauvegardé.

Signature électronique
Cette zone contient une icône si le document a été signé numériquement. Après 
enregistrement, cliquer ici ouvre la boîte de dialogue Signatures numériques.

Adapter la diapo à la fenêtre active
Cliquez ici voir la totalité de la page dans la zone de travail.

Réglage du zoom et Pourcentage de zoom
Vous pouvez voir et ajuster le pourcentage de zoom avec lequel l’espace de travail est 
affiché. Un clic gauche sur le champ Pourcentage de zoom ouvre la boîte de dialogue Zoom 
et disposition des pages, un clic droit ouvre un menu déroulant avec quelques pourcentages 
standard.

Les barres d’outils

Pour masquer ou afficher les barres d’outils de Draw, sélectionnez Affichage > Barres d’outils 
dans la barre de menu. Dans la liste qui s’ouvre alors, choisissez les barres d’outils que vous 
voulez afficher.

L’apparence de leurs icônes peut dépendre de votre système d’exploitation et du choix de leur 
style et de leur taille dans la page LibreOffice – Affichage de la boîte de dialogue Options (Outils >
Options). Pour plus d’information sur le travail avec les barres d’outils, voyez le chapitre 1, 
Introduction à LibreOffice dans le Guide du débutant.

La fenêtre principale de Draw | 15



Vous pouvez aussi choisir les icônes ou boutons que vous voulez voir dans les barres d’outils. 
Pour changer les boutons visibles d’une barre d’outils, faites un clic droit sur celle-ci et 
sélectionnez Boutons visibles dans le menu contextuel. Ceux-ci sont indiqués dans le sous-menu
par un fond légèrement coloré comme on le voit sur la Figure 6

Figure 6 : Choix des icônes visibles dans une barre d’outils

Les barres d’outils disponibles dans Draw sont présentées dans les paragraphes suivants.

Barre d’outils Standard
La barre d’outils Standard (Figure 7) est semblable dans tous les modules de LibreOffice et 
n’est pas décrite en détail dans ce chapitre. Elle est située par défaut sous la barre de menu.

Figure 7 : La barre d’outils Standard

Barre d’outils de dessin
La barre d’outils Dessin (Figure 8) est la plus importante de Draw. Elle contient toutes les 
fonctions nécessaires pour dessiner diverses formes géométriques ou à main levée et pour 
les organiser sur la page. Elle est ancrée par défaut sur la gauche de la fenêtre de Draw. Elle
est décrite en détail au chapitre 2, Dessiner des formes élémentaires, page 23.

Figure 8 : La barre d’outils Dessin

Barre d’outils Ligne et remplissage
Utilisez la barre d’outils Ligne et remplissage (Figure 9) pour modifier les propriétés 
principales d’un objet de dessin. Les icônes et les listes déroulantes changent selon le type 
d’objet sélectionné. Par exemple, pour modifier le style d’une ligne, cliquez sur la flèche vers 
le bas de la liste déroulante Style de ligne et choisissez le style désiré.
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Figure 9 : La barre d’outils Ligne et remplissage

Les fonctions de la barre d’outils Ligne et remplissage permettent de changer la couleur, le 
style et la largeur des lignes, la couleur et le style de remplissage et d’autres propriétés d’un 
objet. Celui-ci doit d’abord avoir été sélectionné par un clic de la souris. Si l’objet sélectionné 
est un cadre de texte, la barre d’outils Ligne et remplissage est remplacée par la barre 
d’outils Formatage du texte (Figure 10).

Barre d’outils Formatage du texte
La barre d’outils Formatage du texte (Figure 10) est semblable à la barre d’outils Formatage 
de Writer et elle n’apparaît qu’après sélection d’un objet texte dans votre dessin. Pour une 
explication des fonctions de cette barre d’outils, voyez le chapitre 4, Modifier les attributs 
d’un objet, page 73. Si vous cherchez des informations sur l’ajout et le formatage du texte, 
voyez le chapitre 9, Ajouter et formater des textes, page 201.

Figure 10 : La barre d’outils Formatage du texte

Barre d’outils Options
Utilisez la barre d’outils Options (Figure 11) pour activer ou non diverses aides au tracé. Par 
défaut, elle n’est pas affichée, mais vous pouvez le faire à partir du menu Affichage > 
Barres d’outils. Les outils que l’on trouve sur cette barre d’outils sont décrits plus en détail 
dans les autres chapitres du Guide Draw.

Figure 11 : La barre d’outils Options

Faire flotter et déplacer les barres d’outils

Palettes d’outils

Les icônes d’une barre d’outils qui possèdent un petit triangle (▾) à leur droite disposent d’outils 
supplémentaires. Cliquez sur le triangle pour les afficher.

Ces palettes d’outils peuvent être transformées en barres d’outils flottantes. Cliquez en haut de la 
palette comme le montre la Figure 12, tirez-la jusqu’à l’emplacement voulu puis relâchez le bouton 
de la souris. Pour refermer une barre d’outils flottante, cliquez sur le X à droite de son titre.
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Cliquez et tirez ici pour 
transformer la palette en barre 
d’outils flottante

Palette d’outils Barre d’outils flottante

Figure 12 : Exemple de détachement d’une palette d’outils

Remarque

Quand une palette d’outils est transformée en barre d’outils flottante, son icône reste dans la
barre d’outils à laquelle elle appartient et montre toujours le dernier outil utilisé. Cela signifie 
que l’icône que vous voyez sur votre écran peut ne pas être la même que celle qui apparaît 
dans ce guide.

Astuce

Quand vous faites un double-clic sur une icône dans une barre d’outils, la commande qui lui 
correspond devient active et le reste. Vous pouvez alors répéter la même action aussi 
souvent que vous voulez. Pour quitter ce mode, appuyez sur la touche Échap ou cliquez sur
une autre icône. Notez cependant que cela ne fonctionne pas avec toutes les icônes de 
toutes les barres d’outils.

Barres d’outils par défaut

Quand vous ouvrez Draw, les barres d’outils par défaut sont déjà ancrées à leurs positions en haut
et en bas de l’espace de travail. Cet ensemble de barres d’outils par défaut est normalement 
composé des barres d’outils Standard et Dessin. Elles peuvent être libérées et rendues flottantes.

• Pour détacher une barre d’outils, placer le pointeur de la souris au-dessus de sa poignée 
située à l’extrême gauche de la barre (Figure 13). Le curseur change de forme, une main qui
saisit, une flèche quadruple, ou autre selon les réglages de votre ordinateur et son système 
d’exploitation. Cliquez et tirez la poignée de la barre d’outils pour la déplacer jusqu’à ce 
qu’elle devienne une barre flottante. Cette possibilité est partagée par tous les composants 
de LibreOffice.

Poignées des
barres d’outils

Figure 13 : Les poignées des barres d’outils
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• Pour ancrer une barre d’outils flottante en haut de l’espace de travail de Draw, maintenez la 
touche Ctrl appuyée en faisant un double-clic sur sa barre de titre. Elle se positionne à un 
emplacement libre en haut de l’espace de travail.

• Une autre méthode pour ancrer une barre d’outils consiste à cliquer sur sa barre de titre et à 
la tirer jusqu’à sa position d’ancrage qui peut se situer sur un des quatre côtés de l’espace 
de travail.

Personnaliser les barres d’outils

Vous pouvez personnaliser les barres d’outils de différentes manières. Pour afficher ou masquer 
les boutons d’une barre d’outils, voir le paragraphe « Les barres d’outils » et la Figure 6 page 16.

Pour ajouter des fonctions à une barre d’outils, déplacer des outils entre barres d’outils ou créer de
nouvelles barres d’outils :

 8) Choisissez Affichage > Barre d’outils > Personnaliser dans la barre de menu ou faites un 
clic droit sur la barre d’outils et sélectionnez Personnaliser la barre d’outils dans le menu 
contextuel pour ouvrir la boîte de dialogue Personnaliser (Figure 14).

Figure 14 : L’onglet Barres d’outil de la boîte de dialogue Personnaliser
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 9) Sélectionnez l’onglet Barres d’outils puis la barre d’outils que vous voulez modifier dans la 
liste déroulante Cible.

 10) Cochez une fonction qui ne l’est pas dans la liste Commandes assignées pour l’ajouter à la 
barre d’outils choisie.

 11) Si vous voulez ajouter une nouvelle fonction à la barre d’outils choisie, cliquez sur son nom 
dans la liste Commandes disponibles puis sur la flèche vers la droite  entre les deux 
listes.

 12) Cliquez sur l’icône  à droite de la liste déroulante Cible et sélectionnez dans le menu 
déroulant si vous voulez que la barre d’outils comporte des icônes et du texte, des icônes 
seules ou du texte seul.

 13) Pour créer une nouvelle barre d’outils, cliquez sur l’icône  à droite de la liste déroulante 
Cible et sélectionnez Ajouter. Une boîte de dialogue s’ouvre pour vous permettre de donner 
un nom à votre nouvelle barre d’outils et choisir où vous voulez l’enregistrer.

 14) Pour rendre à la barre d’outils sélectionnée son jeu d’outils par défaut, cliquez sur le bouton 
Par défaut. Toutes les fonctions supplémentaires qui ont été ajoutées seront supprimées et 
les fonctions par défaut remises en place.

 15) Cliquez sur OK pour enregistrer les modifications et fermer la boîte de dialogue.

Pour plus d’information sur l’ajout de nouvelles fonctions ou la modification d’une barre d’outils, 
voyez le Guide du débutant.

Choisir et définir des couleurs

Barre de couleurs

Pour afficher la barre de couleurs qui contient la palette de couleur actuellement utilisée, 
sélectionnez Affichage > Barre de couleurs dans la barre de menu. Par défaut, elle apparaît à 
droite de l’espace de travail (Figure 15) et affiche les couleurs de la palette en cours. Vous pouvez 
la fermer en désélectionnant Barre de couleurs dans le menu Affichage. Elle vous permet de 
sélectionner rapidement la couleur de différents objets (lignes, zones et effets 3D) de votre 
document. La dernière case du panneau, en bas à gauche, correspond à invisible (pas de 
couleur).

Figure 15 : La barre de couleurs
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Choisir une palette de couleurs

Vous pouvez accéder à plusieurs palettes de couleurs spécialisées dans Draw. Vous pouvez 
également modifier les couleurs individuelles selon votre goût. Ceci s’effectue dans la boîte de 
dialogue Remplissage (Figure 16), qui apparaît en choisissant Format > Remplissage depuis la 
barre de menus ou en cliquant sur l’icône Remplissage  la barre d’outils Ligne et remplissage. 
Dans cette boîte de dialogue, cliquez sur l’onglet Couleurs. Pour charger une autre palette, 
sélectionnez-la dans la liste déroulante Palette.

Pour ajouter une couleur à la palette personnalisée, commencez par la sélectionner en cliquant sur
le bouton Choisir une couleur avant de l’ajuster à l’aide de la boîte de dialogue Choisir une 
couleur qui s’ouvre alors (Figure 17). Vous pouvez effectuer les modifications en déplaçant le 
curseur rond dans le carré coloré et en cliquant sur la barre multicolore qui se trouve à sa droite, 
ou en changeant les valeurs numériques des champs situés à la droite de la boîte de dialogue 
pour les trois schémas de couleurs proposés.

Figure 16 : L’onglet Couleur de la boîte de dialogue Remplissage

Quand un objet de votre dessin est sélectionné, vous pouvez aussi modifier ses couleurs de ligne 
et de remplissage de la façon suivante :

• pour la couleur de remplissage, déployez la section Zone de l’onglet Propriétés du volet 
latéral (Figure 17) et cliquez sur le bouton coloré sous le champ Remplir pour sélectionner 
une couleur dans la palette qui s’ouvre alors ;
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• pour la couleur de ligne, déployez la section Ligne de l’onglet Propriétés du volet latéral 
(Figure 17) et cliquez sur le bouton coloré Couleur pour sélectionner une couleur dans la 
palette qui s’ouvre alors.

Ces palettes sont semblables à celle qui s’affiche dans la boîte de dialogue Remplissage.

Une description plus détaillée des palettes de couleurs, de leurs options et de la différence entre 
les schémas de couleur RVB et CMJN figure dans le chapitre 11, Techniques avancées, page 293.

Figure 17 : Couleurs de Zone et de Ligne dans le volet latéral.

Grille, magnétisme et lignes d’aide

Draw propose une grille et des lignes magnétiques comme aides au tracé ; elles peuvent être 
activées ou désactivées en cliquant sur les boutons Afficher la grille ( ) ou Afficher les lignes 
de capture ( ) des barres d’outils Ligne et remplissage et Options. La grille et les lignes de 
capture ne sont affichées qu’à l’écran et n’apparaissent pas sur les dessins imprimés ou quand 
ceux-ci sont utilisés dans un autre composant de LibreOffice. La couleur, l’espacement et la 
résolution des points de la grille peuvent être choisis individuellement pour chaque axe.

Des lignes d’aide pendant le déplacement des objets peuvent être affichées, ou masquées, en 
cliquant sur le bouton Lignes d’aide lors du déplacement ( ) des barres d’outils Ligne et 
remplissage et Options. En affichant la position de l’objet pendant son déplacement, elles facilitent 
son positionnement. Quand cette fonction est activée, des paires de lignes horizontales et 
verticales prolongeant le rectangle de sélection jusqu’aux bords de l’espace de travail sont visibles 
quand l’objet est déplacé.

Draw offre aussi plusieurs fonctions magnétiques pour vous aider à positionner les objets avec 
précision dans un dessin.

Pour plus d’informations sur la grille, les lignes et les fonctions magnétiques et les lignes d’aide, 
voir le chapitre 3, Manipuler les objets et les points des objets, page 56 et suivantes.
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Guide Draw
6.4

Chapitre 2 
Dessiner des formes 
élémentaires





Créer des formes simples

Vous pouvez créer des objets 2D et 3D dans Draw. Ce chapitre vous montre comment dessiner 
des objets 2D simples. Les chapitres suivants vous indiqueront comment manipuler et éditer de 
tels objets. Pour plus d’informations sur les objets 3D, voir Chapitre 7, Manipuler des objets 3D, 
page 161.

Toutes les formes, qu’elles soient des lignes, des rectangles ou des formes plus complexes, sont 
appelées objets. C’est un terme courant pour les applications de dessin vectoriel.

Les outils de dessin se trouvent dans la barre d’outils Dessin (Figure 18).

Figure 18 : La barre d’outils Dessin

Comme indiqué au chapitre 1, Introduction à Draw, la barre d’outils Dessin se trouve ordinairement
à gauche de la fenêtre. Si vous ne la voyez pas, vous pouvez la faire apparaître en sélectionnant 
Affichage > Barres d’outils > Dessin dans la barre de menu.

Comme avec les autres modules de LibreOffice, vous pouvez détacher la barre d’outils Dessin et 
la placer où vous voulez dans la fenêtre de Draw en tant que barre d’outils flottante. Vous pouvez 
également personnaliser la barre d’outils en ajoutant, déplaçant, masquant ou supprimant des 
icônes. Voir le chapitre 1, Présentation de Draw, page 9, pour plus d’informations.

Lorsque vous dessinez une forme, sélectionnez un objet pour l’éditer ou ajoutez un texte au 
dessin, la zone d’information de la barre d’état (Figure 19) change pour refléter l’action effectuée 
ou en cours. Voir le chapitre 1, Présentation de  Draw, page 9, pour plus d’informations sur la barre
d’état.

Nombre et 
numéro de diapo

Informations sur 
la sélection

Nom de la diapo 
maîtresse

Signature électroniqueDocument modifié

Position et taille de 
l’objet sélectionné

Réglage 
du zoom

Pourcentage 
de zoom

Adapter la diapo à 
la fenêtre active

Position du curseur

Figure 19 : La barre d’état de Draw

Dessiner des formes élémentaires

Les formes élémentaires, dont les textes font partie, sont considérées comme des objets dans 
Draw. Les différents outils disponibles, après l’installation, dans la barre d’outils Dessin pour 
dessiner des formes élémentaires sont visibles sur la Figure 18. Faites un clic droit dans la barre 
d’outils Dessin puis sélectionnez Boutons visibles dans le menu contextuel pour ouvrir une liste 
des outils disponibles (Figure 20).
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Les icônes marquées (par une coche, un cadre ou un fond de couleur selon votre système 
d’exploitation et les réglages choisis) sont celles affichées par défaut, par exemple Sélectionner 
ou Ligne. Vous pouvez cliquer sur les autres, par exemple Zoom ou En courbe, pour les rendre 
disponibles dans la barre d’outils.

Notez bien que certaines icônes de la barre d’outils Dessin peuvent changer selon la dernière 
forme sélectionnée. Les outils disponibles sont accessibles en cliquant sur le petit triangle noir à 
droite de l’icône. Voir « Dessiner des formes géométriques » page 37 pour plus d’informations 
sur les formes disponibles.

Figure 20 : Outils de la barre d’outils Dessin

Remarque

Quand vous dessinez une forme élémentaire ou que vous la sélectionnez pour la modifier, le
champ d’information à la gauche de la barre d’état change pour correspondre à l’action en 
cours : par exemple, Créer ligne, Cadre de texte xxxx sélectionné, etc. (voir Figure 21).

Dessiner des lignes droites

L’élément de dessin le plus simple est la ligne droite.

 16) Débutez le tracé d’une ligne droite d’une des façons suivantes :

– cliquez sur l’icône Ligne  dans la barre d’outils Dessin ;

– cliquez sur le petit triangle à droite de l’icône Lignes et flèches  dans la barre d’outils 
Dessin et sélectionnez Insérer une ligne  dans la palette d’outils ;

– cliquez sur Insérer une ligne dans la section Lignes et flèches de l’onglet Formes du 
volet latéral.
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 17) Placez le pointeur de la souris à l’endroit où vous voulez que la ligne commence. Faites 
glisser la souris en gardant son bouton gauche appuyé.

 18) Relâchez le bouton de la souris à l’endroit où vous voulez que la ligne se termine. Une 
poignée de sélection apparaît à chaque extrémité de la ligne, ce qui indique que cet objet est
l’objet en cours de sélection (Figure 21). La poignée de sélection au début de la ligne est 
légèrement plus grande que l’autre.

En cours de tracé Résultat

Point de départ

Figure 21 : Dessiner une ligne droite

• Maintenez la touche Ctrl enfoncée pendant le tracé de la ligne pour que son extrémité se 
verrouille au sommet le plus proche de la grille.

Remarque

Il s’agit du comportement par défaut de la touche Ctrl. Cependant si l’option Aligner sur la 
grille a été sélectionnée dans le menu Affichage > Grille et lignes guide, la touche Ctrl 
désactive l’attraction par la grille.

• Si vous maintenez la touche Maj appuyée durant le tracé de la ligne, cela restreint son angle
à un multiple de 45 degrés (0, 45, 90, 135, etc.).

Remarque

Ceci est le comportement par défaut de la touche Maj. Cependant, si l’option Lors de la 
création ou du déplacement de l’objet de la section Contraindre les objets est cochée dans
la page LibreOffice Draw – Grille de la boîte de dialogue Options (Outils > Options dans la 
barre de menu), l’action de la touche Maj est inversée. Les lignes seront automatiquement 
tracées avec un angle multiple de 45 degrés, à moins que la touche Maj ne soit appuyée.

• Pour dessiner une ligne à partir de son centre, positionnez le curseur dans votre document, 
cliquez sur le bouton de la souris et gardez appuyée la touche Alt pendant que vous faites 
glisser le curseur. La ligne utilisera la position de départ (l’endroit où vous avez cliqué en 
premier sur le bouton de la souris), comme centre et s’étendra de façon symétrique à partir 
de ce point.

Quand une ligne est dessinée, elle utilise des attributs par défaut. Pour modifier ces attributs, 
sélectionnez la ligne en cliquant sur celle-ci, puis utilisez une des méthodes suivantes pour 
changer ses propriétés :

• ouvrez le panneau Ligne (Figure 22) de l’onglet Propriétés du volet latéral ;

Dessiner des formes élémentaires | 27



Figure 22 : le panneau Ligne dans l’onglet Propriétés du volet latéral.

• faites un clic droit et choisissez Ligne dans le menu contextuel ou Sélectionnez Format > 
Ligne dans la barre de menu pour ouvrir la boîte de dialogue Ligne (Figure 23).

Figure 23 : La boîte de dialogue Ligne

• Utilisez les contrôles de la barre d’outils Ligne et remplissage (Figure 24). Si elle n’est pas 
visible, sélectionnez Affichage > Barres d’outils dans la barre de menu, puis Ligne et 
remplissage dans le menu déroulant.

Figure 24 : La barre d’outils Ligne et remplissage
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Dessiner des flèches

Les flèches se tracent de la même façon que les lignes. En fait, Draw classe les flèches dans un 
sous-groupe de lignes : les lignes avec une ou des flèches. Quand le pointeur de la souris survole 
l’icône d’une flèche dans la palette Lignes et flèches, une infobulle vous indique le type d’extrémité
qui sera ajouté en fin de ligne.

Remarque

Le dessin de l’icône correspond au dernier outil utilisé, ce qui facilite sa réutilisation.

Les extrémités de ligne possibles sont les flèches, les cercles et les carrés. La palette propose 
aussi des lignes sans décorations aux extrémités, des lignes de cote et des lignes à 45°. La zone 
d’information de la barre d’état les indique uniquement comme des lignes.

 1) Utilisez une des méthodes suivantes pour débuter le tracé d’une flèche :

– cliquez sur le bouton Lignes et flèches de la barre d’outils Dessin pour tracer le type de 
flèche indiqué par l’icône ;

– cliquez sur le petit triangle à droite du bouton Lignes et flèches dans la barre d’outils 
Dessin et sélectionnez le type de flèche que vous souhaitez dans la palette (Figure 25) ;

– cliquez sur l’icône du type de flèche que vous souhaitez dans la section Lignes et 
flèches de l’onglet Formes du volet latéral (Figure 26).

 2) Placez le pointeur au point de départ de la flèche et déplacez la souris en maintenant le 
bouton appuyé. L’extrémité de la flèche est dessinée au point d’arrivée quand vous relâchez 
le bouton de la souris.

Remarque

Une fois la ligne tracée, vous pouvez encore modifier le style de flèche en cliquant sur 
l’icône Style de flèche ( ) de la barre d’outils Ligne et remplissage et en choisissant un 
style de flèche pour le début (colonne de gauche) ou la fin (colonne de droite) de la ligne. 
Vous pouvez également le faire dans l’onglet Ligne de la boîte de dialogue Ligne (Figure 
23). Voir Chapitre 4, Modifier les attributs d’un objet, page 73, pour plus d’informations.

Ligne avec flèche à 
la fin

Ligne avec cercle / 
flèche

Ligne avec carré / 
flèche

Ligne avec flèches

Ligne avec flèche 
au début

Ligne avec flèche / 
cercle

Ligne avec flèche / 
carré

Insérer une ligne

Ligne de cote Ligne (45°)

Figure 25 : La palette Lignes et flèches
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Figure 26 : L’onglet Formes du volet latéral

Dessiner des rectangles ou des carrés

Le dessin d’un rectangle est similaire au tracé d’une ligne droite.

• Cliquez sur l’icône du type de rectangle souhaité ( , , , ) 

– dans la barre d’outils Dessin (rectangle seulement, Figure 18, page 25),

– cliquez sur le petit triangle à droite du bouton Formes de base dans la barre d’outils 
Dessin et sélectionnez le type de rectangle que vous souhaitez dans la palette Formes de
base (Figure 36, page 38),

– dans la section Formes de base de l’onglet Formes du volet latéral (Figure 26),

– dans la barre d’outils Anciens rectangles (Figure 27). Si elle n’est pas affichée, 
sélectionnez-la dans le sous-menu Affichage > Barres d’outils.

Figure 27 : La barre d’outils Anciens rectangles

Au fur et à mesure que vous faites glisser la souris en maintenant l’appui sur le bouton 
gauche, le rectangle se dessine jusqu’à la position du curseur.

• Les carrés sont des rectangles dont les côtés ont la même longueur. Pour dessiner un carré, 
vous pouvez cliquer sur l’icône Rectangle et garder appuyée la touche Maj pendant que 
vous faites glisser la souris.
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Remarque

Ceci est le comportement par défaut de la touche Maj. Cependant, si l’option Lors de la 
création ou du déplacement de l’objet de la section Contraindre les objets est cochée dans
la page LibreOffice Draw – Grille de la boîte de dialogue Options (Outils > Options dans la 
barre de menu), l’action de la touche Maj est inversée. Des carrés seront tracés, à moins 
que la touche Maj ne soit appuyée pour dessiner des rectangles.

• Pour dessiner un rectangle ou un carré à partir de son centre, positionnez le pointeur dans 
votre document, appuyez sur le bouton de la souris et gardez appuyée la touche Alt 
pendant que vous faites glisser le pointeur. Le rectangle ou le carré utilisera la position de 
départ (l’endroit où vous avez cliqué en premier sur le bouton de la souris) comme centre.

Dessiner des ellipses ou des cercles

Pour dessiner d’une ellipse (aussi dite ovale) ou un cercle, procédez de la façon suivante. 

• Cliquez sur l’icône du type d’ellipse souhaité ( , )

– dans la barre d’outils Dessin (ellipse seulement Figure 18, page 25),

– cliquez sur le petit triangle à droite du bouton Formes de base dans la barre d’outils 
Dessin et sélectionnez le type d’ellipse que vous souhaitez dans la palette Formes de 
base (Figure 36, page 38),

– dans la section Formes de base de l’onglet Formes du volet latéral (Figure 26),

– dans la barre d’outils Anciens cercles et ellipses (Figure 28). Si elle n’est pas affichée, 
sélectionnez-la dans le sous-menu Affichage > Barres d’outils.

Figure 28 : La barre d’outils Anciens cercles et ellipses

Au fur et à mesure que vous faites glisser la souris en maintenant l’appui sur le bouton 
gauche, l’ellipse se dessine à l’intérieur du rectangle allant jusqu’à la position du curseur.

• Les cercles sont des ellipses dont les axes sont de même longueur. Pour dessiner un cercle,
vous pouvez cliquer sur l’icône Ellipse et garder appuyée la touche Maj pendant que vous 
faites glisser la souris.

Remarque

Ceci est le comportement par défaut de la touche Maj. Cependant, si l’option Lors de la 
création ou du déplacement de l’objet de la section Contraindre les objets est cochée dans
la page LibreOffice Draw – Grille de la boîte de dialogue Options (Outils > Options dans la 
barre de menu), l’action de la touche Maj est inversée. Des cercles seront tracés, à moins 
que la touche Maj ne soit appuyée pour dessiner des ellipses.

• Pour dessiner une ellipse ou un cercle à partir de son centre, positionnez le pointeur dans 
votre document, appuyez sur le bouton de la souris et gardez appuyée la touche Alt 
pendant que vous faites glisser le pointeur. L’ellipse ou le cercle utilisera la position de 
départ (l’endroit où vous avez cliqué en premier sur le bouton de la souris), comme centre.
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Astuce

Si vous cliquez sur l’icône Ligne, Rectangle, Ellipse ou Texte en gardant appuyée la 
touche Ctrl, un objet correspondant est automatiquement dessiné au centre de l’espace 
de travail en utilisant les valeurs par défaut pour sa taille, sa forme et sa couleur. Ces 
attributs peuvent être modifiés par la suite si désiré. Voir le chapitre 4, Modifier les attributs 
d’un objet, page 73, pour plus d’informations.

Dessiner une ligne de cote

Les lignes de cotes affichent les dimensions d’un objet dans le dessin (Figure 29). Les lignes de 
cotes ne font pas partie de l’objet lui-même mais sont normalement placées près de lui. Un objet 
peut avoir autant de lignes de cotes que nécessaire pour indiquer les mesures de ses côtés, bords
et distances. Les lignes de cotes calculent et affichent automatiquement les dimensions linéaires.

4,16 cm
2,

7
 c

m

Figure 29 : Mesure d’un objet avec des lignes de cotes

 1) Pour tracer une ligne de cote, ouvrez la palette d’outils Lignes et flèches (Figure 25) en 
cliquant sur le petit triangle à droite de l’icône Lignes et flèches (initialement ) ou l’onglet 

Formes du volet latéral et cliquez sur l’icône ligne de cote .

 2) Déplacez le pointeur de la souris à l’emplacement du début de la ligne, appuyez sur le 
bouton gauche et tracez la ligne en déplaçant la souris sans relâcher le bouton. Maintenez la
touche Maj enfoncée pour facilement tracer la ligne de cote horizontale ou verticale.

La ligne de cote est tracée et la dimension automatiquement calculée et affichée.

 3) Relâchez le bouton gauche de la souris à l’emplacement de la fin de la ligne.

 4) Vous pouvez contrôler l’apparence des composants de la ligne de cote en la sélectionnant, 
en faisant un clic droit sur celle-ci et en choisissant Cotation dans le menu contextuel pour 
ouvrir la boîte de dialogue Cotation (Figure 30).
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Figure 30 : Boîte de dialogue de configuration des lignes de cotes

Dessiner des arcs ou des segments d’ellipses

Si vous voulez dessiner régulièrement des arcs, des secteurs ou des segments d’ellipses ou de 
cercles), vous devez tout d’abord faire apparaître la barre d’outils Anciens cercles et ellipses 
(Figure 28, page 31). Choisissez Affichage > Barres d’outils dans la barre de menu et 
sélectionnez-la dans le sous-menu déroulant. Quand le pointeur de la souris survole une icône, le 
nom de l’objet dessiné grâce à ce bouton s’affiche dans une infobulle.

Pour dessiner des arcs et des segments :

 1) Sélectionnez l’icône voulue dans la barre d’outils Anciens cercles et ellipses (Figure 28) ou 
dans la palette Formes de base (Figure 36, page 38). La forme du pointeur de la souris 
rappelle l’outil choisi.

 2) Cliquez et faites glisser le pointeur de la souris sans relâcher le bouton pour créer une ellipse
ou un cercle de guidage. Vous obtenez un dessin à l’écran similaire à celui-ci dessous.

Dessiner des formes élémentaires | 33



 3) Relâchez le bouton et déplacez le pointeur de la souris à l’endroit où vous voulez que l’arc 
ou le segment commence. La barre d’état vous indique l’angle en degrés. Vous obtenez un 
dessin à l’écran similaire à celui-ci dessous.

 4) Cliquez puis déplacez le curseur de la souris à l’endroit où vous voulez que l’arc ou le 
segment se termine. La barre d’état vous indique l’angle en degrés. Faites un simple clic à 
cet endroit pour terminer l’arc ou le segment.

Dessiner des courbes, des polygones et des lignes à main levée

Pour débuter le dessin d’une courbe, d’un polygone ou d’une ligne à main levée,

• cliquez sur le petit triangle à droite de l’icône Courbes et polygones ( ) de la barre d’outils
Dessin et sélectionnez le type de courbe, de polygone ou de ligne à main levée dans la 
palette (Figure 31), Si vous placez le pointeur de la souris au-dessus d’une icône, une 
infobulle vous indique le type de ligne dessiné,

Figure 31 : la palette Courbes et polygones

• sélectionnez le type de courbe, de polygone ou de ligne à main levée dans la section 
Courbes et polygones de l’onglet Formes du volet latéral (Figure 26, page 30).

Remarque

L’icône du dernier outil utilisé est affichée dans la barre d’outils Dessin pour faciliter sa 
réutilisation.

34 | Chapitre 2  Dessiner des formes élémentaires



Courbes

 1) Cliquez et gardez appuyé le bouton gauche de la souris pour créer le point de départ de la 
courbe. Puis, tout en gardant le bouton de la souris appuyé, faites glisser le pointeur pour 
tracer une ligne droite à partir de ce point de départ. Relâchez le bouton gauche de la souris 
et déplacez le curseur pour infléchir la ligne droite en une courbe.

 2) Cliquez pour définir le point final et fixer la courbe dans la page.

 3) Continuez votre ligne en déplaçant le curseur de la souris et en cliquant pour fixer le point 
d’angle suivant ; vous pouvez infléchir la ligne obtenue en gardant le bouton gauche de la 
souris appuyé et en le faisant glisser jusqu’à obtenir ce que vous désirez.

 4) Pour terminer la courbe, faites un double-clic.

Remarque

Une courbe remplie joint automatiquement le dernier point de la courbe avec son point de 
départ par un segment, pour la refermer et la remplir avec la couleur standard. Une courbe 
non remplie n’est pas refermée à la fin du tracé.

Polygones

 1) Cliquez et gardez appuyé le bouton gauche de la souris pour créer le point de départ du 
polygone. Puis, tout en gardant le bouton de la souris appuyé, faites glisser le pointeur pour 
tracer le premier côté. Dès que vous relâchez le bouton de la souris, le segment est tracé 
entre le premier et le deuxième point.

 2) Déplacez le pointeur pour dessiner le côté suivant. Chaque clic de souris va déterminer un 
sommet et vous permet de dessiner un autre côté.

 3) Faites un double-clic pour terminer le polygone.

Remarque

Un polygone rempli joint automatiquement le dernier sommet avec son point de départ, pour
le refermer et le remplir avec la couleur standard. Un polygone non rempli n’est pas refermé 
à la fin du tracé.

Remarque

Si vous gardez appuyée la touche Maj durant le tracé d’une courbe ou d’un polygone, les 
angles seront limités aux multiples de 45 degrés.

Polygones à 45°

Les polygones à 45° se tracent comme les autres polygones, mais les angles entre les lignes sont 
limités aux multiples de 45 degrés. Mais si le polygone à 45° est fermé, la ligne tracée 
automatiquement pour refermer la figure peut former des angles non multiples de 45 degrés.

En cas de besoin, appuyez sur la touche Maj en traçant un côté pour pouvoir lui donner un angle 
qui ne soit pas multiple de 45°.
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Lignes à main levée

L’utilisation de l’outil Ligne à main levée est comparable au dessin sur un papier avec un crayon.

 1) Cliquez et gardez appuyé le bouton gauche de la souris en faisant glisser le pointeur pour 
dessiner la ligne que vous voulez.

 2) Pour terminer la ligne, relâchez simplement le bouton : il n’est pas nécessaire de faire de 
double-clic.

 3) Si l’outil Ligne à main levée remplie est sélectionné, l’objet est automatiquement complété 
par une ligne droite entre le point d’arrivée et le point de départ, et rempli avec la couleur 
standard.

Points de collage et connecteurs

Points de collage

Tous les objets Draw ont des points de collage, qui ordinairement ne sont pas affichés. Les points 
de collage deviennent visibles quand une icône Connecteur (Figure 18, page 25) est sélectionnée
dans la barre d’outils Dessin ( ) ou dans la section Connecteurs de l’onglet Formes du volet 
latéral (Figure 26, page 30).

La plupart des objets ont quatre points de collage (Figure 32). Vous pouvez ajouter et 
personnaliser des points de collage avec la barre d’outils Points de collage (Figure 33). 
Sélectionnez Affichage > Barres d’outils > Points de collage dans la barre de menu pour la 
faire apparaître.

Figure 32 : Points de collage après sélection d’un outil Connecteur

Figure 33 : La barre d’outils Points de collage

Les points de collage ne sont pas les poignées de sélection d’un objet. Les poignées de sélection 
servent à modifier la forme d’un objet, comme décrit au chapitre 3, Manipuler les objets et les 
points des objets, page 41. Les points de collage servent à relier un connecteur à un objet afin que
le connecteur reste attaché à l’objet quand celui-ci est déplacé. Pour plus d’information sur les 
points de collage, voir le chapitre 8, Connecteurs et organigrammes, page 187.

Connecteurs

Les connecteurs sont des lignes ou des flèches dont les extrémités sont automatiquement 
attachées à un point de collage d’un objet. Ils sont très utiles pour dessiner des organigrammes, 
des diagrammes de flux et des cartes heuristiques. Lorsque les objets sont déplacés ou 
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réordonnés, les connecteurs restent fixés à un point de collage. La Figure 34 montre l’exemple de 
deux objets reliés par un connecteur.

Figure 34 : Deux objets reliés par un connecteur

Draw dispose de plusieurs connecteurs et fonctions de connexion. Cliquez sur le petit triangle à 
droite de l’icône Connecteurs pour ouvrir la barre d’outils Connecteurs (Figure 35). Vous pouvez 
aussi sélectionner un connecteur dans la section Connecteurs de l’onglet Formes du volet latéral 
(Figure 26, page 30). Pour une description plus détaillée de l’utilisation des connecteurs, voir le 
chapitre 8, Connecteurs et organigrammes, page 187.

Figure 35 : La barre d’outils Connecteurs

Dessiner des formes géométriques

Les icônes pour dessiner des formes géométriques se situent dans la barre d’outils Dessin et dans
l’onglet Formes du volet latéral (Figure 26, page 30). Cliquez sur le petit triangle à droite de 
chaque icône pour ouvrir la palette d’outils correspondante qui donne accès aux outils de ce 
groupe.

L’utilisation des outils pour dessiner des formes géométriques est similaire à celle de l’outil pour 
dessiner des rectangles et des carrés. Voir « Dessiner des rectangles ou des carrés » page 30.

Remarque

Les icônes utilisées pour représenter les formes géométriques dans la barre d’outils Dessin 
sont variables et changent selon le dernier outil sélectionné et utilisé pour dessiner un objet. 
Elles peuvent donc être différentes de celles représentées dans les sections suivantes.

Il est possible d’ajouter du texte à toutes les formes géométriques. Pour plus d’informations, voir le
chapitre 11, Techniques avancées, page 259.

Formes de base

Cliquez sur le petit triangle à droite de l’icône Formes de base ( ) pour ouvrir la palette d’outils 
Formes de base (Figure 36). Cette barre d’outils comprend des outils Rectangle et Ellipse 
identiques à ceux qui se trouvent dans la barre d’outils Dessin. Vous pouvez aussi sélectionner 
l’outil souhaité dans la section Formes de base de l’onglet Formes du volet latéral (Figure 26, 
page 30).
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Figure 36 : La palette d’outils Formes de base

Formes des symboles

Cliquez sur le petit triangle à droite de l’icône Formes des symboles ( ) pour ouvrir la barre 
d’outils Formes des symboles (Figure 37). Vous pouvez aussi sélectionner l’outil souhaité dans la 
section Formes des symboles de l’onglet Formes du volet latéral (Figure 26, page 30).

Figure 37 : La palette d’outils Formes des symboles

Flèches pleines

Cliquez sur le petit triangle à droite de l’icône Flèches pleines ( ) pour ouvrir la barre d’outils 
Flèches pleines (Figure 38). Vous pouvez aussi sélectionner l’outil souhaité dans la section 
Flèches pleines de l’onglet Formes du volet latéral (Figure 26, page 30).

Figure 38 : La palette d’outils Flèches pleines

Organigramme

Cliquez sur le petit triangle à droite de l’icône Organigramme ( ) pour ouvrir la barre d’outils 
Organigramme (Figure 39). Vous pouvez aussi sélectionner l’outil souhaité dans la section 
Organigramme de l’onglet Formes du volet latéral (Figure 26, page 30).

La création des organigrammes, diagrammes de flux et autres outils similaires est détaillée 
Chapitre 8, Connecteurs et organigrammes, page 187.
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Figure 39 : La palette d’outils Organigramme

Légendes

Cliquez sur le petit triangle à droite de l’icône Légendes ( ) pour ouvrir la barre d’outils 
Légendes (Figure 40). Vous pouvez aussi sélectionner l’outil souhaité dans la section Légendes 
de l’onglet Formes du volet latéral (Figure 26, page 30).

Figure 40 : La palette d’outils Légendes

Étoiles et bannières

Cliquez sur le petit triangle à droite de l’icône Étoiles et bannières ( ) pour ouvrir la barre 
d’outils Étoiles et bannières (Figure 41). Vous pouvez aussi sélectionner l’outil souhaité dans la 
section Étoiles et bannières de l’onglet Formes du volet latéral (Figure 26, page 30).

Figure 41 : La palette d’outils Étoiles et bannières

Objets 3D

Cliquez sur le petit triangle à droite de l’icône Objets 3D ( ) pour ouvrir la barre d’outils Objets 
3D (Figure 41). Vous pouvez aussi sélectionner l’outil souhaité dans la section Objet 3D de l’onglet
Formes du volet latéral (Figure 26, page 30).

Figure 42 : La palette d’outils Objets 3D
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Dessiner successivement plusieurs formes

Vous pouvez dessiner successivement plusieurs formes, plusieurs lignes par exemple, sans avoir 
à sélectionner l’icône Ligne à chaque fois. Pour ceci, faites un double-clic sur l’icône de la forme 
que vous souhaitez dessiner. Tracez votre première forme. Vous pouvez remarquer que le pointeur
de la souris garde la même apparence et ne revient pas au symbole qu’il a lorsqu’il est un outil de 
sélection. Tracez les formes suivantes. Pour terminer, appuyez sur la touche Échap ou faites un 
clic simple dans un emplacement libre de l’espace de travail.

Vous pouvez faire de même avec les formes géométriques. Par contre, il est nécessaire de 
détacher la palette d’outils correspondante pour la transformer en barre d’outils avant de faire un 
double-clic sur la forme désirée.

Ajouter du texte aux dessins et aux objets

Dans Draw, vous pouvez ajouter, insérer et formater du texte dans un document, dans des objets 
ou dans des formes de plusieurs façons.

• Vous pouvez gérer des textes avec cadre dynamique, qui sont des objets Draw 
indépendants que vous pouvez placer où vous voulez dans votre document et dont le cadre 
s’étend au fur et à mesure que vous ajoutez du texte.

• Vous pouvez également insérer un texte dans un objet préalablement dessiné. Ce texte est 
intégré à l’objet et est placé dans un rectangle inscrit à l’intérieur des limites qui entourent 
l’objet. Ce rectangle n’est pas dynamique et vous devez faire attention à ce que votre texte 
ne déborde pas des limites de l’objet.

Pour plus d’informations, voir le chapitre 9, Ajouter et formater un texte, page 201.
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6.4

Chapitre 3
Manipuler les objets et les 
points des objets





Introduction

Ce chapitre examine les outils et les fonctions qui vont vous permettre de modifier des dessins 
existants. Toutes les fonctions s’appliquent à l’objet sélectionné ou au groupe d’objets 
sélectionnés, qui peuvent être distingués par les poignées de sélection sur un cadre rectangulaire 
suffisamment large pour contenir l’objet. Lorsque plusieurs objets sont sélectionnés, le cadre 
correspond au plus petit rectangle qui peut contenir tous ces objets. Ce cadre est appelé rectangle
de sélection.

Remarque

La forme et la couleur des poignées de sélection peuvent changer selon le type d’objet, ainsi
que l’outil et la fonction qui ont été sélectionnés pour en modifier les propriétés. La couleur 
des poignées de sélection dépend également du système d’exploitation et des 
paramétrages de l’ordinateur.

Sélectionner des objets

Sélection directe

La façon la plus simple de sélectionner un objet est de cliquer directement sur lui. Pour 
sélectionner un objet sans remplissage, cliquez sur sa bordure. Cliquez ailleurs dans le document 
pour désélectionner l’objet. Pour sélectionner plusieurs objets, gardez appuyée la touche Maj 
pendant que vous cliquez successivement sur chacun d’eux.

Sélection par encadrement

Vous pouvez également sélectionner plusieurs objets en cliquant et faisant glisser la souris autour 
d’eux. Un rectangle en pointillés se dessine et seuls les objets qui sont entièrement compris dans 
ce rectangle seront sélectionnés.

Pour sélectionner plusieurs objets par encadrement, l’icône Sélectionner  de la barre d’outils 
Dessin doit être active.

Sélectionner des objets cachés

Si des objets sont cachés derrière d’autres objets et ne sont donc pas visibles, vous pouvez quand
même les sélectionner. Quand vous sélectionnez un objet caché, ses poignées de sélection 
apparaissent à travers les objets qui le recouvrent.

• Système d’exploitation Windows ou Mac : sélectionnez l’objet devant les objets cachés, 
puis cliquez sur l’objet caché à sélectionner en maintenant appuyée la touche Alt. S’il y a 
plusieurs niveaux d’objets cachés, gardez appuyée la touche Alt et cliquez jusqu’à ce que 
vous atteigniez l’objet que vous désirez. Pour parcourir les objets empilés dans l’ordre 
inverse, gardez appuyées les touches Maj+Alt et cliquez.

Lorsque vous cliquez sur l’objet caché, son contour apparaît brièvement à travers l’objet qui 
le recouvre.

• Système d’exploitation Linux : Appuyez sur la touche Tabulation pour parcourir le cycle
des objets existants et de vous arrêter sur l’objet que vous voulez sélectionner. Pour 
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parcourir le cycle dans l’ordre inverse, appuyez sur Maj+Tab. Cette méthode permet 
d’atteindre très rapidement un objet, mais elle peut ne pas être pratique si le dessin 
comporte de nombreux objets. Elle fonctionne aussi sous Windows et Mac.

Disposer les objets

Dans un dessin complexe, plusieurs objets peuvent être empilés les uns sur les autres. Pour 
modifier l’ordre de l’empilement en déplaçant les objets vers l’avant ou vers l’arrière, sélectionnez 
un objet et choisissez une des méthodes suivantes :

• sélectionnez Disposition dans le menu contextuel ou dans l’entrée Forme de la barre de 
menus et choisissez l’une des actions disponibles,

• utilisez un des raccourcis clavier indiqués ci-dessous,

• cliquez sur une des icônes

– de la palette accessible à partir de l’icône Disposer  de la barre d’outils Standard ou 
de la barre d’outils Position (Figure 43 en haut) obtenue en détachant la palette ;

– à gauche de la barre d’outils Ligne et remplissage (Figure 43 en bas)  ;

– du panneau Position et taille de l’onglet Propriétés du volet latéral (Figure 55, page 53).

Figure 43 : La barre d’outils Position (en haut)
et la partie gauche de la barre d’outils Ligne et remplissage (en bas)

Actions / Entrées de menu Raccourcis clavier Icônes

Envoyer à l’avant Ctrl+Maj++

Envoyer vers l’avant Ctrl++

Envoyer vers l’arrière Ctrl+-

Envoyer à l’arrière Ctrl+Maj+-

Devant l’objet

Derrière l’objet

Inverser

Positionner et ajuster les objets

Utiliser le zoom

Pour vous aider à positionner et modifier les objets, Draw dispose d’une fonction zoom qui réduit 
ou élargit l’affichage à l’écran du document en cours. Vous pouvez par exemple augmenter le 
facteur de zoom pour positionner très précisément un objet dans votre document ; puis réduire ce 
facteur pour voir la page complète. Vous pouvez agir rapidement sur le facteur de zoom en 
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gardant appuyée la touche Ctrl et en utilisant la molette de votre souris. Vous pouvez contrôler 
plus précisément le zoom de trois façons différentes : en utilisant la barre d’état, la boîte de 
dialogue Zoom & disposition des pages ou la barre d’outils Zoom.

Remarque

Le zoom est traité différemment entre les systèmes d’exploitation Windows et Linux. Un 
document enregistré avec un facteur de zoom 100 % dans Windows peut être affiché avec 
un plus grand facteur de zoom dans Linux.

Barre d’état

Les zones de contrôle du zoom s’affichent à l’extrémité droite de la barre d’état (Figure 44). Elles 
vous permettent un accès rapide et facile au zoom.

Diminuer le zoom Augmenter le zoom

Curseur de zoom

Adapter la
diapo à la
fenêtre active

Facteur de zoom
Figure 44 : Les contrôles de zoom dans la barre d’état

• Cliquez sur l’icône Adapter la diapo à la fenêtre active ( ) pour que la page occupe tout 
l’espace de travail de la fenêtre active.

• Cliquez sur le signe – pour réduire le facteur de zoom.

• Cliquez sur le signe + pour augmenter le facteur de zoom.

• Cliquez et faites glisser le curseur pour réduire ou augmenter le facteur de zoom.

• Faites un clic droit sur la valeur du pourcentage de zoom et choisissez l’un des facteurs de 
zoom prédéfinis disponibles dans le menu contextuel.

• Sélectionnez Affichage > Zoom > Zoom ou faite un double-clic sur la valeur du 
pourcentage de zoom et choisissez un facteur de zoom dans la boîte de dialogue Zoom & 
disposition des pages qui s’ouvre (Figure 45).

Boîte de dialogue Zoom & disposition des pages

Figure 45 : La boîte de dialogue Zoom & disposition des pages

La boîte de dialogue Zoom & disposition des pages (Figure 45) offre les options suivantes pour 
contrôler la façon dont votre dessin est affiché sur votre écran :
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Facteur de zoom
Cette section permet de définir le facteur de zoom avec lequel le document est affiché et 
tous les documents du même type que vous ouvrirez par la suite.

– Optimal : le facteur de zoom est le plus élevé qui permet à tous les objets de la page 
d’être entièrement affichés à l’écran.

– Adapter la largeur et la hauteur : la page entière est affichée à l’écran.

– Adapter à la largeur : la page est affichée afin que toute sa largeur soit visible à l’écran. 
Le haut et le bas de la page peuvent ne pas être visibles.

– 100 % :la page est affichée à sa taille réelle.

– Variable : vous permet de saisir le pourcentage de facteur de zoom dans le champ 
correspondant.

Disposition des pages
Pour les documents texte uniquement (cette section n’est pas accessible sous Draw), vous 
pouvez paramétrer l’aperçu de la mise en page. Réduisez le facteur de zoom pour voir les 
effets des différents paramètres d’aperçu de la mise en page.

– Automatique : l’aperçu automatique de la mise en page affiche les pages côte à côte, 
avec autant de pages que le facteur de zoom le permet.

– Une page : la disposition des pages sur une seule page affiche les pages les unes au-
dessous des autres, mais jamais côte à côte.

– Colonnes : dans la disposition en colonnes des pages, vous voyez les pages dans un 
nombre donné de colonnes côte à côte. Saisissez le nombre de colonnes.

– Mode livre : dans la disposition des pages en mode livre, vous voyez deux pages côte à 
côte comme pour un livre ouvert. La première page est une page de droite avec un 
numéro de page impair.

Barre d’outils Zoom

Sélectionnez Affichage > Barres d’outils > Zoom pour afficher la barre d’outils Zoom (Figure 46).
Certains outils ne sont pas affichés par défaut.

Agrandir le zoom Réduire le zoom 100 % Zoom précédent1

Zoom suivant1 Page entière Largeur de page Affichage optimal

Zoom sur les objets Zoom et panoramique Déplacer

Figure 46 : La barre d’outils Zoom

Les outils disponibles sont les suivants :

• Agrandir le zoom : double le facteur de zoom.

• Réduire le zoom : divise par deux le facteur de zoom.

1 Non affiché par défaut.
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• Zoom 100 % : affiche la page à sa taille réelle.

• Zoom précédent1 : revient à l’affichage avec le précédent facteur de zoom appliqué. Vous 
pouvez également utiliser le raccourci clavier Ctrl+, (virgule).

• Zoom suivant1 : annule l’action de la commande Zoom précédent.

• Page entière : affiche la page entière à l’écran.

• Largeur de page : affiche la page afin que toute sa largeur soit visible à l’écran. Le haut et le
bas de la page peuvent ne pas être affichés.

• Optimal : choisit le facteur de zoom le plus élevé avec lequel tous les objets de la page 
puissent être entièrement affichés à l’écran.

• Zoom sur les objets : choisit le facteur de zoom le plus élevé avec lequel le ou les objets 
sélectionnés puissent être entièrement affichés à l’écran.

• Zoom et panoramique : double le facteur de zoom à chaque clic. Vous pouvez également 
cliquer sur l’icône puis cliquer et faire glisser le pointeur de la souris dans la page pour 
dessiner un cadre rectangulaire qui représente la zone qui sera affichée à l’écran. 
Ctrl+clic divise le facteur de zoom par deux. Maj+clic-tirer permet de déplacer la 
page dans la zone de travail.

• Déplacer : déplace le document dans l’espace de travail sans modifier le facteur de zoom. 
Cliquez et faites glisser le pointeur de la souris sur le document.

Déplacer et ajuster la taille d’un objet

Lorsque vous déplacez ou modifiez la taille d’un objet, observez la barre d’état en bas de la fenêtre
de Draw (Figure 47). Le deuxième champ indique le type d’objet sélectionné et le quatrième, sa 
position dans le dessin en coordonnées X/Y et ses dimensions. L’unité de mesure est celle 
sélectionnée dans le menu dans la page LibreOffice Draw – Général de la boîte de dialogue 
Options (Outils > Options).

Opération en cours

Coordonnées du coin supérieur gauche

Dimensions

Figure 47 : Extrémité gauche de la barre d’état quand un objet est sélectionné

Déplacer des objets

Avec la souris

Pour déplacer un objet (ou un groupe d’objets), sélectionnez-le et positionnez le pointeur de la 
souris au-dessus pour qu’il prenne la forme du curseur de déplacement (habituellement la 
quadruple flèche) ; puis cliquez et faites glisser jusqu’à la position désirée en maintenant l’appui 
sur le bouton gauche de la souris. Durant le déplacement, une image fantôme de l’objet apparaît 
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pour aider à son positionnement (Figure 48). Relâchez le bouton de la souris pour attribuer son 
nouvel emplacement à l’objet.

Figure 48 : Déplacer un objet avec la souris

Avec les touches de direction

Dès lors qu’un objet (ou un groupe d’objets) est sélectionné, vous pouvez le déplacer à l’aide des 
touches de direction (flèches Haut, Bas, Gauche, Droite). Ce positionnement est en général 
plus précis qu’avec la souris. La précision est encore accrue en gardant appuyée la touche Alt 
lors du déplacement. Inversement, l’amplitude du déplacement est augmentée si vous maintenez 
l’appui sur la touche Maj lors du déplacement.

Avec la boîte de dialogue ou l’onglet Position et taille du volet latéral

Voir « Position et taille », page 53 .

Modifier la taille des objets

Avec la souris

Pour modifier la taille de l’objet sélectionné (ou du groupe d’objets sélectionnés), déplacez le 
pointeur de la souris au-dessus d’une des poignées de sélection. Il change de forme pour vous 
indiquer la direction du mouvement correspondant. Cliquez et faites glisser, en maintenant l’appui 
sur le bouton de la souris, jusqu’à atteindre la taille désirée. Au fur et à mesure du changement de 
taille, une image fantôme du nouvel objet apparaît pour vous aider (Figure 49). Relâchez le bouton
une fois la taille souhaitée atteinte.

Figure 49 : Modifier la taille d’un objet
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Le résultat dépend de la poignée de sélection choisie. Utilisez une poignée au milieu d’un côté 
pour redimensionner un objet selon un seul axe. Utilisez une poignée de coin pour le 
redimensionner selon les deux axes.

Remarque

Si vous gardez appuyée la touche Maj durant le redimensionnement d’un objet, la 
proportion entre hauteur et largeur sera conservée, afin que le rapport d’aspect de l’objet 
reste inchangé. Ce comportement s’applique à toutes les poignées.

Ceci est le comportement par défaut de la touche Maj. Cependant, si l’option Lors de la 
création ou du déplacement des objets de la section Contraindre les objets est cochée 
dans la page LibreOffice Draw – Grille de la boîte de dialogue Options (Outils > Options 
dans la barre de menu), l’action de la touche Maj est inversée. La proportion entre hauteur 
et largeur sera automatiquement conservée, à moins que la touche Maj ne soit appuyée.

Avec la boîte de dialogue ou l’onglet Position et taille du volet latéral

Voir « Position et taille », page 53.

Modifier un arc

La taille d’un arc d’ellipse ou de cercle peut être modifiée en modifiant la position de ses points de 
départ et d’arrivée.

Sélectionnez l’arc et cliquez sur l’icône Points ( ) de la barre d’outils Standard. Deux poignées 
plus importantes apparaissent au début et à la fin de l’arc (Figure 7). Lorsque le curseur de la 
souris se trouve au-dessus de l’une de ces deux poignées, sa forme change et vous pouvez alors 
déplacer le point de départ ou d’arrivée de l’arc.

Figure 50 : Arc en cours de modification

Faire pivoter et incliner des objets

Pour faire effectuer une rotation à un objet (ou à un groupe d’objets), sélectionnez-le, puis passez 
en mode rotation par une des méthodes suivantes :

• cliquez une deuxième fois sur l’objet quand les poignées de sélection sont apparues (pas 
trop vite, ce n’est pas un double-clic),

• cliquez sur le triangle à droite de l’icône Transformations dans la barre d’outils Ligne et 
remplissage (ou la barre d’outils Standard) puis sur l’icône Pivoter ( ) dans la palette 
d’outils. L’icône de la palette d’outils Transformations est celle du dernier outil utilisé (  à 
l’ouverture de Draw),

La palette d’outils est détachable et devient la barre d’outils Transformations, que vous 
pouvez aussi afficher en sélectionnant Affichage > Barres d’outils > Transformations 
dans la barre de menu,
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• sélectionnez Pivoter dans le menu Forme > Transformation de la barre de menu ou dans 
le sous-menu Pivoter ou retourner du menu contextuel de l’objet.

Figure 51 : Un objet prêt à effectuer une rotation

Les poignées de sélection changent de forme et de couleur (Figure 51). Le centre de rotation 
apparaît également au milieu de l’objet. Déplacez le curseur de la souris au-dessus d’une des 
poignées : sa forme change. Les poignées de coin servent à faire effectuer une rotation à l’objet, 
tandis que les poignées de côté servent à l’incliner.

Effectuer une rotation

Avec la souris

Le centre de rotation est normalement situé au centre du rectangle de sélection de l’objet. Pour le 
déplacer, cliquez sur celui-ci et tirez-le à la position voulue avec la souris ; celle-ci peut se trouver 
hors de l’objet.

Déplacez le curseur de la souris au-dessus d’une des poignées de coin. Le curseur prend 
normalement la forme d’un arc. Cliquez et faites glisser pour faire tourner l’objet. Au fur et à 
mesure de la rotation, une image fantôme du nouvel objet apparaît pour vous aider.

Vous trouverez également des informations dans la barre d’état, comme le montre la Figure 52. La
zone d’information vous indique que vous faites tourner un objet et l’angle de rotation. Les 
nombres indiquant la position et la taille s’actualisent au cours de la rotation.

Figure 52 : Objet en cours de rotation

50 | Chapitre 3 Manipuler les objets et les points des objets



Remarque

Si vous gardez appuyée la touche Maj durant la rotation d’un objet, l’angle de rotation est 
limité aux multiples de 15 degrés. Ceci est le comportement par défaut de la touche Maj. 
Cependant, si l’option Lors de la création ou du déplacement des objets de la section 
Contraindre les objets de Outils > Options > LibreOffice Draw > Grille est cochée, 
l’action de la touche Maj est inversée. L’angle de rotation est limité aux multiples de 15 
degrés (valeur par défaut), à moins que la touche Maj ne soit appuyée.

Remarque

La rotation des objets 3D fonctionne de manière assez différente, étant donné qu’elle 
s’effectue dans un espace à trois dimensions et non dans un plan simple. Voir Chapitre 7, 
Manipuler des objets 3D, , page 161, pour plus d’informations.

Avec la boîte de dialogue ou l’onglet Position et taille du volet latéral

Voir « Rotation des objets », page 54.

Incliner des objets

Avec la souris

Pour incliner un objet (ou un groupe d’objets), sélectionnez-le, puis passez en mode rotation (voir 
« Faire pivoter et incliner des objets », page 49).

Déplacez le pointeur de la souris au-dessus d’une des poignées au milieu d’un côté. Il prend 
normalement la forme de deux demi-flèches inversées. L’axe utilisé pour l’inclinaison est le côté 
opposé à celui de la poignée sur laquelle vous cliquez. Cet axe reste fixe, tandis que les autres 
côtés bougent en fonction du pointeur de la souris que vous faites glisser. Au fur et à mesure de 
l’inclinaison, une image fantôme du nouvel objet apparaît pour vous aider.

Vous trouverez également des informations dans la barre d’état, comme le montre la Figure 53. La
zone d’information vous indique que vous inclinez un objet et l’angle d’inclinaison. Les nombres 
indiquant la position et la taille s’actualisent au cours de la rotation.

Figure 53 : Objet en cours d’inclinaison
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Remarque

Si vous gardez appuyée la touche Maj durant l’inclinaison d’un objet, l’angle d’inclinaison 
est limité aux multiples de 15 degrés. Ceci est le comportement par défaut de la touche Maj.
Cependant, si l’option Lors de la création ou du déplacement des objets de la section 
Contraindre les objets de Outils > Options > LibreOffice Draw > Grille est cochée, 
l’action de la touche Maj est inversée. L’angle d’inclinaison est limité aux multiples de 15 
degrés (valeur par défaut), à moins que la touche Maj ne soit appuyée.

Avec la boîte de dialogue ou l’onglet Position et taille du volet latéral

Voir « Inclinaison et rayon d’angle », page 55.

Définir la position, la taille ou les angles d’inclinaison et de rotation 
avec précision

Il est possible de positionner des objets ou de modifier leur taille avec la souris, mais cette 
méthode est peu précise. Si vous voulez obtenir une position et une taille précises, vous devez 
utiliser la boîte de dialogue Position et taille (Figure 54) ou la section Position et taille du volet 
latéral (Figure 55).

Figure 54 : L’onglet Position et taille de la boîte de dialogue Position et taille.

Pour ouvrir la boîte de dialogue Position et taille (Figure 54), sélectionnez l’objet, puis

• choisissez Position et taille dans le menu Format ou le menu contextuel de l’objet ;

• cliquez sur l’icône Position et taille ( ) à gauche de la barre d’outils Ligne et remplissage 
(Figure 43 en bas) ;

• appuyez sur la touche F4.
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Pour ouvrir la section Position et taille (Figure 55) du volet latéral, sélectionnez l’objet, puis cliquez 
sur l’icône Propriétés ( ) à droite du volet latéral puis sur la flèche ˅ à gauche du titre de la 
section.

Figure 55 : Le panneau Position et taille de l’onglet Propriétés du volet latéral

Les options disponibles dans la boîte de dialogue et la section Position et taille du volet latéral sont
semblables. Elles sont cependant plus réduites dans ce dernier : on ne peut pas y protéger la 
position et la taille de l’objet contre les dimensions, y définir le point de base pour les changements
de position ou de taille ni permettre à l’objet de s’adapter au texte qu’il contient.

Position et taille

Position
– Position X : saisissez la distance horizontale entre le point de base sélectionné dans la 

grille et la marge gauche de la page.

– Position Y : saisissez la distance verticale entre le point de base sélectionné dans la grille 
et la marge du haut de la page.

– Point de base : sélectionnez un point de base dans la grille, puis saisissez, dans les 
champs Position Y et Position X, les coordonnées de ce point de base dans la zone 
imprimable de la feuille (l’origine étant, par défaut, l’intersection des marges gauche et 
supérieure de la page). Les points de base correspondent aux poignées de sélection d’un 
objet.

Taille
Spécifiez les nouvelles dimensions de l’objet sélectionné. Le point de base restera fixe et les 
autres sommets seront déplacés en conséquence.

– Largeur : saisissez une largeur pour l’objet sélectionné.

– Hauteur : saisissez une hauteur pour l’objet sélectionné.

– Proportionnel : conserve les proportions ; lorsque vous modifiez une dimension de l’objet 
sélectionné, l’autre est calculée pour que leur rapport reste constant.

– Point de base : cliquez sur un point de base dans la grille, qui restera fixe, puis saisissez 
les nouvelles dimensions de l’objet sélectionné dans les champs Largeur et Hauteur.

Protéger
Ces options ne sont disponibles que dans la boîte de dialogue Position et taille.
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– Position : cochez cette option pour empêcher les changements de position et de taille de 
l’objet sélectionné.

– Taille : cochez cette option pour empêcher les changements de taille de l’objet 
sélectionné.

Adapter
Ces options spécifient si la taille de l’objet doit s’ajuster à celle du texte saisi. Elles ne sont 
disponibles que dans la boîte de dialogue Position et taille.

– Adapter la largeur au texte : cochez cette option pour étendre la largeur de l’objet à celle 
du texte si elle n’est pas suffisante.

– Adapter la hauteur au texte : cochez cette option pour étendre la hauteur de l’objet à celle 
du texte si elle n’est pas suffisante.

L’unité de mesure employée pour les coordonnées, la largeur et la hauteur est celle choisie dans 
Outils > Options > LibreOffice Draw > Général.

L’emplacement par défaut du point de base pour la position et la taille se situe dans le coin 
supérieur gauche du rectangle de sélection de l’objet. Dans la boîte de dialogue Position et taille, 
vous pouvez changer temporairement de point de base en cliquant sur le point correspondant de 
la figure de droite. Ce changement n’est valable que pour une seule utilisation et le point de base 
revient à son emplacement par défaut lors de la fermeture de la boîte de dialogue Position et taille 
(Figure 54, page 52).

Rotation des objets

Pour faire pivoter de façon précise un objet, utilisez l’onglet Rotation de la boîte de dialogue 
Position et taille (Figure 56). Vous pouvez y définir l’angle de rotation et l’emplacement du centre 
de rotation. Vous pouvez aussi utiliser les options disponibles dans la section Position et taille de 
l’onglet Propriétés du volet latéral (Figure 55, page 53).

Figure 56 : L’onglet Rotation de la boîte de dialogue Position et taille
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Point de pivot
L’objet sélectionné tourne autour d’un point de pivot (centre de rotation) dont vous précisez 
les coordonnées. Il est situé par défaut au centre du rectangle de sélection de l’objet. Si vous
placez le point de pivot loin hors des limites de l’objet, la rotation peut le déplacer hors de la 
page. Cette option n’est disponible que dans la boîte de dialogue Position et taille (Figure 
56).

– Position X : saisissez la distance horizontale entre la marge gauche de la page et le point 
de pivot.

– Position Y : saisissez la distance verticale entre la marge du haut de la page et le point de
pivot.

– Paramètres par défaut : sélectionnez une position pour le point de pivot parmi les neuf 
points proposés (les huit poignées et le centre du rectangle de sélection). Ce choix ne 
sera valable qu’une seule fois : le point sélectionné reprendra sa position par défaut au 
centre de la grille à l’ouverture suivante.

Angle de rotation
Spécifiez le nombre de degrés dont vous voulez faire tourner l’objet sélectionné (dans le 
sens inverse des aiguilles d’une montre).

– Angle : saisissez le nombre de degrés (entre 0° et 360°, 0° à trois heures) dont vous 
voulez faire tourner l’objet ou utilisez les boutons pour augmenter ou diminuer la valeur 
indiquée (en nombres entiers). Cette option n’est disponible que dans la boîte de dialogue
Position et taille (Figure 56).

– Paramètres par défaut : cliquez dans la roue et déplacez la souris sans relâcher le bouton
pour la faire tourner. Le nombre de degrés s’affiche dans le champ Angle (et 
réciproquement : si vous modifiez le champ Angle, la roue tourne). Cette option n’est 
disponible que dans la boîte de dialogue Position et taille.

– Rotation : cliquez dans la roue et déplacez la souris sans relâcher le bouton pour la faire 
tourner. Le nombre de degrés s’affiche dans le champ de droite où vous pouvez aussi le 
saisir directement. Vous pouvez encore utiliser la liste déroulante de ce champ pour 
spécifier un angle prédéfini. Cette option n’est disponible que dans la section Position et 
taille de l’onglet Propriétés du volet latéral (Figure 55).

– Retourner : retourner l’objet sélectionné verticalement ou horizontalement (symétrie 
axiale) en cliquant sur un des boutons. Cette option n’est disponible que dans la section 
Position et taille de l’onglet Propriétés du volet latéral.

Inclinaison et rayon d’angle

Pour paramétrer précisément le rayon d’angle ou l’angle d’inclinaison d’un objet, ouvrez l’onglet 
Inclinaison et rayon d’angle de la boîte de dialogue Position et taille (Figure 57). Ces options ne 
sont disponibles que dans cet onglet.
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Figure 57 : L’onglet Inclinaison et rayon d’angle de la
boîte de dialogue Position et taille

Rayon d’angle
Il est seulement possible d’arrondir les sommets d’un objet rectangulaire. Si cette section est
grisée, le paramétrage d’un rayon d’angle n’est pas possible.

– Rayon : saisissez le rayon du cercle que vous voulez utiliser pour arrondir les angles. Plus
la valeur est grande, plus les sommets de l’objet sont arrondis.

Incliner
Permet d’incliner les bords verticaux de l’objet. Le résultat est différent d’une inclinaison avec
la souris, car la distance entre les bords horizontaux n’est pas modifiée.

– Angle : saisissez l’angle dont les bords verticaux vont tourner.

Point de contrôle 1 et 2
Saisissez les coordonnées des points de contrôles de l’objet par rapport au sommet 
supérieur du rectangle de sélection de l’objet. En l’absence de point de contrôle, les champs 
sont grisés et vous ne pouvez pas y définir de coordonnées.

Utiliser la grille et les fonctions de capture

Avec Draw, vous pouvez positionner des objets de manière précise et cohérente en utilisant les 
points de la grille, les points et les lignes de capture, les cadres des objets, les points individuels 
des objets et les bords de page. Ce sont les fonctions de capture.

Il est plus facile d’utiliser les fonctions de capture avec un facteur de zoom le plus élevé possible 
pour votre document. Vous pouvez utiliser deux fonctions de capture en même temps ; par 
exemple, faire une capture à une ligne de guide et aux bords de page. Cependant, il est 
recommandé de n’activer que les fonctions de capture dont vous avez réellement besoin.
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Configurer les fonctions de grille et de capture

Figure 58 : La page LibreOffice Draw – Grille de la boîte de dialogue Options

Pour configurer les fonctions de grille et de capture de votre document, sélectionnez Outils > 
Options dans la barre de menu puis ouvrez la page LibreOffice Draw – Grille (Figure 58). Les 
fonctions de grille et de capture peuvent être affichées, activées et désactivées dans cette boîte de
dialogue, en faisant un clic droit dans votre document et en utilisant les options du menu 
contextuel, ou en utilisant les icônes de barre d’outils Options (Figure 59). Si cette barre d’outils 
n’est pas affichée, sélectionnez Affichage > Barre d’outils > Options dans la barre de menu.

Mode rotation après un clic 
sur l’objet

Afficher la grille Afficher les guides de capture

Lignes d’aide lors du 
déplacement

Aligner sur la grille Capturer aux guides de capture

Capturer aux marges
Capturer à la bordure de
l’objet

Capturer aux points de l’objet

Permettre l’édition rapide
Sélectionner la zone de 
texte seule

Double-clic pour éditer du texte

Modifier l’objet avec des 
attributs

Quitter tous les groupes

Figure 59 : La barre d’outils Options

Grille
Cette section définit les paramètres de la grille configurable qui peut être affichée sur les 
pages de votre document. Celle-ci vous aide à déterminer la position exacte des objets. 
Vous pouvez aussi relier cette grille à la grille magnétique. Si vous avez activé la grille 
magnétique, mais que vous voulez déplacer ou créer des objets sans attraction magnétique, 
maintenez la touche Maj appuyée pour désactiver cette fonction aussi longtemps que 
nécessaire.
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– Capturer à la grille : spécifie si les cadres, éléments de dessin et contrôles sont 
uniquement déplacés entre points de la grille. Pour inverser l’attraction de la grille 
seulement pour l’action en cours, maintenez l’appui sur la touche Ctrl pendant que vous 
déplacez un objet. Cette option est aussi contrôlée par l’icône Aligner sur la grille ( ) 
de la barre d’outils Options.

– Grille visible : spécifie si la grille est visible ou non. Cette option est aussi contrôlée par 
l’icône Afficher la grille ( ) de la barre d’outils Options.

Résolution
– Horizontale : définit l’espacement horizontal entre les points principaux de la grille.

– Verticale : définit l’espacement vertical entre les points principaux de la grille.

– Synchroniser les axes : cochez cette option pour que les deux espacements et les deux 
nombres de subdivisions restent identiques quand l’un est modifié.

Subdivision
– Horizontale : définit le nombre d’intervalles entre deux points principaux de la grille dans 

le sens horizontal.

– Verticale : définit le nombre d’intervalles entre deux points principaux de la grille dans le 
sens vertical.

Capturer
– Aux lignes de captures : si cette option est cochée, la bordure de l’objet en cours de 

déplacement est attirée vers la ligne de capture la plus proche quand vous relâchez le 
bouton de la souris. Cette option est aussi contrôlée par l’icône Capturer aux guides de 
capture ( ) de la barre d’outils Options.

– Aux marges de la page : si cette option est cochée, le contour de l’objet de dessin est 
aligné sur la marge de la page la plus proche. Le curseur, ou une ligne du contour de 
l’objet, doit être dans la plage de capture. Cette option est aussi contrôlée par l’icône 
Capturer aux marges ( ) de la barre d’outils Options.

– Au cadre de l’objet : si cette option est cochée, le contour de l’objet de dessin est aligné 
sur la bordure de l’objet de dessin le plus proche. Le curseur, ou une ligne du contour de 
l’objet, doit être dans la plage de capture. Cette option est aussi contrôlée par l’icône 
Capturer à la bordure de l’objet ( ) de la barre d’outils Options.

– Aux points de l’objet : si cette option est cochée, le contour de l’objet de dessin est aligné 
sur les points de l’objet de dessin le plus proche. Le curseur, ou une ligne du contour de 
l’objet, doit être dans la plage de capture. Cette option est aussi contrôlée par l’icône 
Capturer aux points de l’objet ( ) de la barre d’outils Options.

– Plage de capture : cette option définit la distance entre le pointeur de la souris et le 
contour de l’objet. Il est attiré par un point magnétique si le pointeur de la souris est plus 
proche que la distance choisie.

Contraindre les objets
– Lors de la création ou du déplacement des objets : si cette option est cochée, la création 

et le déplacement des objets de dessin est limitée à l’horizontale, la verticale et la 
diagonale (45°). Cette fonction peut être temporairement désactivée en appuyant sur la 
touche Maj.
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– Étendre les arêtes : si cette option est cochée, un carré est créé à partir du plus long côté 
du rectangle quand on appuie sur Maj avant de relâcher le bouton de la souris. De même,
un cercle sera créé à partir de l’axe le plus long de l’ellipse dans les mêmes conditions. Si
elle n’est pas cochée, le plus petit côté ou le plus petit axe sera utilisé.

– Lors de la rotation : cochez cette option pour la rotation des objets graphiques soit limitée 
à des multiples de l’angle précisé dans le champ voisin. Si vous voulez effectuer une 
rotation à un angle autre que celui-ci, appuyez sur la touche Maj pendant la rotation. 
Relâchez la touche quand l’angle désiré est obtenu.

– Réduction de point : définit l’angle pour la réduction de point. Quand vous travaillez avec 
des polygones, vous trouverez peut-être utile de réduire leurs points d’édition.

Capturer à la grille

Utiliser la capture par la grille

Utilisez la fonction de capture à la grille pour positionner un objet exactement à un point de la grille
de votre document. Cette fonction peut être activée et désactivée de plusieurs façons :

• Cochez l’option Capturer à la grille de la page LibreOffice Draw – Grille de la boîte de 
dialogue Options.

• Sélectionnez Affichage > Guides de capture > Aligner sur la grille dans la barre de menu.

• Faites un clic droit dans un espace libre de votre document et choisissez Guides de capture
> Aligner sur la grille dans le menu contextuel.

• Utilisez l’icône Aligner sur la grille  de la barre d’outils Options.

Afficher la grille

Vous pouvez activer ou désactiver l’affichage de la grille de plusieurs façons :

• Utilisez l’option Grille visible de la page LibreOffice Draw – Grille de la boîte de dialogue 
Options.

• Sélectionnez Affichage > Grille et lignes guide > Afficher la grille dans la barre de menu.

• Faites un clic droit dans un espace libre de votre document et choisissez Grille et lignes 
guide > Afficher la grille dans le menu contextuel.

• Utilisez l’icône Afficher la grille  de la barre d’outils Options.

Changer la couleur des points de la grille

Par défaut et selon les paramètres d’affichage de votre ordinateur, les points de la grille sont en 
gris et ne sont pas toujours très visibles. Vous pouvez sélectionner Outils > Options dans la barre
de menu puis ouvrir la page LibreOffice  – Couleurs de l’interface (Figure 60) et, dans la section 
Dessin/Présentation, sélectionner, dans la palette qui s’ouvre en cliquant sur le bouton, une 
couleur plus appropriée pour les points de la grille.
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Figure 60 : La page Couleurs de l’application dans la boîte de dialogue Options

Lignes et points de capture

Contrairement à la grille, les lignes et les points de capture sont insérés par vous où vous 
souhaitez positionner un objet dans votre document. Les lignes de capture peuvent être 
horizontales ou verticales et apparaissent sous la forme de tirets. Les points de capture 
apparaissent sous la forme d’une croix de lignes de tirets. Les lignes et les points de capture 
n’apparaissent pas lors de l’impression du document.

Insérer des lignes et des points de capture

Pour insérer une ligne ou un point de capture, sélectionnez Insertion > Guide de capture dans la 
barre de menu. La boîte de dialogue Nouvel objet de capture s’ouvre (Figure 61).

Figure 61 : la boîte de dialogue Nouvel objet de capture

Position
Définit la position de la ligne ou du point de capture par rapport au coin supérieur gauche de 
la zone imprimable de la page.

– X : saisissez la distance entre la ligne ou le point de capture et la marge gauche de la 
page.
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– Y : saisissez la distance entre la ligne ou le point de capture et la marge supérieure de la 
page.

Type
Spécifie le type d’objet de capture à insérer.

– Point : insère un point de capture.

– Vertical : insère une ligne de capture verticale.

– Horizontal : insère une ligne de capture horizontale.

Conseil

Pour insérer une ligne de capture, vous pouvez tirer avec la souris la règle horizontale ou 
verticale jusqu’à la position voulue.

Afficher les lignes et points de capture

Vous pouvez activer et désactiver l’affichage des lignes et des points de capture de plusieurs 
façons :

• Sélectionnez Affichage > Guides de capture > Afficher les guides de capture dans la 
barre de menu.

• Faites un clic droit dans un espace vide de votre document et choisissez Guides de capture
> Afficher les guides de capture dans le menu contextuel.

• Utilisez l’icône Afficher les guides de capture  de la barre d’outils Options.

Vous pouvez activer ou désactiver l’affichage des lignes de capture au premier plan (devant les 
objets) de plusieurs façons :

• Sélectionnez Affichage > Guides de capture > Guides de capture au premier plan dans 
la barre de menu.

• Faites un clic droit dans un espace vide de votre document et choisissez Guides de capture
> Guides de capture au premier plan dans le menu contextuel.

Éditer les lignes et points de capture

Pour éditer une ligne ou un point de capture, positionnez-vous au-dessus de l’objet de capture et 
faites un clic droit, puis choisissez Éditer la ligne de capture ou Éditer le point de capture dans 
le menu contextuel pour ouvrir la boîte de dialogue Édition de la ligne / du point de capture (Figure 
62). Saisissez les nouvelles coordonnées du point, la nouvelle abscisse pour une ligne verticale et 
la nouvelle ordonnée pour une ligne horizontale. Vous pouvez également cliquer sur l’objet et le 
faire glisser à l’endroit voulu.

   
Figure 62 : Les boîtes de dialogue Édition de la ligne / du point de capture
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Supprimer des lignes et points de capture

Pour supprimer une ligne ou un point de capture, positionnez-vous au-dessus de l’objet de capture
et faites un clic droit, puis choisissez Supprimer la ligne de capture ou Supprimer le point de 
capture dans le menu contextuel.

Vous pouvez également cliquer sur l’objet de capture et le tirez sur une règle.

Configurer la plage de capture

Pour configurer la plage de capture à partir de laquelle un objet est attiré,

 4) Sélectionnez Outils > Options dans la barre de menu et ouvrez la page LibreOffice Draw – 
Grille (Figure 58, page 57).

 5) Dans le champ Plage de capture, saisissez le nombre de pixels pour définir la distance à 
partir de laquelle l’objet sera capturé. La valeur par défaut est 5 pixels.

 6) Cliquez sur OK pour définir la plage de capture et refermer la boîte de dialogue.

Utiliser les lignes d’aide

Les lignes d’aide lors du déplacement sont une autre fonction de Draw qui vous assiste pour 
positionner des objets. Des lignes d’aide peuvent être affichées au cours du déplacement d’un 
objet. Elles étendent les bords du rectangle de sélection de l’objet jusqu’aux règles (Figure 63), et 
n’ont aucune fonction de capture.

Figure 63 : Lignes d’aide lors du déplacement

Pour activer et désactiver l’affichage des lignes d’aide :

• Cochez l’option Lignes d’aide lors du déplacement de la page LibreOffice Draw – Affichage 
de la boîte de dialogue Options (Figure 64).

Figure 64 : La page LibreOffice Draw – Affichage de la boîte de dialogue Options
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• Utilisez l’icône Lignes d’aide lors du déplacement  de la barre d’outils Options ou Ligne 
et remplissage.

Modifier les formes géométriques simples

Lorsque vous dessinez ou sélectionnez certaines formes géométriques, un ou plusieurs points 
apparaissent et ont une forme ou une couleur différente des poignées de sélection (Figure 65). 
Lorsque le curseur de la souris se trouve au-dessus de ces points, sa forme change. Si alors vous 
cliquez et faites glisser le curseur, la forme de l’objet change. Vous pouvez par exemple augmenter
le rayon d’angle d’un rectangle aux coins arrondis, ou changer l’épaisseur d’un cadre.

Figure 65 : Point de réglage d’un rectangle arrondi

Ces repères ont différentes fonctions selon la forme géométrique sélectionnée. Ces fonctions sont 
indiquées ci-dessous.

Formes de base

• Rectangle et carré arrondis : utilisez le point pour modifier le rayon d’angle de la courbe qui 
remplace les coins du rectangle ou du carré.

• Secteur de cercle : utilisez les points pour modifier la taille du secteur rempli.

• Triangle isocèle : utilisez le point pour modifier le type de triangle.

• Trapèze, parallélogramme, hexagone et octogone : utilisez le point pour modifier l’angle 
entre les côtés.

• Croix : utilisez le point pour modifier l’épaisseur des quatre bras de la croix.

• Anneau : utilisez le point pour modifier le diamètre intérieur de l’anneau.

• Arc plein : utilisez le point pour modifier à la fois le diamètre intérieur et la taille d’un arc 
plein.

• Cylindre et cube : utilisez le point pour modifier la perspective.

• Coin replié : utilisez le point pour modifier la taille du coin replié.

• Cadre : utilisez le point pour modifier l’épaisseur du cadre.

Formes des symboles

• Frimousse : utilisez le point pour modifier le sourire du visage.
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• Soleil : utilisez le point pour modifier le diamètre du cercle intérieur.

• Lune : utilisez le point pour modifier l’épaisseur de la lune.

• Cœur : utilisez le point pour modifier la forme du cœur.

• Interdit : utilisez le point pour modifier l’épaisseur de la barre diagonale et de l’anneau.

• Parenthèses, parenthèse ouvrante et parenthèse fermante : utilisez le point pour modifier la 
courbure des parenthèses.

• Accolades : utilisez le point pour modifier la courbure des accolades.

• Accolade ouvrante et accolade fermante ; utilisez les points pour modifier la courbure et la 
hauteur de la pointe de l’accolade.

• Plaque carrée, plaque octogone et plaque en forme de losange : utilisez le point pour 
modifier de la forme intérieure de la plaque.

Flèches pleines

• Flèches : utilisez le point pour modifier l’épaisseur et la forme de la flèche.

• Pentagone et chevron : utilisez le point pour modifier l’angle entre les côtés.

• Légendes avec flèches : utilisez les points pour modifier la taille de la légende, la taille du 
trait et la forme de la flèche.

• Flèche en arc : utilisez le point pour modifier la taille de l’arc.

Légendes

• Légendes : utilisez le point pour modifier le pointeur.

• Légendes 1, 2 et 3 : utilisez les points pour modifier le trait pointeur.

Étoiles

• Étoile à 4 branches, étoile à 8 branches et étoile à 24 branches : utilisez le point pour 
modifier la forme et l’épaisseur des branches.

• Parchemin horizontal et vertical : utilisez le point pour modifier la taille de l’enroulement du 
parchemin.

• Plaque de porte : utilisez le point pour modifier la courbure des coins incurvés de la plaque.

Courbes et polygones

Courbes de Bézier

L’édition des courbes s’effectue à partir des théories mathématiques des courbes de Bézier, qui 
portent le nom de l’ingénieur qui les modélisa dans les années 1960 dans le but de faciliter la 
modélisation de la carrosserie des véhicules. L’explication des courbes de Bézier dépasse le cadre
de ce guide et seules les notions de base sont abordées ici.

LibreOffice manipule des courbes de Bézier de type cubique. Une telle courbe est définie par un 
point de départ P0, un point d’arrivée P3 et deux points de contrôle P1 et P2 (Figure 66). La 
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courbe commence au point P0 en direction du point P1 et se termine au point P3 depuis la 
direction du point P2. Plus le point de contrôle sera éloigné du point de départ ou d’arrivée, plus la 
courbe sera accentuée à cet endroit. Si un point de contrôle coïncide avec son point de départ ou 
d’arrivée, il n’aura aucune influence sur la courbe. Des tangentes apparaissent, reliant un point de 
contrôle à son point associé.

Figure 66 : Les points de contrôle d’une courbe de Bézier

L’édition d’une courbe de Bézier consiste à déplacer ses points de contrôle ou ses extrémités. 
L’angle relatif et la distance avec ces points de contrôle vont déterminer la forme de la courbe. 
Vous pouvez convertir un objet en un ensemble de courbes reliées entre elles. Des tangentes vont
se former, comportant un point de contrôle à chacune de ses extrémités et un point de jonction à 
l’endroit où elle rencontre la courbe. La Figure 67 vous montre ce qui se passe à partir d’un carré 
(transformé en courbe) en déplaçant un point de contrôle d’un sommet.

Figure 67 : Déplacer les tangentes pour créer des formes différentes

Vous pouvez créer différentes formes en déplaçant l’un des points de contrôle à l’extrémité d’une 
tangente, ou les deux points de contrôle, ou même le point de jonction avec la courbe. Draw offre 
encore plus de possibilités avec les fonctions de la barre d’outils Éditer les points.

Convertir en courbe ou en polygone

Avant d’éditer les points d’un objet, vous devez le convertir en courbe ou en polygone, selon le 
type d’effet que vous voulez produire. Après avoir sélectionné un objet,

• sélectionnez Forme > Convertir et choisissez En courbe ou En polygone,

• faites un clic droit et choisissez Convertir > En courbe ou Convertir > En polygone dans 
le menu contextuel.

Après avoir converti un objet en courbe ou en polygone, sélectionnez-le puis procédez d’une des 
façons suivantes pour éditer les points de l’objet

• cliquez sur l’icône Points  de la barre d’outils Standard,
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• choisissez Édition > Points dans la barre de menus,

• faites un clic droit sur l’objet et sélectionnez Points dans le menu contextuel,

• appuyez sur la touche F8.

La barre d’outils Éditer les points s’ouvre (Figure 68).

Notez que lorsque vous êtes en mode Édition de points, les poignées de sélection disparaissent et
font place à d’autres poignées de forme ou de couleur différentes. Ceci est normal, et ces 
nouvelles poignées sont celles que vous allez utiliser avec les outils de la barre d’outils Éditer les 
points.

Barre d’outils Éditer les points

Éditer les points Déplacer des points Insérer des points

Supprimer des points Convertir en courbe Fermer la courbe de Bézier

Scinder la courbe Point d’inflexion Jonction lisse

Jonction symétrique Réduire les points

Figure 68 : La barre d’outils Éditer les points

Après avoir été ouverte, la barre d’outils Éditer les points (Figure 68) apparaît lorsque vous 
sélectionnez un objet qui a été converti en courbe ou en polygone. Chaque fois que l’objet perd la 
sélection, la barre d’outils se ferme. La disponibilité des outils de cette barre d’outils dépend de 
l’objet et du point de l’objet sélectionnés.

Actions sur les tangentes

Avant de pouvoir utiliser les tangentes sur un objet, vous devez le convertir en courbe. 
Sélectionnez Convertir > En courbe dans le menu Forme ou dans le menu contextuel de l’objet.

Remarque

Les tangentes ne sont utilisées qu’avec les courbes. Si un objet a été converti en polygone 
et qu’un point d’inflexion est ajouté, ce qui crée deux tangentes, l’objet est automatiquement 
converti en courbe.

Jonction symétrique

L’outil Jonction symétrique  convertit un point anguleux ou une jonction lisse en point de 
jonction symétrique. Le point de jonction et ses points de contrôle sont alignés et séparés par des 
distances égales ; chaque mouvement d’un point de contrôle est transposé de façon symétrique à 
l’autre point de contrôle. Le rayon de courbure est le même dans les deux directions.

 1) Convertissez l’objet en courbe et cliquez sur le point de la courbe que vous voulez 
transformer en jonction symétrique.

 2) Cliquez sur l’icône Jonction symétrique  dans la barre d’outils Éditer les points (Figure 
68).
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 3) Cliquez sur une des poignées de la tangente et tirez-la pour modifier la forme de l’objet. Les 
deux poignées restent symétriques par rapport au point de la courbe.

Figure 69 : Point transformé en jonction symétrique

Jonction lisse

L’outil Jonction Lisse  convertit un point anguleux ou une jonction symétrique en point de 
jonction lisse asymétrique. Le point de jonction et ses points de contrôle sont alignés. Les deux 
points de contrôle se déplacent simultanément, mais peuvent être séparés par des distances 
différentes. La tangente devient asymétrique et la courbe est plus aplatie du côté le plus long et le 
rayon de courbure plus grand.

 1) Convertissez l’objet en courbe et cliquez sur le point de la courbe que vous voulez 
transformer en jonction lisse.

 2) Cliquez sur l’icône Jonction lisse  dans la barre d’outils Éditer les points (Figure 68, page
66).

 3) Cliquez sur une des poignées de la tangente et tirez-la pour modifier la forme de l’objet. Les 
deux poignées restent alignées avec le point de la courbe.

Figure 70 : Point transformé en jonction lisse

Point d’inflexion

L’outil Point d’inflexion  convertit le ou les points sélectionnés en points anguleux. Il est 
possible de modifier indépendamment l’angle de chaque côté de la tangente en déplaçant de 
façon indépendante les deux points de contrôle.

 1) Convertissez l’objet en courbe et cliquez sur le point de la courbe que vous voulez 
transformer en point d’inflexion.

 2) Cliquez sur l’icône Point d’inflexion  dans la barre d’outils Éditer les points (Figure 68, 
page 66).
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 3) Cliquez sur une des poignées de la tangente et tirez-la pour modifier la forme de l’objet. 
Chaque poignée peut être déplacée indépendamment de l’autre pour créer des creux et des 
bosses dans l’objet.

Figure 71 : Point transformé en point d’inflexion

Rotation d’une jonction

Vous pouvez modifier l’angle que forme la tangente à un point de jonction par rapport à la courbe 
en déplaçant un des points de contrôle. La courbe va alors se déformer.

Figure 72 : Rotation de la tangente

Actions sur les points

Déplacer des points

Cliquez sur l’icône Déplacer des points  pour pouvoir déplacer chacun des points d’un objet 
converti en courbe ou en polygone. Quand l’icône est active, le curseur de la souris change de 
forme lorsqu’il se trouve au-dessus d’un point. Cliquez alors et faites glisser le curseur jusqu’à la 
position désirée.  La courbe de chaque côté du point suit le mouvement et la section de la courbe 
entre les deux points qui entourent le point déplacé change de forme.

Pour déplacer une forme entière sans la déformer, cliquez entre deux points ou à l’intérieur d’une 
courbe fermée et tirez-la avec la souris.

 1) Assurez-vous que l’objet est converti en courbe.

 2) Cliquez sur l’icône Déplacer des points  dans la barre d’outils Éditer les points (Figure 
68, page 66).

 3) Placez le pointeur de la souris au-dessus du point à déplacer. Quand le pointeur change de 
forme, cliquez et tirez le point pour créer une nouvelle forme comme sur la Figure 73.
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Figure 73 : Déplacer des points

Insérer des points

Cliquez sur l’icône Insérer des points  pour ajouter un point supplémentaire à une courbe ou à 
un polygone. Cliquez sur la bordure de l’objet, puis déplacez le curseur à l’endroit où vous voulez 
insérer un point. La jonction est lisse (le point inséré et ses deux points de contrôle sont alignés) si 
le point est inséré dans une courbe. Si vous souhaitez créer un point d’inflexion, créez le nouveau 
point puis convertissez-le grâce à l’outil Point d’inflexion (  à droite de la barre d’outils)

 1) Assurez-vous que l’objet est converti en courbe ou en polygone.

 2) Cliquez sur l’icône Insérer des points  à gauche de la barre d’outils Éditer les points 
(Figure 68, page 66).

Figure 74 : Insérer d’un point
dans une courbe (à gauche) dans un polygone (à droite)

 3) Cliquez sur la bordure de l’objet à l’endroit où vous voulez insérer le point. L’espacement des
points de contrôles dépend de l’endroit où le nouveau point a été ajouté. La Figure 74 
montre un nouveau point ajouté sur le côté droit d’un carré transformé en courbe puis 
déplacé pour créer la forme illustrée.

Supprimer des points

Sélectionnez un ou plusieurs points et cliquez sur l’icône Supprimer des points  pour 
supprimer le ou les points de la bordure de l’objet. Pour sélectionner plusieurs points, maintenez 
l’appui sur la touche Maj en cliquant sur ceux-ci. La courbe se transforme alors en fonction des 
points restants. Vous pouvez également supprimer un point sélectionné en appuyant sur la touche 
Suppr.

La Figure 75 montre ce qui se passe si vous supprimez trois points à gauche d’un cercle converti 
en courbe. L’image de droite est le résultat converti en ligne (voir « Convertir en courbe ou en 
ligne », page 70) : on obtient une ligne droite entre les deux points de chaque côté des points 
supprimés.
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Figure 75 : Supprimer des points
résultat (à gauche) après conversion en ligne (à droite)

Éliminer des points

L’icône Réduire les points (  à droite de la barre d’outils) ne fonctionne que sur des lignes avec 
plusieurs points. Celles-ci sont créées quand une courbe est convertie en ligne grâce à l’icône 
Convertir en courbe ( ) de la barre d’outils Éditer les points (Figure 68, page 66).

Pour supprimer un point et relier ses voisins par un segment, procédez de la façon suivante :

 1) Sélectionnez une courbe avec plusieurs points qui a été convertie en
ligne (voir « Convertir en courbe ou en ligne », page 70).

 2) Sélectionnez avec la souris le point de la ligne que vous voulez
éliminer. Ce point est mis en valeur.

 3) Cliquez sur l’icône Réduire les points( ) à droite de la barre d’outils Éditer les points 
(Figure 68, page 66).

 4) Placez le pointeur de la souris au-dessus du point sélectionné, cliquez
et commencez à le déplacer. Une ligne pointillée se forme entre ce
point et ses deux voisins.

 5) Quand la ligne pointillée est un segment qui joint les deux voisins,
relâchez le bouton de la souris. Le point sélectionné est supprimé et
ses deux voisins sont maintenant directement reliés par un segment.

Convertir en courbe ou en ligne

L’icône Convertir en courbe  va vous permettre de convertir une courbe en ligne droite, ou 
vice-versa. Quand une courbe est convertie en ligne un segment est créé entre les points 
sélectionnés de la courbe. Quand une ligne est convertie en courbe, une courbe de Bézier est 
créée entre les points sélectionnés de la ligne.

 1) Sélectionnez une courbe (ou une ligne) puis les points de la courbe (ou de la ligne) auxquels
vous voulez appliquer la conversion.

 2) Cliquez sur l’icône Convertir en courbe  de la barre d’outils Éditer les points (Figure 68, 
page 66) pour convertir la courbe en ligne (ou la ligne en courbe).
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Figure 76 : Convertir une ligne en courbe

Si vous convertissez en courbe une ligne polygonale, les portions de ligne restent droites, mais 
des points de contrôle apparaissent. Déplacez-les pour obtenir une courbe à votre convenance.

Scinder les courbes

 1) Sélectionnez le point de la courbe où vous voulez effectuer une coupure. Pour séparer une 
courbe simultanément à plusieurs endroits, maintenez l’appui sur la touche Maj en 
sélectionnant tous les points où la coupure doit se produire.

 2) Cliquez sur l’icône Scinder la courbe  de la barre d’outils Éditer les points (Figure 68, 
page 66) pour scinder ou couper la courbe à l’endroit du point sélectionné. Si l’objet est 
rempli, le remplissage est supprimé, étant donné que la courbe qui constitue la bordure de 
l’objet n’est plus fermée.

 3) Désélectionnez la courbe, puis cliquez et faites glisser le curseur de la souris pour éloigner le
segment coupé de la courbe (Figure 77).

Remarque

Le point où vous scindez la courbe est désormais plus grand que les autres points visibles 
sur la courbe, le point de départ mis à part.

Figure 77 : Courbe scindée en deux parties

Fermer les courbes

 1) Sélectionnez la courbe ouverte,

 2) Sélectionnez un point de la courbe. Notez que le point de départ est plus grand que les 
autres points visibles sur la courbe.
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 3) Cliquez sur l’icône Fermer Bézier  de la barre d’outils Éditer les points (Figure 68, page
66) pour fermer la courbe par une ligne droite entre ses points d’arrivée et de départ (Figure 
78).

Si la courbe ouverte était à l’origine une courbe fermée et remplie, et si vous cliquez sur 
l’icône Fermer Bézier, la courbe sera alors fermée et remplie.

Figure 78 : Fermer une courbe

Faire pivoter et distordre les courbes

 1) Sélectionnez la courbe puis choisissez Affichage > Barre d’outils > Transformations dans
la barre de menu pour ouvrir la barre d’outils Transformations. Cliquez sur l’icône Pivoter (

 ; voir « Faire pivoter et incliner des objets », page 49 pour plus d’informations sur la 
rotation des objets).

 2) Sélectionnez un des points de la courbe et tirez-le à une nouvelle position pour déformer la 
courbe (Figure 79).

 3) Sélectionnez un des points de contrôle au bout d’une tangente et faites tourner la courbe 
déformée en faisant glisser le pointeur de la souris. La courbe tourne autour du centre de 
rotation.

Figure 79 : Déformer et faire tourner une courbe
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Formater les lignes

Dans LibreOffice, le terme de ligne s’applique à un segment indépendant (ligne), au bord extérieur 
d’une forme (bordure) ou à une flèche. Dans la plupart des cas, les propriétés d’une ligne que vous
pouvez modifier sont son style (continu, tirets, pointillés, invisible…), sa largeur et sa couleur.

! Attention

L’outil Largeur permet de définir l’épaisseur du trait. Ne pas confondre avec la largeur 
(longueur du trait) définissable dans la boîte de dialogue Position et taille.

Avec la barre d’outils Ligne et remplissage

Pour formater une ligne grâce à la barre d’outils Ligne et remplissage (Figure 80) :

 4) Assurez-vous que la ligne est sélectionnée dans le dessin.

 5) Sélectionnez le style de la ligne dans la liste déroulante Style de ligne.

 6) Définissez la largeur de la ligne, soit en la tapant dans la zone de saisie Largeur de ligne, 
soit en utilisant les flèches adjacentes vers le haut et vers le bas.

 7) Cliquez sur le petit triangle à droite de l’icône Couleur de ligne ( ) et choisissez une 
couleur dans la palette qui s’ouvre alors.

 

Figure 80 : La barre d’outils Ligne et remplissage.
Les outils disponibles pour modifier les attributs sont encadrés en vert.

En haut les lignes, en bas le remplissage, les ombres et les extrémités de lignes.

Remarque

Quand le pointeur de la souris survole une icône ou un bouton d’une barre d’outils ou du 
volet latéral, une infobulle vous indique son objet.

Avec le volet latéral

Pour formater une ligne grâce à la section Ligne de l’onglet Propriétés du volet latéral (Figure 81) :

 1) Assurez-vous que la ligne est sélectionnée dans le dessin.

 2) Ouvrez l’onglet Propriétés en cliquant sur son icône ( ) à droite de la fenêtre.

 3) Ouvrez la section Ligne en cliquant sur  à gauche de son titre.

 4) Sélectionnez dans les deux listes déroulantes le type de décoration (flèche, carré, cercle, 
etc.) à ajouter aux extrémités pour transformer la ligne en flèche. La liste de gauche 
s’applique au début de la ligne et celle de droite à sa fin.

 5) Choisissez le style de ligne dans la liste déroulante entre les deux précédentes.
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 6) Choisissez la largeur de la ligne parmi celles proposées dans la liste déroulante Largeur ou 
définissez-la dans la zone de saisie en bas de cette liste.

 7) Cliquez sur  à droite de l’icône Couleur pour faire votre choix dans la palette qui s’ouvre.

 8) Désélectionnez la ligne pour enregistrer vos modifications.

Figure 81 : la section Ligne dans l’onglet Propriétés du volet latéral.

Avec la boîte de dialogue Ligne

Figure 82 : la boîte de dialogue Ligne

Si vous désirez modifier totalement l’apparence d’une ligne, vous devez utiliser la boîte de 
dialogue Ligne.
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 1) Assurez-vous que la ligne est sélectionnée dans le dessin.

 2) Sélectionnez Ligne dans le menu Format ou dans le menu contextuel ouvert par un clic 
droit sur la ligne, ou cliquez sur le bouton Plus d’options ( ) à droite du titre du panneau 
Ligne dans le volet latéral. La boîte de dialogue Ligne s’ouvre (Figure 82). Cette boîte de 
dialogue est constituée de quatre onglets : Ligne, Ombre, Styles de ligne et Styles de flèche 
qui sont présentés dans les sections suivantes.

 3) Une fois les modifications réalisées, cliquez sur OK pour refermer la boîte de dialogue et 
enregistrer les changements. La zone d’aperçu en bas de la boîte de dialogue vous montre 
les effets sur la ligne des choix que vous effectuez.

Onglet Ligne

L’onglet Ligne de la boîte de dialogue Ligne (Figure 82) est l’endroit où vous pouvez définir les 
paramètres de base de la ligne. Il est partagé en trois sections.

Propriétés de ligne
Cette section vous permet de définir les paramètres suivants :

– Style : sélectionnez un style de ligne dans la liste déroulante ;

– Couleur : sélectionnez une couleur prédéfinie dans la palette ou créez une couleur 
personnalisée ;

– Largeur : tapez la largeur de la ligne dans la boîte de saisie ou utilisez les boutons fléchés
adjacents. L’unité de mesure par défaut est celle indiquée dans Outils > Options > 
LibreOffice Draw > Général, mais vous pouvez saisir une autre unité. Si cette valeur est 
nulle, la ligne résultante a une largeur minimale d’un pixel.

– Transparence : définissez la transparence de la ligne. La Figure 83 montre l’effet de 
différents pourcentages de transparence de lignes placées sur un objet.

Figure 83 : Transparence d’une ligne.
De gauche à droite  : 0 %, 25 %, 50 % et 75 %.

Styles de flèches
Les paramètres de la section Styles de flèche ne s’appliquent qu’aux lignes individuelles et 
n’ont aucun effet sur les lignes qui constituent la bordure d’une forme.

– Style de départ et Style de fin : choisissez le style de terminaison en début et en fin de 
ligne dans les listes déroulantes.

– Largeur : spécifiez la largeur de l’élément terminal choisi. L’unité de mesure par défaut est
celle indiquée dans Outils > Options > LibreOffice Draw > Général, mais vous pouvez 
saisir une autre unité. Si cette valeur est nulle, la flèche disparaîtra.

– Centre : cochez cette option pour déplacer le centre de l’élément de terminaison à 
l’extrémité de la ligne (Figure 84).
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Figure 84 : Placement des terminaisons de lignes.
En haut  : par défaut  ; en bas : option centre cochée.

– Synchroniser les extrémités : cochez cette option si vous voulez deux extrémités 
identiques.

! Attention

Le simple fait de cocher l’option Synchroniser les extrémités ne va
pas rendre identique les deux extrémités de la ligne. Il faut que
vous modifiiez un attribut pour que ses valeurs soient identiques
pour le début et la fin de la ligne.

Pour choisir rapidement les terminaisons d’une ligne sélectionnée,
cliquez sur l’icône Style de flèche ( ) dans la barre d’outils Ligne et
remplissage pour ouvrir la palette Extrémités de flèches (Figure 85) où
vous pouvez faire votre choix parmi les terminaisons prédéfinies pour le
début (à gauche dans la palette) et la fin (à droite dans la palette) de la
ligne.

Remarque

Les terminaisons ne sont applicables qu’aux lignes individuelles et
n’ont aucun effet sur les bordures des objets.

Styles d’angle et de coiffe
Les styles d’angle et de coiffe déterminent l’apparence de la jonction entre deux segments. 
Pour constater la différence entre les styles, dessinez une ligne épaisse et observez le 
changement dans l’aperçu.

– Style d’angle : sélectionnez la forme qui sera appliquée aux sommets de la ligne. Si les 
deux parties forment un angle aigu, le style En onglet sera remplacé par un style 
Biseauté.

Figure 86 : De gauche à droite, style d’angle
Arrondi, - aucun -, En onglet, Biseauté.

– Style de coiffe : choisissez la forme des extrémités de la ligne. Le style de coiffe choisi 
s’applique aussi aux tirets.
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Figure 87 : Styles de coiffe. De haut en bas, Plat, Rond et Carré.

Onglet Ombre

L’onglet Ombre (Figure 88) est l’endroit où vous pouvez ajouter et formater une ombre à la ligne 
sélectionnée. Le contenu de cet onglet est identique à celui s’appliquant aux objets et est décrit 
dans « Ombre » page 101.

Figure 88 : L’onglet Ombre de la boîte de dialogue Ligne

Vous pouvez appliquer rapidement une ombre à la ligne sélectionnée en utilisant l’icône Ombre (
) de la barre d’outils Ligne et remplissage. Cependant, l’ombre appliquée ne sera que celle 

définie par le style graphique par défaut.

Onglet Styles de ligne

L’onglet Styles de ligne (Figure 89) est l’endroit où vous allez pouvoir créer de nouveaux styles de 
ligne et charger des styles préalablement enregistrés. Il est préférable de créer de nouveaux styles
plutôt que de modifier des styles prédéfinis. Un exemple du style de ligne sélectionné ou créé est 
affiché en bas de la boîte de dialogue.

Créer un style de ligne

Pour créer un style de ligne à partir de cet onglet :

 1) Ouvrez la boîte de dialogue Ligne en sélectionnant Ligne dans le menu Format ou dans le 
menu contextuel, ou en cliquant sur le bouton Ligne ( ) dans la barre d’outils Ligne et 
formatage.

 2) Ouvrez l’onglet Styles de ligne (Figure 89).

 3) Choisissez dans la liste déroulante Style de ligne un style proche de celui que vous voulez 
créer.
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 4) Cliquez sur Ajouter. Dans la boîte de dialogue Nom qui s’ouvre, saisissez le nom du 
nouveau style de ligne et cliquez sur OK.

 5) Définissez le nouveau style. Commencez par choisir le type de composant de la ligne (Point 
ou Tiret). Vous pouvez alterner ces composants en choisissant deux types différents dans 
les deux zones du type de ligne.

 6) Saisissez le nombre et la longueur de chacun des composants de la ligne. La longueur n’est 
pas disponible pour un composant de type Point.

 7) Saisissez l’espacement entre les différents composants.

 8) Vous pouvez cocher l’option Adapter à la largeur de la ligne.

Figure 89 : L’onglet Styles de ligne de la boîte de dialogue Ligne

Le nouveau style de ligne ainsi créé n’est disponible que dans le document en cours. Si vous 
voulez l’utiliser dans d’autres documents, cliquez sur l’icône Enregistrer les styles de lignes ( )
et saisissez un nom de fichier dans la boîte de dialogue Enregistrer sous qui s’ouvre. Le fichier a 
une extension .sod et comprend la liste active des styles de ligne.

Pour utiliser des styles de ligne préalablement enregistrés, cliquez sur l’icône Charger les styles 
de ligne ( ) et sélectionnez un fichier dans la boîte de dialogue Ouvrir qui s’ouvre. Cliquez sur 
Ouvrir pour charger la liste des styles dans votre document.

Si nécessaire, cliquez sur le bouton Modifier pour modifier le nom du style de ligne.

Supprimer des styles de ligne

Pour supprimer un style de ligne :

 1) Ouvrez la boîte de dialogue Ligne en sélectionnant Ligne dans le menu Format ou dans le 
menu contextuel, ou en cliquant sur le bouton Ligne ( ) dans la barre d’outils Ligne et 
formatage.
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 2) Ouvrez l’onglet Styles de ligne (Figure 89).

 3) Sélectionnez le style que vous voulez supprimer dans la liste déroulante Styles de ligne.

 4) Cliquez sur le bouton Supprimer et confirmez la suppression en cliquant sur Oui dans la 
boîte de dialogue qui s’ouvre.

 5) Cliquez sur OK pour refermer la boîte de dialogue Ligne et enregistrer les modifications 
faites.

Remarque

Quand vous supprimez un style de ligne, vérifiez qu’il n’est pas utilisé dans un autre 
document.

Onglet styles de flèche

L’onglet Styles de flèche (Figure 90) est l’endroit où vous allez pouvoir créer et modifier des styles 
de flèche et charger des styles préalablement enregistrés.

Figure 90 : L’onglet Styles de flèche de la boîte de dialogue Ligne

Créer un style de flèche

Pour créer un style de flèche à partir de cet onglet :

 1) Dessinez tout d’abord la courbe que vous voulez utiliser comme pointe de flèche, ou créez 
une forme et convertissez-la en courbe. Le sommet de la forme doit se trouver vers le haut, 
comme sur la Figure 91, parce qu’il va devenir la pointe de la flèche.
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Figure 91 : utiliser une courbe comme pointe de flèche

 2) Sélectionnez la forme et, si nécessaire, convertissez-la en courbe en choisissant Convertir 
> En courbe dans le menu Forme ou le menu contextuel. Si la forme est déjà une courbe, la
commande ne sera pas disponible.

Remarque

La pointe de flèche doit être une courbe, c’est-à-dire quelque chose que vous pouvez tracer 
sans lever le crayon du papier. Par exemple, une étoile peut être une courbe, mais une 
frimousse ne peut pas l’être. Le bouton Ajouter ne sera pas actif si l’objet sélectionné n’est 
pas du bon type.

 3) Ouvrez la boîte de dialogue Ligne en sélectionnant Ligne dans le menu Format ou le menu 
contextuel, ou en cliquant sur le bouton Ligne ( ) dans la barre d’outils Ligne et formatage.

 4) Dans l’onglet Styles de flèche, cliquez sur le bouton Ajouter, saisissez le nom du nouveau 
style de flèche et cliquez sur OK. Le nouveau style de flèche va s’afficher dans l’aperçu en 
bas de la boîte de dialogue.

Vous pouvez alors choisir ce style de flèche en bas de la liste déroulante.

Le nouveau style de flèche ainsi créé n’est disponible que dans le document en cours. Si vous 
voulez l’utiliser dans d’autres documents, cliquez sur l’icône Enregistrer les styles de flèche ( )
et saisissez un nom de fichier dans la boîte de dialogue Enregistrer sous qui s’ouvre. Le fichier a 
une extension .soe et comprend la liste active des styles de flèche.

Pour utiliser des styles de flèche préalablement enregistrés, cliquez sur l’icône Charger les styles 
de flèche ( ) et sélectionnez un fichier dans la boîte de dialogue Ouvrir qui s’ouvre. Cliquez sur 
Ouvrir pour charger la liste des styles dans votre document.

Si nécessaire, cliquez sur le bouton Modifier pour modifier le nom du style de flèche.

Supprimer des styles de flèche

Pour supprimer un style de flèche :

 1) Ouvrez la boîte de dialogue Ligne en sélectionnant Ligne dans le menu Format ou dans le 
menu contextuel, ou en cliquant sur le bouton Ligne ( ) dans la barre d’outils Ligne et 
formatage.

 2) Ouvrez l’onglet Styles de flèche (Figure 89).

 3) Sélectionnez le style que vous voulez supprimer dans la liste déroulante Styles de flèche.

 4) Cliquez sur le bouton Supprimer et confirmez la suppression en cliquant sur Oui dans la 
boîte de dialogue qui s’ouvre.

 5) Cliquez sur OK pour refermer la boîte de dialogue Ligne et enregistrer les modifications 
faites.
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Remarque

Quand vous supprimez un style de flèche, vérifiez qu’il n’est pas utilisé dans un autre 
document.

Formater le remplissage

Le terme de remplissage fait référence à l’intérieur d’un objet, qui peut être d’une couleur uniforme,
en dégradé, avec un motif ou des hachures, ou constitué d’une image bitmap (Figure 92). Le 
remplissage d’un objet peut être partiellement ou totalement transparent et projeter une ombre.

Couleur

Dégradé

Hachures

Bitmap

Motif

Figure 92 : Exemples de types de remplissage

Avec la barre d’outils Ligne et remplissage

La barre d’outils Ligne et remplissage (Figure 80, page 75) contient les outils le plus 
habituellement utilisés pour formater des objets. Si elle n’est pas visible, sélectionnez Affichage > 
Barres d’outils > Ligne et remplissage dans la barre de menu. Pour formater le remplissage 
d’un objet :

 1) Sélectionnez tout d’abord un objet (les poignées de sélection deviennent visibles).

 2) Cliquez sur le contrôle Style de remplissage et choisissez ensuite un des types de 
remplissage (Figure 93).

Figure 93 : Les styles de remplissage

 3) Cliquez ensuite sur le contrôle situé à sa droite pour choisir une des options disponibles 
dans la liste déroulante. Pour plus d’informations sur les types de remplissage, voir « Avec 
la boîte de dialogue Remplissage », page 85.

– Options de couleur sur la Figure 94.

– Options de dégradés sur la Figure 95.

– Options de hachures sur la Figure 96.
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– Options de bitmaps sur la Figure 97.

– Options de motifs, voir l’option Remplir dans la section Zone de l’onglet Propriétés du 
volet latéral (Figure 98) ou la section Motif de l’onglet Remplissage de la boîte de 
dialogue Remplissage (Figure 103, page 89).

 4) Désélectionnez l’objet pour enregistrer les modifications (en appuyant sur la touche Échap 
ou en cliquant sur un emplacement libre de l’espace de travail).

Figure 94 : Couleurs de remplissage

Figure 95 : Styles de dégradés

Figure 96 : Styles de hachures

Figure 97 : Types de Bitmaps

Avec le volet latéral

Pour formater rapidement l’intérieur d’un objet avec le volet latéral (Figure 98) :

 1) Assurez-vous que la ligne est sélectionnée dans le dessin.
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 2) Ouvrez l’onglet Propriétés en cliquant sur son icône ( ) à droite de la fenêtre puis la section
Zone en cliquant sur  à gauche de son titre.

 3) Utilisez les options des listes déroulantes Remplir et Transparence pour formater le 
remplissage de l’objet. Pour plus d’informations sur les choix possibles, voyez « Avec la 
boîte de dialogue Remplissage », page 85.

 4) Désélectionnez la ligne pour enregistrer vos modifications.

Figure 98 : La section Zone de l’onglet Propriétés du volet latéral.

Avec la boîte de dialogue Remplissage

Si vous avez besoin de régler plus finement les attributs de remplissage d’un objet ou de créer les 
vôtres, vous pouvez le faire dans la boîte de dialogue Remplissage (Figure 99). Pour y accéder,

 1) sélectionnez l’objet que vous souhaitez modifier.

 2) Choisissez Remplissage dans le menu Format ou le menu contextuel, ou cliquez sur l’icône
Remplissage ( ) de la barre d’outils Ligne et remplissage, pour ouvrir la boîte de dialogue 
Remplissage.

 3) Ouvrez l’onglet Remplissage qui vous permet d’appliquer des remplissages prédéfinis, 
fournis par LibreOffice ou créés par vous ou d’autres utilisateurs. Voir « Créer de nouveaux 
remplissages », page 90.

 4) Choisissez le type de remplissage (Aucun, Couleur, Dégradé, Bitmap, Motif et Hachures) en 
cliquant sur un des boutons en haut de l’onglet.

 5) Sélectionnez un style de remplissage parmi les options qui sont présentées. Elles dépendent
du type de remplissage précédemment sélectionné.

 6) Cliquez sur OK pour refermer la boîte de dialogue et enregistrer les modifications. Le 
remplissage choisi apparaît dans l’objet sélectionné.

Types de remplissages

Aucun

Si vous cliquez sur le bouton Aucun (Figure 99), vous obtenez un objet vide.
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Couleur

 1) Cliquez sur Couleur (Figure 99) pour faire apparaître les contrôles de réglage de la couleur.

 2) Sélectionnez une palette dans la liste déroulante Palette puis une couleur parmi celles qui 
sont proposées. Ce sont toutes des couleurs unies.

Figure 99 : L’onglet Couleur de la boîte de dialogue Remplissage

 3) Le rectangle de la section Active vous montre la couleur de remplissage courante de l’objet 
sélectionné. Après le choix d’une nouvelle couleur, le rectangle de la section Nouveau 
reflète votre sélection.

 4) Vous pouvez aussi saisir les valeurs des composantes Rouge, Verte et Bleue ou la valeur 
hexadécimale de la couleur dans les contrôles de saisie de la section Nouveau.

 5) Vous avez encore la possibilité de cliquer sur Choisir une couleur pour ouvrir la boîte de 
dialogue de même nom (Figure 100). Dans celle-ci, vous pouvez sélectionner une couleur en
cliquant dans la surface colorée en haut à gauche, changer de teinte grâce à la bande 
verticale à sa droite ou saisir les composantes de la couleur dans les systèmes RVB 
(Rouge/Vert/Bleu), HSB (Hue/Saturation/Brightness : Teinte/Saturation/Luminosité) ou CJMN
(Cyan/Jaune/Magenta/Noir).

 6) Si vous souhaitez réutiliser une couleur dont vous vous êtes déjà servi, choisissez-la parmi 
les Couleurs récemment utilisées.

 7) Cliquez sur OK pour refermer la boîte de dialogue et enregistrer vos modifications. La 
couleur choisie apparaît dans l’objet sélectionné.
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Figure 100 : La boîte de dialogue Choisir une couleur

Dégradé

 1) Cliquez sur Dégradé (Figure 101) pour faire apparaître les contrôles de réglage des 
dégradés.

Figure 101 : L’onglet Dégradé de la boîte de dialogue Remplissage
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 2) Sélectionnez un dégradé dans la liste à gauche de la boîte de dialogue. Il apparaît dans la 
zone Aperçu à droite.

 3) Si vous décochez l’option Automatique, vous pouvez choisir le nombre de pas (Incrément) 
du dégradé, puis sélectionnez le Type (Linéaire, Axial, Radial, Ellipsoïde, Quadratique ou 
Carré), l’Angle, la Bordure et la Couleur d’origine et de destination.

 4) Cliquez sur OK pour que le dégradé choisi devienne le dégradé de remplissage de l’objet 
sélectionné.

Bitmap

 1) Cliquez sur Bitmap (Figure 102) pour faire apparaître les contrôles de réglage des images 
bitmap.

Figure 102 : L’onglet Bitmap de la boîte de dialogue Remplissage

 2) Sélectionnez une image dans liste Bitmap à gauche de la boîte de dialogue. Elle apparaît 
dans zone Aperçu à droite.

 3) Pour paramétrer l’image selon vos besoins, modifiez les valeurs des champs Style, Taille, 
Position, Décalage X et Y et Décalage dans la section Options.

 4) Cliquez sur OK pour refermer la boîte de dialogue et enregistrer vos modifications. L’image 
bitmap choisie apparaît dans l’objet sélectionné.

Motif

 1) Cliquez sur Motif (Figure 103) pour faire apparaître les contrôles de réglage des motifs.
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Figure 103 : L’onglet Motif de la boîte de dialogue Remplissage

 2) Sélectionnez un style dans liste Motif à gauche de la boîte de dialogue. Elle apparaît dans 
zone Aperçu à droite.

 3) Pour paramétrer le motif selon vos besoins, modifiez-le dans l’Éditeur de motif puis 
choisissez une Couleur de premier plan et une Couleur d’arrière-plan dans les contrôles de 
la section Options.

 4) Cliquez sur OK pour refermer la boîte de dialogue et enregistrer vos modifications. Le motif 
choisi apparaît dans l’objet sélectionné.

Hachures

 1) Cliquez sur Hachures (Figure 104) pour faire apparaître les contrôles de réglage des styles 
de hachures.

 2) Sélectionnez un style dans liste Hachures à gauche de la boîte de dialogue. Elle apparaît 
dans zone Aperçu à droite.

 3) Pour paramétrer les hachures selon vos besoins, saisissez un nouvel Espacement, l’Angle 
d’inclinaison des lignes, le Type et la Couleur de ligne ainsi que la Couleur d’arrière-plan 
dans les contrôles de la section Options.

 4) Cliquez sur OK pour refermer la boîte de dialogue et enregistrer vos modifications. Le motif 
choisi apparaît dans l’objet sélectionné.
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Figure 104 : L’onglet Hachures de la boîte de dialogue Remplissage

Créer de nouveaux remplissages

Couleurs personnalisées

Créer des couleurs à l’aide de la boîte de dialogue Remplissage

Grâce à la boîte de dialogue Remplissage (Figure 99, page 86), vous pouvez créer une nouvelle 
couleur par une combinaison des trois couleurs primaires rouge, vert et bleu (notation RVB). 
Procédez de la manière suivante :

 1) Sélectionnez l’objet que vous souhaitez modifier.

 2) Choisissez Remplissage dans le menu Format ou le menu contextuel, ou cliquez sur l’icône
Remplissage ( ) de la barre d’outils Ligne et remplissage, pour ouvrir la boîte de dialogue 
Remplissage.

 3) Ouvrez l’onglet Remplissage et cliquez sur le bouton Couleur pour ouvrir la page 
correspondante.

 4) Spécifiez les valeurs de rouge (R), vert (V) et bleu (B) entre 0 et 255 dans les contrôles de 
saisie de la section Nouvelle pour créer la nouvelle couleur.

 5) Cliquez sur le bouton Ajouter pour ouvrir la boîte de dialogue Nom (Figure 105) et saisissez 
un nom pour la nouvelle couleur.
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Figure 105 : La boîte de dialogue Nom d’une couleur

 6) Cliquez sur OK pour refermer la boîte de dialogue Nom et ajouter la nouvelle couleur à la 
palette Personnalisé.

 7) Cliquez sur OK pour enregistrer les modifications et refermer la boîte de dialogue 
Remplissage. La nouvelle couleur remplit l’objet sélectionné.

Créer des couleurs à l’aide de la boîte de dialogue Choisir une couleur

Il est possible de créer une nouvelle couleur en utilisant la boîte de dialogue Choisir une couleur 
de la manière suivante :

 1) Sélectionnez l’objet que vous souhaitez modifier.

 2) Choisissez Remplissage dans le menu Format ou le menu contextuel, ou cliquez sur l’icône
Remplissage ( ) de la barre d’outils Ligne et remplissage, pour ouvrir la boîte de dialogue 
Remplissage.

 3) Ouvrez l’onglet Remplissage et cliquez sur le bouton Couleur pour ouvrir la page 
correspondante (Figure 99, page 86).

 4) Cliquez sur le bouton Choisir une couleur pour ouvrir la boîte de dialogue de même nom 
(Figure 100, page 87).

 5) Utilisez une des méthodes suivantes pour créer la nouvelle couleur. Un aperçu de la 
nouvelle couleur apparaît dans la moitié gauche du rectangle en bas à gauche de la boîte de
dialogue, où vous pouvez la comparer à la couleur initiale (moitié droite du rectangle) ;

– Sélectionnez une teinte en cliquant dans le rectangle vertical multicolore au centre de la 
boîte de dialogue. Cliquez et déplacez le pointeur de la souris dans le grand rectangle en 
haut à gauche de la boîte de dialogue pour choisir une nuance.

– Saisissez les valeurs (entre 0 et 255) de rouge, vert et bleu dans les contrôles de saisie 
correspondants en haut à droite de la boîte de dialogue.

– Saisissez la valeur hexadécimale de la couleur dans le système RVB dans le contrôle 
Hexa sous les précédents.

– Saisissez les valeurs de la teinte (entre 0 et 360°), de la saturation et de la luminosité 
(entre 0 et 100 %) dans les contrôles de saisie de la section HSB.

– Saisissez les valeurs (entre 0 et 100 %) de cyan, magenta, jaune et de noir (le champ 
Touche2 ou Valeur3 contrôle la couleur noire) dans les contrôles de saisie de la section 
CMJN.

 6) Cliquez sur OK pour fermer la boîte de dialogue Choisir une couleur.

2 LibreOffice 6.4.5
3 LibreOffice 6.4.6
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 7) Cliquez sur le bouton Ajouter pour ouvrir la boîte de dialogue Nom (Figure 105) et saisissez 
un nom pour la nouvelle couleur.

 8) Cliquez sur OK pour refermer la boîte de dialogue Nom et ajouter la nouvelle couleur à la 
Palette personnalisée.

 9) Cliquez sur OK pour enregistrer les modifications et refermer la boîte de dialogue 
Remplissage. La nouvelle couleur remplit l’objet sélectionné.

Supprimer des couleurs personnalisées

 1) Choisissez Remplissage dans le menu Format ou le menu contextuel, ou cliquez sur l’icône
Remplissage ( ) de la barre d’outils Ligne et remplissage, pour ouvrir la boîte de dialogue 
Remplissage.

 2) Ouvrez l’onglet Remplissage et cliquez sur le bouton Couleur pour ouvrir la page 
correspondante (Figure 99, page 86).

 3) Sélectionnez personnalisé dans la liste déroulante Palette.

 4) Choisissez la couleur que vous voulez supprimer dans la palette et cliquez sur le bouton 
Supprimer. La couleur est supprimée de la palette sans demande de confirmation.

 5) Refermez la boîte de dialogue en cliquant sur OK (pour appliquer la couleur visible dans la 
section Nouvelle à l’objet sélectionné) ou sur Annuler (pour seulement enregistrer la 
suppression de la couleur).

Remarque

Il est recommandé de ne supprimer que des couleurs que vous avez créées dans la Palette 
personnalisée. Supprimer des couleurs dans les palettes standards fournies avec Libre-
Office peut provoquer des problèmes dans les documents qui utilisent une des couleurs 
standards.

Dégradés personnalisés

Vous pouvez créer des dégradés personnalisés, ou modifier des dégradés existants, dans l’onglet 
Dégradés de la boîte de dialogue Remplissage. Plusieurs types de dégradés sont prédéfinis et, 
dans la plupart des cas, il suffira de modifier les couleurs pour obtenir le résultat désiré.

Remarque

Il est recommandé, même si vous souhaitez seulement modifier les deux couleurs, de 
conserver les dégradés prédéfinis tels quels et de les utiliser plutôt comme point de départ 
pour créer de nouveaux dégradés, plutôt que de les modifier. En effet, les dégradés 
prédéfinis peuvent avoir été utilisés dans d’autres objets du dessin ou d’un autre document.

Créer de nouveaux dégradés

 1) Sélectionnez l’objet que vous souhaitez modifier.

 2) Choisissez Remplissage dans le menu Format ou le menu contextuel, ou cliquez sur l’icône
Remplissage ( ) de la barre d’outils Ligne et remplissage, pour ouvrir la boîte de dialogue 
Remplissage.
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 3) Ouvrez l’onglet Remplissage et cliquez sur le bouton Dégradé pour ouvrir la page 
correspondante (Figure 101, page 87).

 4) Dans la section Options,

– sélectionnez les couleurs d’origine et de destination dans les palettes qui s’ouvrent en 
cliquant sur les boutons,

– choisissez le type de dégradé dans la liste déroulante Type : Linéaire, Axial, Radial, 
Ellipsoïde, Quadratique ou Carré. La zone d’Aperçu à droite de la boîte de dialogue 
montre l’aspect du gradient choisi (Figure 106),

Linéaire Axial Radial

Ellipsoïde Quadratique Carré

Figure 106 : Types de dégradés

– paramétrez les propriétés selon vos goûts. Leurs fonctions sont résumées dans le
Tableau 2. Selon le type de dégradé choisi, toutes ne sont pas accessibles,

– si vous décochez l’option Automatique, vous pouvez choisir le nombre de pas (Incrément)
du dégradé (Figure 107),

Figure 107 : Dégradé automatique (64 pas) à gauche et de 4 pas à droite

 5) Cliquez sur le bouton Ajouter pour ouvrir la boîte de dialogue Nom (Figure 105) et saisissez 
un nom pour le nouveau dégradé. Cliquez sur OK pour refermer la boîte de dialogue Nom.

 6) Cliquez sur OK pour enregistrer les modifications et refermer la boîte de dialogue 
Remplissage.

Tableau 2 : Propriétés du dégradé

Propriété Signification

Centre X, 
Centre Y

Pour les types Radial, Ellipsoïde, Carré et Quadratique, positionne le centre du 
dégradé sur l’axe X ou l’axe Y, en pourcentage de la largeur de l’objet.
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Propriété Signification

Angle Pour tous les types de dégradés, spécifie l’angle de l’axe du dégradé par rapport
à l’axe horizontal.

Bordure Spécifie le pourcentage de l’axe du dégradé à partir duquel le dégradé 
commence (0 % : au début de l’axe ; 100 % : à la fin de l’axe).

Couleur 
d’origine

Indique la couleur de départ du dégradé. Le pourcentage correspond à l’intensité
de la couleur, de 0 % pour le noir à 100 % pour l’intensité maximale.

Couleur de 
destination

Indique la couleur d’arrivée du dégradé. Le pourcentage correspond à l’intensité 
de la couleur, de 0 % pour le noir à 100 % pour l’intensité maximale.

Modifier des dégradés

 1) Choisissez Remplissage dans le menu Format ou le menu contextuel, ou cliquez sur l’icône
Remplissage ( ) de la barre d’outils Ligne et remplissage, pour ouvrir la boîte de dialogue 
Remplissage.

 2) Ouvrez l’onglet Remplissage et cliquez sur le bouton Dégradé pour ouvrir la page 
correspondante (Figure 101, page 87).

 3) Sélectionnez un dégradé que vous avez créé et ajouté à la liste affichée dans l’onglet 
Dégradé.

 4) Saisissez les nouvelles valeurs des propriétés du dégradé que vous souhaitez modifier. 
Reportez-vous au Tableau 2 pour plus d’informations sur ces propriétés. Selon le type de 
dégradé choisi, certaines pourront ne pas être accessibles.

 5) Cliquez sur le bouton Modifier pour enregistrer vos changements. Aucune confirmation ne 
vous est demandée quand vous modifiez un dégradé.

 6) Refermez la boîte de dialogue en cliquant sur OK (pour appliquer le dégradé visible dans la 
section Aperçu à l’objet sélectionné) ou sur Annuler (pour seulement enregistrer la 
suppression du dégradé).

Supprimer des dégradés

 1) Choisissez Remplissage dans le menu Format ou le menu contextuel, ou cliquez sur l’icône
Remplissage ( ) de la barre d’outils Ligne et remplissage, pour ouvrir la boîte de dialogue 
Remplissage.

 2) Ouvrez l’onglet Remplissage et cliquez sur le bouton Dégradé pour ouvrir la page 
correspondante (Figure 101, page 87).

 3) Faites un clic droit sur le dégradé que vous voulez supprimer et choisissez Supprimer dans 
le menu contextuel. Confirmez en cliquant sur Oui dans la boîte de dialogue qui s’ouvre 
alors.

 4) Cliquez sur OK pour fermer la boîte de dialogue Remplissage et enregistrer les 
modifications.
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Remarque

Il est recommandé de ne supprimer que des dégradés que vous avez créés. Supprimer des 
dégradés fournis avec LibreOffice peut provoquer des problèmes dans les documents qui 
utilisent un de ceux-ci.

Contrôle interactif des dégradés

LibreOffice offre un contrôle interactif des dégradés utilisable de la façon suivante.

 1) Sélectionnez un objet qui utilise le dégradé comme remplissage.

 2) Ouvrez la palette Transformations dans la barre d’outils Standard ou Ligne et remplissage 
(Figure 108) et cliquez sur l’icône Outil dégradé interactif ( ). Vous pouvez aussi 
sélectionner Forme > Transformations > Outil dégradé dans la barre de menu.

Figure 108 : La palette Transformations dans la barre d’outils Ligne et remplissage

 3) Une ligne en tirets terminée par deux carrés colorés s’affiche. Les couleurs des carrés sont 
celles des champs Couleur d’origine et Couleur de destination du dégradé (Figure 109).

Figure 109 : L’outil Dégradé interactif en action

 4) Les propriétés que vous pouvez ajuster dépendent du type de dégradé sélectionné.

– Linéaire : déplacez le carré correspondant à la Couleur d’origine pour modifier le point de 
départ du dégradé. Déplacez le carré correspondant à la Couleur de destination pour 
modifier l’orientation du dégradé (valeur du champ Angle).

– Axial : déplacez le carré correspondant à la Couleur de destination pour modifier à la fois 
l’orientation (valeur du champ Angle) et le point de départ du dégradé (valeur du champ 
Bordure).

– Radial : déplacez le carré correspondant à la Couleur d’origine pour modifier la valeur du 
champ Bordure et définir le rayon du cercle du dégradé. Déplacez le carré correspondant 
à la Couleur de destination pour changer le point où le dégradé s’achève (valeurs des 
champs Centre X et Y)

– Ellipsoïde : déplacez le carré correspondant à la Couleur d’origine pour modifier la valeur 
du champ Bordure et définir la taille du dégradé, et pour modifier l’orientation de l’axe du 
dégradé (valeur du champ Angle). Déplacez le carré correspondant à la Couleur de 
destination pour changer le centre du dégradé (valeurs des champs Centre X et Y).
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– Quadratique et carré : déplacez le carré correspondant à la Couleur d’origine pour 
modifier la valeur du champ Bordure et définir la taille du dégradé, et pour modifier 
l’orientation de l’axe du dégradé (valeur du champ Angle). Déplacez le carré 
correspondant à la Couleur de destination pour changer le centre du dégradé (valeurs des
champs Centre X et Y).

Images Bitmap

Modifier les images

 1) Sélectionnez l’objet qui doit contenir le bitmap que vous souhaitez modifier.

 2) Choisissez Remplissage dans le menu Format ou le menu contextuel, ou cliquez sur l’icône
Remplissage ( ) de la barre d’outils Ligne et remplissage, pour ouvrir la boîte de dialogue 
Remplissage.

 3) Ouvrez l’onglet Remplissage et cliquez sur le bouton Bitmap pour ouvrir la page 
correspondante (Figure 102, page 88).

 4) Sélectionnez, dans la section Bitmap, l’image que vous voulez utiliser et modifier. Notez que
tous les bitmaps importés sont aussi disponibles.

 5) Dans la section Options, paramétrez le Style, la Taille, la Position et le Décalage. Voyez le
Tableau 3 pour plus d’informations sur ces propriétés. La meilleure façon de bien les 
comprendre est de les utiliser. La Figure 110 montre des exemples de remplissage par un 
bitmap avec les propriétés utilisées.

 6) Cliquez sur OK pour enregistrer vos modifications et fermer la boîte de dialogue 
Remplissage.

Image originale

Largeur et Hauteur 
proportionnelles 25 %
Position en haut à gauche
Pas de décalage.

Largeur et Hauteur 
proportionnelles 25 %
Position en haut à droite
Décalage Ligne 50 %

Figure 110 : Exemples de remplissage par une image bitmap
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Tableau 3 : Propriétés du motif

Propriété Signification

Style • Position / taille personnalisée : quand cette option est sélectionnée, la 
position et la taille de l’image peuvent être déterminées.

• Mosaïque : quand cette option est sélectionnée, l’image recouvre la 
surface comme des carreaux dont la taille est définie par les champs 
Largeur et Hauteur.

• Étiré : quand cette option est sélectionnée, l’image est étirée pour recouvrir
toute la surface.

Largeur
Hauteur

Définissent les dimensions de l’image, soit en unités de longueur, soit en 
pourcentage des dimensions de la surface à remplir si Échelle est cochée 
(100 % : toute la largeur ou toute la hauteur ; 50 % la moitié de la largeur ou de 
la hauteur).

Échelle Si cette option est cochée, les dimensions de l’image sont données en 
pourcentages de celles de la surface à remplir. Sinon, ce sont les dimensions 
réelles de l’image qui sera utilisée.

Position Cette option définit le point d’ancrage de l’image dans la surface à remplir.

Décalage X
Décalage Y

Définissent le décalage horizontal et vertical de l’image, par rapport au point 
d’ancrage, en pourcentage de ses dimensions. 50 % signifie que le milieu de 
l’image sera placé au point d’ancrage pour commencer la mosaïque.

Décalage Définit le décalage des lignes ou des colonnes en pourcentage pour que deux 
lignes ou colonnes consécutives ne soient pas alignées.

Importer des images

Pour importer des images matricielles (bitmaps) créées par un autre programme :

 1) Sélectionnez l’objet qui doit contenir le bitmap que vous souhaitez importer.

 2) Choisissez Remplissage dans le menu Format ou le menu contextuel, ou cliquez sur l’icône
Remplissage ( ) de la barre d’outils Ligne et remplissage, pour ouvrir la boîte de dialogue 
Remplissage.

 3) Ouvrez l’onglet Remplissage et cliquez sur le bouton Bitmap pour ouvrir la page 
correspondante (Figure 102, page 88).

 4) Cliquez sur le bouton Ajouter / Importer. Une boîte de dialogue d’ouverture de fichier, 
nommée Ajouter une image, apparaît.

 5) Recherchez l’image que vous voulez importer, sélectionnez-la et cliquez sur Ouvrir.

 6) Saisissez un nom pour l’image dans la boîte de dialogue Nom puis cliquez sur OK pour la 
refermer.

 7) Cliquez sur OK pour fermer la boîte de dialogue Remplissage et enregistrer les 
modifications.
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Supprimer des images

 1) Choisissez Remplissage dans le menu Format ou le menu contextuel, ou cliquez sur l’icône
Remplissage ( ) de la barre d’outils Ligne et remplissage, pour ouvrir la boîte de dialogue 
Remplissage.

 2) Ouvrez l’onglet Remplissage et cliquez sur le bouton Bitmap pour ouvrir la page 
correspondante (Figure 102, page 88).

 3) Faites un clic droit sur l’image que vous voulez supprimer et choisissez Supprimer dans le 
menu contextuel. Confirmez en cliquant sur Oui dans la boîte de dialogue qui s’ouvre alors.

 4) Cliquez sur OK pour fermer la boîte de dialogue Remplissage et enregistrer les 
modifications.

Remarque

Il est recommandé de ne supprimer que des images que vous avez importées. Supprimer 
des images fournies avec LibreOffice peut provoquer des problèmes dans les documents 
qui utilisent une de celles-ci.

Motifs

Créer ou éditer un motif

 1) Sélectionnez l’objet qui doit contenir le bitmap que vous souhaitez créer ou modifier.

 2) Choisissez Remplissage dans le menu Format ou le menu contextuel, ou cliquez sur l’icône
Remplissage ( ) de la barre d’outils Ligne et remplissage, pour ouvrir la boîte de dialogue 
Remplissage.

 3) Ouvrez l’onglet Remplissage et cliquez sur le bouton Motif pour ouvrir la page 
correspondante (Figure 103, page 89).

 4) Dans la section Options, choisissez les couleurs que vous voulez utiliser pour le premier 
plan et l’arrière-plan dans les palettes ouvertes en cliquant sur les boutons correspondants 
(Figure 111).

 5) Dans l’Éditeur de motif, cliquez dans les carrés qui représentent les pixels du motif, avec le 
bouton gauche pour leur donner la couleur de premier plan et avec le bouton droit pour leur 
donner la couleur d’arrière-plan. La zone Aperçu vous permet de vérifier l’effet obtenu.

 6) Si vous avez créé un nouveau motif, cliquez sur le bouton Ajouter pour ouvrir la boîte de 
dialogue Nom. Saisissez le nom du nouveau motif puis cliquez sur OK pour refermer la boîte
de dialogue.

 7) Si vous avez modifié un motif existant, cliquez sur Modifier pour enregistrer les 
changements. Aucune confirmation ne vous est demandée avant l’enregistrement.

 8) Cliquez sur OK pour enregistrer les modifications et refermer la boîte de dialogue 
Remplissage.
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Figure 111 : Créer ou modifier un motif

Supprimer des motifs

 1) Choisissez Remplissage dans le menu Format ou le menu contextuel, ou cliquez sur l’icône
Remplissage ( ) de la barre d’outils Ligne et remplissage, pour ouvrir la boîte de dialogue 
Remplissage.

 2) Ouvrez l’onglet Remplissage et cliquez sur le bouton Motif pour ouvrir la page 
correspondante (Figure 103, page 89).

 3) Faites un clic droit sur le motif que vous voulez supprimer et choisissez Supprimer dans le 
menu contextuel. Confirmez en cliquant sur Oui dans la boîte de dialogue qui s’ouvre alors.

 4) Cliquez sur OK pour fermer la boîte de dialogue Remplissage et enregistrer les 
modifications.

Remarque

Il est recommandé de ne supprimer que des motifs que vous avez créés. Supprimer des 
motifs fournis avec LibreOffice peut provoquer des problèmes dans les documents qui 
utilisent un de ceux-ci.

Hachures personnalisées

Vous pouvez créer des hachures personnalisées, ou modifier des hachures existantes, dans 
l’onglet Hachure de la boîte de dialogue Remplissage. Comme pour les dégradés et les couleurs, il
est recommandé de conserver les hachures prédéfinies telles quelles et de les utiliser plutôt 
comme point de départ pour créer de nouvelles hachures. Les paramètres d’une hachure sont 
décrits dans le Tableau 4.
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Tableau 4. Propriétés d’une hachure

Propriété Signification

Espacement Spécifie l’espacement entre deux lignes de hachure.

Angle Spécifie l’angle des lignes de hachure par rapport à l’axe horizontal. Vous 
pouvez également utiliser la miniature en dessous pour spécifier un angle 
multiple de 45 degrés.

Type de ligne Indique l’utilisation d’une ligne simple ou de lignes croisées ou triples comme 
motif de hachure.

Couleur de ligne Permet de sélectionner la couleur de la ligne de hachure dans la liste 
déroulante.

Couleur d’arrière-
plan

Si l’option est cochée, une couleur de remplissage est ajoutée derrière les 
lignes qui forment les hachures.

Créer de nouvelles hachures

 1) Sélectionnez l’objet qui doit contenir le bitmap que vous souhaitez créer ou modifier.

 2) Choisissez Remplissage dans le menu Format ou le menu contextuel, ou cliquez sur l’icône
Remplissage ( ) de la barre d’outils Ligne et remplissage, pour ouvrir la boîte de dialogue 
Remplissage.

 3) Ouvrez l’onglet Remplissage et cliquez sur le bouton Hachures pour ouvrir la page 
correspondante (Figure 104, page 90).

 4) Modifiez les options des lignes qui constituent les hachures. Un aperçu est disponible à 
droite de la boîte de dialogue. Voyez le Tableau 4 pour les informations sur ces options.

 5) Cliquez sur le bouton Ajouter pour ouvrir la boîte de dialogue Nom. Saisissez le nom du 
nouveau type de hachures puis cliquez sur OK pour refermer la boîte de dialogue.

 6) Cliquez sur OK pour enregistrer les modifications et refermer la boîte de dialogue 
Remplissage.

Modifier des hachures

 1) Sélectionnez l’objet qui doit contenir le bitmap que vous souhaitez créer ou modifier.

 2) Choisissez Remplissage dans le menu Format ou le menu contextuel, ou cliquez sur l’icône
Remplissage ( ) de la barre d’outils Ligne et remplissage, pour ouvrir la boîte de dialogue 
Remplissage.

 3) Ouvrez l’onglet Remplissage et cliquez sur le bouton Hachures pour ouvrir la page 
correspondante (Figure 104, page 90).

 4) Sélectionnez le type de hachures que vous avez créé et ajouté à celles qui sont affichées 
dans la boîte de dialogue Remplissage.

 5) Modifiez les options des lignes qui constituent les hachures. Un aperçu est disponible à 
droite de la boîte de dialogue. Voyez le Tableau 4 pour les informations sur ces options.

 6) Cliquez sur le bouton Modifier pour enregistrer les changements. Aucune confirmation ne 
vous est demandée avant l’enregistrement.
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 7) Cliquez sur OK pour enregistrer les modifications et refermer la boîte de dialogue 
Remplissage.

Supprimer des hachures

 1) Choisissez Remplissage dans le menu Format ou le menu contextuel, ou cliquez sur l’icône
Remplissage ( ) de la barre d’outils Ligne et remplissage, pour ouvrir la boîte de dialogue 
Remplissage.

 2) Ouvrez l’onglet Remplissage et cliquez sur le bouton Hachures pour ouvrir la page 
correspondante (Figure 104, page 90).

 3) Faites un clic droit sur le type de hachures que vous voulez supprimer et choisissez 
Supprimer dans le menu contextuel. Confirmez en cliquant sur Oui dans la boîte de 
dialogue qui s’ouvre alors.

 4) Cliquez sur OK pour fermer la boîte de dialogue Remplissage et enregistrer les 
modifications.

Remarque

Il est recommandé de ne supprimer que des hachures que vous avez créées. Supprimer 
des hachures fournies avec LibreOffice peut provoquer des problèmes dans les documents 
qui utilisent une de celles-ci.

Ombre

Ombres par défaut

Vous pouvez appliquer rapidement une ombre à l’objet sélectionné en utilisant l’icône Ombre ( ) 
de la barre d’outils Ligne et remplissage. Cependant, l’ombre appliquée ne sera que celle définie 
par défaut.

Formater les ombres

Pour bénéficier de plus d’options, utilisez l’onglet Ombre de la boîte de dialogue Remplissage 
(Figure 112).

Figure 112 : L’onglet Ombre de la boîte de dialogue Remplissage
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 1) Sélectionnez l’objet auquel vous souhaitez ajouter une ombre.

 2) Choisissez Remplissage dans le menu Format ou le menu contextuel, ou cliquez sur l’icône
Remplissage ( ) de la barre d’outils Ligne et remplissage, pour ouvrir la boîte de dialogue 
Remplissage.

 3) Ouvrez l’onglet Ombre (Figure 112).

 4) Cochez l’option Utiliser l’ombre pour appliquer l’ombre à l’objet et rendre les autres options 
accessibles.

 5) Sous cette option, cliquez sur un des neuf points du rectangle pour sélectionner la direction 
de l’ombre projetée par rapport à l’objet.

 6) Dans l’option Couleur, cliquez sur le bouton pour ouvrir une palette où vous pourrez choisir 
la couleur de l’ombre.

 7) Dans le champ Distance, saisissez l’espacement entre l’objet et son ombre.

 8) Dans le champ Transparence, saisissez la transparence de l’ombre en pourcentage (0 % : 
aucune transparence ; 100 % ombre totalement transparente).

 9) Cliquez sur OK pour fermer la boîte de dialogue Remplissage et enregistrer les 
modifications.

Transparence

La transparence s’applique au remplissage des objets ainsi qu’aux ombres et aux lignes.

• Pour appliquer une transparence aux lignes, voyez « Erreur : source de la référence non 
trouvée », page Erreur : source de la référence non trouvée.

• Pour appliquer une transparence aux ombres, voyez « Formater les ombres », page 101.

Pour régler la transparence de l’objet sélectionné, utilisez l’onglet Transparence de la boîte de 
dialogue Remplissage.

 1) Sélectionnez l’objet auquel vous souhaitez appliquer une transparence.

 2) Choisissez Remplissage dans le menu Format ou le menu contextuel, ou cliquez sur l’icône
Remplissage ( ) de la barre d’outils Ligne et remplissage, pour ouvrir la boîte de dialogue 
Remplissage.

 3) Ouvrez l’onglet Transparence (Figure 113).

 4) Pour appliquer une transparence uniforme, cochez l’option Transparence et saisissez le 
pourcentage de transparence dans le champ adjacent (0 % : aucune transparence ; 100 % 
ombre totalement transparente).

 5) Pour créer un gradient de transparence tel que celle-ci varie peu à peu,

– cochez l’option Dégradé et choisissez le type de dégradé dans la liste déroulante Type 
(Linéaire, Axial, Radial, Ellipsoïde, Quadratique ou Carré) ;

– définissez les options pour le type de dégradé choisi en vous rapportant au Tableau 5 
pour leurs descriptions. Les paramètres accessibles dépendent du type de dégradé de 
transparence sélectionné.
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 6) Cliquez sur OK pour fermer la boîte de dialogue Remplissage et enregistrer les 
modifications.

Figure 113 : L’onglet Transparence de la boîte de dialogue Remplissage

Tableau 5 : Propriétés du dégradé

Propriété Signification

Centre X, 
Centre Y

Pour les types Radial, Ellipsoïde, Carré et Quadratique, positionne le centre du 
dégradé sur l’axe X, en pourcentage de la largeur de l’objet.

Angle Pour les types de dégradés Linéaire, Axial, Ellipsoïde et Carré, spécifie l’angle 
de l’axe du dégradé par rapport à l’axe horizontal.

Bordure Spécifie le pourcentage de l’axe du dégradé à partir duquel le dégradé 
commence (0 % : au début de l’axe ; 100 % : à la fin de l’axe).

Valeur initiale Indique la transparence initiale du dégradé. 0 % pour totalement opaque, 100 % 
pour totalement transparent.

Valeur finale Indique la transparence finale du dégradé. 0 % pour totalement opaque, 100 % 
pour totalement transparent.

Contrôle interactif de la transparence d’un objet

Vous pouvez également modifier la transparence en dégradé d’un objet avec la souris.

 1) Sélectionnez un objet qui a reçu un dégradé de transparence.

 2) Ouvrez la palette Transformations dans la barre d’outils Standard ou Ligne et remplissage 
(Figure 108, page 95) et cliquez sur l’icône Outil transparence interactif ( ). Vous pouvez
aussi sélectionner Forme > Transformations > Outil transparence dans la barre de menu.

! Attention

Cette modification n’est possible qu’avec des objets de type courbe. Faites un clic droit sur 
l’objet et choisissez Convertir > En courbe si nécessaire.
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 3) L’axe du dégradé apparaît en pointillés avec, à chacune de ses extrémités, un carré de noir 
à blanc selon la transparence (Figure 114).

Figure 114 : L’outil transparence interactif en action

 4) Vous pouvez alors déplacer chacun de ses points pour obtenir le dégradé que vous 
souhaitez. Les valeurs des propriétés de l’onglet Transparence de la boîte de dialogue 
Remplissage sont mises à jour. Il n’est pas possible de déplacer le point de départ de l’axe 
d’un dégradé de transparence de type Axial.

Utiliser les styles

Remarque

Dans LibreOffice Draw, seuls les styles d’objets de dessin sont disponibles la boîte de 
dialogue Styles pour objets graphiques et dans l’onglet Styles du volet latéral.

Supposez que vous vouliez appliquer le même remplissage et la même largeur de bordure et de 
ligne à un ensemble d’objets. Cette procédure répétitive peut être simplifiée par l’utilisation des 
styles. Cette fonctionnalité vous permet de définir un format modèle (un style) et de l’appliquer à 
plusieurs objets. Pour plus d’informations sur les styles, voir le Chapitre 6, Introduction aux styles, 
du Guide Writer.

Styles liés

Les styles d’image permettent l’héritage. En d’autres termes, un style peut être lié à un autre style 
(parent) afin d’hériter de ses attributs de formatage. Vous pouvez utiliser cette fonctionnalité pour 
créer des familles de styles.

Par exemple, si vous avez besoin de plusieurs rectangles qui ne diffèrent que par leur couleur de 
remplissage, la meilleure façon de procéder est de définir un style générique pour la forme 
rectangle qui définit les bordures, le type de remplissage, la police, etc. Puis créez des styles liés à
ce premier style, qui ne diffèrent que par la couleur de remplissage. Ainsi, si vous n’avez besoin de
modifier que l’épaisseur de la bordure, vous pouvez ne le faire que dans le style parent, et les 
autres styles liés vont changer en conséquence.

Remarque

Quand des styles sont liés, changer une couleur change celle-ci dans tous les styles liés. 
C’est parfois exactement ce que vous voulez, parfois vous ne souhaiterez pas appliquer les 
changements à tous les styles liés. Cela vaut la peine d’y réfléchir avant.
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Créer des nouveaux styles

Après création, le nouveau style apparaîtra dans les listes Tous les styles et Styles personnalisés 
de l’onglet Styles du volet latéral. Quand il aura été appliqué à un objet, il apparaîtra aussi dans la 
liste Styles appliqués.

Avec l’onglet Styles

 1) Cliquez sur l’icône Styles ( ) du volet latéral pour ouvrir l’onglet correspondant (Figure 115)

Figure 115 : L’onglet Styles du volet latéral

 2) Sélectionnez, si vous le souhaitez, le style à partir duquel vous voulez créer un nouveau 
style.

 3) Faites un clic droit et choisissez Nouveau dans le menu contextuel pour ouvrir la boîte de 
dialogue Styles pour objets graphiques (Figure 116).

Figure 116 : L’onglet Gestionnaire de la boîte de dialogue Styles pour objets graphiques

 4) Attribuez au nouveau style un nom significatif.

 5) Si vous aviez sélectionné un style, vous allez lier le nouveau style à ce style de départ. Si 
vous n’avez pas sélectionné de style, le nouveau style sera lié au style Standard. Vous 

Utiliser les styles | 105



pouvez en choisir un autre dans la liste déroulante Hérité de si vous souhaitez que votre 
style hérite de celui-ci.

 6) Utilisez les différents onglets de la boîte de dialogue Styles pour objets graphiques afin de 
définir le format du nouveau style.

– Gestionnaire contient un résumé du style et sa position dans la hiérarchie.

– Police, Effets de caractère, Retraits et espacement et Tabulations définissent les 
propriétés du texte inséré dans une zone de texte ou un objet graphique.

– Cotation permet de définir le style des lignes de cote.

– Texte, Animation de texte, Connecteur, Ligne, Remplissage, Ombrage, Mise en évidence 
et Transparence déterminent le formatage de l’objet.

 7) Cliquez sur OK pour enregistrer le nouveau style et refermer la boîte de dialogue Styles pour
objets graphiques.

À partir d’un objet sélectionné

Vous pouvez créer un nouveau style à partir d’un objet déjà formaté, qui peut être un texte ou un 
objet graphique :

 1) Sélectionnez l’objet que vous voulez utiliser ou créez-en un nouveau.

 2) Utilisez les outils de la barre d’outils Ligne et remplissage (Figure 80, page 75) pour apporter
les modifications souhaitées à l’objet.

 3) Sélectionnez Format > Styles > Nouveau style à partir de la sélection dans la barre de 
menu ou cliquez sur l’icône Nouveau style à partir de la sélection ( ) en haut à droite du 
volet latéral.

 4) Dans la boîte de dialogue Créer un style qui s’ouvre (Figure 117), saisissez le nom du 
nouveau style. La liste affiche les styles personnalisés disponibles.

 5) Cliquez sur OK pour enregistrer le nouveau style.

Figure 117 : La boîte de dialogue Créer un style

106 | Chapitre 4  Modifier les attributs d’un objet



Modifier ou éditer les styles

Remarque

Il est recommandé de ne modifier ou éditer que des styles que vous avez créés. Modifier ou 
éditer des styles fournis avec LibreOffice peut provoquer des problèmes dans les 
documents qui utilisent un de ceux-ci.

 1) Sélectionnez un objet utilisant le style que vous voulez modifier.

 2) Ouvrez la boîte de dialogue Styles pour objets graphiques (Figure 116) en sélectionnant 
Éditer le style dans le menu Format > Styles ou dans le menu contextuel, ou en faisant un 
clic droit sur le style de l’objet dans l’onglet Styles du volet latéral et en choisissant Modifier 
dans le menu contextuel.

 3) Utilisez les différents onglets de la boîte de dialogue Styles pour objets graphiques pour 
définir le format du nouveau style.

– Gestionnaire contient un résumé du style et sa position dans la hiérarchie.

– Police, Effets de caractère, Retraits et espacement et Tabulations définissent les 
propriétés du texte inséré dans une zone de texte ou un objet graphique.

– Cotation permet de définir le style des lignes de cote.

– Texte, Animation de texte, Connecteur, Ligne, Remplissage, Ombrage, Mise en évidence 
et Transparence déterminent le formatage de l’objet.

 4) Cliquez sur OK pour enregistrer le nouveau style et refermer la boîte de dialogue Styles pour
objets graphiques.

Éditer des styles liés

Si un objet de votre document utilise des styles liés, vous pouvez les éditer en utilisant la boîte de 
dialogue Styles pour objets graphiques de la façon suivante :

 1) Sélectionnez un objet utilisant le style que vous voulez modifier.

 2) Ouvrez la boîte de dialogue Styles pour objets graphiques (Figure 116) en sélectionnant 
Éditer le style dans le menu Format > Styles ou dans le menu contextuel.

 3) Ouvrez l’onglet Gestionnaire de la boîte de dialogue Styles pour objets graphiques.

 4) Vérifiez que le nom du style indiqué dans le champ Hérité de est bien le style lié que vous 
souhaitez modifier.

 a) Si le style lié n’est pas celui que vous voulez éditer, cliquez sur le bouton Éditer le style à
droite du champ Hérité de jusqu’à ce que le nom du style lié soit affiché. Utilisez les divers
onglets de la boîte de dialogue Styles pour objets graphiques pour éditer le style.

 b) Quand le style lié est celui que vous voulez éditer, cliquez sur le bouton Éditer le style à 
droite du champ Hérité de puis utilisez les divers onglets de la boîte de dialogue Styles 
pour objets graphiques pour le modifier.

 5) Cliquez sur OK quand vous avez terminé pour enregistrer vos modifications et refermer la 
boîte de dialogue Styles pour objets graphiques.
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Remarque

Mettre à jour des styles liés qui font partie de l’installation par défaut de LibreOffice peut 
poser des problèmes dans d’autres documents qui utilisent les styles par défaut de 
LibreOffice.

Mettre à jour des styles

Pour mettre à jour un style d’image à partir des modifications apportées à un objet :

 1) Sélectionnez un objet formaté avec le style que vous désirez modifier.

 2) Utilisez les outils de formatage de ligne (page Erreur : source de la référence non trouvée) et
de remplissage (page 83) pour apporter les changements voulus à l’objet.

 3) Utilisez une des méthodes suivantes pour mettre à jour le style avec le formatage appliqué à 
l’objet :

– Cliquez sur l’icône Actualiser le style ( ) qui se trouve en haut à droite du volet latéral.

– Sélectionnez Format > Styles > Mettre à jour le style sélectionné dans la barre de 
menu.

Remarque

Aucune confirmation n’est demandée quand vous mettez un style à jour de cette façon. 
Faites bien attention de ne mettre à jour que des styles que vous avez créés. Le faire avec 
des styles qui font partie de l’installation par défaut de LibreOffice peut poser des problèmes
dans d’autres documents qui les utilisent.

Appliquer des styles

Vous pouvez appliquer un style d’image grâce à l’onglet Styles du volet latéral de la façon 
suivante :

 1) Sélectionnez l’objet auquel vous voulez appliquer un style.

 2) Pour afficher la liste des styles disponibles, cliquez sur l’icône Styles ( ) dans la barre 
d’outils Ligne et remplissage (Figure 80, page 75) ou dans le volet latéral (Figure 115, page
105).

 3) Faites un double clic sur le nom du style que vous voulez appliquer à l’objet.

Astuce

En bas de l’onglet Styles se trouve une liste déroulante. Vous pouvez choisir d’afficher tous 
les styles ou seulement des groupes de styles comme les Styles appliqués ou les Styles 
personnalisés.

Supprimer des styles

Vous ne pouvez pas supprimer un style prédéfini de LibreOffice, même si vous ne l’avez pas 
utilisé. Vous ne pouvez supprimer que les styles personnalisés. Cependant, avant de le faire, 
vérifiez que le style n’est pas utilisé. S’il est utilisé, remplacez-le par un style de substitution. Pour 
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voir quels styles sont actuellement utilisés, sélectionnez Styles appliqués dans la liste déroulante 
en bas de l’onglet Styles du volet latéral.

 1) Pour afficher la liste des styles disponibles, cliquez sur l’icône Styles ( ) dans la barre 
d’outils Ligne et remplissage (Figure 80, page 75) ou dans le volet latéral (Figure 115, page
105).

 2) Sélectionnez Styles appliqués ou Styles personnalisés dans la liste déroulante en bas de 
l’onglet Styles du volet latéral pour afficher les styles utilisés.

 3) Faites un clic droit sur le nom du style que vous voulez supprimer et sélectionnez Effacer 
dans le menu contextuel.

 4) Si le style est actuellement utilisé, un message d’avertissement apparaît. Cliquez sur Oui sur
supprimer le style. S’il n’est pas utilisé, aucune confirmation n’est demandée.

Appliquer des effets spéciaux

Tout comme les actions de base que sont le déplacement et le changement de dimensions, un 
certain nombre d’effets spéciaux peuvent être appliqués à un objet dans Draw. Plusieurs d’entre 
eux sont disponibles dans la barre d’outils Transformations (Figure 118) ainsi que dans la palette 
Transformations (Figure 108, page95) qui s’ouvre en cliquant sur  à droite de l’icône 
Transformations ( 4) des barres d’outils Standard ou Ligne et remplissage. Si cette barre 
d’outils n’est pas visible, sélectionnez Affichage > Barre d’outils > Transformations dans la 
barre de menu ou détachez la palette Transformations.

Rotation Retourner En corps de révolution 3D

Positionner sur le cercle 
(en perspective)

Positionner sur le cercle 
(incliner)

Déformer

Transparence interactive Dégradé interactif

Figure 118 : La barre d’outils Transformations

Les outils disponibles dans la barre d’outils Transformations sont décrits dans les sections 
suivantes, sauf l’outil Rotation 3D qui est présenté au chapitre 7, Manipuler des objets 3D, page
172.

Faire pivoter les objets

La rotation d’un objet peut être effectuée manuellement, grâce à une boîte de dialogue ou au volet 
latéral.

Rotation manuelle

 1) Cliquez sur l’objet que vous voulez faire tourner pour faire apparaître les poignées de 
sélection.

 2) Pour placer l’objet en mode rotation, utilisez une des méthodes suivantes :

4 à l’ouverture, mais elle est remplacée par l’icône du dernier outil utilisé
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– cliquez de nouveau sur l’objet ;

– cliquez sur l’outil Rotation ( ) dans la palette ou la barre d’outils Transformations (voir 
page 109).

Figure 119 : Rotation manuelle d’un objet

Les poignées de sélection changent de forme et de couleur pour indiquer le passage au 
mode rotation (Figure 119).

 3) Si nécessaire, cliquez et tirez le point central pour déplacer le centre de la rotation que vous 
allez effectuer. Celui-ci est, par défaut, situé au centre de la boîte de sélection, ce qui 
convient très souvent, mais, dans certains cas, vous pourrez avoir envie de faire tourner 
l’objet autour d’un sommet ou même d’un point extérieur à l’objet.

 4) Placez le pointeur de la souris au-dessus de la poignée d’un des sommets de la boîte de 
sélection. Sa forme change (Figure 119). Seules ces quatre poignées des coins permettent 
une rotation.

 5) Cliquez et tirez la souris dans la direction de la rotation souhaitée. L’angle de rotation est 
visible dans la zone d’information de la barre d’état.

 6) Relâchez le bouton de la souris quand vous avez atteint la position souhaitée.

Pour limiter l’angle de rotation à un multiple de 15°, appuyez sur la touche Maj et maintenez 
l’appui pendant la rotation de l’objet. Cela se révèle très pratique pour effectuer une rotation de 90°
et faire passer une figure de l’orientation portrait à l’orientation paysage.

Avec le volet latéral

Pour faire pivoter un objet grâce à la section Position et taille de l’onglet Propriétés du volet 
latéral :

 1) Cliquez sur l’objet que vous voulez faire tourner pour faire apparaître les poignées de 
sélection.

 2) Ouvrez l’onglet Propriétés en cliquant sur son icône ( ) à droite de la fenêtre puis la section
Position et taille en cliquant sur  à gauche de son titre (Figure 120).
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Figure 120 : la section Position et taille de l’onglet Propriétés du volet latéral

 3) Cliquez sur la roue sous Rotation et faites-la tourner. L’objet sélectionné suit les mouvements
de la roue. Vous pouvez aussi saisir une valeur dans le champ à sa droite ou sélectionner un
angle prédéfini dans la liste déroulante associée.

 4) Cliquez hors de l’objet quand vous avez obtenu la position souhaitée pour la fixer.

Avec la boîte de dialogue Position et taille

En plus des deux méthodes précédentes, vous pouvez utiliser l’onglet Rotation de la boîte de 
dialogue Position et taille (Figure 121) pour un contrôle plus précis de la rotation de l’objet.

 1) Cliquez sur l’objet que vous voulez faire tourner pour faire apparaître les poignées de 
sélection.

 2) Ouvrez la boîte de dialogue Position et taille

– en appuyant sur F4,

– en sélectionnant Position et taille dans le menu Format ou le menu contextuel de l’objet

– en cliquant sur son icône ( ) dans la barre d’outils Standard ou Ligne et remplissage.

 3) Ouvrez l’onglet Rotation.

 4) Dans la section Point de pivot, saisissez, dans les champs de saisie Position X et Position 
Y, les coordonnées du centre de rotation par rapport au coin supérieur gauche de la feuille.

Vous pouvez aussi choisir une position par rapport à la boîte de sélection de l’objet dans le 
schéma Paramètres par défaut. La position par défaut se trouve au centre de la boîte de 
sélection.
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Figure 121 : L’onglet Rotation de la boîte de dialogue Position et taille

 5) Dans la section Angle de rotation, saisissez une valeur dans le champ de saisie Angle ou 
cliquez sur la roue à droite et tirez la souris pour obtenir l’angle voulu. Le champ Angle est 
mis à jour pour suivre les mouvements de la roue.

 6) Cliquez sur OK pour enregistrer les modifications, fermer la boîte de dialogue et faire pivoter 
l’objet.

Retourner des objets

Retournement rapide

La méthode la plus simple pour retourner un objet horizontalement ou verticalement est la 
suivante :

 1) Sélectionnez l’objet à retourner pour que les poignées de sélection soient visibles.

 2) Utilisez l’une des méthodes suivantes pour retourner l’objet horizontalement ou 
verticalement :

– Faites un clic droit et choisissez Retourner > Verticalement ou Retourner > 
Horizontalement dans le menu contextuel. Vous pouvez trouver également ces 
commandes dans le menu Forme.

– Dans la section Position et taille de l’onglet Propriétés du volet latéral (Figure 120, page
111), cliquez sur les icônes Retourner l’objet sélectionné verticalement ( ) ou 
horizontalement ( ).

– Cliquez sur les icônes Verticalement ( ) ou Horizontalement ( ) dans la barre 
d’outils Ligne et remplissage (Figure 80, page 75).

Avec l’outil Retourner

L’outil Retourner de la barre d’outils (Figure 118, page 109) ou de la palette (Figure 108, page 95) 
Transformations peut aussi être utilisé. Cet outil vous permet de modifier la position et l’angle de 
l’axe de symétrie (Figure 122  ➁ ).

 1) Cliquez sur l’objet graphique à retourner. Les poignées de sélection apparaissent.
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 2) Cliquez sur l’icône Retourner ( ) dans la barre d’outils ou la palette Transformations. L’axe 
de symétrie apparaît sous la forme d’une ligne de pointillés au milieu de l’objet (Figure 
122 ➀). L’objet sera retourné autour de cet axe.

 3) Cliquez et tirez avec la souris une ou les deux extrémités pour déterminer l’orientation de 
l’axe de symétrie (Figure 122 ➁) ou l’axe lui-même pour le déplacer sans changer 
l’orientation.

 4) Placez le curseur de la souris au-dessus d’une poignée de sélection de l’objet afin que sa 
forme change.

 5) Cliquez et faites glisser le curseur de l’autre côté de l’axe de symétrie. Une image fantôme 
de l’objet retourné apparaît (Figure 122 ➂).

 6) Relâchez le bouton de la souris et l’objet retourné apparaîtra (Figure 122 ➃).

Remarque

Si vous gardez appuyée la touche Maj durant le déplacement de l’axe de symétrie, l’angle 
de cet axe est limité aux multiples de 45 degrés.

➀ ➁

➂ ➃

Figure 122 : Utilisation de l’outil Retourner de la barre d’outils Transformations

Copies miroir

À l’heure actuelle, il n’existe aucune commande Miroir dans Draw. Cependant, l’effet peut être 
réalisé en utilisant l’outil Retourner de la façon suivante :

 1) Sélectionnez l’objet dont vous voulez réaliser une copie miroir et copiez-le dans le presse-
papiers.

 2) Collez-le sur lui-même.

 3) Sélectionnez l’outil Retourner dans la barre d’outils ou la palette Transformations.
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 4) Déplacez l’axe de symétrie à l’emplacement désiré et effectuez le retournement.

 5) Si nécessaire, réalignez les deux objets avec les outils d’alignement (Aligner dans le menu 
Forme ou le menu contextuel, ou la palette Aligner ( ) de la barre d’outils Ligne et 
remplissage).

Déformer un objet

Trois outils de la barre d’outils Transformations permettent de déplacer les coins et les bordures 
d’un objet pour le déformer.

• Déformer déforme un objet en perspective.

• Positionner sur le cercle (incliner) crée un effet pseudo-tridimensionnel.

• Positionner sur le cercle (en perspective) crée un effet pseudo-tridimensionnel.

Dans les trois cas, il peut vous être demandé si vous voulez transformer l’objet en courbe. Comme
cette étape est nécessaire, cliquez sur Oui. Vous pourrez ensuite déplacer les poignées des objets
pour produire l’effet désiré. Des exemples d’utilisations de ces outils sont proposés dans les 
figures suivantes.

Déformer

Sélectionnez l’objet à déformer et cliquez sur l’icône Déformer ( ) dans la barre d’outils (Figure 
118, page 109) ou de la palette (Figure 108, page 95) Transformations. Après avoir converti l’objet 
en courbe comme demandé, cliquez et faites glisser une poignée de sélection pour déformer 
l’objet (Figure 123). L’effet sera différent selon la poignée sélectionnée.

En utilisant une 
poignée de coin.

En utilisant une 
poignée au milieu 
d’un côté vertical.

En utilisant une 
poignée au milieu 
d’un côté horizontal.

Figure 123 : Déformer un objet
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Positionner sur le cercle (en perspective)

Sélectionnez l’objet à déformer et cliquez sur l’icône Positionner sur le cercle (en perspective) (
). Après avoir converti l’objet en courbe, cliquez et faites glisser une poignée de sélection pour 

déformer l’objet (Figure 124).

Figure 124 : Positionner un objet sur un cercle en perspective

Positionner sur le cercle (incliner)

Sélectionnez l’objet à déformer et cliquez sur l’icône Positionner sur le cercle (incliner) ( ). 
Après avoir converti l’objet en courbe, cliquez et faites glisser une poignée de sélection pour 
déformer l’objet (Figure 125).

Figure 125 : Positionner un objet sur un cercle avec inclinaison

Remarque

Transformer un objet en courbe est une opération qui ne peut être inversée qu’avec la 
fonction Annuler (Édition > Annuler dans la barre de menu ou icône Annuler  dans la 
barre d’outils Standard).

Dégradés dynamiques

Il est possible de contrôler des gradients de transparence de la même façon que les dégradés de 
couleurs et les deux types peuvent être utilisés simultanément. Avec un gradient de transparence, 
le degré de transparence du remplissage d’un objet varie entre opaque et totalement transparent 
dans une direction donnée. Dans un dégradé de couleurs, le remplissage passe d’une couleur à 
une autre, mais la transparence reste la même.

Deux icônes de la barre d’outils Transformations (Figure 118, page 109) permettent de contrôler de
façon dynamique, l’un les gradients de transparence ( ), l’autre les dégradés de couleurs ( ).

Même si vous n’avez pas affecté de transparence à un objet avec un remplissage de couleur, vous
pouvez contrôler la transparence en cliquant sur l’icône de l’Outil transparence interactive. Cela 
définit un gradient de transparence et une ligne en tirets qui joint deux carrés apparaît sur l’objet. 
Déplacez les deux carrés pour modifier le gradient. Vous pouvez en définir la direction (verticale, 
horizontale ou inclinée à un angle donné) et le point où la transparence commence.
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Un dégradé de couleurs normal est défini de la même façon. Sélectionnez un objet, choisissez un 
dégradé dans l’onglet Dégradé de la boîte de dialogue Remplissage (Figure 101, page 87). L’Outil
dégradé interactif est alors accessible dans la barre d’outils Transformations. Quand vous cliquez
sur celui-ci, une ligne en tirets reliant deux carrés apparaît sur l’objet, exactement comme pour un 
gradient de transparence.

Dans les deux cas, cliquez hors de l’objet pour confirmer le remplissage.

Dans l’exemple de la Figure 126, le rectangle est rempli par un dégradé linéaire et a reçu un 
gradient de transparence radiale de 100 % au centre à 0 % à la périphérie. Le gradient de 
transparence peut être ajusté dynamiquement en déplaçant le carré blanc pour modifier le centre 
et le carré noir pour modifier la bordure (début du gradient).

Figure 126 : Exemple de gradient dynamique

Remarque

L’effet du déplacement des carrés est différent selon le type de gradient. Par exemple, pour 
un gradient linéaire, les carrés de début et de fin sont toujours situés de chaque côté du 
centre de l’objet.
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Grouper des objets

Le groupement d’objets peut être vu comme un dépôt d’objets dans un contenant. Vous pouvez 
déplacer les objets en tant que groupe et leur appliquer des modifications globales. Un groupe 
peut toujours être défait et les objets qui le constituent peuvent toujours être manipulés 
séparément.

Groupement temporaire

Un groupement temporaire se produit lorsque plusieurs objets sont sélectionnés. Toutes les 
modifications que vous effectuez sur les paramètres des objets sont appliquées à tous les objets à 
l’intérieur de ce groupe temporaire. Par exemple, vous pouvez modifier la couleur de remplissage 
de tous les objets d’un groupe temporaire en une seule fois. Vous pouvez également effectuer une
rotation du groupe temporaire dans sa globalité.

Pour supprimer un groupement temporaire, cliquez simplement à l’extérieur des poignées de 
sélection qui s’affichent autour des objets.

Grouper

Pour grouper des objets de façon permanente :

 6) Sélectionnez tout d’abord les objets en appliquant une des méthodes suivantes :

– cliquez successivement sur chacun d’entre eux tout en gardant appuyée la touche Maj,

– utilisez l’outil Sélectionner ( ) de la barre d’outils Dessin et dessiner un rectangle de 
sélection autour des objets avec le pointeur de la souris.

Des poignées de sélection vont alors apparaître autour de l’ensemble des objets du groupe 
(Figure 127).

Figure 127 : Objets groupés

 7) Groupez les objets sélectionnés grâce à l’une de méthodes suivantes :

– faites un clic droit à l’intérieur d’un des objets du groupe et choisissez Grouper dans le 
menu contextuel,

–  sélectionnez Forme > Grouper > Grouper dans la barre de menus,

– utilisez le raccourci clavier Ctrl+Maj+G.

Une fois que les objets sont groupés, toute opération d’édition que vous effectuerez sur ce groupe 
s’appliquera à l’ensemble des objets qui le composent. Si vous cliquez sur l’un des objets du 
groupe, le groupe entier est sélectionné.
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Les objets à l’intérieur d’un groupe conservent leurs propriétés individuelles et peuvent être édités 
séparément. Voir « Éditer des objets individuels » ci-dessous pour plus d’informations.

Dissocier

Pour défaire ou dissocier un groupe d’objets,

 1) Sélectionnez le groupe d’objets qui sera alors entouré par des poignées de sélection (Figure 
127).

 2) Dissociez le groupe d’objets en utilisant une des méthodes suivantes :

– faites un clic droit à l’intérieur d’un des objets du groupe et choisissez Dissocier dans le 
menu contextuel,

– sélectionnez Forme > Grouper > Dissocier dans la barre de menus,

– utilisez le raccourci clavier Ctrl+Alt+Maj+G.

Éditer des objets individuels

Vous pouvez éditer individuellement un objet à l’intérieur d’un groupe sans avoir à le dissocier.

 1) Après avoir sélectionné le groupe, entrez dans celui-ci grâce à une des méthodes suivantes :

– faites un clic droit à l’intérieur d’un des objets du groupe et choisissez Entrer dans le 
groupe dans le menu contextuel,

– sélectionnez Forme > Grouper > Entrer dans le groupe dans la barre de menu,

– appuyez sur la touche F3,

– faites un double-clic à l’intérieur d’un objet.

Lorsque vous entrez dans un groupe, les objets situés à l’extérieur ne peuvent plus être 
sélectionnés pour édition.

 2) Une fois à l’intérieur d’un groupe, cliquez sur un objet pour l’éditer individuellement (Figure 
128).

Figure 128 : Édition d’un élément d’un groupe

 3) Pour quitter un groupe, après avoir apporté des modifications aux différents objets, procédez
d’une des façons suivantes :

– faites un clic droit à l’intérieur du groupe et choisissez Quitter le groupe dans le menu 
contextuel,
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– sélectionnez Forme > Groupe > Quitter le groupe dans la barre de menu,

– appuyez sur les touches Ctrl+F3,

– faites un double-clic à l’extérieur du groupe.

Groupes en cascade

Vous pouvez créer un groupe de groupes, appelé plus communément groupe en cascade. Quand 
vous créez des groupes en cascade, Draw conserve la hiérarchie individuelle de chaque groupe et
se souvient de l’ordre dans lequel les groupes ont été sélectionnés. Par conséquent, le dernier 
groupe individuel sélectionné va se situer au sommet des groupes en cascade.

Dissocier et entrer dans des groupes en cascade s’effectue de la même façon que pour un groupe 
individuel.

Combiner des objets

La combinaison d’objets consiste en une fusion permanente d’objets afin de créer un nouvel objet. 
Les objets d’origine ne sont plus disponibles en tant qu’entités individuelles et ne peuvent plus être
édités individuellement. Toute édition d’un objet combiné s’applique à tous les objets utilisés lors 
de l’opération de combinaison.

Combiner

 1) Sélectionnez les objets que vous voulez combiner.

 2) Combinez les objets sélectionnés en utilisant une des méthodes suivantes :

– faites un clic droit à l’intérieur d’un des objets du groupe et choisissez Formes > 
Combiner dans le menu contextuel,

– sélectionnez Forme > Combiner dans la barre de menu,

– utilisez le raccourci clavier Ctrl+Maj+K.

À première vue, le résultat peut sembler surprenant, mais une fois que vous aurez compris les 
règles régissant la combinaison d’objets dans Draw, ces combinaisons deviendront plus claires.

• Les attributs (la couleur de remplissage par exemple) de l’objet résultant sont ceux de l’objet 
situé le plus en arrière. Dans la Figure 129, c’est le cercle rouge et, dans la Figure 130, c’est 
le rectangle jaune.

Groupés Combinés

Figure 129 : Combiner des objets

• Quand des objets se recouvrent, le remplissage de la zone de recouvrement est soit plein, 
soit vide, selon le nombre de chevauchements. Quand ce nombre est pair, vous obtenez un 

Combiner des objets | 121



espace vide ; quand ce nombre est impair, vous obtenez une zone remplie. Voyez l’exemple
Figure 130.

1  2  3  4   5 1  2  3  4   5

Figure 130 : Remplissage des objets superposés combinés.
Les nombres indiquent combien d’objets sont superposés

Astuce

Avant de procéder à la combinaison, vous pouvez réordonner les objets pour qu’ils se 
situent plus en avant ou plus en arrière dans l’ordre de disposition. Faites un clic droit sur 
l’objet et choisissez Disposition dans le menu contextuel. Voir aussi « Disposer des 
objets » page 128.

Scinder une combinaison

Un objet qui résulte de la combinaison de plusieurs objets peut être scindé en plusieurs entités 
individuelles en utilisant une des méthodes suivantes :

• sélectionnez Forme > Scinder dans la barre de menu

• utilisez le raccourci clavier Ctrl+Alt+Maj+K.

Les objets résultants de la scission vont conserver le formatage de l’objet combiné et ne vont pas 
reprendre leur format d’origine (Figure 131).

Figure 131 : Scinder des objets combinés
à gauche : l’objet combiné de la Figure 130 ; à droite le résultat de la scission

Fractionner une combinaison

Un objet qui résulte de la combinaison de plusieurs objets peut être fractionné en constituants 
élémentaires en choisissant Forme > Fractionner dans la barre de menu. Tous les objets sont 
fractionnés en constituants élémentaires ; par exemple, un rectangle sera fractionné en quatre 
lignes séparées et le remplissage sera perdu (Figure 132).
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Figure 132 : Fractionner un objet combiné

Fusionner, soustraire ou intersecter des objets

Si vous avez sélectionné plus d’un objet, les fonctions de fusion, de soustraction et d’intersection 
deviennent disponibles et vous permettent de créer un nouvel objet avec une nouvelle forme.

Fusion

Lorsque vous fusionnez des objets, un nouvel objet est créé, dont la forme découle de la forme 
des objets fusionnés. Le remplissage de l’objet fusionné est celui de l’objet se trouvant le plus en 
arrière parmi les objets fusionnés (Figure 133).

Après avoir sélectionné plusieurs objets, choisissez une des méthodes suivantes pour fusionner 
les objets :

• sélectionnez Forme > Fusionner dans la barre de menu,

• faites un clic droit à l’intérieur d’un des objets du groupe et choisissez Formes > Fusionner 
dans le menu contextuel.

Figure 133 : Fusionner des objets

Soustraction

Lorsque vous soustrayez des objets, un nouvel objet est créé, dont la forme correspond à la 
portion de l’objet se trouvant le plus en arrière qui n’est recouverte par aucun autre objet situé 
devant lui (Figure 134).

Après avoir sélectionné plusieurs objets qui se recouvrent, choisissez une des méthodes suivantes
pour soustraire les objets :

• sélectionnez Forme > Soustraire dans la barre de menu,

• faites un clic droit à l’intérieur d’un des objets du groupe et choisissez Formes > Soustraire 
dans le menu contextuel.
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Figure 134 : Soustraire des objets

Intersection

Lorsque vous effectuez une intersection d’objets, un nouvel objet est créé, dont la forme 
correspond à la portion de l’objet se trouvant le plus en arrière qui est recouverte par un ou 
plusieurs autres objets situés devant lui (Figure 135).

Après avoir sélectionné plusieurs objets qui se recouvrent, choisissez une des méthodes suivantes
pour créer l’intersection des objets :

• sélectionnez Forme > Intersecter dans la barre de menu,

• faites un clic droit à l’intérieur d’un des objets du groupe et choisissez Formes > Intersecter 
dans le menu contextuel.

Figure 135 : Intersection d’objets

Exemple

L’exemple suivant du Tableau 6 vous montre comment vous pouvez utiliser les fonctions de fusion,
de soustraction et d’intersection pour créer un objet représentant un couteau avec un manche en 
bois.

Tableau 6. Créer un couteau

Dessinez une ellipse, puis un rectangle qui recouvre la 
moitié de sa largeur.

Sélectionnez les deux objets, faites un clic droit et 
choisissez Formes > Soustraire dans le menu 
contextuel.
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Dessinez un autre rectangle et placez-le sur la moitié 
supérieure de l’ellipse.

Sélectionnez les deux objets, faites un clic droit et 
choisissez Formes > Soustraire dans le menu 
contextuel.

Dessinez une petite ellipse qui recouvre le coin inférieur
droit.

Sélectionnez les deux objets, faites un clic droit et 
choisissez Formes > Soustraire dans le menu 
contextuel. La forme de la lame est alors terminée.

Pour faire le manche, dessinez un rectangle et une 
ellipse.

Fusionnez les deux objets.

Positionnez le manche sur la lame. Sélectionnez le 
manche et la lame, puis groupez-les pour créer un objet
représentant un couteau.

Duplication et fondu enchaîné

Duplication

La duplication produit des copies d’un objet tout en appliquant un ensemble de modifications 
(comme une couleur ou un angle de rotation) à chacune de ces copies.

Pour dupliquer un objet ou un groupe d’objets :

 1) Sélectionnez l’objet ou le groupe d’objets, puis ouvrez la boîte de dialogue Dupliquer (Figure 
136) en utilisant une des méthodes suivantes :

– choisissez Édition > Dupliquer ou Forme > Dupliquer dans la barre de menu,

– utilisez le raccourci clavier Maj+F3.

 2) Sélectionnez le nombre de copies, le décalage, l’agrandissement et les couleurs de début et 
de fin.

 3) Cliquez sur OK pour que les copies soient créées. Un exemple de duplication se trouve
Figure 137. Chaque copie est un objet séparé.

 4) Pour regrouper les objets dupliqués, voir « Erreur : source de la référence non trouvée » 
page Erreur : source de la référence non trouvée.

 5) Pour combiner les objets dupliqués en un seul objet, voir « Combiner des objets » page
121.

La boîte de dialogue Dupliquer (Figure 136) comprend les options suivantes :
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Figure 136 : La boîte de dialogue Dupliquer

Nombre de copies
Saisissez le nombre de copies que vous voulez effectuer.

Bouton Utiliser les valeurs de la sélection ( ) : initialise les valeurs de décalage de l’Axe 
X et de l’Axe Y avec la largeur et la hauteur de l’objet sélectionné.

Décalage
Détermine la position et l’angle de rotation de chaque objet dupliqué par rapport à l’objet 
précédent.

– Axe X : saisissez la distance horizontale entre le centre de l’objet et celui de l’objet 
dupliqué. Les valeurs positives décalent l’objet dupliqué vers la droite et les valeurs 
négatives décalent l’objet dupliqué vers la gauche.

– Axe Y : saisissez la distance verticale entre le centre de l’objet et celui de l’objet dupliqué. 
Les valeurs positives décalent l’objet dupliqué vers le bas et les valeurs négatives 
décalent l’objet dupliqué vers le haut.

– Angle : saisissez l’angle de rotation (de 0 à 359 degrés) que vous voulez appliquer à 
l’objet dupliqué. Le décalage de l’objet dupliqué s’effectue dans le sens inverse des 
aiguilles d’une montre si l’angle est positif et dans le sens des aiguilles d’une montre s’il 
est négatif.

 Agrandissement
Détermine la taille des objets dupliqués.

– Largeur : saisissez la valeur avec laquelle vous voulez augmenter ou réduire la largeur de
l’objet dupliqué par rapport à l’objet précédent.

– Hauteur : saisissez la valeur avec laquelle vous voulez augmenter ou réduire la largeur de
l’objet dupliqué par rapport à l’objet précédent.
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Couleurs
Détermine les couleurs de l’objet sélectionné et de l’objet dupliqué. Si vous faites plus d’une 
copie, ces couleurs déterminent les points de départ et d’arrivée d’un dégradé de couleurs.

– Début : choisissez la couleur de l’objet sélectionné.

– Fin : choisissez la couleur du dernier objet dupliqué.

Figure 137 : Exemple de duplication

Fondu enchaîné

Le fondu enchaîné transforme la forme d’un objet en la forme d’un autre objet. Le résultat est un 
nouveau groupe d’objets individuels qui comprend l’objet de départ, l’objet d’arrivée et toutes les 
étapes de la transformation.

Pour effectuer un fondu enchaîné entre deux objets :

 1) Sélectionnez les deux objets de départ et d’arrivée. Il est impératif de sélectionner deux 
objets et seulement deux pour que la fonction soit disponible.

 2) Choisissez Forme > Fondu enchaîné dans la barre de menu pour ouvrir la boîte de 
dialogue Fondu enchaîné (Figure 138).

 3) Sélectionnez le nombre d’incréments pour la transformation. Cochez si nécessaire les 
options Attributs du fondu enchaîné et Même orientation.

 4) Cliquez sur OK pour que le fondu enchaîné soit effectué. Un exemple de fondu enchaîné se 
trouve Figure 139. L’objet créé est un groupe d’objets.

 5) Pour dissocier le groupe d’objets afin d’utiliser chaque forme individuellement, voir 
« Dissocier » page 120.

Les options de la boîte de dialogue Fondu enchaîné (Figure 138) sont :

Figure 138 : La boîte de dialogue Fondu enchaîné

Duplication et fondu enchaîné | 127



Paramètres
– Incréments : saisissez le nombre de formes que vous souhaitez entre les deux objets 

sélectionnés.

– Attributs du fondu enchaîné : applique le fondu enchaîné aux propriétés de ligne et de 
remplissage des objets sélectionnés. Par exemple, si les deux objets sélectionnés sont 
remplis avec des couleurs différentes, un dégradé entre ces deux couleurs est appliqué.

– Même orientation : conserve l’orientation des deux objets sélectionnés pour les formes de
transition.

Figure 139 : Exemple de fondu enchaîné

Positionner des objets

Disposer des objets

Lorsque vous effectuez des combinaisons, des fusions, des soustractions ou des intersections 
d’objets, le résultat final varie selon l’objet qui se trouve à l’avant et celui qui se trouve à l’arrière 
(c’est-à-dire en dessous ou au-dessus de la pile d’objets). Tout nouvel objet que vous placez dans 
un dessin devient automatiquement l’objet le plus en avant et tous les autres objets reculent dans 
l’ordre de positionnement. La disposition des objets vous permet de modifier l’ordre dans lequel les
objets sont positionnés.

Pour modifier l’ordre de l’empilement en déplaçant les objets vers l’avant ou vers l’arrière, 
sélectionnez un objet et choisissez une des méthodes suivantes :

• sélectionnez Disposition dans le menu contextuel ou dans l’entrée Forme de la barre de 
menu et choisissez l’une des actions disponibles,

• utilisez un des raccourcis clavier indiqués ci-dessous,

• cliquez sur une des icônes

– de la palette accessible à partir de l’icône Disposer  de la barre d’outils Standard ou 
de la barre d’outils Position (Figure 140 en haut) obtenue en détachant la palette ;

– à gauche de la barre d’outils Ligne et remplissage (Figure 140 en bas)  ;

– du panneau Position et taille de l’onglet Propriétés du volet latéral.
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Conseil

Pour transformer une palette en barre d’outils, cliquez sur son sommet et tirez-la à autre 
emplacement.

Figure 140 : La barre d’outils Position (en haut)
et la partie gauche de la barre d’outils Ligne et remplissage (en bas)

Les outils qui permettent de disposer les objets sont les suivants :

Menu
Raccourcis 
clavier

Icônes Fonctions

Envoyer à l’avant Ctrl+Maj++ Place les objets sélectionnés à l’avant du groupe.

Envoyer vers l’avant Ctrl++ Place les objets sélectionnés un niveau en avant.

Envoyer vers l’arrière Ctrl+- Place les objets sélectionnés un niveau en 
arrière.

Envoyer à l’arrière Ctrl+Maj+- Place les objets sélectionnés à l’arrière du 
groupe.

Devant l’objet
Place l’objet sélectionné devant un autre objet 
sélectionné.

Derrière l’objet
Place l’objet sélectionné derrière un autre objet 
sélectionné.

Inverser
Inverse l’ordre des objets sélectionnés. Cette 
option n’est pas disponible si un seul objet est 
sélectionné.

Aligner des objets

Pour que votre dessin ait une allure plus professionnelle, vous pouvez aligner les objets les uns 
par rapport aux autres. Sélectionnez un ou plusieurs objets et utilisez une des méthodes suivantes
pour les aligner :

• cliquez sur le petit triangle noir à droite de l’icône Alignement de la barre d’outils Ligne et 
remplissage ou de la barre d’outils Standard. La forme de cette icône peut varier selon le 
dernier outil utilisé. La palette d’outils Aligner s’ouvre et vous pouvez la transformer si 
nécessaire en barre d’outils (Figure 141).

• sélectionnez les options du sous-menu Aligner du menu Forme ou du menu contextuel.

Figure 141 : La barre d’outils Aligner
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Les options sont détaillées dans le tableau ci-dessous :

Menu Icônes Plusieurs objets sélectionnés Un seul objet sélectionné

À gauche
Aligne les côtés gauches des objets 
sélectionnés sur le côté gauche de 
l’objet situé le plus à gauche.

Aligne le côté gauche de l’objet 
sélectionné sur la marge gauche de 
la page.

Centré
Centre horizontalement les objets 
sélectionnés par rapport au centre 
horizontal du groupe temporaire.

Centre horizontalement l’objet 
sélectionné par rapport au centre 
horizontal de la page.

À droite
Aligne les côtés droits des objets 
sélectionnés sur le côté droit de 
l’objet situé le plus à droite.

Aligne le côté droit de l’objet 
sélectionné sur la marge droite de la 
page.

En haut
Aligne les côtés hauts des objets 
sélectionnés sur le côté haut de 
l’objet situé le plus en haut.

Aligne le côté haut de l’objet 
sélectionné sur la marge haute de la 
page.

Centre
Centre verticalement les objets 
sélectionnés par rapport au centre 
vertical du groupe temporaire.

Centre verticalement l’objet 
sélectionné par rapport au centre 
vertical de la page.

En bas
Aligne les côtés bas des objets 
sélectionnés sur le côté bas de l’objet
situé le plus en bas.

Aligne le côté bas de l’objet 
sélectionné sur la marge basse de la 
page.

Répartir des objets

La répartition d’objets vous permet d’espacer régulièrement trois objets ou plus selon l’axe 
horizontal et l’axe vertical. Les objets sont répartis en utilisant les objets de la sélection les plus à 
l’extérieur comme points de base pour l’espacement.

Sélectionnez au moins trois objets. Pour ouvrir la boîte de dialogue Distribution (Figure 142) et 
répartir les objets, utilisez une des méthodes suivantes :

– choisissez Forme > Répartition dans la barre de menu,

– faites un clic droit et choisissez Répartition dans le menu contextuel,

– cliquez sur l’icône Répartition ( ) dans la barre d’outils Ligne et remplissage ou la barre
d’outils Standard.

Figure 142 : La boîte de dialogue Distribution
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Les options de la boîte de dialogue Distribution sont les suivantes :

Horizontal
Les options de la section Horizontal déterminent la répartition horizontale entre les objets 
sélectionnés.

– Aucun(e) : ne répartit pas les objets sélectionnés horizontalement.

– Gauche : répartit les objets sélectionnés pour que leurs côtés gauches soient 
régulièrement espacés.

– Centre : répartit les objets sélectionnés pour que leurs centres horizontaux soient 
régulièrement espacés.

– Espacement : répartit les objets sélectionnés pour qu’ils soient régulièrement espacés 
horizontalement.

– Droite : répartit les objets sélectionnés pour que leurs côtés droits soient régulièrement 
espacés.

Vertical
Les options de la section Vertical déterminent la répartition verticale entre les objets 
sélectionnés.

– Aucun(e) : ne répartit pas les objets sélectionnés verticalement.

– Haut : répartit les objets sélectionnés pour que leurs côtés hauts soient régulièrement 
espacés.

– Centre : répartit les objets sélectionnés pour que leurs centres verticaux soient 
régulièrement espacés.

– Espacement : répartit les objets sélectionnés pour qu’ils soient régulièrement espacés 
verticalement.

– Bas : répartit les objets sélectionnés pour que leurs côtés bas soient régulièrement 
espacés.

Dans l’exemple de la Figure 143, les trois rectangles ont été répartis de manière centrée selon 
l’axe horizontal : vous pouvez constater que le rectangle du bas (qui n’est pas un objet à l’extérieur
selon l’axe horizontal) a été centré sur le centre du groupe temporaire des trois rectangles.

Figure 143 : Exemple de répartition selon l’axe horizontal
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Guide Draw
6.4

Chapitre 6
Éditer des images





Introduction

Les précédents chapitres du guide Draw ont traité uniquement des formes vectorielles. Les types 
de format vectoriel les plus couramment utilisés sont les suivants :

• SVG – Scalable Vector Graphics (Image vectorielle à taille variable). Il s’agit d’un format 
d’image vectorielle à deux dimensions, basé sur le Langage de Balisage Extensible (Extensi-
ble Markup Language : XML) qui permet l’interactivité et les animations.

• EPS – Encapsulated PostScript (PostScript Encapsulé). C’est un format de document 
PostScript utilisable comme format de fichier graphique. Les fichiers EPS sont des 
documents PostScript plus ou moins indépendants, raisonnablement prévisibles qui 
décrivent une image ou un dessin et qui peuvent être placés à l’intérieur d’un autre 
document PostScript.

• AI – Adobe Illustrator. C’est un format de fichier déposé, développé par Adobe Systems pour 
représenter des dessins vectoriels sur une seule page dans les formats EPS ou PDF.

Draw est capable de lire la majorité des formats de fichiers graphiques. Il dispose d’un ensemble 
de possibilités comparable à ceux de logiciels spécialisés de traitement d’image, comme Adobe 
Photoshop ou Gimp. Les images tramées sont généralement des illustrations ou des photos qui 
utilisent l’un des formats suivants, qui sont les plus couramment utilisés :

• JPG/JPEG – acronyme de Joint Photographic Experts Group (Groupe Mixte d’Experts en 
Photographie) qui a créé le format. C’est le format d’image le plus courant sur le World Wide 
Web et la plupart des appareils photo numériques produisent par défaut des images JPEG.

• GIF – Graphics Interchange Format (Format d’Échange d’Image). GIF est un format d’image 
bitmap répandu grâce à son large soutien et sa grande portabilité.

• PNG – Portable Network Graphics (Image Portable pour le Réseau). PNG est un format 
d’image tramée qui permet une compression de données sans pertes et une transparence 
de l’arrière-plan.

• TIF/TIFF – Tagged Image File Format (Format de Fichier Image Étiqueté). TIFF est souple, 
adaptable et capable de stocker les données d’une image dans un format sans pertes.

• BMP – BitMaP. Format d’image bitmap, qui est une structure de données en forme de 
matrice de points.

Importer des images

Insertion

Pour importer des fichiers graphiques dans votre dessin, choisissez Insertion > Images dans la 
barre de menu ou cliquez l’icône Insérer une image  de la barre d’outils Standard. La boîte de 
dialogue Insérer une image s’ouvre (Figure 144).

Draw comporte des filtres d’importation pour la majorité des formats d’images. Si le fichier que 
vous voulez importer a un format d’image non pris en compte par les filtres d’import, il est alors 
recommandé d’utiliser un autre programme de conversion d’images afin d’obtenir un format 
reconnu par Draw.
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Si vous cochez l’option Aperçu, un aperçu du fichier apparaît dans la partie droite de la boîte de 
dialogue. Cela facilite le choix du fichier et vous permet également de vérifier que Draw peut bien 
importer le format de fichier utilisé.

Figure 144 : La boîte de dialogue Insérer une image.

Incorporation

L’incorporation d’une image dans votre dessin fait de cette image un élément permanent de votre 
document. Toute modification que vous apportez à une image incorporée n’apparaîtra que dans 
votre dessin et le fichier image d’origine ne sera pas affecté.

L’incorporation se produit lorsque vous importez une image dans votre dessin en utilisant la boîte 
de dialogue Insérer une image sans l’option Lier, un copier-coller, le scan d’une image ou un 
glisser-déposer.

Le principal avantage des images incorporées dans votre dessin est que ces images sont 
disponibles quel que soit l’ordinateur utilisé pour ouvrir le document.

Le principal inconvénient des images incorporées est que cela peut créer des fichiers de taille 
importante, ce qui peut être gênant si vous n’avez qu’une capacité limitée pour stocker vos 
fichiers. De plus, si l’image d’origine est modifiée, votre dessin ne disposera pas d’une version à 
jour de cette image à chaque fois que vous l’ouvrirez.

Remarque

Quand vous incorporez une image dans un document ou un dessin de LibreOffice, il faut 
veiller à ce que l’option Lier ne soit pas cochée dans la boîte de dialogue Insérer une image.

Liaison

La liaison d’une image avec votre dessin ne l’insère pas dans votre document, mais crée un lien 
vers l’endroit où le fichier d’image se trouve sur votre ordinateur. À chaque fois que votre 
document sera ouvert, toutes les images liées seront affichées dans votre dessin.
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Le principal avantage est que, si l’image d’origine est modifiée ou remplacée par une autre image 
avec le même nom de fichier, quand vous ouvrirez de nouveau votre document, la dernière version
de l’image apparaîtra dans le dessin. De plus, la taille du fichier de dessin est beaucoup plus petite
et l’image d’origine peut facilement être éditée avec une application externe spécialisée.

Le principal inconvénient est que le lien entre votre dessin et les fichiers images doit être maintenu
pour que la liaison fonctionne correctement. Si vous envoyez votre document vers un autre 
ordinateur, vous devez également envoyer les fichiers liés, et dans le même dossier que sur 
l’ordinateur d’origine.

Pour lier un fichier image dans votre dessin, cochez l’option Lier dans la boîte de dialogue Insérer 
une image (Figure 144) avant de cliquer sur le bouton Ouvrir. Un message d’avertissement 
apparaît, pour vous informer que le fichier d’image ne sera pas stocké avec votre dessin mais 
seulement référencé comme lien.

• Cliquez sur Conserver le lien pour lier le fichier et fermer la boîte de dialogue de 
confirmation.

• Cliquez sur Incorporer l’image si vous ne voulez pas que l’image soit liée mais incorporée. 
Cela ferme aussi la boîte de dialogue de confirmation.

Remarque

Quand un fichier d’image est lié à un document ou un dessin de LibreOffice, le format de 
l’image liée n’est pas modifié.

Toute modification d’une image liée à l’intérieur de votre document n’apparaîtra que dans votre 
dessin et le fichier image d’origine ne sera pas affecté.

Les liens peuvent être actualisés, modifiés ou rompus de la façon suivante :

 6) Choisissez Édition > Liens vers des fichiers externes dans la barre de menu pour ouvrir la
boîte de dialogue Éditer les liens (Figure 145).

 7) Sélectionnez le lien à éditer.

 8) Cliquez sur Modifier, Déconnecter ou Actualiser selon le cas.

– Modifier : permet de changer le fichier relié à votre dessin par le lien choisi.

– Déconnecter : brise le lien entre le fichier lié et le document courant. Le contenu du 
fichier lié le plus récemment mis à jour est conservé dans le document courant comme 
image incorporée.

– Actualiser : met à jour le lien sélectionné pour que la dernière version enregistrée du 
fichier lié soit affichée dans le document courant.

Remarque

Si vous cliquez sur Déconnecter, l’image liée est incorporée à votre dessin.
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Figure 145 : La boîte de dialogue Éditer les liens

Image scannée

Avec la plupart des scanners, vous pouvez directement insérer une image scannée dans votre 
dessin ou votre document. Les images scannées sont incorporées au format PNG.

Assurez-vous que votre scanner est configuré sur l’ordinateur et qu’il supporte le système SANE 
pour le système d’exploitation Linux, ou TWAIN pour les systèmes d’exploitation Windows ou Mac.

Pour insérer une image depuis un scanner :

 1) Placez le document, le dessin ou la photographie dans le scanner et assurez-vous que le 
scanner est prêt.

 2) Choisissez Insertion > Média > Scanner > Sélectionner la source dans la barre de menu 
pour sélectionner le scanner à utiliser. Choisissez Insertion > Média > Scanner > Acquérir 
dans la barre de menu une fois le scanner sélectionné.

 3) La suite de la procédure dépend du pilote du scanner, de son interface et du système 
d’exploitation de l’ordinateur. Il vous est habituellement demandé de spécifier les options de 
scan, comme la résolution ou la fenêtre de scan entre autres. Consultez la documentation de
votre scanner pour plus d’informations.

 4) Une fois l’image scannée, Draw la place dans votre dessin. Vous pouvez alors l’éditer 
comme n’importe quelle autre image.

Remarque

Si plusieurs scanners sont connectés à l’ordinateur, vous avez la possibilité d’en choisir un 
quand vous sélectionnez la source. Cette sélection devient la source par défaut quand vous 
faites des acquisitions d’images jusqu’à ce que vous fassiez un autre choix.
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Copie et collage

Copier une image puis la coller est une autre façon d’incorporer des images dans votre dessin. 
Elle utilise le presse-papiers. L’image copiée peut être une image déjà incorporée dans un autre 
document, ou ce peut être un fichier image.

Après la copie, vous pouvez choisir le format dans lequel vous voulez coller l’image dans Draw en 
choisissant Édition > Collage spécial > Collage spécial dans la barre de menu. Les formats 
disponibles dépendent du type d’image copiée dans le presse-papiers.

Figure 146 : La boîte de dialogue Collage spécial

Astuce

Vous pouvez aussi cliquer sur  à droite de l’icône Coller dans la barre d’outils Standard et 
choisir le format souhaité dans le menu déroulant.

Remarque

Quand vous collez des images dans votre dessin, faites attention de respecter les droits et 
licences attachés à celles-ci.

Glisser-déposer

Le glisser-déposer est une autre méthode pour incorporer des images dans un dessin et peut être 
utilisé avec des images incorporées ou liées à l’origine. La façon dont le glisser-déposer fonctionne
dépend du système d’exploitation de l’ordinateur. Le comportement du glisser-déposer est 
habituellement possible en utilisant les touches Ctrl ou Ctrl+Maj en combinaison avec la 
souris.
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Les images fréquemment utilisées peuvent être rangées dans la galerie de LibreOffice. Une copie 
de l’image peut alors être simplement glissée-déposée dans le dessin depuis la galerie. Voir le 
Chapitre 10, Techniques avancées, page 290, pour plus d’informations.

Exporter des images

Exporter le fichier entier

Par défaut, Draw enregistre les dessins au format ODG, mais certains logiciels ne peuvent pas 
ouvrir ces fichiers. Vous pouvez alors exporter le fichier dans divers formats.

 1) Ouvrez le fichier ODG que vous voulez exporter et ne sélectionnez aucun objet.

 2) Choisissez Fichier > Exporter dans la barre de menu. La boîte de dialogue Exporter s’ouvre
(Figure 147).

Figure 147 : La boîte de dialogue Exporter

 3) Saisissez, si nécessaire, un nouveau nom pour le fichier exporté dans le champ Nom de 
fichier et recherchez le dossier où vous souhaitez le placer.

 4) Sélectionnez le format désiré dans la liste déroulante Type de fichier.

 5) Cliquez sur Enregistrer.

 6) Selon le format sélectionné, une autre boîte de dialogue peut s’ouvrir pour vous demander 
de spécifier les options nécessaires à ce format graphique. La Figure 148 présente les 
options d’exportation dans le format WMF.
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 7) Selon la boîte de dialogue, cliquez sur Exporter, Créer ou OK et votre document sera 
exporté en tant que nouveau fichier dans un nouveau format.

Figure 148 : Les options d’exportation au format WMF

Exporter des objets

L’exportation d’objets individuels dans un fichier de dessin se fait de la même façon que 
l’exportation de fichiers entiers décrite ci-dessus. Une fois le fichier ouvert, il suffit de sélectionner 
le ou les objets que vous voulez exporter et de cocher l’option Sélection dans la boîte de dialogue 
Exporter.

Formater des images tramées

Les objets de type image peuvent être formatés en utilisant une des méthodes suivantes pour 
ajouter ou modifier les filtres et ajuster les propriétés de couleur, de lignes, de zones et d’ombres :

• sélectionnez le menu Format > Image et utilisez les outils du menu déroulant qui s’ouvre ;

• utilisez la barre d’outils Image. Voir « La barre d’outils Image », page 10, pour plus 
d’informations ;

• utilisez les outils des sections Ombre et Image de l’onglet Propriétés du volet latéral. Voir 
« Les sections Ombre et Image du volet latéral », page 11, pour plus d’informations ;

• certaines images tramées peuvent avoir un élément textuel. Pour plus d’informations sur le 
formatage du texte, voir le chapitre 9, Ajouter et formater des textes, page 210.

Les images sont des objets, pour lesquels s’appliquent les fonctionnalités décrites dans les autres 
chapitres de ce guide. Elles peuvent être incluses dans un groupe et réagir comme les autres 
objets lorsque les propriétés du groupe sont modifiées.

Nommer les images

Il est recommandé de donner un nom aux objets que sont les images tramées de votre dessin, 
pour les rendre plus visibles et plus facilement accessibles dans le navigateur de LibreOffice. 
Utilisez une des méthodes suivantes pour ouvrir la boîte de dialogue Nom (Figure 149) et pouvoir 
saisir le nom de l’image sélectionnée :
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Figure 149 : La boîte de dialogue Nom

• sélectionnez Format > Nom dans la barre de menu,

• faites un clic droit sur l’image puis choisissez Nom dans le menu contextuel.

La barre d’outils Image

La barre d’outils Image apparaît automatiquement lorsque vous sélectionnez une image (Figure 
150).

Position et taille Aligner Envoyer à l’avant

Envoyer vers l’avant Envoyer vers l’arrière Envoyer à l’arrière

Devant l’objet Derrière l’objet Inverser

Style de ligne Largeur de ligne Couleur de ligne

Style de remplissage Couleur de remplissage Ombre

Filtrer Mode image Rogner

Refléter verticalement Refléter horizontalement Transformations

Transparence Couleurs

Figure 150 : La barre d’outils Image

Les outils disponibles dans la barre d’outils Image sont les suivants :

• Position et taille : ouvre la boîte de dialogue Position et taille. Voir le chapitre 3, Manipuler 
les objets et les points des objets, page 48, pour plus d’informations.

• Aligner : ouvre la palette, détachable en barre d’outils Aligner les objets, qui permet d’aligner
un objet par rapport aux autres objets du dessin. Voir le chapitre 5, Combiner plusieurs 
objets, page 129, pour plus d’informations.

• Outils Disposer : un ensemble de sept outils qui permettent de placer l’objet sélectionné 
devant ou derrière les autres objets du dessin. Voir le chapitre 5, Combiner plusieurs objets, 
page 128, pour plus d’informations.

• Style de ligne : ouvre une liste déroulante qui propose différents styles de ligne. Dans ce 
contexte, la ligne est la bordure du contour de l’image. Voir le chapitre 4, Modifier les 
attributs d’un objet, page75, pour plus d’informations.
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• Largeur de ligne : ce champ vous permet de modifier la largeur (épaisseur) d’une ligne. Voir
le chapitre 4, Modifier les attributs d’un objet, page 75, pour plus d’informations.

• Couleur de ligne : changez la couleur d’une ligne grâce à la palette ouverte par ce bouton. 
Voir le chapitre 4, Modifier les attributs d’un objet, page 75, pour plus d’informations.

• Style de remplissage : cette liste déroulante vous permet de modifier le type de 
remplissage d’une forme. Voir le chapitre 4, Modifier les attributs d’un objet, page 83, pour 
plus d’informations.

• Ombre : permet d’obtenir l’effet d’ombre par défaut autour de l’image. Voir le chapitre 4, 
Modifier les attributs d’un objet, page 101, pour plus d’informations.

• Filtrer : ouvre la barre d’outils Filtre d’image décrite dans le paragraphe « La barre d’outils 
Filtre graphique » page 147.

• Mode Image : modifie l’affichage de l’image de couleur (Par défaut) à Niveaux de gris, 
Noir/Blanc ou Filigrane. Ce paramètre n’affecte que l’affichage et l’impression de l’image : le 
fichier image d’origine, incorporé dans le document ou lié, reste inchangé.

– Par défaut : l’image est affichée sans modification de couleur.

– Niveaux de gris : l’image est affichée avec 256 niveaux de gris.

– Noir/Blanc : l’image est affichée en noir et blanc

– Filigrane : la couleur, la luminosité, le contraste et le gamma de l’image sont réduits afin 
qu’elle puisse être utilisée en tant que filigrane (arrière-plan). Ces réglages par défaut 
peuvent être ajustés grâce à la barre d’outils Couleur (Figure 151).

• Rogner l’image : permet de rogner l’image. Lorsque vous cliquez sur cette icône, des 
poignées de rognage apparaissent autour de l’objet. Faites-les glisser pour rogner l’image à 
la taille désirée. Pour un rognage plus précis, voir « Rogner une image » page 145.

• Refléter verticalement : retourne l’image verticalement. Voir le chapitre 4, Modifier les 
attributs d’un objet, page 112, pour plus d’informations.

• Refléter horizontalement : retourne l’image horizontalement. Voir le chapitre 4, Modifier les 
attributs d’un objet, page 112, pour plus d’informations.

• Transformations : ouvre la palette, détachable en barre d’outils, Transformations. Voir le 
chapitre 4, Modifier les attributs d’un objet, page 114, pour plus d’informations.

• Transparence : définit le degré de transparence de l’image entre 0 % (opaque) et 100 % 
(totalement transparente).

• Couleur : ouvre la barre d’outils Couleur (Figure 151), qui permet d’ajuster les valeurs des 
trois couleurs RVB, la luminosité, le contraste et le gamma. Ces modifications n’affectent pas
l’image d’origine, mais les valeurs d’ajustement sont enregistrées dans Draw en tant que 
paramétrage séparé.

Figure 151 : La barre d’outils Couleur
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– Rouge, Vert, Bleu : permet de sélectionner des valeurs entre −100 % (pas de couleur) et 
100 % (intensité totale) ; 0 % représente la valeur d’origine de la couleur dans l’image.

– Luminosité : permet de sélectionner une valeur entre −100 % (totalement noir) et 100 % 
(totalement blanc).

– Contraste : permet de sélectionner une valeur entre −100 % (minimum) et 100 % 
(maximum).

– Gamma : permet de sélectionner une valeur entre 0,1 et 10 pour modifier la luminosité 
des couleurs intermédiaires. Essayez d’ajuster cette valeur si les modifications de 
luminosité et de contraste ne produisent pas le résultat espéré.

Les sections Ombre et Image du volet latéral

Figure 152 : Les sections Ombre et Image du volet latéral

Les sections Ombre et Image (Figure 152) de l’onglet Propriétés du volet latéral offrent les 
fonctions suivantes :

• Ombre : permet de créer et de paramétrer un effet d’ombre autour d’une image. Voir le 
chapitre 4, Modifier les attributs d’un objet, page 101, pour plus d’informations.

• Image : permet de modifier la façon dont l’image est affichée de couleur en niveaux de gris, 
noir et blanc ou filigrane et d’ajuster les canaux de couleur rouge, vert et bleu. Pour plus 
d’information, voir « La barre d’outils Image », page 142.
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Rogner une image

Le rognage est une méthode qui permet de cacher des parties d’une image ou en modifier la taille 
dans votre dessin.

Toute modification effectuée quand vous rognez une image ne change que l’affichage de l’image. 
L’image d’origine n’est pas modifiée. Si vous voulez utiliser une image rognée dans un autre 
dessin, vous devez utiliser une des méthodes suivantes après avoir sélectionné l’image :

• sélectionnez Fichier > Exporter dans la barre de menu pour ouvrir la boîte de dialogue 
Exporter. Recherchez le dossier que vous voulez utiliser, saisissez un nom pour le fichier et 
cliquez sur Enregistrer. Voir « Exporter des images », page 140, pour plus d’informations ;

• sélectionnez Format > Image > Enregistrer ou faites un clic droit sur l’image rognée et 
choisissez Enregistrer dans le menu contextuel. Cliquez sur Oui dans la boîte de 
confirmation pour enregistrer l’image et ouvrir la boîte de dialogue Export d’image (Figure 
153). Choisissez le format de fichier que vous voulez utiliser, recherchez le dossier où vous 
voulez enregistrer l’image, saisissez son nom et cliquez sur Enregistrer.

Figure 153 : la boîte de dialogue Export d’image

Rognage rapide

Une fois l’image sélectionnée, vous pouvez la rogner rapidement par l’une des méthodes 
suivantes :

• cliquez sur l’outil Rogner  de la barre d’outils Standard ou de la barre d’outils Image (si 
elle est visible) ;

• sélectionnez Format > Image > Rogner dans la barre de menu ;
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• faites un clic droit sur l’image et choisissez Rogner dans le menu contextuel.

Des poignées de rognage apparaissent alors autour de l’image. Utilisez-les de la façon suivante :

• les poignées du haut, du bas, de gauche et de droite permettent de rogner l’image dans une 
seule direction ;

• les poignées des coins permettent de rogner l’image dans deux directions. Par exemple, la 
poignée du coin supérieur droit rogne l’image à partir du haut et de la droite.

La boîte de dialogue Rogner

Pour plus de contrôle et de précision sur les fonctions de rognage, il est recommandé d’utiliser la 
boîte de dialogue Rogner (Figure 154). Après sélection de l’image, choisissez Format > Image > 
Boîte de dialogue rogner dans la barre de menu pour ouvrir la boîte de dialogue Rogner.

Figure 154 : La boîte de dialogue Rogner

Dans la boîte de dialogue Rogner, un aperçu vous permet de vous rendre compte de la façon dont
l’affichage de l’image sera modifié en conséquence des valeurs des différents paramètres.

Rogner
Cette section vous permet de découper l’image sélectionnée, ou d’ajouter un espace vide 
autour de cette image.

– Conserver l’échelle : conserve l’échelle d’origine de l’image lors du rognage, ce qui a pour
conséquence que la taille de l’image va évoluer.

– Conserver la taille de l’image : conserve la taille d’origine de l’image lors du rognage, ce 
qui a pour conséquence que l’échelle de l’image va changer. Pour réduire l’échelle de 
l’image, cochez cette option et entrez des valeurs négatives dans les champs de rognage.
Pour augmenter l’échelle de l’image, saisissez des valeurs positives dans ces champs.

– Gauche et Droite : si Conserver l’échelle est cochée, saisissez une valeur positive pour 
réduire l’image du côté gauche ou droit, ou une valeur négative pour ajouter un espace 
vide du côté gauche ou droit de l’image. Si Conserver la taille de l’image est cochée, 
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l’échelle horizontale sera augmentée ou diminuée en conséquence selon que la valeur 
saisie est positive ou négative.

– Haut et Bas : si Conserver l’échelle est cochée, saisissez une valeur positive pour réduire 
l’image du côté haut ou bas, ou une valeur négative pour ajouter un espace vide du côté 
haut ou bas de l’image. Si Conserver la taille de l’image est cochée, l’échelle verticale 
sera augmentée ou diminuée en conséquence selon que la valeur saisie est positive ou 
négative.

Échelle
Cette section vous permet de modifier l’échelle de l’image sélectionnée telle qu’elle apparaît 
dans le dessin.

– Largeur : saisissez la largeur de l’image affichée sous forme d’un pourcentage de la 
largeur réelle de l’image.

– Hauteur : saisissez la hauteur de l’image affichée sous forme d’un pourcentage de la 
hauteur réelle de l’image.

Taille de l’image
Cette section vous permet de modifier la taille de l’image sélectionnée.

– Largeur : saisissez la largeur de l’image sélectionnée.

– Hauteur : saisissez la hauteur de l’image sélectionnée.

– Taille d’origine : la taille d’origine de l’image est affichée au-dessus du bouton. Cliquez sur
ce bouton puis sur OK pour réinitialiser l’image à une échelle de 100 % et à ses largeur et
hauteur d’origine (en tenant compte des valeurs de la section Rogner).

! Attention

Dans la boîte de dialogue Rogner, les valeurs de largeur et de hauteur des sections Échelle
et Taille de l’image peuvent être manipulées de façon indépendante. Changer une valeur 
sans changer l’autre peut aboutir à des déformations importantes de l’image, ce qui peut ne 
pas être ce que vous avez recherché dans ces opérations de rognage.

La barre d’outils Filtre graphique

Après la sélection d’une image et l’ouverture de la barre d’outils Image (Figure 150, page 142), 
cliquez sur l’icône Filtrer  pour ouvrir la palette détachable en barre d’outils Filtre d’image 
(Figure 155). Draw vous propose onze effets de filtre. Les filtres s’appliquent à l’affichage en cours 
d’une image et peuvent être combinés. Ils s’appliquent toujours à l’image en entier : il n’est pas 
possible d’utiliser les filtres pour éditer une partie d’une image seulement.

Remarque

Si votre image est incorporée, tous les filtres graphiques sont appliqués directement sur 
cette image et ne peuvent être annulés au cours d’une session ultérieure. Une fois le dessin 
enregistré et fermé, les effets des filtres graphiques deviennent permanents. Si vous voulez 
annuler l’effet d’un filtre graphique, vous devez utiliser Édition > Annuler avant de fermer le
fichier. L’image d’origine n’est pas modifiée.
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Inverser Adoucir Augmenter la netteté

Supprimer les interférences Solarisation Vieillissement

Poster Pop’Art Dessin au fusain

Relief Mosaïque

Figure 155 : La barre d’outils Filtre d’image

Les filtres disponibles dans la barre d’outils Filtre d’image sont les suivants :

Filtre graphique Inverser 

Ce filtre inverse les valeurs de couleurs en couleurs ou de luminosité d’une image en niveaux de 
gris, comme pourrait le faire un négatif photographique (Figure 156). Appliquez de nouveau le filtre
pour retrouver l’image d’origine.

Normal Inversé

Figure 156 : Image inversée

Filtre graphique Adoucir 

Ce filtre adoucit ou estompe l’image, en appliquant un filtre de basse fréquence qui va réduire le 
contraste entre des pixels voisins et produire une légère perte de contraste (Figure 157)

Normal Adouci

Figure 157 : Image adoucie

La boîte de dialogue Lisser (Figure 158) s’ouvre, où vous pouvez déterminer le Rayon lisse à 
appliquer au filtre lorsque vous cliquez sur OK : plus la valeur est forte, plus l’image sera floue.
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Figure 158 : La boîte de dialogue Lisser.

Filtre graphique Augmenter la netteté 

Ce filtre augmente la netteté de l’image, en appliquant un filtre de haute fréquence qui va 
augmenter le contraste entre des pixels voisins en élevant la différence de luminosité. Cela va 
accentuer les lignes et cet effet sera renforcé si vous appliquez le filtre plusieurs fois (Figure 159).

Normal Plus net

Figure 159 : Image plus nette

Filtre graphique Supprimer les interférences 

Ce filtre supprime les pixels parasites, en appliquant un filtre médian qui compare chaque pixel à 
ses voisins. Il remplace alors les pixels dont les valeurs de couleur s’écartent le plus des valeurs 
moyennes par des pixels avec ces valeurs de couleur moyennes. Le résultat produisant des 
variations de contraste plus faibles, l’image paraît plus douce (Figure 160).

Normal Après suppression
des interférences

Figure 160 : Image après application du filtre
Supprimer les interférences
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Filtre graphique Solarisation 

La solarisation est un phénomène en photographie par lequel les couleurs d’une image enregistrée
sur un négatif ou imprimée sont totalement ou partiellement inversées. C’était à l’origine un effet 
photochimique utilisé durant le développement d’un film photographique. La solarisation est 
maintenant utilisée dans l’univers de l’image numérique pour créer une modification ou une 
inversion de couleurs (Figure 161).

Normal Seuil 50 %Seuil 50 % Seuil 50 % et
Invertir cochée

Figure 161 : Image solarisée

Cliquer sur l’icône Solarisation ouvre la boîte de dialogue Solarisation (Figure 162). Saisissez une
valeur de seuil de la couleur à partir de laquelle celle-ci est inversée. Cochez l’option Invertir pour 
ajouter un effet inversé à l’image (voir « Filtre graphique Inverser  » page 148).

Figure 162 : La boîte de dialogue Solarisation

Filtre graphique Vieillissement 

Normal Vieillissement 10 %

Figure 163 : Image vieillie
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Le vieillissement crée une apparence qui ressemble aux photographies anciennes. Tous les pixels 
sont fixés à leur valeur de gris et les canaux de couleur verte et bleue sont réduits à la valeur 
déterminée dans la boîte de dialogue Vieillissement. Le canal de couleur rouge n’est pas modifié 
(Figure 163).

Cliquer sur l’icône Vieillissement ouvre la boîte de dialogue Vieillissement (Figure 164), où vous 
pouvez choisir le degré de vieillissement : à 0 %, on ne voit que les valeurs de gris des pixels ; à 
100 %, il ne reste que le canal rouge.

Figure 164 : La boîte de dialogue Vieillissement

Filtre graphique Poster 

L’effet de poster réduit le nombre de couleurs d’une image, la rendant plus plate. Si vous l’utilisez 
sur une photographie, celle-ci pourra ressembler à une peinture (Figure 165).

Normal Postérisée,
16 couleurs

Figure 165 : Image postérisée

Cliquer sur l’icône Poster ouvre la boîte de dialogue Poster (Figure 166), où vous pouvez choisir le
nombre de couleurs.
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Figure 166 : La boîte de dialogue Postériser

Filtre graphique Pop'art 

Ce filtre va modifier les couleurs de l’image pour la mettre au format Pop’art (Figure 167).

Normal Pop art

Figure 167 : Application du filtre Pop’art

Filtre graphique Dessin au fusain 

Ce filtre va afficher l’image comme un croquis au fusain. Les contours de l’image sont tracés en 
noir et les couleurs d’origine sont supprimées (Figure 168).

Normal Dessin au fusain

Figure 168 : Image dessinée au fusain

Filtre graphique Relief 

L’effet de relief permet de faire apparaître les lignes d’une image en relief, comme si l’image était 
éclairée par une source de lumière (Figure 169).
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Normal Effet de relief

Figure 169 : Image en relief

Cliquer sur l’icône Relief ouvre la boîte de dialogue Relief (Figure 170), où vous pouvez choisir la 
position de la source de lumière qui va créer des ombres.

Figure 170 : La boîte de dialogue Relief

Filtre graphique Mosaïque 

L’effet de mosaïque crée de petits groupes de pixels et les transforme en carreaux rectangulaires 
d’une seule couleur, produisant une image qui ressemble à une mosaïque (Figure 171). Plus les 
rectangles individuels créés sont grands, moins l’image comporte de détails.

Normal Mosaïque

Figure 171 : Image en mosaïque

Cliquer sur l’icône Mosaïque ouvre la boîte de dialogue Mosaïque (Figure 172), où vous pouvez 
déterminer la largeur et la hauteur en pixels des rectangles individuels qui seront créés. Le fait de 
cocher l’option Améliorer les bords va accentuer les côtés de chaque carreau.
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Figure 172 : La boîte de dialogue Mosaïque

Remplacer des couleurs

L’outil Remplacement de couleurs vous permet seulement de remplacer une couleur d’une 
image incorporée par une autre ou de la définir comme couleur transparente. Jusqu’à quatre 
couleurs peuvent être remplacées en même temps. L’outil fonctionne sur l’image entière et vous 
ne pouvez pas sélectionner une partie de l’image pour l’éditer.

Remarque

L’outil Remplacement de couleurs ne peut être utilisé qu’avec des images incorporées. Si 
vous essayez d’utiliser cet outil avec une image liée, lorsque vous cliquez sur le bouton 
Remplacer, le message suivant s’affichera : « Cette image est liée à un document. Voulez-
vous rompre le lien de l’image afin de l’éditer ? »

La liste de sélection Remplacer par contient toutes les couleurs disponibles de la palette de 
couleurs en cours pour le document. Vous ne pouvez pas y définir de nouvelles couleurs, mais 
vous pouvez ajouter des couleurs à cette palette avant d’utiliser l’outil. Voir Chapitre 11, 
Techniques avancées, page 300.

Remplacement de couleurs

Pour remplacer des couleurs dans une image incorporée, procédez de la façon suivante :

 1) Sélectionnez Outils > Remplacement de couleurs dans la barre de menu pour ouvrir la 
boîte de dialogue Remplacement de couleur (Figure 173).
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Figure 173 : La boîte de dialogue Remplacement de couleur

 2) Sélectionnez l’image où remplacer des couleurs.

 3) Cliquez sur l’icône Pipette  pour activer le mode de sélection de couleur.

 4) Déplacez le pointeur de la souris au-dessus de la couleur à remplacer dans l’image et 
cliquez.

 5) Une case est cochée dans la liste des couleurs et la couleur sélectionnée apparaît dans la 
zone Couleur d’origine.

 6) Saisissez le pourcentage de tolérance par rapport à la couleur sélectionnée. La valeur par 
défaut est de 10 %.

 7) Dans la zone Remplacer par, sélectionnez la couleur de remplacement dans la palette 
déroulante. La valeur par défaut est Transparent.

 8) Vous pouvez répéter les étapes 3 à 7 pour remplacer jusqu’à quatre couleurs simultanément.

 9) Cliquez sur le bouton Remplacer pour procéder au remplacement.

Normal Après remplacement
des couleurs

Figure 174 : Image obtenue avec le réglage de la Figure 173

Il n’existe pas d’aperçu de l’effet produit par l’outil de remplacement de couleurs. Si le résultat ne 
correspond pas à vos attentes, sélectionnez Édition > Annuler et recommencez.

Remplacement des zones transparentes

Vous pouvez également remplacer les zones transparentes dans une image incorporée par une 
couleur.
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 1) Sélectionnez Outils > Remplacement de couleurs dans la barre de menu pour ouvrir la 
boîte de dialogue Remplacement de couleur (Figure 173).

 2) Assurez-vous que l’image n’est pas sélectionnée.

 3) Dans la boîte de dialogue Remplacement de couleur, cochez la case Transparence.

 4) Sélectionnez la couleur de remplacement dans la palette déroulante à droite de la case 
Transparence.

 5) Sélectionnez l’image.

 6) Cliquez alors sur le bouton Remplacer pour remplacer les zones transparentes par la 
couleur choisie.

Il n’existe pas d’aperçu de l’effet produit par l’outil de remplacement de couleurs. Si le résultat ne 
correspond pas à vos attentes, sélectionnez Édition > Annuler et recommencez.

Le paramètre Tolérance

Le pourcentage de tolérance est utilisé pour indiquer combien de valeurs de couleurs seront 
remplacées. Plus ce pourcentage sera faible, plus les couleurs devront être proches de la valeur 
de couleur sélectionnée pour être remplacées. Pour remplacer une gamme de couleurs plus 
étendue, saisissez une valeur plus élevée pour le paramètre tolérance.

Conversion

Conversion en contour

La conversion en contour produit un dessin en créant un polygone ou un groupe de polygones à 
quatre sommets dont l’arrière-plan est l’image originale. Toute modification doit être effectuée 
avant de procéder à une conversion en contour, car vous ne pouvez pas effectuer d’autres 
modifications sur l’image.

 1) Assurez-vous que les modifications de l’image que vous allez convertir sont terminées et 
qu’elle est sélectionnée dans votre dessin.

 2) Choisissez Convertir > En contour dans le menu Forme ou dans le menu contextuel ouvert
par un clic droit sur l’image.

Si la conversion produit un groupe de polygones (par exemple s’il s’agit d’un objet texte), vous 
devez entrer dans le groupe par l’une des méthodes suivantes avant de sélectionner un polygone 
particulier :

• choisissez Forme > Grouper > Entrer dans le groupe dans la barre de menu ;

• faites un clic droit sur l’image convertie et choisissez Entrer dans le groupe dans le menu 
contextuel ;

• appuyez sur la touche F3.
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Conversion en polygone

La conversion en polygone sert à convertir l’image sélectionnée en un groupe de polygones 
remplis par une couleur. L’image est aussi convertie en un tracé vectoriel sans perte de qualité ni 
distorsion du texte.

Après conversion vous pouvez fractionner le tracé en groupes de polygones puis scinder ces 
groupes en polygones individuels. Ces opérations vous permettent de modifier et de supprimer 
des couleurs particulières dans le dessin.

Convertir

 1) Sélectionnez l’image dans votre dessin.

 2) Ouvrez la boîte de dialogue Convertir en polygone (Figure 175) en sélectionnant Convertir >
En polygone soit dans le menu Forme, soit dans le menu contextuel ouvert par un clic droit 
sur l’image.

Figure 175 : La boîte de dialogue Convertir en polygone

 3) Choisissez le Nombre de couleurs et la Réduction de points à utiliser pour la conversion.

 4) Cochez Remplir les trous pour éviter l’apparition de zones blanches dans l’image.

 5) Saisissez le nombre de pixels pour la Taille du carrelage.

 6) Cliquez sur Aperçu pour vérifier l’aspect du dessin qui sera produit.

 7) Effectuez toutes les modifications des paramètres nécessaires et vérifiez de nouveau 
l’aperçu.
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 8) Quand vous êtes satisfait, cliquez sur OK pour convertir votre image en polygone et refermer
la boîte de dialogue.

Options et contrôles de la boîte de dialogue Convertir en polygone

• Nombre de couleurs : saisissez le nombre de couleurs qui seront affichées dans l’image 
convertie. LibreOffice génère un polygone pour chaque occurrence d’une couleur dans 
l’image. La plage du nombre de couleurs s’étend de 8 à 32.

• Réduction de points : supprime les polygones colorés plus petits que le nombre de pixels 
que vous saisissez, entre 0 et 32.

• Remplir les trous : cochez cette option pour combler les zones vides du dessin qui peuvent 
apparaître en application de la réduction de points.

• Taille de carrelage : saisissez ici la taille des carrés pour le remplissage de l’arrière-plan. La 
plage de valeurs va de 8 à 128 pixels.

• Image source : vous voyez ici l’image originale.

• Image vectorielle : vous avez ici un aperçu de l’image convertie.

• Aperçu : cliquez sur ce bouton pour mettre à jour l’aperçu de l’image vectorielle convertie.

• OK : cliquez sur ce bouton pour créer l’image vectorielle formée de polygones. Le résultat 
est un métafichier au format SVM (StarView Metafile) utilisé par LibreOffice qui permet le 
transfert de l’image convertie dans d’autres documents de LibreOffice.

Fractionner

Une fois l’image convertie en polygones, vous pouvez fractionner le dessin vectoriel en groupes de
polygones. Chaque groupe ne contient qu’une seule couleur et devient un objet que vous pouvez 
utiliser dans un autre dessin.

 1) Convertissez votre image en polygones comme expliqué ci-dessus.

 2) Sélectionnez l’image convertie puis choisissez Fractionner soit dans le menu Forme, soit 
dans le menu contextuel ouvert par un clic droit sur l’image.

 3) Cliquez sur une zone de couleur dans l’image puis, en maintenant le bouton de la souris 
appuyé, faites glisser le groupe de polygones remplis par cette couleur hors de l’image pour 
en créer une nouvelle, ou appuyez sur la touche Suppr pour la faire disparaître de l’image.

Scinder

Quand l’image a été convertie puis fractionnée en groupes de polygones, vous pouvez scinder ces
groupes en polygones individuels.

 1) Convertissez votre image en polygones comme expliqué ci-dessus.

 2) Fractionnez l’image obtenue en groupes de polygones comme expliqué ci-dessus.

 3) Sélectionnez l’image fractionnée puis utilisez une des méthodes suivantes pour scinder le 
groupe de polygones en objets individuels :

– choisissez Scinder dans le menu Forme ou dans le menu contextuel ouvert par un clic 
droit sur l’image ;

– appuyez sur Ctrl+Alt+Maj+K.
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 4) Sélectionnez un (ou plusieurs) polygone dans l’image et, en maintenant le bouton de la 
souris appuyé, faites-le glisser hors de l’image pour en créer une nouvelle, ou appuyez sur la
touche Suppr pour le(s) faire disparaître de l’image.

Convertir en bitmap

Tous les objets de dessin situés dans un document LibreOffice Draw sont des graphiques 
vectoriels qui peuvent être convertis en images bitmap au format PNG. Tous les effets de 
transparence de l’image vectorielle d’origine sont perdus pendant la conversion, bien que le format
PNG utilisé par Draw les supporte.

Pour convertir un graphique vectoriel en image bitmap, sélectionnez Convertir > En bitmap dans 
le menu Forme ou dans le menu contextuel ouvert par un clic droit sur le dessin.

Options d’impression

Si vous ne disposez que d’une imprimante monochrome (noir et blanc) ou que vous rencontrez 
des problèmes d’impression, les réglages suivants peuvent vous aider à imprimer vos dessins. 
Vous pouvez paramétrer l’impression de façon que tous les textes et toutes les images soient 
imprimés soit en niveaux de gris, soit en noir et blanc.

Ouvrez la boîte de dialogue Options en sélectionnant Outils > Options dans la barre de menu 
puis la page LibreOffice Draw – Imprimer (Figure 176) où vous trouverez les paramètres 
d’impression propres à Draw.

Figure 176 : La page LibreOffice Draw – Imprimer dans la boîte de dialogue Options

Pour régler les options d’impression pour le seul document courant, sélectionnez Fichier > 
Imprimer dans la barre de menu ou utilisez la combinaison de touches Ctrl+P pour ouvrir la 
boîte de dialogue Imprimer puis cliquez sur l’onglet LibreOffice Draw (Figure 177).
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Figure 177 : La boîte de dialogue Imprimer pour le document ouvert

Pour paramétrer les options d’impression pour tous les modules de LibreOffice, ouvrez la boîte de 
dialogue Options en sélectionnant Outils > Options dans la barre de menu puis la page 
LibreOffice – Impression (Figure 176). Ces options permettent de réduire la quantité de données 
d’impression envoyées à l’imprimante ou au fichier. De plus, des avertissements concernant la 
taille et l’orientation du papier ainsi que la transparence de l’image peuvent vous être donnés.
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Chapitre 7
Manipuler les objets 3D





Introduction

Bien que Draw ne dispose pas de toutes les fonctionnalités des principaux programmes d’édition 
des dessins ou d’images, il est capable de produire et éditer des dessins et des images en 3D.

Dans Draw, il existe deux sortes d’objets 3D : les séquences 3D et les formes 3D. La barre d’état 
indique qu’une séquence 3D a été sélectionnée (Figure 178), mais elle indique seulement qu’une 
forme a été sélectionnée (Figure 179) quand il s’agit d’une forme 3D extrudée.

Figure 178 : La barre d’état indiquant qu’une séquence 3D est sélectionnée

Figure 179 : La barre d’état indiquant qu’une forme est sélectionnée

Selon le type choisi, les possibilités d’édition ultérieure de l’objet (rotation, éclairage, perspective,  
etc.) sont différentes. Les formes 3D extrudées sont plus simples à paramétrer et à modifier, mais 
les séquences 3D offrent plus de possibilités de personnalisation.

Vous pouvez créer des objets 3D grâce à l’une des méthodes suivantes :

• insérer un des objets 3D prédéfinis qui sont des séquences 3D. Choisissez-le :

– en cliquant sur l’icône Objets 3D ( ) dans la barre d’outils Dessin (Figure 180, page
164) avant de sélectionner un objet dans la palette qui s’ouvre alors ;

– en sélectionnant un objet dans la section Objets 3D de l’onglet Formes du volet latéral ;

• convertir un objet 2D en séquence 3D grâce à l’un des outils suivants de la barre d’outils 
Dessin (Figure 180, page 164) :

– En 3D ( ) pour créer une séquence 3D contenant un objet obtenu par extrusion ;

– En corps de révolution 3D ( ) pour créer une séquence 3D dans un corps de 
révolution autour de l’axe par défaut ;

– En corps de révolution 3D ( ) pour créer une séquence 3D dans un corps de 
révolution autour d’un axe que vous pouvez définir ;

• extruder un objet 2D en cliquant sur l’icône (Des)activer l’extrusion ( ) dans la barre 
d’outils Standard pour créer une forme 3D. Seules celles-ci peuvent être converties de 
nouveau en objet 2D.

Types d’objets 3D

Séquences 3D

Une séquence 3D est un objet 3D défini selon ses trois coordonnées x, y et z qui peuvent contenir 
des objets comme un cube, une sphère, un objet obtenu par extrusion ou de révolution. Ces objets
n’ont pas d’existence hors d’une séquence 3D.

Lorsqu’une séquence 3D, qui a été créée par conversion en objet obtenu par extrusion ou en objet
de révolution, ou qui est un objet 3D natif, est sélectionnée, le libellé Séquence 3D sélectionné(e)
(s) s’affiche dans la barre d’état (Figure 178).
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Draw considère les séquences 3D comme des groupes d’objets et, comme pour tous les groupes, 
vous devez y entrer pour éditer un objet particulier de la séquence 3D puis la quitter une fois les 
modifications achevées. Voyez le chapitre 5, Combiner plusieurs objets, page 119, pour plus 
d’informations sur la façon d’entrer dans un groupe, d’en modifier les éléments et de le quitter.

Ces groupes ne comportent généralement qu’un seul objet. Cependant, ce n’est pas le cas si vous
convertissez en 3D une forme de base qui représente en 2D une forme 3D (la forme Cube par 
exemple) ou si vous convertissez en 3D un groupe d’objets 2D.

Remarque

Il n’est pas possible de dégrouper en éléments individuels une séquence 3D, créée à partir 
d’une sélection d’objets 2D.

Formes 3D

Les formes 3D sont des objets solides qui possèdent trois dimensions, une longueur, une largeur 
et une hauteur. Alors que les formes 2D sont plates, les formes 3D possèdent une épaisseur.

Une forme 3D est créée quand une forme 2D ou un objet de la galerie Fontwork est transformé en 
3D grâce à l’icône (Dés)activer l’extrusion  de la barre d’outils Standard. Lorsqu’une forme 3D
est sélectionnée, le libellé Forme sélectionné(e)(s) (Figure 179) s’affiche dans la barre d’état.

Une forme 3D peut être affichée et éditée en 3D ou en 2D. Dans ce dernier cas, désactivez 
l’extrusion, effectuez les modifications puis activez de nouveau l’extrusion.

Remarque

L’extrusion n’est utilisable que si vous avez sélectionné une forme 2D ou un objet 3D que 
vous avez extrudé à partir d’une forme 2D ou un objet de la galerie Fontwork en utilisant 
l’outil (Dés)activer l’extrusion. Elle n’est pas accessible pour le texte, les lignes, les 
flèches, les courbes ni les polygones.

La barre d’outils Dessin

Avant de commencer à créer des objets 3D dans votre dessin, il est recommandé d’ajouter les 
outils 3D et d’extrusion à la barre d’outils Dessin (Figure 180) en utilisant les Boutons visibles 
(Figure 181) ou la boîte de dialogue Personnaliser (Figure 182).

Objets 3D En 3D En corps de révolution 3D5

En corps de révolution 3D6 Effets 3D (Dés)activer l’extrusion

Figure 180 : La barre d’outils Dessin avec les outils 3D

5 Axe réglable.
6 Axe par défaut.
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Remarque

Les icônes 3D ne sont accessibles que si vous sélectionnez un objet 2D, un objet texte ou 
un objet de la galerie Fontwork et elles n’apparaissent pas par défaut parmi les icônes de la 
barre d’outils Dessin.

Boutons visibles

 5) Cliquez sur le triangle ▼ ou faites un clic droit dans un emplacement vide de la barre d’outils
Dessin et sélectionnez Boutons visibles dans le menu contextuel.

Figure 181 : Boutons visibles dans la barre d’outils Dessin

 6) Choisissez les boutons dont vous avez besoin pour la 3D (Figure 181). Les boutons 
sélectionnés apparaîtront dans la barre d’outils Dessin. Les boutons visibles dans la barre 
d’outils sont précédés d’une marque ✓         ou sur un fond coloré selon votre système
’    .d exploitation et ses réglages

Personnaliser la barre d’outils

 1) Faites un clic droit dans un emplacement vide de la barre d’outils Dessin et sélectionnez 
Personnaliser la barre d’outils dans le menu contextuel pour ouvrir la boîte de dialogue 
Personnaliser (Figure 182).

 2) Vérifiez que Dessin est bien affiché dans le champ Cible.

 3) Parcourez la liste Commandes disponibles jusqu’à ce que vous ayez trouvé le bouton 3D 
que vous cherchez.

Vous pouvez aussi saisir le nom de ce bouton dans le champ Rechercher pour limiter la liste 
qui apparaît dans Commandes disponibles.
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Figure 182 : La boîte de dialogue Personnaliser

 4) Cliquez sur le bouton vers la droite  entre les deux listes de commandes et le bouton 
choisi apparaît dans la liste Commandes assignées.

 5) Cliquez sur OK pour enregistrer les modifications et refermer la boîte de dialogue 
Personnaliser. Le bouton choisi apparaît dans la barre d’outils Dessin.

Créer des objets 3D

Objets 3D prédéfinis

Les objets 3D prédéfinis sont des séquences 3D que vous pouvez insérer dans votre dessin par 
une des méthodes suivantes :

• cliquez sur le triangle à droite de l’icône Objets 3D dans la barre d’outils Dessin (Figure 180,
page 164) et choisissez un objet dans la palette d’objets. L’icône affichée par l’outil Objets 
3D est celle du dernier objet sélectionné (  par défaut) ;
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• ouvrez la barre d’outils Objets 3D (Figure 183) en sélectionnant Affichage > Barres d’outils
> Objets 3D dans la barre de menu ou en détachant la palette ouverte grâce à l’icône 
Objets 3D de la barre d’outils Dessin (voir ci-dessus). La palette et la barre d’outils offrent le 
même choix d’objets ;

Figure 183 : La barre d’outils Objets 3D

• sélectionnez Forme > Insertion > Objets 3D dans la barre de menu puis choisissez un objet
dans le sous-menu qui s’ouvre alors ;

• ouvrez l’onglet Formes du volet latéral puis choisissez un objet dans la section Objets 3D. 
Le choix offert est le même que dans la boîte de dialogue ou le menu.

Remarque

Le dessin, le positionnement, le changement de taille et l’édition de ces objets 3D sont 
identiques à ceux des formes élémentaires : voir le chapitre 3, Manipuler les objets et les 
points des objets, page 41, pour plus d’informations.

Extrusion grâce à l’outil En 3D

L’outil En 3D convertit un objet 2D en une séquence 3D en extrudant l’objet 2D vers l’observateur. 
La séquence est pivotée de 20° autour de l’axe horizontal pour rendre l’effet 3D plus visible. La
Figure 184 propose des exemples de l’utilisation de l’outil En 3D.

Texte en 3D

Figure 184 : Exemples d’extrusions grâce à l’outil En 3D

Pour convertir un objet 2D en séquence 3D, sélectionnez l’objet 2D dans votre dessin puis utilisez 
une des méthodes suivantes :

Créer des objets 3D | 167



• faites un clic droit sur l’objet 2D sélectionné puis choisissez Convertir > En 3D dans le menu
contextuel ;

• cliquez sur l’icône En 3D ( ) dans la barre d’outils Dessin (Figure 180, page 164) ;

• cliquez sur le bouton En 3D dans la boîte de dialogue Effets 3D (Figure 192, page 174).

Corps de révolution

En corps de révolution 3D (axe par défaut)

L’outil En corps de révolution 3D convertit un objet 2D en séquence 3D en faisant tourner l’objet 
autour du bord gauche de son rectangle de sélection. Des exemples d’objets obtenus grâce à cet 
outil à partir d’une ligne épaisse sont présentés sur la Figure 185. La forme 3D effectivement créée
dépend de l’angle et de la forme de l’objet qui effectue la rotation.

Figure 185 : Exemples de conversion en corps de révolution 3D (axe fixe)

Pour convertir un objet 2D en séquence 3D, sélectionnez l’objet 2D puis utilisez une des méthodes
suivantes :

• faites un clic droit sur l’objet sélectionné puis choisissez Convertir > En corps de 
révolution 3D dans le menu contextuel ;

• cliquez sur l’icône En corps de révolution 3D (la deuxième) dans la barre d’outils Dessin 
(Figure 180, page 164).

En corps de révolution 3D (axe paramétrable)

L’outil En corps de révolution 3D convertit un objet 2D en séquence 3D en faisant tourner l’objet 
autour d’un axe de rotation que vous pouvez déplacer. Des exemples d’objets obtenus grâce à cet 
outil à partir d’une ligne épaisse sont présentés sur la Figure 186. La forme 3D effectivement créée
dépend de l’angle et de la forme de l’objet qui effectue la rotation.

 1) Dessinez un objet 2D et assurez-vous qu’il est sélectionné.

 2) Cliquez sur l’icône En corps de révolution 3D (la première) dans la barre d’outils Dessin 
(Figure 180, page 164).

 3) Ajustez la position et l’inclinaison de l’axe de rotation. Il est représenté par une ligne en tirets 
munie d’une poignée de rotation à chaque extrémité.

 4) Cliquez hors de l’objet 2D pour le convertir en séquence 3D.
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Axe par défaut

Axe déplacé et 
incliné

Figure 186 : Exemples de conversion en corps de révolution 3D (axe paramétrable)

Extrusion à l’aide de l’outil (Dés)activer l’extrusion

Dans une extrusion, des surfaces parallèles sont déplacées pour créer une forme 3D. Dans Draw, 
la surface 2D est déplacée vers l’avant hors du niveau du dessin. En même temps, l’objet est 
légèrement incliné et une projection centrale est activée pour créer l’impression d’une forme 3D. 
Draw utilise une valeur par défaut pour cette extrusion (profondeur de corps) fondée sur la taille de
l’objet 2D. Cette valeur peut être modifiée après l’extrusion : voir « Éditer les objets 3D », page
170.

La conversion par extrusion s’effectue grâce à l’outil (Dés)activer l’extrusion ( ) qui crée une 
forme 3D à partir d’un objet 2D. Cet outil ne s’applique qu’aux formes de base, aux symboles, 
flèches pleines, éléments d’organigrammes, légendes, étoiles et bannières qui font partie de 
l’ensemble d’outils par défaut de la barre d’outils Dessin ou de l’onglet Formes du volet latéral. Il 
peut aussi être utilisé avec tous les objets créés avec la galerie Fontwork. La Figure 187 montre 
des exemples d’extrusions d’objets.

Figure 187 : Exemples d’extrusion avec (Dés)activer l’extrusion

 1) Dessinez un objet 2D et assurez-vous qu’il est sélectionné.
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 2) Cliquez sur l’icône (Dés)activer l’extrusion ( ) dans la barre d’outils Dessin (Figure 180, 
page 164) ou dans la barre d’outils Standard pour convertir l’objet 2D en forme 3D.

 3) Pour retrouver l’objet 2D d’origine, sélectionnez l’objet 3D et cliquez sur l’icône (Dés)activer 
l’extrusion ( ).

Remarque

Cet outil ne s’applique pas aux objets textes créés par les outils Insérer une zone de texte 
ou Insérer une zone de texte verticale de la barre d’outils Standard (ou Dessin s’ils sont 
activés).

Éditer les objets 3D

Remarque

Quand une séquence 3D a été réalisée à partir de plusieurs objets 2D, un groupe de 
séquences 3D est automatiquement créé. Il n’est pas possible de dégrouper les séquences 
3D de ce groupe et toute édition que vous effectuerez affectera tous les objets 3D à 
l’intérieur du groupe. Pour modifier un objet 3D particulier du groupe, vous devez entrer 
dans ce groupe. Voyez le chapitre 5, Combiner plusieurs objets, page 119, pour plus 
d’informations sur la gestion des groupes.

Position, taille et rotation

La modification de la position, de la taille et de l’orientation des objets 3D est semblable à celle des
objets 2D. Voyez le chapitre 3, Manipuler les objets et les points des objets, page 41, pour plus 
d’informations.

Paramètres 3D

La barre d’outils Paramètres 3D (Figure 188) ne sert qu’à éditer une forme 3D qui a été créée à 
partir d’un objet 2D grâce à l’outil (Dés)activer l’extrusion (voir « Extrusion à l’aide de l’outil 
(Dés)activer l’extrusion », page 169).

Pour ouvrir la barre d’outils Paramètres 3D, sélectionnez Affichage > Barres d’outils > 
Paramètres 3D dans la barre de menu. Les outils qu’elle propose ne sont actifs que si une forme 
3D créée grâce à l’outil (Dés)activer l’extrusion est sélectionnée.

(Dés)activer l’extrusion Incliner vers le bas Incliner vers le haut

Incliner vers la gauche Incliner vers la droite Profondeur

Direction Éclairage Surface

Couleur 3D

Figure 188 : La barre d’outils Paramètres 3D
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Le résultat des modifications effectuées par les outils visibles sur la Figure 188 et présentées ci-
dessous est immédiatement appliqué à la forme 3D sélectionnée et visible dans l’effet 3D.

(Dés)activer l’extrusion 
C’est l’outil utilisé pour créer une forme 3D à partir d’un objet 2D. Si nécessaire, il peut aussi 
servir à annuler l’effet 3D créé par l’extrusion pour pouvoir modifier l’objet 2D sous-jacent.

Incliner vers le bas 
Incline l’objet sélectionné vers le bas (autour d’un axe horizontal) d’un angle de 5 degrés à 
chaque clic.

Incliner vers le haut 
Incline l’objet sélectionné vers le haut (autour d’un axe horizontal) d’un angle de 5 degrés à 
chaque clic.

Incliner vers la gauche 
Incline l’objet sélectionné vers la gauche (autour d’un axe vertical) d’un angle de 5 degrés à 
chaque clic.

Incliner vers la droite 
Incline l’objet sélectionné vers la droite (autour d’un axe vertical) d’un angle de 5 degrés à 
chaque clic.

Profondeur 
Ouvre un menu déroulant où vous pouvez choisir une valeur prédéfinie pour la profondeur 
de l’objet sélectionné ou définir une valeur particulière en choisissant l’option Personnalisé.

Direction 
Ouvre un menu déroulant qui vous permet de sélectionner la direction dans
laquelle la 3ème dimension s’effectue, et de choisir entre une vue en
perspective à point de fuite ou cavalière (parallèle).

Éclairage 
Ouvre un menu déroulant qui vous permet de choisir la direction et l’intensité de
l’éclairage de la forme 3D.

Surface 
Ouvre un menu déroulant où vous pouvez choisir le type de surface de la forme 3D (Fil de 
fer, Mat, Plastique et Métal).

Couleur 3D 
Ouvre une palette qui vous donne le choix de la couleur de la partie extrudée ; cette couleur 
peut-être différente de celle de l’objet 2D d’origine.

La Figure 189 offre un exemple de forme 3D inclinée vers la gauche de 15°, dont la profondeur a 
été portée à 2,5 cm et la couleur d’extrusion modifiée, grâce aux outils de la barre Paramètres 3D.
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Cercle après
extrusion

Cercle extrudé, incliné vers la
gauche, après augmentation

de la profondeur et
changement de couleur

Figure 189 : Exemple d’édition de forme 3D

Remarque

La boîte de dialogue Effets 3D décrite page 173 ne peut pas être utilisée avec des formes 
3D créées par l’outil (Dés)activer l’extrusion, car les résultats corrects du formatage ne 
seront pas obtenus. Si vous l’avez fait par erreur, vous pouvez supprimer le formatage 
incorrect en sélectionnant Format > Effacer le formatage direct dans la barre de menu.

Rotation des séquences 3D

La rotation des séquences 3D diffère de celle des objets 2D, telle que décrite au chapitre 3, 
Modifier les objets et les points des objets, page 50. L’inclinaison n’est pas possible, mais elle est 
remplacée par la rotation en 3D autour de l’axe vertical ou horizontal.

Pour faire effectuer une rotation 3D à une séquence 3D, sélectionnez-la, puis passez en mode 
rotation 

• en sélectionnant Forme > Transformations > Pivoter dans la barre de menu,

• en cliquant sur le bouton Pivoter  dans la palette Transformations de la barre d’outils 
Ligne et remplissage ou de la barre d’outils Standard

• en cliquant une deuxième fois sur la séquence 3D déjà sélectionnée.

Les poignées de sélection changent de forme et de couleur. Le point de centre de rotation apparaît
également au milieu de l’objet.

• Déplacez le pointeur de la souris au-dessus d’une des poignées de coin. Le curseur prend 
normalement la forme d’un arc. Cliquez et faites glisser pour faire tourner l’objet 3D autour 
d’un axe perpendiculaire à la feuille passant par le centre de rotation.

• Déplacez le pointeur de la souris au-dessus de la poignée de côté droite ou gauche. Le 
curseur prend normalement la forme d’une double demi-flèche. Cliquez et faites glisser pour 
faire tourner l’objet 3D autour d’un axe horizontal passant par le centre de rotation. Le 
pointeur prend la forme d’un arc dès le début du mouvement.

• Déplacez le pointeur de la souris au-dessus de la poignée de côté haute ou basse. Le 
curseur prend normalement la forme d’une double demi-flèche. Cliquez et faites glisser pour 
faire tourner l’objet 3D autour d’un axe vertical passant par le centre de rotation. Le pointeur 
prend la forme d’un arc dès le début du mouvement.
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• Déplacez le curseur de la souris au-dessus de la séquence 3D, mais en dehors de ses 
poignées. Le pointeur prend normalement la forme d’un arc. Cliquez et faites glisser pour 
faire tourner l’objet 3D autour du point de rotation, dans les trois dimensions.

Figure 190 : Rotation d’une séquence 3D

Contrairement aux objets 2D, les informations de la barre d’état ne s’actualisent pas au cours de la
rotation et l’image fantôme n’apparaît pas. La touche Maj est également sans effet.

Le point de rotation se situe habituellement au centre de l’objet. Pour modifier sa position, cliquez 
sur le point de rotation et faites-le glisser jusqu’à l’emplacement désiré. Le point de rotation peut se
situer à l’extérieur de l’objet.

Effets 3D

La boîte de dialogue Effets 3D (Figure 192) dispose de nombreuses possibilités de paramétrage 
pour les objets 3D prédéfinis ou les séquences 3D. Elle peut aussi servir à convertir un objet 2D en
3D en utilisant les outils situés dans le coin inférieur gauche de la boîte.

Pour ouvrir cette boîte de dialogue, sélectionnez la séquence 3D, faites un clic droit et choisissez 
Effets 3D dans le menu contextuel ou cliquez sur le bouton Effets 3D ( ) dans la barre d’outils 
Dessin (Figure 180, page 164).

Les effets que vous appliquez à une séquence 3D ne sont effectifs qu’après avoir cliqué sur le 
bouton Assigner  situé en haut à droite de la boîte de dialogue. Cela vous permet de 
paramétrer toutes les modifications des effets 3D avant de les appliquer à la séquence.

L’icône Actualiser  permet d’actualiser les valeurs de la boîte de dialogue avec celles de l’objet 
3D sélectionné.

Conversion 3D

Les icônes Convertir en 3D et Convertir en corps de révolution situées en bas à gauche de la 
boîte de dialogue Effets 3D permettent de convertir l’objet 2D sélectionné en séquence 3D et de 
changer la projection utilisée dans les séquences 3D.

• Convertir en 3D ( ) convertit un objet 2D en séquence 3D de la même manière que 
« Extrusion grâce à l’outil En 3D », page 167.

• Convertir en corps de révolution ( ) convertit un objet 2D en séquence 3D représentant 
un corps de révolution de la même manière que « En corps de révolution 3D (axe par 
défaut) », page 168.
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• L’icône Activer/désactiver la perspective ( ) permet d’activer ou de désactiver l’affichage 
en perspective d’une séquence 3D (Figure 191). La projection en perspective est un type de 
dessin qui simule graphiquement, sur une surface 2D (par exemple une feuille de papier), les
images d’objets 3D de manière à se rapprocher de la perception visuelle réelle. Elle est 
parfois aussi appelée vue en perspective, dessin en perspective ou simplement perspective.

Perspective
activée

Perspective
désactivée

Figure 191 : Effets 3D : Perspective

Effets 3D – Géométrie

Dans la page Géométrie de la boîte de dialogue Effets 3D (Figure 192), vous pouvez modifier les 
propriétés géométriques de l’objet 3D.

Figure 192 : La boîte de dialogue Effets 3D, page Géométrie

Géométrie
Définissez dans cette section les propriétés d’un objet d’une séquence 3D créée à partir d’un
objet 2D.

– Bords arrondis : saisissez le pourcentage avec lequel vous voulez arrondir les arêtes 
d’une séquence 3D (Figure 193). La valeur par défaut est de 10 %.
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0 %                  10 %                50 %
(par défaut)

Figure 193 : Effets 3D : bords arrondis

– Échelle de profondeur : saisissez le pourcentage avec lequel vous voulez agrandir ou 
diminuer la face avant d’un objet 3D (Figure 194). La valeur par défaut est de 100 %.

67 %                  100 %               150 %
(par défaut)

Figure 194 : Effets 3D : échelle de profondeur

– Angle de rotation : saisissez l’angle en degrés sur lequel s’étend une séquence 3D créée 
par révolution 3D (Figure 195). La valeur par défaut est 360 degrés.

Cercle
de départ

Cercle converti en
corps de révolution

rotation 360°

Cercle converti en
corps de révolution

rotation 150°

Figure 195 : Effets 3D : angle de rotation

– Profondeur : saisissez la profondeur de l’objet 3D (Figure 196). Ce paramètre ne 
s’applique pas aux séquences 3D créées par révolution 3D. La valeur par défaut dépend 
de la taille de l’objet.

Cercle
de départ

Cercle converti
par l’outil En 3D

Le même objet avec
une profondeur de 3 cm

Figure 196 : Effets 3D : profondeur
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Segments
Cette section permet de modifier le nombre de segments que Draw utilise pour dessiner les 
surfaces courbes des séquences 3D. Plus le nombre de segments sera élevé, plus la 
surface sera lisse, mais cela peut augmenter le temps d’affichage de la séquence 3D. La
Figure 197 montre la différence sur une sphère 3D pour laquelle le nombre de segments 
varie de 10 à 30, horizontalement et verticalement.

– Horizontal : saisissez le nombre de segments horizontaux à utiliser pour les surfaces 
arrondies de la séquence 3D.

– Vertical : saisissez le nombre de segments verticaux à utiliser pour les surfaces arrondies 
de la séquence 3D.

10 segments 30 segments

Figure 197 : Effets 3D : segments

Normales
Une normale est une droite orientée traversant perpendiculairement la surface d’un objet. 
Les normales permettent de définir l’aspect extérieur d’une séquence 3D et ses interactions 
avec les textures et les lumières.

– Spécifique à l’objet : restitue les surfaces 3D selon la forme de la séquence 3D. Par 
exemple, une forme circulaire sera restituée avec une surface arrondie.

– Plat : restitue les surfaces 3D en tant que polygones.

– Sphérique : restitue les surfaces 3D en tant que surfaces arrondies, quelle que soit la 
forme de l’objet.

Spécifique
à l’objet

Plat Sphérique

Figure 198 : Effets 3D : normales

– Inverser les normales : inverse le sens de la normale qui pointe vers l’extérieur. Si vous 
représentez un objet creux, une normale inversée peut être indiquée, car les deux 
surfaces sont tournées vers l’intérieur et l’extérieur dans le même modèle. La séquence 
3D paraît alors comme éclairée de l’intérieur (Figure 199).

– Éclairage des deux côtés : permet d’éclairer une séquence 3D à la fois de l’extérieur et de
l’intérieur (Figure 199), ce qui n’a d’effet que si l’intérieur est dessiné (voir Bilatéral ci-
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dessous). Ce réglage concerne la totalité de la séquence 3D, pas seulement un objet 
unique à l’intérieur de celle-ci.

Désactivée Activée

Inversion des normales

Désactivé

Activé

Éclairage des
deux côtés

Figure 199 : Effets 3D : inverser les normales et
éclairage des deux côtés

– Bilatéral : un objet 3D possède une face externe (devant) et une face interne (derrière). 
Quand Bilatéral est désactivé, seule la face externe de l’objet est représentée. Vu de 
l’extérieur, l’effet produit est celui d’un objet plein, mais, vue de l’intérieur, la face avant est
transparente. Normalement, pour un objet extrudé en 3D avec une texture unie, l’option 
Bilatéral doit être désactivée pour augmenter la vitesse d’affichage. Les objets de 
révolution offrent souvent une vue de l’intérieur et il est alors recommandé d’activer 
l’option Bilatéral (Figure 200).

Activée Désactivée

Figure 200 : Effets 3D : option Bilatéral

Effets 3D – Ombrage

Dans la page Ombrage de la boîte de dialogue Effets 3D (Figure 201), vous pouvez modifier les 
propriétés d’ombrage de la séquence 3D et les réglages de l’appareil photo.
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Figure 201 : La boîte de dialogue Effets 3D, page Ombrage

Ombrage
Permet de choisir dans la liste déroulante le mode d’ombrage de la séquence 3D (Figure 
202) :

– Plat : attribue une seule couleur d’ombrage à un espace délimité par les segments 
horizontaux et verticaux.

– Gouraud (mode par défaut) : interpole la normale à la surface de chaque sommet des 
polygones du modèle 3D spécifié ou trouvé en faisant la moyenne des normales à la 
surface des polygones qui se rencontrent à chaque sommet.

– Phong : calcule la normale en un point d’un polygone en interpolant les normales des 
sommets. L’angle entre cette normale et la direction de la lumière détermine la quantité de
lumière utilisée pour colorer le pixel. Cette méthode constitue une amélioration de la 
méthode de Gouraud, avec cependant un temps de calcul supérieur.

Gouraud               Phong                   Plat

Figure 202 : Exemple de modes d’ombrage

Ombre
Permet d’ajouter ou de supprimer un effet d’ombre à la séquence 3D (Figure 203).
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– L’icône Activer/désactiver l’ombrage 3D  permet d’activer ou de désactiver l’affichage
de l’ombre.

– L’Angle de surface permet de spécifier l’angle avec lequel l’ombre est affichée, entre 0 et 
90 degrés.

Angle de surface
0°                                         50°

Figure 203 : Exemples d’ombres

Caméra
Permet de définir la position et la focale de la caméra virtuelle permettant de visualiser 
l’objet. Plus la caméra est proche et plus la focale sera courte, plus l’effet de perspective 
sera accentué (Figure 204). Ces paramètres n’affectent que la perspective centrale, pas la 
projection parallèle.

– Distance : saisissez la distance entre la caméra virtuelle et le centre de la séquence 3D. 
La distance par défaut est de 2,6 cm.

– Focale : saisissez la longueur de focale de la lentille de la caméra virtuelle, une valeur 
faible correspondant à un grand-angle et une valeur forte correspondant à un téléobjectif. 
La focale par défaut est de 10 cm.

Distance : 2,6 cm
Focale : 10 cm

Distance : 10 cm
Focale : 100 cm

Figure 204 : Effets 3D : distance et longueur focale

Ces deux paramètres sont propres à l’objet (ou aux objets) sélectionné(s). Pour des raisons 
évidentes de cohérence, il vaut mieux que ces paramètres soient réglés de la même façon 
pour tous les objets appartenant à une même feuille.

Effets 3D – Éclairage

Dans la page Éclairage de la boîte de dialogue Effets 3D (Figure 205), vous pouvez définir la 
façon dont la séquence 3D sera éclairée. Vous pouvez spécifier la direction de la source de 
lumière, ainsi que sa couleur et celle de la lumière ambiante.
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Figure 205 : La boîte de dialogue Effets 3D, page Éclairage

Par défaut, une source de lumière blanche est active quand vous ouvrez la page éclairage. Pour 
modifier cette source de lumière :

 1) Assurez-vous que la source de lumière est active (l’icône représente une ampoule électrique
allumée).

 2) Appuyez sur la barre d’espace ou cliquez de nouveau sur la source sélectionnée pour en 
ajuster la couleur.

 3) Sélectionnez une couleur dans la palette déroulante. Vous pouvez également cliquer sur 
l’icône  pour ouvrir la boîte de dialogue Sélecteur de couleur, où vous pouvez choisir la 
couleur que vous désirez.

 4) Choisissez une couleur pour la Luminosité ambiante dans la palette déroulante associée ou 
en cliquant sur l’icône  pour ouvrir la boîte de dialogue Sélecteur de couleur.

 5) Dans l’aperçu, déplacez les ascenseurs horizontal et vertical pour déterminer la position de 
la source de lumière. Cette position est matérialisée par une petite boule de la couleur 
choisie. Vous pouvez également cliquer et déplacer cette boule de couleur.

Pour éteindre une source, sélectionnez-la puis cliquez une deuxième fois sur elle.

Si vous cliquez sur le carré dans le coin en bas à droite de l’aperçu, vous pouvez choisir d’afficher 
une sphère ou un cube dans cet aperçu.

Vous pouvez définir jusqu’à huit sources de lumière. Pour ceci, cliquez sur la source de lumière 
désirée pour la sélectionner. Cliquez une deuxième fois pour l’activer. Puis procédez comme ci-
dessus pour la régler. Chaque source de lumière se matérialise dans l’aperçu par une petite boule 
de couleur, celle de la source de lumière sélectionnée étant légèrement plus grosse que les autres 
(Figure 206).
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Figure 206 : Effets 3D : trois sources de lumière

Effets 3D – Textures

Figure 207 : La boîte de dialogue Effets 3D, page Textures
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Dans la page Textures de la boîte de dialogue Effets 3D (Figure 207), vous pouvez définir la 
texture de la séquence 3D. Ceci n’est possible que si le remplissage de la séquence 3D est de 
type Dégradé, Hachure ou Bitmap. Voir le chapitre 4, Modifier les attributs d’un objet, page 85.

Type
Permet de basculer le type de couleurs de la texture entre :

– Noir et blanc : convertit la texture en noir et blanc.

– Couleur : convertit la texture en couleurs.

Mode
Permet de basculer le mode de texture entre :

– Uniquement la texture : applique la texture sans ombrage.

– Texture et ombrage : applique la texture avec l’ombrage défini dans la page Ombrage, 
page 177.

– Texture, ombrage et couleur : applique la texture avec l’ombrage et la couleur. Pour définir
les options d’ombrage de la texture, voir « Effets 3D – Ombrage », page 177.

Projection X
Permet de choisir entre trois façons d’afficher la texture dans l’axe horizontal (Figure 208) :

– Spécifique à l’objet (par défaut) : ajuste automatiquement la texture pour qu’elle s’adapte 
le mieux possible à la forme et à la taille de la séquence 3D.

– Parallèle : applique la texture parallèlement à l’axe horizontal.

– Circulaire : applique la texture circulairement autour de l’axe horizontal.

Spécifique 
à l’objet

Parallèle Circulaire

Figure 208 : Effets 3D : projection X

Projection Y
Permet de choisir entre trois façons d’afficher la texture dans l’axe vertical :

– Spécifique à l’objet (par défaut) : ajuste automatiquement la texture pour qu’elle s’adapte 
le mieux possible à la forme et à la taille de la séquence 3D.

– Parallèle : applique la texture parallèlement à l’axe vertical.

– Circulaire : applique la texture circulairement autour de l’axe vertical.

Filtrage
L’icône Activer/désactiver le filtre permet d’activer ou de désactiver le filtre permettant 
d’enlever certaines petites taches non désirées lors de l’application de la texture.
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Effets 3D – Matériau

Dans la page Matériau de la boîte de dialogue Effets 3D (Figure 209), vous pouvez modifier 
l’apparence de la séquence 3D pour qu’elle soit semblable à celle d’objets de divers matériaux. 
Matériaux et textures peuvent être associés, ce qui demandera quelques essais pour obtenir le 
résultat souhaité.

Figure 209 : La boîte de dialogue Effets 3D, page Matériau

Matériau
Cette section vous permet d’affecter une couleur prédéfinie à partir d’une liste de couleurs ou
de créer votre propre couleur. Les couleurs personnalisées sont stockées dans la palette 
personnalisée (voir le chapitre 11, Techniques avancées, page 293, pour plus d’informations 
sur les couleurs).

– Favoris : permet de choisir dans la liste déroulante une couleur prédéfinie, ou la valeur 
Défini par l’utilisateur pour pouvoir déterminer les paramètres suivants à volonté. Ce choix
n’est possible que si le remplissage de l’objet est réglé sur Couleur ; dans ce cas, la 
Couleur de l’objet devient la couleur de remplissage.

– Couleur de l’objet : sélectionnez la couleur de la séquence 3D dans la liste déroulante, ou 
cliquez sur l’icône pour ouvrir la boîte de dialogue Sélecteur de couleur. Ce choix n’est 
possible que si le remplissage de l’objet est réglé sur Couleur ; dans ce cas, la Couleur 
de l’objet devient la couleur de remplissage.

– Couleur d’éclairage : sélectionnez dans la palette déroulante la couleur pour éclairer la 
séquence 3D et éclaircir les parties de l’objet qui se trouvent à l’ombre ; ou cliquez sur 
l’icône pour ouvrir la boîte de dialogue Sélecteur de couleur. L’objet paraîtra plus éclairé.
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Point brillant
Cette section définit les propriétés de réflexion de la lumière de l’objet sélectionné en 
simulant la capacité de réflexion de la surface. La position du point brillant est déterminée 
par le paramétrage de la première source de lumière.

– Couleur : sélectionnez la couleur du point d’illumination de la séquence 3D dans la liste 
déroulante, ou cliquez sur l’icône pour ouvrir la boîte de dialogue Sélecteur de couleur.

– Intensité : saisissez le pourcentage de l’intensité de la couleur du point brillant de la 
séquence 3D.

Icônes Boîtes de dialogue des couleurs 
Elles ouvrent la boîte de dialogue Choisir une couleur (Figure 210) où vous pouvez définir 
vos propres couleurs en utilisant le carré en haut à gauche, la gamme de teinte en haut au 
centre ou les champs numériques. Toutes les couleurs créées sont stockées dans la palette 
personnalisée. Voir le chapitre 11, Techniques avancées, page 293, pour plus d’informations 
sur les couleurs.

Figure 210 : La boîte de dialogue Choisir une couleur

Combiner des objets

Il n’est pas possible de combiner plusieurs objets 3D avec la commande Combiner (Forme > 
Combiner dans la barre de menu ou Ctrl+Maj+K). Il faut commencer par créer plusieurs objets 
2D puis créer un objet 3D unique de la façon suivante (voir le chapitre 5, Combiner plusieurs 
objets, page 121, pour plus d’informations sur la façon de combiner des objets) :

 1) Créez les objets 2D et apportez-leur toutes les modifications nécessaires.

 2) Assurez-vous que tous les objets 2D que vous souhaitez utiliser pour créer l’objet 3D sont 
sélectionnés.
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 3) Créez l’objet 3D qui combine tous les objets 2D grâce à une des méthodes suivantes (Figure
211) :

– cliquez sur l’icône En 3D  ou sur l’icône En corps de révolution 3D  de la barre 
d’outils Dessin ;

– sélectionnez Convertir > En 3D ou Convertir > En corps de révolution 3D dans le 
menu Forme ou dans le menu contextuel ouvert par un clic droit sur la sélection.

Plusieurs
formes 2D

Conversion
En 3D

Conversion
En corps de
révolution 3D

Figure 211 : Objets 3D créés à partir de plusieurs objets 2D

Assembler des objets 3D

Les objets 3D qui forment des séquences séparées peuvent être combinés en une séquence 3D 
unique comme ceci (voir le résultat sur la Figure 212) :

 1) Insérez un objet 3D (par exemple un cube) en utilisant la palette Objets 3D de la barre 
d’outils Dessin ou de l’onglet Formes du volet latéral.

 2) Insérez de la même manière un deuxième objet 3D (par exemple une sphère).

 3) Si nécessaire, réglez le remplissage sur Aucun(e) et le style de ligne sur Continue pour créer
une représentation en fil de fer des objets (voir Figure 212). Le positionnement des objets 
dans la séquence assemblée sera plus facile.

 4) Sélectionnez le deuxième objet et coupez-le dans le presse-papier (Couper dans le menu 
Édition ou dans le menu contextuel de l’objet).

 5) Entrez dans le groupe du premier objet en faisant un double-clic sur celui-ci ou en le 
sélectionnant puis en choisissant Forme > Grouper > Entrer dans le groupe dans la barre 
de menu.

 6) Collez le deuxième objet dans le groupe (Coller dans le menu Édition ou dans le menu 
contextuel du deuxième objet). La sphère apparaît maintenant à l’intérieur du cube et fait 
partie du même groupe que lui. Si vous le souhaitez, vous pouvez éditer les objets 
individuellement ou modifier leur position dans le groupe.

 7) Sortez du groupe en faisant un double-clic à l’extérieur du groupe ou en sélectionnant 
Forme > Grouper > Quitter le groupe dans la barre de menu.
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Remarque

Le deuxième objet réapparaîtra aussi à sa position originale quand vous effectuerez le 
collage. Cet objet ne fait pas partie de la séquence 3D assemblée et peut être supprimé si 
nécessaire.

Figure 212 : Assemblage d’objets 3D
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Chapitre 8
Connecteurs et 
organigrammes





Introduction

Les connecteurs et les points de collage ont été brièvement présentés dans le chapitre 2, Dessiner
des formes élémentaires, page 36. Nous allons les examiner ici plus en détail.

Les connecteurs sont des lignes ou des flèches dont les extrémités sont automatiquement 
attachées à un point de collage ou de connexion d’un objet. Ils sont utiles pour dessiner des 
organigrammes et des diagrammes de flux, entre autres. Les lignes de connexion entre objets 
demeurent, même si ces objets sont déplacés ou réarrangés. De même, si vous copiez un objet 
avec un connecteur, celui-ci sera également copié (il est nécessaire de sélectionner le connecteur 
avec l’objet avant la copie).

Connecteurs et points de collage

Connecteurs

Draw comprend une grande variété de connecteurs dans la barre d’outils Connecteurs pour vous 
aider à relier des objets dans un organigramme. Pour ouvrir cette barre d’outils, procédez d’une 
des façons suivantes :

• cliquez sur le petit triangle noir ▼ à droite de l’icône Connecteur de la barre d’outils Dessin 
(Figure 213). Le dessin de cette icône dépend du dernier outil connecteur utilisé.

Figure 213 : L’icône Connecteurs dans la barre d’outils Dessin

• sélectionnez un connecteur dans la section Par défaut > Connecteurs de l’onglet Formes 
du volet latéral (Figure 214).

Figure 214 : La section Connecteurs dans l’onglet Formes
du volet latéral

Vous pouvez détacher la palette qui s’ouvre grâce à l’icône de la barre d’outils Dessin pour 
l’afficher comme barre d’outils flottante :

 8) Cliquez sur le petit triangle à droite de l’icône Connecteurs ▼ de la barre d’outils Dessin.

 9) Cliquez sur le haut de la palette et tirez-la dans l’espace de travail.

 10) Relâchez le bouton de la souris et la palette devient une barre d’outils flottante (Figure 215).
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Avec flèche à la fin Direct avec flèche à la fin Incurvé avec flèche à la fin

Linéaire avec flèche à la fin Connecteur Connecteur direct

Connecteur incurvé Connecteur linéaire Connecteur avec flèches

Direct avec flèches Incurvé avec flèches Linéaire avec flèches

Avec flèche au début Direct avec flèche au début Incurvé avec flèche au début

Linéaire avec flèche au début Avec cercle à la fin Direct avec cercle à la fin

Incurvé avec cercle à la fin Linéaire avec cercle à la fin Avec cercle au début

Direct avec cercle au début Incurvé avec cercle au début Linéaire avec cercle au début

Avec cercles Direct avec cercles Incurvé avec cercles

Linéaire avec cercles

Figure 215 : La barre d’outils Connecteurs
Les boutons des six dernières lignes du tableau sont masqués par défaut

Types de connecteurs

L’ensemble des connecteurs prédéfinis est accessible en cliquant sur la petite flèche vers le bas 
de la barre d’outils Connecteurs et en choisissant Boutons visibles dans le menu déroulant. Les 
connecteurs visibles dans la barre d’outils sont indiqués par une marque ✓ devant leur nom ou un 
fond coloré.

Les connecteurs peuvent être regroupés en quatre familles :

• Les connecteurs standards sont matérialisés par une ligne dont les segments sont verticaux 
ou horizontaux et forment entre eux un angle de 90 degrés. Chaque segment ne faisant pas 
partie de l’extrémité du connecteur comporte un point de contrôle. Cliquez sur un point de 
collage d’un objet, tirez la souris jusqu’à un point de collage d’un autre objet et relâchez le 
bouton.

• Les connecteurs linéaires sont matérialisés par une ligne droite avec, à chacune de ses 
extrémités, un petit segment horizontal ou vertical. Chaque extrémité de cette ligne droite 
comporte un point de contrôle. Cliquez sur un point de collage d’un objet, tirez la souris 
jusqu’à un point de collage d’un autre objet et relâchez le bouton. Pour ajuster la longueur du
segment entre un point d’inflexion et un point de collage, cliquez sur le connecteur et tirez le 
point d’inflexion avec la souris.

• Les connecteurs directs sont matérialisés par une ligne droite. Cliquez sur un point de 
collage d’un objet, tirez la souris jusqu’à un point de collage d’un autre objet et relâchez le 
bouton.

• Les connecteurs incurvés sont matérialisés par une ligne courbe de Bézier. Les points de 
contrôle de cette courbe apparaissent. Cliquez sur un point de collage d’un objet, tirez la 
souris jusqu’à un point de collage d’un autre objet et relâchez le bouton.
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Ajouter des connecteurs

Lorsque vous sélectionnez un connecteur les points de collage des différentes formes de bases 
présentes dans le dessin apparaissent ; cela peut ne pas être le cas pour certaines formes, les 
rectangles notamment. Si vous déplacez alors le pointeur de la souris au-dessus d’un objet rempli 
ou au-dessus de la bordure d’un objet vide, les points de collage de cet objet apparaissent sous 
forme de petits carrés en pointillés. Un point de collage est un point fixe où vous pouvez attacher 
la ligne de votre connecteur. Vous pouvez ajouter des points de collage personnalisés : voir 
« Points de collage » page 193.

Un outil Connecteur est sélectionné Le pointeur survole le carré

Figure 216 : Les points de collage sont visibles quand un connecteur est sélectionné

Pour dessiner un connecteur, sélectionnez un type de connecteur, et cliquez sur le point de collage
de l’objet qui constituera son départ. Faites alors glisser le pointeur de la souris au-dessus du point
de collage de l’objet qui constituera l’arrivée, puis relâchez le bouton (Figure 217). Le dessin du 
connecteur se fait au cours de ce tracé, ce qui vous permet de mieux le contrôler.

Figure 217 : Connecteur entre deux objets

Il est possible de tracer un connecteur en cliquant n’importe où à l’intérieur de l’objet de départ et 
en faisant glisser le pointeur de la souris n’importe où au-dessus de l’objet de destination. Draw 
choisira alors les points de collage qui semblent les plus adaptés.

Vous pouvez également tracer un connecteur depuis ou jusqu’à un point du dessin qui n’est pas 
un point de collage d’un objet. Une extrémité d’un connecteur non attachée à un objet reste fixée à
l’endroit que vous avez choisi jusqu’à ce que vous le tiriez à un autre emplacement, et le 
déplacement des autres objets du dessin n’a aucune conséquence sur sa position. Attacher un 
objet à une extrémité d’un connecteur se fait toujours depuis le connecteur : rapprocher ou 
redimensionner l’objet afin qu’il « touche » l’extrémité ne provoquera pas le collage.

Modifier des connecteurs

Vous pouvez cliquer et faire glisser les points de contrôle aux extrémités d’un connecteur à 
l’endroit que vous voulez. Vous pouvez ainsi attacher ou détacher un connecteur d’un objet, 
l’attacher à un autre objet ou l’attacher à un autre point de collage d’un objet. Il est possible que 
Draw modifie l’attachement de l’autre extrémité du connecteur afin d’optimiser son tracé.
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Vous pouvez aussi cliquer et faire glisser les points de contrôles situés au milieu d’un connecteur. 
Cela peut être utile pour éviter d’autres objets se trouvant sur cette route. Sur la Figure 217, les 
points de contrôle du connecteur sont les petits carrés orange.

Vous pouvez modifier un connecteur en plaçant le pointeur de la souris au-dessus de lui, en 
faisant un clic droit et en choisissant Connecteur dans le menu contextuel. La boîte de dialogue 
Connecteur s’ouvre (Figure 218). Vous pouvez à cet endroit modifier les paramètres du connecteur
sélectionné. L’aperçu vous permet de visualiser les changements avant leur validation.

Figure 218 : La boîte de dialogue Connecteur

Type
Permet de choisir le type de connecteur : standard, linéaire, direct ou incurvé. Vous pouvez 
modifier le type d’un connecteur : Draw le redessinera comme dans l’aperçu.

Décalage de ligne
Permet de déplacer chaque point de contrôle du connecteur autres que ses extrémités. Ce 
déplacement peut être horizontal ou vertical, selon le point de contrôle et le dessin du 
connecteur.

Interligne
Permet d’indiquer un espace minimal horizontal et vertical à respecter, s’appliquant au début 
et à la fin du connecteur. Draw applique ces paramètres dans la mesure où le dessin du 
connecteur le permet.

– Début horizontal : saisissez l’espace horizontal souhaité au début du connecteur.

– Fin horizontale : saisissez l’espace horizontal souhaité à la fin du connecteur.

– Début vertical : saisissez l’espace vertical souhaité au début du connecteur.

– Fin verticale : saisissez l’espace vertical souhaité à la fin du connecteur.
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Remarque

Vous ne pouvez pas intervertir les points de départ et d’arrivée d’un connecteur en utilisant 
cette boîte de dialogue. Pour ce faire, vous devez tracer un nouveau connecteur.

Vous pouvez agrandir l’image dans la fenêtre d’aperçu par un clic gauche et la réduire par un clic 
droit.

Vous pouvez modifier les attributs de la ligne du connecteur en le sélectionnant et en cliquant sur 
l’icône Ligne ( ) de la barre d’outils Ligne et remplissage, en choisissant Ligne dans le menu 
Format ou le menu contextuel après un clic droit sur le connecteur.

Points de collage

Il ne faut pas confondre les points de collage et les poignées de sélection d’un objet, bien que 
parfois ils soient situés au même endroit. Les poignées de sélection servent à modifier la forme 
d’un objet : voir le chapitre 3, Manipuler les objets et les points des objets, page 43. Les points de 
collage servent à attacher un connecteur à un objet afin que, lorsque l’objet se déplace, le 
connecteur reste fixé à l’objet et soit redessiné en conséquence.

Tous les objets ont des points de collage, qui normalement ne sont pas visibles et qui 
n’apparaissent que lorsque les icônes Connecteur de la barre d’outils Dessin ou Points de 
collage ( ) de la barre d’outils Standard sont sélectionnées. Les points de collage de certaines 
formes de base (des rectangles notamment) peuvent ne pas s’afficher sous forme de croix : ils ne 
sont alors visibles que lors du tracé d’un connecteur.

La manipulation des points de collage se fait au moyen de la barre d’outils Points de collage 
(Figure 219), qui apparaît lorsque vous cliquez sur l’icône Afficher les fonctions pour les points 
de collage ( ) de la barre d’outils Standard ou de la barre d’outils Dessin si vous avez rendu 
l’icône visible, ou lorsque vous choisissez Affichage > Barres d’outils > Points de collage ou 
Édition > Points de collage dans la barre de menu.

Insérer un point de collage Sortie vers la gauche Sortie vers le haut

Sortie vers la droite Sortie vers le bas Point de collage relatif

Point de collage horizontal 
à gauche

Point de collage horizontal 
au centre

Point de collage horizontal 
à droite

Point de collage vertical en 
haut

Point de collage vertical au 
centre

Point de collage vertical en 
bas

Figure 219 : La barre d’outils Points de collage

Par défaut, seuls les six premiers outils sont actifs (voir « Personnaliser des points de collage » 
page 196).
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Remarque

L’icône Afficher les fonctions pour les points de collage ( ) n’est pas visible par défaut 
dans la barre d’outils Dessin. Pour l’y ajouter, faites un clic droit sur un emplacement vide de
la barre d’outils et sélectionnez Boutons visibles > Points de collage dans le menu 
contextuel.

Types de points de collage

À l’ouverture de la barre d’outils Points de collage, seuls les six outils de gauche sont actifs. Les 
six outils de droite ne le deviennent qu’au moment où l’icône Point de collage relatif ( ) est 
désélectionnée.

Voici une brève description des fonctions de chaque outil de la barre d’outils Points de collage 
(Figure 219).

Insérer un point de collage 
insère un point de collage où vous cliquez dans un objet.

Sortie vers la gauche 
le connecteur se fixe sur le bord gauche du point de collage sélectionné.

Sortie vers le haut 
le connecteur se fixe sur le bord supérieur du point de collage sélectionné.

Sortie vers la droite 
le connecteur se fixe sur le bord droit du point de collage sélectionné.

Sortie vers le bas 
le connecteur se fixe sur le bord inférieur du point de collage sélectionné.

Point de collage relatif 
maintient la position relative du point de collage sélectionné quand vous modifiez les 
dimensions d’un objet. Cette fonction est sélectionnée par défaut à l’ouverture de la barre 
d’outils Points de collage.

Les six outils suivants ne sont actifs que si l’outil Point de collage relatif est désactivé.

Point de collage horizontal à gauche 
quand les dimensions de l’objet sont modifiées, le point de collage courant reste fixe par 
rapport au côté gauche de l’objet.

Point de collage horizontal au centre 
quand les dimensions de l’objet sont modifiées, le point de collage courant reste fixe par 
rapport au centre horizontal de l’objet.

Point de collage horizontal à droite 
quand les dimensions de l’objet sont modifiées, le point de collage courant reste par rapport 
au côté droit de l’objet.

Point de collage vertical en haut 
quand les dimensions de l’objet sont modifiées, le point de collage courant reste fixe par 
rapport au bord supérieur de l’objet.
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Point de collage vertical au centre 
quand les dimensions de l’objet sont modifiées, le point de collage courant reste fixe par 
rapport au centre vertical de l’objet.

Point de collage vertical à gauche 
quand les dimensions de l’objet sont modifiées, le point de collage courant reste fixe par 
rapport au bord inférieur de l’objet.

Remarque

Les points de collage que vous avez ajoutés ne peuvent avoir qu’une position horizontale et 
une position verticale. Un seul outil de position horizontale et un seul outil de position 
verticale peut être sélectionné et utilisé à la fois.

Ajouter des points de collage

La plupart des objets ont par défaut quatre points de collage. Pour ajouter des points de collage 
supplémentaires :

 1) Assurez-vous qu’aucun objet n’est sélectionné et utilisez une des méthodes suivantes pour 
ouvrir la barre d’outils Points de collage :

– cliquez sur l’icône Afficher les fonctions pour les points de collage ( ) de la barre 
d’outils Standard ou de la barre d’outils Dessin,

– choisissez Édition > Points de collage dans la barre de menu.

Si la barre d’outils Points de collage n’apparaît pas, sélectionnez Affichage > Barre d’outils
> Points de collage.

 2) Sélectionnez l’objet auquel vous voulez ajouter un point de collage et cliquez sur l’icône 
Insérer un point de collage .

Déplacez le pointeur de la souris à l’endroit de l’objet où vous voulez ajouter le point de 
collage et cliquez.

 3) Pour déplacer un point de collage à un autre endroit de l’objet, cliquez sur ce point de 
collage et tirez-le à son nouvel emplacement. L’amplitude du déplacement s’affiche dans la 
barre d’état au fur et à mesure (Figure 220).

Figure 220 : Déplacement d’un point de collage
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Conseil

Quand vous ajoutez, déplacez ou personnalisez des points de collage, il est recommandé 
d’utiliser la fonction zoom pour faciliter votre travail. Voir le chapitre 3, Manipuler les objets 
et les points des objets, page 44, pour plus d’informations. De plus, les points de collage 
sont attirés par la grille ce qui permet de les positionner plus facilement.

Personnaliser des points de collage

Seuls les points de collage que vous avez ajoutés peuvent être personnalisés : les points de 
collage par défaut ne peuvent l’être.

Vous pouvez déterminer les sorties possibles d’un point de collage ajouté de la façon suivante :

 1) Assurez-vous qu’aucun objet n’est sélectionné et utilisez une des méthodes suivantes pour 
ouvrir la barre d’outils Points de collage :

– cliquez sur l’icône Afficher les fonctions pour les points de collage ( ) de la barre 
d’outils Standard ou de la barre d’outils Dessin,

– choisissez Édition > Points de collage dans la barre de menu.

 2) Si la barre d’outils Points de collage n’apparaît pas, sélectionnez Affichage > Barre d’outils
> Points de collage.

 3) Faites un double-clic sur un point de collage que vous avez ajouté pour le sélectionner.

 4) Choisissez la direction de la sortie que vous voulez utiliser pour le connecteur que vous allez
relier au point de collage en sélectionnant une ou plusieurs icônes Sortie vers… dans la 
barre d’outils Points de collage (Figure 219, page 193) ou, après un clic droit, dans le menu 
contextuel. Par défaut, les quatre directions de sortie sont possibles.

L’option Point de collage relatif est active par défaut. Elle permet de maintenir la position relative 
du point de collage lorsque l’objet est redimensionné. Vous pouvez également accéder à cette 
option en sélectionnant le point de collage, en faisant un clic droit et en choisissant Point de 
collage relatif dans le menu contextuel.

Pour personnaliser la position horizontale et verticale d’un point de collage ajouté, procédez 
comme ceci :

 1) Assurez-vous qu’aucun objet n’est sélectionné et utilisez une des méthodes suivantes pour 
ouvrir la barre d’outils Points de collage :

– cliquez sur l’icône Afficher les fonctions pour les points de collage ( ) de la barre 
d’outils Standard ou de la barre d’outils Dessin,

– choisissez Édition > Points de collage dans la barre de menu.

 2) Si la barre d’outils Points de collage n’apparaît pas, sélectionnez Affichage > Barre d’outils
> Points de collage.

 3) Faites un double-clic sur un point de collage que vous avez ajouté pour le sélectionner.

 4) Cliquez sur l’icône Point de collage relatif ( ) dans la barre d’outils Points de collage 
(Figure 219, page 193) pour désactiver la fonction, ou désélectionnez-la dans le menu 
contextuel ouvert par un clic droit sur le point de collage.
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 5) Sélectionnez les outils de positionnement horizontal et vertical que vous voulez utiliser pour 
le point de collage. Chaque point de collage ne peut avoir qu’une option de positionnement 
horizontal et qu’une option de positionnement vertical à un moment donné.

Supprimer des points de collage

Seuls les points de collage que vous avez ajoutés peuvent être supprimés : les points de collage 
par défaut ne peuvent l’être.

Pour supprimer un point de collage, sélectionnez un point de collage que vous avez ajouté et que 
vous voulez supprimer, faites un clic droit et choisissez Couper dans le menu contextuel, 
choisissez Édition > Couper dans la barre de menu ou appuyez sur la touche Suppr.

Textes des connecteurs

Des textes peuvent facilement être associés à des connecteurs, puis formatés et édités, afin, par 
exemple, de rendre vos organigrammes plus faciles à comprendre. Ils présentent alors l’avantage 
de s’adapter aux objets associés au connecteur lorsque ceux-ci sont déplacés ou redimensionnés.
Voir le chapitre 2, Dessiner des formes élémentaires, page 36, et le chapitre 9, Ajouter et formater 
des textes, page 210, pour plus d’informations sur la gestion des textes.

Ajouter un texte aux connecteurs

 6) Sélectionnez le connecteur et les points de contrôle deviennent actifs.

 7) Cliquez sur l’icône Zone de texte ( ) (ou Texte vertical ( ) si elle est active) dans la 
barre d’outils Standard (ou Dessin). Un curseur clignotant apparaît près du connecteur et la 
barre d’outils Formatage du texte apparaît (Figure 221).

Figure 221 : La barre d’outils Formatage du texte

 8) Vous pouvez utiliser la barre d’outils Formatage du texte ou les commandes des menus 
Format > Texte pour définir le format par défaut du texte.

 9) Saisissez votre texte et, lorsque vous avez terminé, cliquez à l’extérieur de son cadre pour 
mettre fin à l’édition. Cela referme aussi la barre d’outils Formatage du texte.

Formater le texte des connecteurs

 10) Sélectionnez le connecteur et les points de contrôle deviennent actifs.

 1) Cliquez sur l’icône Zone de texte ( ) (ou Texte vertical ( ) si elle est active) dans la barre 
d’outils Standard (ou Dessin). Un curseur clignotant apparaît près du connecteur et la barre 
d’outils Formatage du texte apparaît (Figure 221).

 2) Vous pouvez utiliser la barre d’outils Formatage du texte ou les commandes des menus 
Format > Texte pour définir le format par défaut du texte.
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 3) Vous pouvez ouvrir la boîte de dialogue Texte en sélectionnant Texte dans le menu Format 
ou dans le menu contextuel ouvert par un clic droit sur le texte du connecteur. Vous pourrez 
y modifier la façon dont le texte est associé au connecteur.

– Texte d’objet de dessin : cette section vous permet d’adapter le texte au rectangle de 
sélection du connecteur (cadre) ou de lui faire suivre le contour du connecteur.

– Espacement avec les bordures : vous pouvez saisir ici la largeur des marges autour du 
texte à l’intérieur du rectangle de sélection du connecteur.

– Ancre de texte : indiquez ici la position du texte à l’intérieur du rectangle de sélection du 
connecteur.

Figure 222 : L’onglet Texte de la boîte de dialogue Texte

 4) Si nécessaire, cliquez sur l’onglet Animation de texte (Figure 223) où vous pourrez 
paramétrer cette animation. Ce n’est cependant pas recommandé, sauf si vous avez 
l’intention d’afficher le dessin dans une présentation. Voyez le Guide Impress pour plus 
d’informations sur l’animation du texte.

Figure 223 : L’onglet Animation de texte de la boîte de dialogue Texte
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 5) Quand vous avez terminé l’édition du texte, déplacez le pointeur de la souris hors du texte et
du connecteur et cliquez. Le mode d’édition de texte prend fin et la barre d’outils Formatage 
du texte se referme.

Diagrammes de flux

Draw propose une barre d’outils Diagramme de flux (Figure 224) qui comprend un grand nombre 
de formes de base vous permettant de dessiner des diagrammes de flux. Pour ouvrir la barre 
d’outils Diagramme de flux  :

 1) Cliquez sur ▼ à droite de l’icône Organigramme (  à l’ouverture de Draw) dans la barre 
d’outils Dessin pour ouvrir la palette Diagramme de flux. Notez que cette icône est celle du 
dernier outil utilisé dans la palette.

Cliquez en haut de la palette et tirez-la dans l’espace de travail. Quand vous relâchez le 
bouton de la souris, la palette devient la barre d’outils Diagramme de flux.

Procédé Procédé alternatif Décision

Données Procédé défini Stockage interne

Document Multidocument Terminaison

Préparation Entrée manuelle Opération manuelle

Connecteur Connecteur hors page Carte

Bande perforée Jonction de sommaire Ou

Joindre Trier Extraire

Fusionner Données stockées Délai

Accès séquentiel Disque magnétique Stockage à accès direct

Affichage

Figure 224 : La barre d’outils Diagramme de flux

Pour créer un diagramme de flux, il est recommandé de respecter les étapes suivantes :

Pour ajouter des objets à votre diagramme, voyez le chapitre 2, Dessiner des formes 
élémentaires, page 23, où vous trouverez des informations sur la façon de tracer et de 
modifier les dimensions des formes.

 2) Ajoutez un texte à chaque forme du diagramme pour qu’elle soit facile à identifier. Voyez le 
chapitre 2, Dessiner des formes élémentaires, page 23, et le chapitre 11, Techniques 
avancées, page 259, pour plus d’informations.

 3) Utilisez des lignes de connexions dans votre diagramme. Cela vous permet de repositionner 
un objet tout en maintenant la liaison avec les autres objets du diagramme. Voyez 
« Connecteurs et points de collage », page 189 pour plus d’informations.
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 4) Utilisez le zoom, la grille et les fonctions de capture pour vous aider à positionner les objets 
de votre diagramme. Voyez le chapitre 3, Manipuler les objets et les points des objets, pages
44 et 56, pour plus d’informations.

 5) Utilisez les fonctions d’alignement et de distribution pour donner un aspect plus 
professionnel à votre diagramme. Voyez le chapitre 5, Combiner plusieurs objets, page 129, 
pour plus d’informations.

 6) Dupliquez les objets quand vous en avez besoin de plusieurs de la même forme et de la 
même taille. Voyez le chapitre 5, Combiner plusieurs objets, page 125, pour plus 
d’informations.

Organigrammes

Draw ne dispose pas de barre d’outils dédiée aux organigrammes organisationnels, mais ceux-ci 
peuvent facilement être dessinés avec les formes de base et les connecteurs prédéfinis. Les 
couleurs et la transparence peuvent faciliter leur lecture, en indiquant la hiérarchie dans 
l’organisation. Quand vous utilisez des couleurs dans un organigramme, assurez-vous que votre 
choix offre un contraste suffisant entre le texte et les couleurs pour que votre diagramme soit facile
à lire sur l’écran d’un ordinateur comme sur un document imprimé.

Direction

Informatique Production Ventes

Usine de 
Lyon

Usine de 
Toulouse

LogicielsInfrastructure Europe Amériques Asie

Figure 225 : Exemple d’organigramme

Un exemple d’organigramme organisationnel est présenté sur la Figure 225. Il a été construit avec 
la forme Organigramme : procédé de la barre d’outils Dessin et des lignes de connexions.

Les recommandations sont les mêmes que celles pour les diagrammes de flux.
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Guide Draw
6.4

Chapitre 9
Ajouter et formater des textes





Introduction

Lorsque des textes sont utilisés dans des documents Draw, ils sont placés dans un objet ou un 
cadre de texte. Ce chapitre décrit comment créer, formater, utiliser et supprimer des textes. Il traite 
également des différents types de texte qui peuvent être insérés dans des dessins. Enfin, il indique
comment insérer certaines formes de texte particulières, comme des listes numérotées ou à puce, 
des tableaux, des champs, des hyperliens et des objets de Fontwork.

Le texte

Le mode texte

Avant de pouvoir saisir un texte dans un dessin, il faut activer le mode texte. Cliquez sur l’icône 
Insérer une zone de texte ( ) pour un texte horizontal ou Insérer un texte vertical ( ) pour un
texte vertical dans la barre d’outils Standard (Figure 226) ou la barre d’outils Dessin (Figure 227). 
La barre d’outils Formatage du texte (Figure 228) s’ouvre automatiquement à la place de la barre 
d’outils Ligne et remplissage.

Figure 226 : Les outils de texte dans la barre d’outils Standard

Figure 227 : Les outils de texte dans la barre d’outils Dessin

Figure 228 : La barre d’outils Formatage du texte

Si l’icône Insérer un texte vertical n’est pas visible dans la barre d’outils Standard ou Dessin, vous 
pouvez l’activer de la manière suivante :

 7) Sélectionnez Outils > Options dans la barre de menu et ouvrez la page Paramètres 
linguistiques – Langues de la boîte de dialogue Options.

 8) Dans la section Langue par défaut des documents, cochez l’option Asiatique et choisissez
Par défaut – Chinois (simplifié) dans la liste déroulante.

 9) Cliquez sur Appliquer puis sur OK pour refermer la boîte de dialogue et enregistrer vos 
modifications.

 10) Redémarrez LibreOffice pour activer le texte vertical.

Ajouter du texte

Quand vous ajoutez du texte à un dessin, un cadre de texte est automatiquement créé pour le 
contenir. Par défaut, ce cadre s’élargit horizontalement pour s’adapter à une ligne de texte unique. 
Pour changer le réglage par défaut, il faut formater le cadre de texte, voir « Formater les cadres 
de texte », page 209 pour plus d’informations.

Quand vous ajoutez du texte à un dessin, un cadre de texte est automatiquement créé pour 
contenir celui-ci. Par défaut, le cadre de texte s’allonge horizontalement pour s’adapter à une ligne 
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de texte unique. Pour modifier ce comportement par défaut, il faut formater le cadre de texte, 
voyez « Formater les cadres de texte », page 209, pour plus d’informations.

 1) Activez le mode texte, voir « Le mode texte » ci-dessus pour plus d’informations.

 2) Cliquez dans votre dessin à l’emplacement approximatif où vous voulez placer le texte. Un 
cadre de texte qui contient un curseur clignotant est créé.

 3) Commencez à saisir votre texte. Le cadre de texte s’allonge automatiquement à mesure que 
vous tapez pour contenir votre ligne de texte. De plus, le deuxième champ à gauche de la 
barre d’état indique que vous êtes en mode d’édition de texte ainsi que la position de votre 
curseur (Figure 229).

Figure 229 : Informations sur le texte dans la barre d’état

 4) Pour créer plusieurs lignes dans le cadre de texte, utilisez l’une des méthodes suivantes :

– Appuyez sur la touche Entrée pour créer un nouveau paragraphe d’une seule ligne à 
l’intérieur du cadre de texte dont la hauteur augmente pour s’adapter à la ligne 
supplémentaire.

– Créez un cadre de texte avant de saisir le texte, voir « Créer des cadres de texte » ci-
dessous. Quand vous atteignez la limite horizontale du cadre, le texte est 
automatiquement renvoyé à la ligne suivante et la hauteur du cadre augmente pour 
l’accueillir.

 5) Quand vous avez saisi tout le texte, cliquez hors du cadre de texte pour quitter le mode 
texte. La barre d’outils Formatage du texte se ferme et est remplacée par la barre d’outils 
Ligne et remplissage.

 6) Pour formater ou déplacer ce cadre de texte, voyez « Manipuler les cadres de texte » ci-
dessous et le chapitre 3, Manipuler les objets et les points des objets, page 44, pour plus 
d’informations.

 7) Si nécessaire, mettez le texte en forme : sélectionnez-le et utilisez les divers outils de la 
barre d’outils Formatage du texte (Figure 228) ou des sections Caractère et Paragraphe de 
l’onglet Propriétés du volet latéral (Figure 230). Pour plus d’informations sur la mise en forme
du texte, voir « Formater du texte », page 214.
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Figure 230 : Les sections Caractère et Paragraphe
de l’onglet Propriétés du volet latéral

Créer des cadres de texte

Il est recommandé de créer un cadre de texte avant de saisir le texte dans votre dessin. Cela vous 
donne l’occasion de placer, par exemple, une légende pour une forme, une note explicative, un 
titre … semblable à ceux qui sont utilisés dans les dessins techniques.

 1) Activez le mode texte : voir « Le mode texte », page 203.

 2) Cliquez et faites glisser la souris, sans relâcher le bouton, pour dessiner un cadre de texte 
dans le document et en définir la largeur. La hauteur augmentera au fur et à mesure de la 
saisie du texte.

 3) Relâchez le bouton de la souris quand le cadre a la largeur souhaitée. Le curseur de texte 
apparaît à l’intérieur et le cadre est matérialisé par une bordure qui dépend de votre système
d’exploitation et qui indique que vous êtes en mode édition de texte (Figure 229).

 4) Saisissez ou collez le texte dans le cadre. La barre d’état indique que vous êtes en mode 
Édition texte et la position du curseur dans le cadre (paragraphe, ligne, colonne), voir Figure 
229.

 5) Cliquez hors du cadre pour le désélectionner et quitter le mode texte. La barre d’outils 
Formatage du texte se ferme et est remplacée par la barre d’outils Ligne et remplissage.

 6) Si nécessaire, mettez le texte en forme : sélectionnez-le et utilisez les divers outils de la 
barre d’outils Formatage du texte (Figure 228) ou des sections Caractère et Paragraphe de 
l’onglet Propriétés du volet latéral (Figure 230). Pour plus d’informations sur la mise en forme
du texte, voir « À qui s’adresse ce livre ? », page 1.
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Remarque

Les cadres de texte utilisent un moteur d’édition simplifié et ne sont conçus que pour 
contenir du texte. Ils ne peuvent pas recevoir d’illustrations, d’images en ligne, de formules, 
de tableaux ni de formes.

Manipuler les cadres de texte

Vous pouvez formater, déplacer, faire pivoter un cadre de texte et en modifier la taille exactement 
comme n’importe quel objet de votre dessin. Pour plus d’informations, voir le chapitre 3, Manipuler
les objets et les points des objets, page 41.

Déplacer un cadre de texte

 1) Cliquez sur le texte dans le cadre pour passer en mode d’édition et faire apparaître la 
bordure épaisse correspondant à ce mode.

 2) Placez le pointeur de la souris au-dessus de la bordure. Il prend la forme du pointeur de 
déplacement de votre ordinateur (par exemple une flèche à quatre branches).

Vous pouvez aussi cliquer juste à côté du cadre de texte (gauche, droite, haut, bas) où le 
pointeur de la souris est un pointeur de déplacement.

Le cadre de texte est sélectionné : les poignées de sélection apparaissent sur la bordure 
épaisse.

 3) Cliquez au-dessus de la bordure (mais pas sur une poignée de sélection) et faites glisser le 
cadre de texte jusqu’à sa nouvelle position. Une copie transparente du cadre vous permet de
voir à quel endroit vous allez le déplacer (Figure 231). Vous pouvez voir l’amplitude du 
déplacement dans la barre d’état.

Figure 231 : Déplacer un cadre de texte

 4) Relâchez le bouton de la souris quand le cadre de texte est dans la position voulue.

 5) Pour positionner un cadre de texte avec précision, utilisez la boîte de dialogue Position et 
taille ou la section Position et taille de l’onglet Propriétés du volet latéral. Voir le chapitre 3, 
Manipuler les objets et les points des objets, page 48, pour plus d’informations sur cette 
boîte de dialogue et cette section du volet latéral.
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Redimensionner un cadre de texte

 1) Cliquez sur le texte dans le cadre pour passer en mode d’édition et faire apparaître la 
bordure épaisse correspondant à ce mode.

 2) Placez le pointeur de la souris au-dessus de la bordure. Il prend la forme du pointeur de 
déplacement de votre ordinateur (par exemple une flèche à quatre branches).

Vous pouvez aussi cliquer juste à côté du cadre de texte (gauche, droite, haut, bas) où le 
pointeur de la souris est un pointeur de déplacement.

Le cadre de texte est sélectionné : les poignées de sélection apparaissent sur la bordure 
épaisse.

 3) Déplacez le pointeur de la souris au-dessus d’une poignée de sélection. Il change de forme 
et devient le symbole de redimensionnement d’objet qui dépend de votre ordinateur (par 
exemple une flèche à deux extrémités).

 4) Cliquez et faites glisser la poignée de sélection pour redimensionner le cadre de texte. Une 
copie transparente du cadre vous permet de voir son nouvel aspect (Figure 232).

Figure 232 : Modifier les dimensions d’un cadre de texte.

 5) Relâchez le bouton de la souris quand le cadre atteint la taille voulue.

 6) Pour donner une dimension précise à un cadre de texte, utilisez la boîte de dialogue Position
et taille ou la section Position et taille de l’onglet Propriétés du volet latéral. Voir le chapitre 
3, Manipuler les objets et les points des objets, page 49, pour plus d’informations sur cette 
boîte de dialogue et cette section du volet latéral.

Pour conserver les proportions d’un cadre de texte lors de son redimensionnement, maintenez la 
touche Maj enfoncée avant de cliquer-glisser. Prenez soin de relâcher le bouton de la souris avant
la touche Maj.

Remarque

Par défaut, vous ne pouvez réduire la hauteur d’un cadre de texte en dessous de la hauteur 
minimale pour que le texte entier apparaisse. Pour cette raison, il est possible que, si vous 
réduisez la largeur du cadre, sa hauteur augmente. Voir l’option Adapter la hauteur au texte 
de la boîte de dialogue Position et taille.
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Faire pivoter un cadre de texte

 1) Cliquez sur le texte dans le cadre pour passer en mode d’édition et faire apparaître la
bordure épaisse correspondant à ce mode.

 2) Placez le pointeur de la souris au-dessus de la bordure. Il prend la forme du pointeur de 
déplacement de votre ordinateur (par exemple une flèche à quatre branches).

Vous pouvez aussi cliquer juste à côté du cadre de texte (gauche, droite, haut, bas) où le 
pointeur de la souris est un pointeur de déplacement.

Le cadre de texte est sélectionné : les poignées de sélection apparaissent sur la bordure 
épaisse.

 3) Cliquez de nouveau sur la bordure du cadre, cliquez sur l’icône Pivoter ( ) dans la barre 
d’outils Transformations ou sélectionnez Forme > Transformations > Pivoter dans la barre 
de menu. Les poignées de sélection changent de forme et de couleur.

 4) Cliquez sur une des poignées de coin et faites-la glisser pour faire tourner le cadre de texte. 
Une copie transparente du cadre vous permet de voir sa nouvelle orientation et l’angle de 
rotation est affiché dans la barre d’état (Figure 233).

Figure 233 : Faire pivoter un cadre de texte

 5) Relâchez le bouton de la souris quand le cadre atteint l’orientation voulue.

 6) Pour faire tourner un cadre de texte avec précision, utilisez l’onglet Rotation de la boîte de 
dialogue Position et taille ou la section Position et taille de l’onglet Propriétés du volet 
latéral. Voir le chapitre 3, Manipuler les objets et les points des objets, page 51, pour plus 
d’informations sur cette boîte de dialogue et cette section du volet latéral.
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Remarque

En mode rotation, les poignées des milieux des côtés, bien que visibles, ne peuvent pas être
utilisées. De plus, les cadres de texte ne peuvent être ni déformés, ni inclinés, ni retournés 
verticalement ou horizontalement.

Formater les cadres de texte

Les cadres de texte peuvent être formatés comme les autres formes de base de votre dessin 
quand il s’agit d’en définir le remplissage et la bordure (ligne). Voir le chapitre 3, Manipuler les 
objets et les points des objets, page 44, pour plus d’informations sur le formatage des cadres de 
texte.

Pour définir la façon dont le texte se présente dans un cadre de texte, procédez comme ceci :

 1) Sélectionnez le cadre de texte et utilisez une des méthodes suivantes pour ouvrir la boîte de 
dialogue Texte :

– faites un clic droit sur le cadre de texte et choisissez Texte… dans le menu contextuel ;

– sélectionnez Format > Texte… dans la barre de menu.

Remarque

Faites bien attention de sélectionner l’entrée Texte… dans le menu Format et pas l’entrée 
Texte ► car celle-ci ouvre un sous-menu qui vous permet de formater le texte et non le 
cadre de texte lui-même.

 2) Dans l’onglet Texte (Figure 234), choisissez les options voulues dans les sections Texte 
d’objet de dessin et Espacement avec les bordures.

Figure 234 : La boîte de dialogue Texte

 3) Dans l’onglet Animation de texte (Figure 235), choisissez les options voulues dans les 
sections Effet et Propriétés. Cela est, toutefois, déconseillé sauf si votre dessin est conçu 
pour être affiché dans une présentation. Voyez le Guide Impress pour plus d’informations sur
l’animation du texte.
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Figure 235 : L’onglet Animation de texte de la boîte de dialogue Texte

 4) Cliquez sur OK pour enregistrer les options choisies et refermer la boîte de dialogue.

Supprimer un cadre de texte

Pour supprimer un cadre de texte, sélectionnez-le, puis appuyez sur la touche Suppr.

Associer des textes à des objets Draw

Il est possible d’associer un texte à la plupart des objets Draw. Les exceptions sont les éléments 
de contrôle, comme les boutons ou les listes déroulantes, les polygones, les courbes et les 
séquences 3D.

Par défaut, un objet n’est pas dynamique quand il est créé et ne se comporte pas comme un cadre
de texte. Le renvoi à la ligne n’est pas automatique et pour conserver un texte à l’intérieur des 
bordures d’un objet, vous devrez créer des paragraphes (touche Entrée), des sauts de ligne 
(touches Maj+Entrée), réduire la taille de la police ou agrandir l’objet, ou combiner ces quatre 
possibilités.

Pour associer un texte à un objet avec un renvoi à la ligne automatique à l’intérieur de celui-ci :

 1) Créez un objet dans votre dessin et assurez-vous qu’il est sélectionné et que les poignées 
de sélection sont visibles.

 2) Cliquez sur l’icône Insérer une zone de texte ( ) pour un texte horizontal ou Insérer un 
texte vertical ( ) pour un texte vertical dans la barre d’outils Standard (Figure 226, page
203) ou la barre d’outils Dessin (Figure 227, page 203). Un curseur de texte se met à 
clignoter au centre de l’objet et la barre d’outils Formatage du texte (Figure 228, page 203) 
s’ouvre automatiquement à la place de la barre d’outils Ligne et remplissage. Vous pouvez 
alors saisir votre texte.

Vous pouvez également faire un double-clic sur l’objet pour faire apparaître le curseur de 
texte au centre et entrer automatiquement en mode d’édition de texte horizontal.

Dans ce cas, pour passer en texte vertical, cliquez sur l’icône Insérer un texte vertical ( ) 
pour un texte vertical dans la barre d’outils Standard ou la barre d’outils Dessin.
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 3) Commencez à saisir votre texte. S’il dépasse les bordures de l’objet, utilisez les paragraphes
(Entrée), les changements de ligne (Maj+Entrée), la réduction de la taille de la police ou 
l’agrandissement de l’objet, ou une combinaison de ces quatre possibilités.

LibreOffice Draw Version 6.4

LibreOffice 
Draw 

Version 
6.4

Par défaut, sans
renvoi à la ligne

Avec renvoi à la
ligne dans la forme

Figure 236 : Exemple de renvoi à la ligne dans un objet

Pour être certain que votre texte reste à l’intérieur de la bordure de l’objet (Figure 236), vous 
pouvez aussi procéder de la manière suivante :

 a) Faites un clic droit sur le texte à l’intérieur de l’objet et choisissez Texte… dans le menu 
contextuel pour ouvrir la boîte de dialogue Texte (Figure 237)

Figure 237 : La boîte de dialogue Texte, avec l’option
Renvoyer le texte à la ligne dans la forme sélectionnée

 b) Ouvrez l’onglet Texte.

 c) Dans la section Texte de forme personnalisée, cochez l’option Renvoyer le texte à la 
ligne dans la forme.

 d) Cliquez sur OK pour refermer la boîte de dialogue et enregistrer votre choix.

 e) Finissez de saisir le texte, cliquez hors de l’objet pour quitter le mode texte et enregistrer 
vos modifications. Le texte est ajusté au mieux à l’intérieur de l’objet par des retours 
automatiques à la ligne comme sur la droite de la Figure 236.
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 4) Pour formater le texte à l’intérieur de l’objet, voir « À qui s’adresse ce livre ? », page 1.

Remarque

Si le double-clic n’active pas le mode d’édition de texte, sélectionnez Affichage > Barres 
d’outils > Options dans la barre de menu pour ouvrir la barre d’outils Options et cliquez sur
l’icône Double-clic pour éditer du texte ( ) ou appuyez sur la touche F2.

Insérer du texte

Coller du texte

Un texte peut être inséré dans un cadre de texte ou dans un objet en le copiant depuis un autre 
document et en le collant dans le cadre ou l’objet de votre dessin.

Quand vous collez le texte 

• avec l’icône Coller ( ) de la barre d’outils Standard,

• l’entrée Coller du menu Édition ou du menu contextuel ouvert par un clic droit

• par l’appui sur la combinaison Ctrl+V,

Le texte est inséré avec son formatage d’origine qui peut ne pas correspondre au format des 
textes déjà inclus dans votre dessin. Cela peut parfois être ce que vous désirez, mais, le plus 
souvent, il vaut mieux assurer l’homogénéité du formatage du texte dans tout le dessin.

Remarque

Si vous collez du texte directement dans un dessin, et non dans un objet ou un cadre, il est 
inséré en tant qu’objet OLE et non d’objet Draw. Il est recommandé de coller le texte dans 
Draw sous forme de texte non formaté pour créer un objet texte de Draw.

Coller du texte non formaté

C’est une bonne habitude de coller le texte sans formatage puis d’appliquer celui-ci après en 
cohérence avec le texte déjà inséré dans votre dessin.

Pour coller un texte avec le format par défaut du paragraphe de destination,

 1) Copier le texte dans son document d’origine puis activez la fenêtre de votre dessin.

 2) Collez le texte que vous venez de copier par une des méthodes suivantes :

– cliquez sur le petit triangle à droite de l’icône Coller de la barre d’outils Standard et 
choisissez Texte non formaté dans la liste,

– sélectionnez Édition > Collage spécial > Coller le texte non formaté dans la barre de 
menu

– sélectionnez Édition > Collage spécial > Collage spécial dans la barre de menu ou 
appuyez sur les touches Ctrl+Maj+V et choisissez Texte non formaté dans la boîte de 
dialogue Collage spécial qui s’ouvre (Figure 238).
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Figure 238 : la boîte de dialogue Collage spécial

 3) Un cadre contenant le texte avec le style de formatage par défaut est collé dans le dessin, 
au milieu de l’espace de travail.

Coller du texte PDF

Le texte provenant d’un document PDF est collé dans un cadre de texte au centre de l’espace de 
travail ou à l’intérieur d’un objet si le mode texte est activé (curseur clignotant dans l’objet)

 1) Sélectionnez le texte que vous voulez coller dans le fichier PDF et copiez-le dans le Presse-
papier.

 2) Activez la fenêtre de votre dessin et collez le texte par l’une des méthodes suivantes. Il peut 
conserver (selon le lecteur de fichier PDF utilisé) une partie de son formatage.

– Cliquez sur l’icône Coller ( ) de la barre d’outils Standard.

– Sélectionnez Édition > Coller dans la barre de menu.

– Appuyez sur les touches Ctrl+V.

– Faites un clic droit dans le dessin et choisissez Coller dans le menu contextuel.

Éventuellement, voyez « Coller du texte non formaté » ci-dessus si vous désirez coller le 
texte non formaté dans votre dessin.

Formater le texte collé

 1) Sélectionnez le texte que vous venez de coller (voir « Sélectionner du texte » ci-dessous 
pour plus d’informations). La barre d’outils Formatage du texte (Figure 226, page 203) 
s’ouvre automatiquement à la place de la barre d’outils Ligne et remplissage.

 2) Utilisez les outils de formatage disponibles dans

– la barre d’outils Formatage du texte,

– les sections Caractère et Paragraphe de l’onglet Propriétés du volet latéral,

– le menu Format.

 3) Vous pouvez utiliser un des choix possibles dans l’onglet Styles du volet latéral. Voir 
« Utiliser les styles de dessin », page 220, pour plus d’informations.
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Insérer des caractères spéciaux, espaces insécables et tirets

Pour toute information sur l’insertion de caractères spéciaux, d’espaces insécables et de tirets 
dans un dessin, voyez le Guide du débutant et le Guide Writer.

Formater du texte

L’utilisation judicieuse du formatage peut donner aux textes de votre dessin un aspect plus 
homogène et professionnel, sans éléments de différenciation pouvant distraire l’attention. Le 
formatage du texte peut demander d’intervenir sur les attributs des caractères (par exemple, la 
couleur de police), des paragraphes (par exemple, l’alignement) ou des listes (par exemple, le type
de puces).

Sélectionner du texte

Avant tout formatage d’un texte, celui-ci doit être sélectionné dans le cadre ou l’objet qui le 
contient :

 1) Assurez-vous que le cadre ou l’objet contenant le texte que vous voulez sélectionner est lui-
même sélectionné.

 2) Cliquez à l’intérieur du texte pour positionner le curseur.

 3) Sélectionnez le texte à formater grâce l’une des méthodes suivantes :

– appuyez sur Ctrl+A pour sélectionner tout le texte ;

– cliquez et tirez le pointeur de la souris sur le texte à sélectionner ;

– appuyez sur Maj et les touches de direction pour étendre votre sélection caractère par 
caractère (droite et gauche) ou ligne par ligne (haut et bas) ;

– appuyez sur Maj+Ctrl et les touches de direction droite et gauche pour étendre votre 
sélection mot par mot ;

– appuyez sur Maj+Début pour étendre votre sélection jusqu’au début de la ligne ;

– appuyez sur Maj+Fin pour étendre votre sélection jusqu’à la fin de la ligne.

 4) Effectuez alors le formatage.

Formatage direct du texte

Dans LibreOffice Draw, le formatage effectué sur le texte est normalement un formatage direct. 
Cependant, dans les situations où vous devez réaliser le même formatage sur plusieurs 
paragraphes de texte, l’utilisation des styles de paragraphe est recommandée.

Conseil

Il est parfois très utile de réappliquer le format par défaut du texte sélectionné et ainsi de 
supprimer tout formatage manuel effectué, particulièrement si vous avez fait une erreur et 
n’êtes pas sûr de la façon de l’annuler. Pour revenir au style par défaut, sélectionnez la 
portion de texte concernée et sélectionnez Effacer le formatage direct dans le menu 
Format ou dans le menu contextuel ouvert par un clic droit sur le texte sélectionné, ou 
appuyez sur Ctrl+M.
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Formatage direct des caractères

Les caractères d’un texte peuvent être formatés indépendamment du formatage utilisé pour le 
paragraphe. Ce formatage vient écraser le formatage du paragraphe appliqué directement ou par 
un style de paragraphe. Notez qu’il n’existe pas de style de caractère dans Draw. Tout formatage 
de caractère doit être appliqué directement.

Remarque

Si un cadre de texte ou un objet est sélectionné, mais pas le texte qu’il contient, tout 
formatage de caractère s’appliquera à l’ensemble de ce texte.

 1) Cliquez dans le texte où vous voulez formater des caractères. La barre d’outils Formatage 
du texte (Figure 226, page 203) s’ouvre automatiquement à la place de la barre d’outils 
Ligne et remplissage.

 2) Sélectionnez les caractères que vous souhaitez formater. Voir « Sélectionner du texte » ci-
dessus pour plus d’informations sur la façon de procéder.

 3) Utilisez une des méthodes suivantes pour ouvrir la boîte de dialogue Caractère (Figure 239 
et Figure 240) : sélectionnez Format > Caractère dans la barre de menu ou faites un clic 
droit sur les caractères sélectionnés et choisissez Caractère dans le menu contextuel.

Figure 239 : La boîte de dialogue Caractère quand
les polices de texte asiatique et de scripts complexes sont activées
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Figure 240 : La boîte de dialogue Caractère quand
les polices de texte asiatique et de scripts complexes ne sont pas activées.

 4) Effectuez les modifications désirées dans le formatage des caractères en utilisant les options
disponibles dans les onglets de la boîte de dialogue Caractère.

 5) Cliquez sur OK pour enregistrer ces modifications et refermer la boîte de dialogue.

Au lieu de la boîte de dialogue Caractères, vous pouvez utiliser les outils proposés par la barre 
d’outils Formatage du texte (Figure 226, page 203), par la section Caractère de l’onglet Propriétés 
du volet latéral ou par le menu Format > Texte.

Pour annuler les changements que vous avez apportés au formatage des caractères, cliquez sur 
le bouton Réinitialiser dans la boîte de dialogue Caractère (avant d’appuyer sur OK) ou 
sélectionnez Format > Effacer le formatage direct dans la barre de menu (après avoir refermé la
boîte de dialogue) pour que les caractères reprennent le formatage appliqué au paragraphe.

Options de la boîte de dialogue Caractère

Les onglets de la boîte de dialogue Caractère proposent les options suivantes :

Police
Vous pouvez y choisir le type de police, ses attributs de base (Italique, Gras, Langue, etc.) 
ainsi que sa taille. Un exemple de la police est affiché en bas de la boîte de dialogue. Cet 
onglet est aussi disponible pour créer ou modifier un style de dessin.

Si le support des langues asiatiques et de la mise en page de texte complexe a été activé 
(Outils > Options, page Paramètres linguistiques – Langues), la page Police offre trois 
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sections pour les polices de texte occidental, asiatique et les scripts complexes où vous 
pouvez spécifier les polices et leurs attributs pour la majorité des familles de polices.

Effets de caractère
Vous pouvez appliquer ici des effets spéciaux au texte (sections Couleur de la police, 
Décoration du texte et Effets). Un exemple de texte est affiché en bas de la boîte de 
dialogue pour vous permettre de juger rapidement de l’effet appliqué. Cet onglet est aussi 
disponible pour créer ou modifier un style de dessin.

Position
Choisissez ici le type de position, d’échelle et d’espacement appliqué aux caractères. Cet 
onglet n’est pas disponible pour créer ou modifier un style de dessin.

– Position vous permet de définir la position des caractères par rapport à la ligne de base 
quand vous insérez des exposants ou des indices.

– Échelle de largeur définit le pourcentage de la largeur de la police par lequel les 
caractères sélectionnés seront comprimés ou étirés.

– Espacement des caractères définit l’espace entre les caractères en nombre de points.

– Paire de crénage : cochez cette option pour ajuster automatiquement l’espace entre 
certaines paires de caractères et améliorer leur apparence visuelle.

Surlignage7

Définissez ici une couleur de fond propre aux caractères sélectionnés (comme si on avait 
utilisé un surligneur).

Formatage direct des paragraphes

Chaque paragraphe du texte peut être formaté indépendamment. Ce formatage vient écraser celui
du style d’image utilisé.

 1) Cliquez dans le texte où vous voulez formater des caractères. La barre d’outils Formatage 
du texte (Figure 226, page 203) s’ouvre automatiquement à la place de la barre d’outils 
Ligne et remplissage.

 2) Sélectionnez les paragraphes que vous souhaitez formater. Voir « Sélectionner du texte » 
page 214 pour plus d’informations sur la façon de procéder.

 3) Utilisez une des méthodes suivantes pour ouvrir la boîte de dialogue Paragraphe (Figure 
241) :

– sélectionnez Format > Paragraphe dans la barre de menu ;

– faites un clic droit sur le texte sélectionné et choisissez Paragraphe dans le menu 
contextuel ;

– cliquez sur l’icône Paragraphe dans la barre d’outils Formatage du texte.

 4) Effectuez les modifications désirées dans le formatage des paragraphes en utilisant les 
options disponibles dans les onglets de la boîte de dialogue Paragraphe.

 5) Cliquez sur OK pour enregistrer ces modifications et refermer la boîte de dialogue.

7 Ne pas confondre cette option avec l’option Surlignage de la section Décoration du texte dans l’onglet Effets de 
caractère qui concerne un trait dessiné au-dessus des caractères.
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Figure 241 : L’onglet Retraits et espacement de la boîte de dialogue Paragraphe

Au lieu de la boîte de dialogue Paragraphe, vous pouvez utiliser les outils proposés par la barre 
d’outils Formatage du texte (Figure 226, page 203), par la section Caractère de l’onglet Propriétés 
du volet latéral ou par les menus Format > Espacement et Format > Aligner.

Pour annuler les changements que vous avez apportés au formatage des caractères, cliquez sur 
le bouton Réinitialiser dans la boîte de dialogue Paragraphe (avant d’appuyer sur OK) ou 
sélectionnez Format > Effacer le formatage direct dans la barre de menu (après avoir refermé la
boîte de dialogue) pour que les paragraphes reprennent le formatage appliqué précédemment.

Options de la boîte de dialogue Paragraphe

Les onglets de la boîte de dialogue Paragraphe proposent les options suivantes :

Retraits et espacement
Cet onglet (Figure 241) détermine les retraits et espacements appliqués aux paragraphes 
sélectionnés :

– Retrait : définissez ici les retraits avant et après le texte ainsi que le retrait particulier de la
première ligne du paragraphe.

– Espacement : indiquez ici l’espace au-dessus et en dessous des paragraphes 
sélectionnés.

– Interligne : ce choix détermine l’espace entre deux lignes d’un même paragraphe. Si vous 
choisissez Proportionnel, vous devez préciser l’interligne en pourcentage de la hauteur de
la ligne elle-même : 100 % pour une ligne, 200 % pour deux lignes, 50 % pour la moitié de
la ligne. Si vous choisissez Fixe, indiquez la valeur de l’interligne dans l’unité de mesure 
par défaut.
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Remarque

Vous pouvez changer l’unité de mesure par défaut en sélectionnant Outils > Options dans 
la barre de menu puis en ouvrant la page LibreOffice Draw – Général dans la boîte de 
dialogue Options.

Typographie asiatique
Vous pouvez définir ici certains paramètres reliés à la typographie des langues asiatiques. 
Cet onglet n’apparaît que si l’option Asiatique est cochée dans la page Paramètres 
linguistiques – Langues de la boîte de dialogue Options (Outils > Options).

Figure 242 : L’onglet Typographie asiatique de la boîte de dialogue Paragraphe

Tabulation
Définissez ici la position, le type et le caractère de remplissage des arrêts de tabulation. Cet 
onglet est aussi disponible pour créer ou modifier un style de dessin.

Figure 243 : L’onglet Tabulations de la boîte de dialogue Paragraphe.

Alignement
Cet onglet (Figure 244) détermine l’alignement du paragraphe. Une zone d’aperçu (à droite) 
montre l’effet des modifications effectuées. L’alignement d’un paragraphe peut aussi être 
défini grâce aux icônes ( , ,  et ) de la barre d’outils Formatage du texte et de la 
section Paragraphe de l’onglet Propriétés du volet latéral.

– Options  : choisissez l’alignement du paragraphe.

– Texte-à-texte : définissez l’alignement vertical du texte quand il y a un mélange de tailles 
de police sur la même ligne de texte. Vous avez le choix entre Automatique, Ligne de 
base, Haut, Milieu et Bas.

– Propriétés : sélectionnez la direction du texte. De-gauche-à-droite et De-droite-à-gauche 
ne sont disponibles que si l’option Mise en page de texte complexe a été sélectionnée 
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dans la page Paramètres linguistiques – Langues de la boîte de dialogue Options (Outils 
> Options).

Figure 244 : L’onglet Alignement de la boîte de dialogue Paragraphe

Utiliser les styles de dessin

Appliquer les mêmes options de formatage à des objets ou des textes de Draw est un processus 
répétitif qui peut être grandement simplifié par l’utilisation de styles. Les styles de dessin dans 
Draw vous permettent de définir un modèle de formatage (un style) puis de l’appliquer à plusieurs 
objets graphiques ou textuels.

Pour plus d’informations sur les paramètres purement graphiques des styles de dessin, comme le 
remplissage et les lignes, voir le chapitre 4, Modifier les attributs d’un objet, page 73. Pour plus 
d’informations sur les styles de texte, voir le Guide Writer.

Figure 245 : L’onglet Gestionnaire de la boîte de dialogue Styles pour objets graphiques

Draw offre plusieurs styles prêts à l’emploi avec des objets ou des textes. Ces styles prédéfinis ne 
peuvent être ni supprimés ni renommés, mais on peut les modifier grâce aux options de la boîte de
dialogue Styles pour objets graphiques (Figure 245).
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Styles liés

Dans Draw, un style peut hériter des paramètres de formatage d’un autre style auquel il est lié. 
Cette propriété permet de créer des familles de styles hiérarchisés. La Figure 246 montre un 
exemple de hiérarchies de styles liés utilisés dans Draw.

Figure 246 : L’onglet Styles dans le volet latéral

Par exemple, si vous avez plusieurs cadres de texte qui ne diffèrent que par la taille de la police, 
mais qui ont, par ailleurs, un formatage identique, il est recommandé de créer un style de base 
pour le type et le style de police et les autres paramètres de formatage. Créez ensuite tous les 
styles nécessaires qui en dépendent hiérarchiquement et ne diffèrent que par la taille de la police. 
S’il devient nécessaire de modifier le style de la police, il suffira de le faire dans le style parent pour
modifier en conséquence tous les styles qui lui sont liés.

Remarque

Quand des styles sont liés, modifier un attribut de la police dans le style parent changera 
celui-ci chez tous ses descendants. C’est parfois exactement ce que vous souhaitez, parfois
non. Il vaut la peine d’y réfléchir avant.
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Créer de nouveaux styles

Quand un nouveau style est créé, il est placé dans les listes Tous les styles et Styles 
personnalisés de l’onglet Styles du volet latéral (en bas de la Figure 246). Quand il aura été 
appliqué à un objet ou à un texte, il apparaîtra aussi dans la liste Styles appliqués.

 1) Apportez toutes les modifications souhaitées au texte sélectionné puis

– faites un clic droit sur le nom d’un style dans le volet latéral et sélectionnez Nouveau 
dans le menu contextuel, pour ouvrir la boîte de dialogue Styles pour objets graphiques 
(Figure 245, page 220),

– cliquez sur l’icône Nouveau style à partir de la sélection dans le volet latéral (encadrée 
sur la Figure 246), et saisissez un nom unique pour le nouveau style dans la boîte de 
dialogue Nom du style qui s’ouvre et cliquez sur OK pour la refermer et enregistrer vos 
modifications.

 2) Si vous utilisez la boîte de dialogue Styles pour objets graphiques, procédez comme ceci :

 a) Ouvrez l’onglet Gestionnaire (Figure 245, page 220).

 b) Saisissez un nom unique pour votre style dans le champ Nom.

 c) Si vous ne souhaitez pas lier le nouveau style à un autre, sélectionnez – Aucun(e) – dans 
le champ Hérité de, sinon sélectionnez le nom du style parent dans la liste déroulante.

 d) Cliquez sur OK pour enregistrer vos modifications et refermer la boîte de dialogue.

Modifier ou éditer les styles

Il est recommandé de modifier seulement les styles que vous avez créés.

 1) Sélectionnez un texte ou un objet contenant du texte dans votre dessin. La barre d’outils 
Formatage du texte (Figure 226, page 203) s’ouvre automatiquement à la place de la barre 
d’outils Ligne et remplissage.

 2) Ouvrez la boîte de dialogue Styles pour objets graphiques (Figure 245, page 220) grâce à 
une des méthodes suivantes :

– sélectionnez Format > Styles > Éditer le style dans la barre de menu,

– faites un clic droit sur l’objet et sélectionnez Éditer le style dans le menu contextuel,

– faites un clic droit sur le style de l’objet dans l’onglet Styles du volet latéral et sélectionnez
Modifier dans le menu contextuel.

 3) Utilisez les options des divers onglets de la boîte de dialogue Styles pour objets graphiques 
pour modifier le style de la manière suivante :

– l’onglet Gestionnaire affiche le nom du style, le nom de celui dont il a hérité le formatage, 
sa catégorie et les paramètres de son formatage ;

– les onglets Police, Effets de caractère, Retraits et espacement, Alignement et Tabulations 
définissent les propriétés du texte inséré dans un cadre ou un objet graphique ;

– l’onglet Cotation permet de paramétrer le style des lignes de cote ;

– les onglets Texte, Animation de texte, Connecteur, Ligne, Remplissage, Ombrage, Mise 
en évidence et Transparence déterminent le formatage de l’objet.
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 4) Cliquez sur OK quand vous avez terminé pour enregistrer vos modifications et refermer la 
boîte de dialogue Styles pour objets graphiques.

Vous pouvez aussi sélectionner votre texte et lui appliquer toutes les modifications de formatage 
puis procéder de la manière suivante :

 1) Sélectionner un style dans l’onglet Styles du volet latéral (Figure 246, page 221).

 2) Cliquez sur l’icône Actualiser le style ( ) en haut du volet latéral pour enregistrer le style 
avec les nouveaux attributs de formatage.

Éditer des styles liés

Si un objet de votre document utilise des styles liés, il est possible d’éditer les styles liés qui lui ont 
été appliqués en utilisant la boîte de dialogue Styles pour objets graphiques de la façon suivante :

 1) Sélectionnez un texte ou un objet contenant du texte dans votre dessin qui utilise les styles 
liés. La barre d’outils Formatage du texte (Figure 226, page 203) s’ouvre automatiquement à 
la place de la barre d’outils Ligne et remplissage.

 2) Ouvrez la boîte de dialogue Styles pour objets graphiques (Figure 245, page 220) grâce à 
une des méthodes suivantes :

– sélectionnez Format > Styles > Éditer le style dans la barre de menu,

– faites un clic droit sur l’objet et sélectionnez Éditer le style dans le menu contextuel,

– faites un clic droit sur le style de l’objet dans l’onglet Styles du volet latéral et sélectionnez
Modifier dans le menu contextuel.

 3) Ouvrez l’onglet Gestionnaire (Figure 245, page 220).

 4) Cliquez sur le bouton Éditer le style à droite du champ Hérité de jusqu’à ce que le nom du 
style dans le titre de la boîte de dialogue Style pour objets graphiques soit celui que vous 
voulez modifier.

Utilisez alors les divers onglets de la boîte de dialogue Styles pour objets graphiques pour 
modifier ce style.

 5) Cliquez sur OK quand vous avez terminé pour enregistrer vos modifications et refermer la 
boîte de dialogue Styles pour objets graphiques.

Appliquer des styles

Vous pouvez appliquer un style au texte dans un cadre de texte ou un objet de la façon suivante :

 1) Sélectionnez le texte auquel vous voulez appliquer un style. La barre d’outils Formatage du 
texte (Figure 226, page 203) s’ouvre automatiquement à la place de la barre d’outils Ligne et
remplissage.

 2) Ouvrez l’onglet Styles du volet latéral en cliquant sur son icône .

 3) Faites un double-clic sur le nom du style désiré dans l’onglet Styles (Figure 246, page 221) 
pour appliquer le style à l’objet sélectionné.
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Conseil

Une liste de déroulante située en bas de l’onglet Styles du volet latéral vous permet de 
limiter les styles affichés. Choisissez d’afficher Tous les styles, les Styles personnalisés ou 
les Styles appliqués selon vos besoins.

Supprimer des styles

Vous ne pouvez pas supprimer les styles prédéfinis de LibreOffice, même si vous ne les utilisez 
pas. Vous ne pouvez supprimer que les styles que vous (ou un autre utilisateur) a définis. 
Cependant, avant de supprimer un style créé par vous, assurez-vous qu’il n’est pas en cours 
d’utilisation. Pour cela, choisissez Styles appliqués dans la liste déroulante en bas de l’onglet 
Styles du volet latéral.

Il n’est pas possible de supprimer les styles prédéfinis dans LibreOffice, même si vous ne les 
utilisez pas. Vous ne pouvez supprimer que les styles que vous (ou un autre utilisateur) avez 
définis. Avant de supprimer un style personnalisé, assurez-vous cependant qu’il n’est pas utilisé. 
Pour voir les styles utilisés, choisissez Styles appliqués dans la liste déroulante

Supprimez un style personnalisé comme ceci :

 1) Ouvrez l’onglet Styles du volet latéral en cliquant sur son icône  (Figure 246, page 221).

 2) Choisissez Styles personnalisés ou Styles appliqués dans la liste déroulante en bas de 
l’onglet Styles du volet latéral pour afficher les styles utilisés.

 3) Faites un clic droit sur le nom d’un style dans la liste et sélectionnez Effacer dans le menu 
contextuel.

 4) Si le style est utilisé, un message d’avertissement apparaît. Cliquez sur Oui pour supprimer 
le style. Si le style n’est pas utilisé, la suppression est immédiate sans message 
d’avertissement.

Créer des listes à puces et numérotées

Les listes à puces et numérotées peuvent être créées dans des cadres de textes, les formes et 
dans des objets. Cependant, si vous créez une liste dans un objet, gardez à l’esprit que cet objet 
n’est pas dynamique et ne va pas s’étendre au fur et à mesure de la création de la liste.

Remarque

La création de listes à puces ou numérotées dans Draw se fait de la même façon que dans 
LibreOffice Writer, mais leurs fonctionnalités dans Draw sont réduites.

Créer des listes

Vous pouvez créer des listes à puces ou numérotées dans les cadres de texte ou les objets de 
Draw de la façon suivante :

 1) Cliquez dans le texte où vous voulez créer une liste. La barre d’outils Formatage du texte 
(Figure 226, page 203) s’ouvre automatiquement à la place de la barre d’outils Ligne et 
remplissage.
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 2) Sélectionnez tout le texte que vous voulez utiliser dans la liste à puces ou numérotée.

 3) Pour créer une liste avec les paramètres par défaut, utilisez une des méthodes suivantes :

– cliquez sur l’icône (Dés)activer les puces ( ) ou (Dés)activer la numérotation ( ) 
dans la barre Formatage du texte ou dans la section Listes de l’onglet Propriétés du volet
latéral ;

– sélectionnez Format > Listes > Liste à puces ou Liste numérotée dans la barre de 
menu.

 4) Pour changer le format de la liste en la créant, cliquez sur le petit triangle à droite de l’icône 
et sélectionnez un style parmi les choix offerts par la palette qui s’ouvre alors (Figure 247 et
Figure 248).

Figure 247 : La palette Styles de listes à puces Figure 248 : La palette Styles de listes
numérotées

Ajuster le niveau des entrées d’une liste

Pour ajuster le niveau d’une entrée dans une liste à puces ou numérotée, procédez de la façon 
suivante :

 1) Cliquez au début de l’entrée de la liste. Le curseur doit clignoter au début du paragraphe 
pour pouvoir abaisser ou hausser le niveau de l’élément dans la liste.

 2) Pour abaisser le niveau de l’élément dans la liste, appuyez sur la touche Tabulation. 
Chaque appui va abaisser l’élément d’un niveau supplémentaire.

 3) Pour hausser le niveau de l’élément dans la liste, appuyez sur la combinaison de touches 
Maj+Tabulation. Chaque appui va hausser l’élément d’un niveau supplémentaire.

Éditer et personnaliser une liste

Vous pouvez modifier et personnaliser l’apparence d’une liste en changeant le type de puce ou de 
numérotation de l’ensemble de la liste ou d’une seule entrée ou le niveau de plan d’un élément de 
la liste. Toutes les modifications se font grâce à la boîte de dialogue Puces et numérotation.

 1) Sélectionnez les entrées de la liste que vous souhaitez modifier. La barre d’outils Formatage 
du texte (Figure 226, page 203) s’ouvre automatiquement à la place de la barre d’outils 
Ligne et remplissage.
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 2) Pour ouvrir la boîte de dialogue Puces et numérotation (Figure 249), sélectionnez Puces et 
numérotation soit dans le menu Format, soit dans le menu contextuel ouvert par un clic 
droit sur le texte sélectionné.

 3) Choisissez le niveau que vous souhaitez modifier.

 4) Apportez les changements voulus aux différentes options pour formater le style de chaque 
niveau de la liste. La zone Aperçu vous montre l’aspect de la liste en fonction de vos choix.

 5) Pour annuler les modifications que vous avez faites, cliquez sur Reset (Réinitialiser) pour 
redonner à la liste le formatage qu’elle avait à l’ouverture de la boîte de dialogue.

 6) Quand vous êtes satisfait de vos choix, cliquez sur OK pour enregistrer les changements et 
refermer la boîte de dialogue.

Figure 249 : La boîte de dialogue Puces et numérotation

Options de la boîte de dialogue Puces et numérotation

Les options de la boîte de dialogue Puces et numérotation (Figure 249) sont les suivantes :

Niveau
Choisissez le niveau de plan des entrées dans la liste située à gauche de la boîte de 
dialogue. Chaque niveau peut recevoir un type de liste différent. Le choix 1 – 10 permet de 
modifier simultanément tous les niveaux de la liste.

Propriétés
Définissez ici l’apparence des entrées dans la liste.

– Type : choisissez le type de marqueur de liste utilisé (Aucun, Puce, Images ou différents 
types de numérotation).

– Couleur : sélectionnez la couleur du marqueur de liste pour qu’il ressorte face au texte de 
l’entrée.
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– Commencer à : saisissez la valeur du marqueur de la première entrée de la liste (par 
exemple pour commencer une liste au point 4 au lieu de 1).

Séparateur
Pour les listes numérotées, vous pouvez définir les caractères qui s’afficheront avant et 
après le numéro de l’entrée dans la liste.

– Avant : saisissez le texte que vous voulez faire apparaître avant le numéro (par exemple, 
Étape).

– Après : saisissez le texte que vous voulez faire apparaître après le numéro (par exemple, 
une parenthèse fermante suivie d’un espace).

Taille
Spécifiez ici la taille du marqueur de liste en pourcentage de la taille des caractères dans le 
paragraphe. Elle peut être plus grande ou plus petite que la taille du texte. Si vous utilisez 
une image comme puce, vous pouvez saisir ses dimensions. L’option Conserver le ratio lie la
largeur et la hauteur de l’image pour en maintenir les proportions : saisissez l’une et l’autre 
est automatiquement calculée.

Position
Cette section vous permet de définir le retrait du paragraphe et l’espacement entre le 
marqueur et le texte de l’entrée de la liste.

– Indentation : saisissez le retrait du marqueur de liste par rapport à la bordure gauche du 
cadre de texte ou de l’objet.

– Largeur : saisissez la distance entre le marqueur de liste et le texte de l’entrée. Cela crée 
visuellement un retrait négatif du marqueur par rapport au texte classique pour les listes à
puces ou numérotées.

– Relatif : si vous cochez cette option, le retrait de l’entrée de la liste est mesuré par rapport
aux réglages du niveau parent quand des styles liés sont utilisés.

– Alignement : sélectionnez l’alignement (gauche, centré ou droite) du marqueur de liste à 
l’intérieur de la zone définie par Largeur. Un alignement à droite vous permet de 
conserver un alignement correct pour des numéros de listes constitués de deux ou 
plusieurs chiffres.

Portée
– Diapo : les modifications sont appliquées à tous les éléments de votre dessin.

– Sélection : les modifications ne sont appliquées qu’aux éléments sélectionnés de votre 
dessin.

– Appliquer à la diapo maîtresse : les modifications sont appliquées à tous les éléments de 
la page maîtresse de votre dessin, si vous en avez créé une.

Utiliser des tableaux

Les tableaux sont utiles lorsque vous voulez faire figurer des informations structurées dans votre 
dessin, comme une liste de spécifications par exemple. Vous pouvez créer des tableaux 
directement dans Draw, sans avoir besoin d’incorporer une feuille de calcul Calc ou un tableau 
Writer. Les tableaux élaborés avec Draw ont cependant des fonctionnalités limitées.
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Créer un tableau

Pour travailler avec des tableaux, il est utile de connaître le nombre de leurs lignes et de leurs 
colonnes ainsi que leur apparence. Dans un dessin, les tableaux sont placés au centre du dessin, 
à l’intérieur d’un cadre de tableau : ils ne peuvent être placés dans un objet ou une forme. De plus,
contrairement aux cadres de texte et autres objets, il n’est pas possible de les faire pivoter.

 1) Sélectionnez Insertion > Tableau dans la barre de menu pour ouvrir la boîte de dialogue 
Insérer un tableau (Figure 250).

 2) Choisissez le nombre de lignes et de colonnes de votre tableau.

 3) Cliquez sur OK pour créer un tableau qui sera placé au centre de l’espace de travail, dans 
son cadre.

Figure 250 : La boîte de dialogue
Insérer un tableau

Figure 251 : La palette Tableau

Vous pouvez aussi cliquer sur l’icône Tableau (non visible par défaut) dans la barre d’outils 
Standard pour ouvrir la palette Tableau (Figure 251). Cliquez et tirez le pointeur de la souris pour 
sélectionner les nombres de lignes et de colonnes. Quand vous relâchez le bouton de la souris, le 
tableau apparaît au centre de l’espace de travail et la palette se referme. Le bouton Plus 
d’options ouvre la boîte de dialogue Insérer un tableau.

La barre d’outils Tableau

Lorsqu’un tableau est sélectionné, la barre d’outils Tableau (Figure 252) est alors active et offre 
l’essentiel des outils nécessaires à l’édition des tableaux. Elle apparaît généralement par défaut. 
Dans le cas contraire, vous pouvez l’afficher en utilisant Affichage > Barre d’outils > Tableau. 
Vous pouvez également utiliser les outils du menu contextuel.

Normalement, la barre d’outils Tableau est ancrée en haut ou en bas de l’espace de travail. Pour la
transformer en barre d’outils flottante :

• si elle est ancrée en position horizontale, cliquez sur l’extrémité gauche de la barre d’outils et
tirez-la sur l’espace de travail ;

• si elle est ancrée en position verticale, cliquez sur l’extrémité supérieure de la barre d’outils 
et tirez-la sur l’espace de travail.
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Tableau Style de bordure Couleur de bordure

Bordure (Maj pour écraser) Style/couleur de remplissage Fusionner les cellules

Scinder les cellules Optimiser Aligner en haut

Centrer verticalement Aligner en bas Insérer une ligne au-dessus

Insérer une ligne au-dessous Insérer une colonne avant Insérer une colonne après

Supprimer la ligne Supprimer la colonne Sélectionner le tableau

Sélectionner la colonne Sélectionner la ligne Ébauche de tableau

Propriétés du tableau

Figure 252 : La barre d’outils Tableau

Modifier un tableau

Une fois le tableau inséré dans votre dessin, vous pouvez contrôler son apparence, sa taille, sa 
position, etc. en utilisant un ensemble d’outils disponibles dans Draw.

Tableau 
Si vous cliquez sur cette icône, une grille apparaît (Figure 251). Faites glisser le pointeur de 
la souris dans cette grille en appuyant sur le bouton pour choisir la dimension du tableau et 
relâchez le bouton pour créer le tableau. Le bouton Plus d’options ouvre la boîte de 
dialogue Insérer un tableau.

Style de bordure 
Permet de choisir le style de ligne des bordures parmi des styles prédéfinis. Ce
style s’applique aux bordures du tableau ou des cellules sélectionnées. Cliquez
sur l’icône ou le petit triangle à sa droite pour ouvrir une liste déroulante où vous
pourrez choisir parmi les styles prédéfinis.

Couleur de bordure 
Permet de choisir la couleur des lignes des bordures dans la palette de couleurs.
Cette couleur de ligne s’applique aux bordures du tableau ou des cellules
sélectionnées. Cliquez sur l’icône pour appliquer la couleur rappelée en bas de celle-ci ou 
sur le petit triangle à sa droite pour ouvrir une palette de couleur où vous pourrez choisir 
parmi une gamme de couleurs prédéfinies ou créer la vôtre.

Bordures 
Permet de choisir une configuration de bordure parmi les configurations
prédéfinies. Cette configuration s’applique aux bordures du tableau ou des
cellules sélectionnées. Cliquez sur l’icône ou le petit triangle à sa droite pour
ouvrir la palette présentant les bordures prédéfinies.

Vous pouvez définir plus précisément les bordures en utilisant l’onglet 
Bordures de la boîte de dialogue Propriétés du tableau.
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Style de remplissage
Permet de choisir le style de remplissage (Aucun(e), Couleur, Dégradé, Hachure, Bitmap, 
Motif) du tableau ou des cellules sélectionnées. La liste déroulante située à droite contient 
des remplissages selon le style choisi.

Fusionner les cellules 
Permet de fusionner les cellules sélectionnées en une seule cellule. Cet outil fusionne 
également le contenu de ces cellules : chaque contenu de cellule forme un nouveau 
paragraphe. Vous pouvez également fusionner des cellules en sélectionnant Fusionner les 
cellules dans le menu contextuel ouvert par un clic droit sur les cellules sélectionnées.

Scinder les cellules 
Assurez-vous que le pointeur de la souris est positionné sur une cellule que vous voulez 
scinder puis cliquez sur l’icône Scinder les cellules pour ouvrir la boîte de dialogue Scinder 
les cellules (Figure 253).

Figure 253 : La boîte de dialogue Scinder les cellules

Choisissez le nombre de cellules à obtenir et le sens du partage (horizontalement ou 
verticalement). En cas de scission horizontale, vous pouvez cocher En proportions égales 
pour obtenir des cellules de même taille. Le contenu reste dans les cellules d’origine (celle 
de gauche ou du haut) et n’est pas scindé.

Optimiser
Permet de répartir également les cellules sélectionnées, dans le sens
horizontal ou vertical. Cliquez sur l’icône ou sur le petit triangle à sa
droite pour ouvrir une palette détachable d’outils où vous pourrez faire
votre choix dans une gamme d’options prédéfinies pour optimiser la
répartition des cellules sélectionnées.

Aligner en haut  , Centrer verticalement  , Aligner en bas 
Permet d’aligner verticalement le contenu des cellules sélectionnées.

Insérer une ligne au-dessus  , Insérer une ligne au-dessous  , Insérer une colonne 
avant  , Insérer une colonne après 

Permet d’insérer une ligne au-dessus ou au-dessous de la ligne ou une colonne à droite ou à
gauche de la colonne où se trouve le curseur de texte.

Supprimer la ligne  , Supprimer la colonne 
Permet de supprimer la ligne ou la colonne où se trouve le curseur de texte. Vous pouvez 
supprimer plusieurs lignes ou colonnes à la fois en les sélectionnant (totalement ou 
partiellement) dans le tableau avant de cliquer sur l’icône.
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Sélectionner le tableau  , Sélectionner la colonne  , Sélectionner la ligne 
Permet de sélectionner la totalité du tableau, d’une colonne ou d’une ligne où l’on se trouve 
pour y appliquer les mêmes changements de formatage à toutes les cellules.

Ébauche de tableau 
Permet d’ouvrir la section Ébauche de tableau (Figure 254) dans l’onglet Propriétés du volet 
latéral, où vous pouvez choisir l’apparence du tableau sélectionné.

Figure 254 : La section Ébauche de tableau
dans l’onglet Propriétés du volet latéral

Propriétés du tableau 
Ouvre la boîte de dialogue Propriétés du tableau dont les onglets sont décrits ci-dessous. 
Vous pouvez aussi ouvrir cette boîte de dialogue en sélectionnant Propriétés du tableau 
dans le menu contextuel ouvert par un clic droit sur le tableau.

– Police (identique à la Figure 239 ou à la Figure 240, page 215) : vous pouvez y choisir le 
type de police, ses attributs de base (Italique, Gras, Langue, etc.) ainsi que sa taille. Un 
exemple de la police est affiché en bas de la boîte de dialogue.

– Effets de caractère (Figure 255) : Vous pouvez appliquer ici des effets spéciaux au texte 
(sections Couleur de la police, Décoration du texte et Effets).

– Bordures (Figure 256) permet de définir plus précisément les bordures du tableau.

Dans la section Disposition des lignes, vous pouvez choisir une disposition des lignes 
par défaut ou cliquer dans l’aperçu pour définir votre propre style de bordure. Cliquez 
successivement sur une ligne pour ajouter une bordure (apparence du trait), conserver la 
bordure existante (trait en grisé) ou supprimer une bordure (vide).

Dans la section Ligne, vous pouvez choisir le style, la largeur et la couleur de la ligne de 
bordure.

Dans la section Remplissage, vous pouvez indiquer l’espace que vous voulez laisser 
entre la bordure d’une cellule et son contenu. L’option Synchroniser permet d’appliquer le 
même espacement des quatre côtés de la cellule.
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Figure 255 : L’onglet Effets de caractère de la boîte de dialogue Propriétés du tableau

Figure 256 : L’onglet Bordures de la boîte de dialogue Propriétés du tableau

– Arrière-plan (Figure 257) : cet onglet permet de modifier le fond des cellules 
sélectionnées ; il est identique à l’onglet Remplissage de la boîte de dialogue 

232 | Chapitre 9 Ajouter et formater des textes



Remplissage (voir le chapitre 4, Modifier les attributs d’un objet, page 85, pour plus 
d’informations).

Figure 257 : L’onglet Arrière-plan de la boîte de dialogue Propriétés du tableau

– Réinitialiser : cliquez sur ce bouton pour rétablir les options que la boîte de dialogue 
Propriétés du tableau avait à son ouverture.

Position et taille

Vous pouvez modifier la position du tableau en cliquant et faisant glisser son cadre (voir 
« Déplacer un cadre de texte », page 206). Vous pouvez modifier sa taille en cliquant et faisant 
glisser une de ses poignées de sélection (voir « Redimensionner un cadre de texte », page
207). Pour un travail plus précis, vous pouvez sélectionner Format > Position et taille dans la 
barre de menu, faire un clic droit et choisir Position et taille dans le menu contextuel, ou appuyer 
sur la touche F4 pour ouvrir la boîte de dialogue Position et taille. Vous pouvez aussi utiliser la 
section Position et taille de l’onglet Propriétés du volet latéral. Cependant, vous ne pouvez pas 
faire effectuer une rotation à un tableau.

Supprimer un tableau

Supprimer le tableau entier

Assurez-vous que tout le tableau est sélectionné et que les poignées de sélection sont visibles 
puis supprimez tout le tableau d’une des façons suivantes :

• cliquez sur l’icône Supprimer la ligne   ou Supprimer la colonne   dans la barre 
d’outils Tableau (Figure 252, page 229) ;
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• faites un clic droit dans le tableau et sélectionnez Supprimer > Supprimer la ligne ou 
Supprimer la colonne dans le menu contextuel.

Supprimer des lignes ou des colonnes

Sélectionnez les lignes ou les colonnes à supprimer puis procédez d’une des façons suivantes :

• cliquez sur l’icône appropriée, Supprimer la ligne   ou Supprimer la colonne  , dans la
barre d’outils Tableau (Figure 252, page 229) ;

• faites un clic droit dans le tableau et sélectionnez Supprimer > Supprimer la ligne ou 
Supprimer la colonne selon le cas dans le menu contextuel.

Supprimer le contenu des cellules

Pour supprimer le contenu de cellules d’un tableau, procédez comme ceci :

 1) Sélectionnez le contenu des cellules.

 2) Appuyez sur la touche Suppr ou Retour arrière.

Utiliser des champs

Les champs permettent l’insertion automatique de texte dans un dessin. Vous pouvez voir un 
champ comme une sorte de formule dont la valeur est calculée lorsque le document est chargé ou 
imprimé et dont le résultat s’inscrit dans le dessin.

Insérer un champ

Quand vous insérez un champ, un cadre de texte est créé que vous pouvez repositionner comme 
tout autre cadre de texte. Voyez « Déplacer un cadre de texte », page 206, pour plus 
d’informations.

Pour insérer un champ dans le dessin, sélectionnez Insertion > Champs dans la barre de menu, 
puis choisissez le champ que vous désirez dans le menu déroulant. Un cadre de texte contenant le
champ est créé au milieu de l’espace de travail.

Vous pouvez également positionner le curseur de texte où vous le souhaitez dans un cadre de 
texte, puis utiliser Insertion > Champs. Le champ sera alors inséré à cet endroit.

Les champs disponibles dans Draw sont :

• Date (fixe) : insère un champ contenant la date au moment de l’insertion du champ.

• Date (variable) : insère un champ qui se met à jour avec la date lors de l’ouverture du 
document.

• Heure (fixe) : insère un champ contenant l’heure au moment de l’insertion du champ.

• Heure (variable) : insère un champ qui se met à jour avec l’heure lors de l’ouverture du 
document.

• Auteur : insère un champ contenant l’auteur du document. Cette information provient de 
Outils > Options > LibreOffice > Données d’identité.

• Numéro de page : insère un champ contenant le numéro de la page en cours.
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• Titre de la page : insère un champ contenant le nom de la page. Sélectionnez Page > 
Renommer pour changer le nom par défaut.

• Nombre de pages : insère un champ contenant le nombre total de pages (diapositives) du 
document.

• Nom de fichier : insère un champ contenant le nom du document.

Personnaliser un champ

Vous pouvez personnaliser le contenu d’un champ, sauf les champs Numéro de page, Nombre de 
page et Titre de la page. Procédez de la façon suivante :

 1) Placez le curseur de texte au début de ce champ et sélectionnez Édition > Champs dans la 
barre de menu. La boîte de dialogue Éditer le champ s’ouvre (Figure 258).

Figure 258 : La boîte de dialogue Éditer le champ

 2) Choisissez un format dans la liste déroulante. Les formats disponibles dépendent du champ 
sélectionné.

 3) Cliquez sur OK pour enregistrer les modifications et refermer la boîte de dialogue.

Vous pouvez également personnaliser un champ en faisant un clic droit sur le champ en mode 
d’édition de texte : le contenu du menu contextuel est équivalent à celui de la boîte de dialogue 
Éditer le champ.

Utiliser des hyperliens

Quand vous insérez un texte qui peut servir d’hyperlien (par exemple, l’adresse ou l’URL d’un site 
web), Draw le formate automatiquement, en créant l’hyperlien, en lui appliquant une couleur et en 
le soulignant.

Insérer des hyperliens

 1) Si vous souhaitez insérer l’hyperlien dans un cadre de texte, cliquez dans celui-ci à l’endroit 
où vous voulez insérer l’hyperlien, sinon veillez à ce qu’aucun objet ne soit sélectionné 
(l’hyperlien sera inséré dans un nouveau cadre de texte situé au centre de l’espace de 
travail).

 2) Sélectionnez Insertion > Hyperlien dans la barre de menu ou utilisez le raccourci Ctrl+K 
pour ouvrir la boîte de dialogue Hyperlien (Figure 259).
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 3) Sélectionnez le type d’hyperlien que vous voulez insérer et les options que vous souhaitez 
utiliser.

 4) Cliquez sur Appliquer pour insérer l’hyperlien et enregistrer votre sélection. Si vous créez 
plusieurs hyperliens successivement, cliquez sur Appliquer entre chacun d’eux.

 5) Cliquez sur Fermer ou sur OK pour enregistrer vos modifications et refermer la boîte de 
dialogue Hyperlien.

Figure 259 : La boîte de dialogue Hyperlien

Du côté gauche de la boîte de dialogue, choisissez l’un des quatre types d’hyperliens. Le contenu 
de la boîte de dialogue change en fonction de votre choix.

Internet
Choisissez entre un lien Web ou FTP puis saisissez son adresse (URL).

Courrier
Saisissez l’adresse du destinataire et le sujet du courriel.

Document
Vous allez créer un hyperlien vers un autre document ou un autre emplacement dans le 
dessin, ce que l’on appelle couramment un signet.

– Saisissez le chemin vers le document ou cliquez sur l’icône Ouvrir le fichier  pour 
faire apparaître une boîte de dialogue d’ouverture de fichier. Laissez le champ vide si 
vous voulez créer un lien vers une cible dans le même dessin.

– Vous pouvez aussi spécifier une cible (par exemple une page particulière). Cliquez sur 
l’icône Cible dans le document  pour ouvrir la boîte de dialogue de même nom où 
vous pourrez faire votre choix. Si vous connaissez le nom de la cible, vous pouvez le 
saisir directement dans le champ Cible.

Nouveau document
Vous allez créer un hyperlien qui ouvrira un nouveau document.

– Cochez Éditer maintenant pour modifier immédiatement le document nouvellement créé 
ou Éditer ultérieurement pour le modifier plus tard.

– Choisissez le type de document à créer (texte, classeur, etc.).
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– Cliquez sur l’icône Sélectionner un chemin  pour choisir le dossier où sera créé le 
nouveau document.

Conseil

Pour que LibreOffice ne transforme pas automatiquement les adresses de sites web (URL) 
en hyperliens, ouvrez la page Options de la boîte de dialogue Autocorrection (Outils > 
Options d’AutoCorrection) et décochez l’option Détecter les URL.

Pour modifier la couleur des hyperliens, ouvrez la page LibreOffice – Couleurs de l’interface 
dans la boîte de dialogue Options (Outils > Options), recherchez Liens non visités ou Liens
visités dans la section Couleurs personnalisées, cochez ces options et choisissez les 
nouvelles couleurs puis cliquez sur OK.

! Attention

Le changement de couleur des hyperliens s’appliquera à tous les modules de LibreOffice, ce
qui n’était peut-être pas votre intention.

La section Paramétrages supplémentaires de la boîte de dialogue Hyperlien est commune à 
tous les types d’hyperliens, bien que certains choix concernent plus certains types que d’autres.

Cadre
Le choix dans la liste déroulante détermine comment l’hyperlien s’ouvre. Il s’applique aux 
documents qui s’ouvrent dans un navigateur web.

Formulaire
Le choix fait ici détermine si le lien est affiché sous forme de texte ou de bouton.

Texte
Saisissez ici le texte qui sera visible dans votre dessin.

Nom
Saisissez le texte qui sera ajouté comme attribut NAME dans le code HTML derrière 
l’hyperlien. Ne s’applique qu’au document HTML.

Éditer les hyperliens

 1) Sélectionnez l’hyperlien.

 2) Choisissez Édition > Hyperlien dans la barre de menu pour ouvrir la boîte de dialogue 
Hyperlien (Figure 259, page 236).

 3) Apportez les modifications souhaitées aux différentes options puis cliquez sur Appliquer 
quand vous avez fini. Si vous devez modifier plusieurs hyperliens, cliquez sur Appliquer 
après chacun d’eux.

 4) Cliquez sur Fermer ou sur OK pour enregistrer vos modifications et refermer la boîte de 
dialogue.

Images cliquables

Une image cliquable définit des zones (appelées zones sensibles) reliées par un hyperlien à une 
adresse web, d’autres fichiers sur l’ordinateur ou d’autres parties du même document. Les zones 
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sensibles sont l’équivalent graphique des hyperliens textuels. Quand on clique sur une zone 
sensible, LibreOffice ouvre la page liée dans le programme associé (par exemple, le navigateur 
par défaut pour les pages HTML, LibreOffice Calc pour un fichier ODS, un lecteur de PDF pour les 
fichiers PDF). Vous pouvez créer des zones sensibles de diverses formes et inclure plusieurs 
zones sensibles dans la même image.

Pour utiliser l’éditeur d’image cliquable (Figure 260) :

 1) Sélectionnez une image de votre document Draw dans laquelle vous voulez créer une zone 
sensible.

 2) Choisissez Outils > Image Map dans la barre de menu pour ouvrir l’éditeur d’image 
cliquable.

 3) Sélectionnez le type de zone sensible que vous voulez créer parmi les icônes en haut de 
l’éditeur d’image cliquable : rectangle , ellipse , polygone , polygone à main levée 

 4) Dessinez la zone sensible sur l’image.

 5) Saisissez l’adresse pointée par l’hyperlien dans le champ Adresse en utilisant le format 
d’adresse file:///<chemin>/nom_du_document#nom_de_l’ancre.

 6) Cliquez sur l’icône Appliquer  pour appliquer ces réglages.

 7) Quand vous avez fini, cliquez sur l’icône Enregistrer  pour sauvegarder l’image cliquable 
dans un fichier puis refermez l’éditeur.
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Figure 260 : L’éditeur d’image cliquable

La plus grande partie de l’éditeur d’image cliquable affiche l’image sur laquelle les zones sensibles
sont définies. Ceux-ci sont indiqués par un contour de la forme utilisée pour les créer.

L’éditeur d’image cliquable propose les outils suivants :

• Appliquer  : applique les modifications.

• Ouvrir , Enregistrer , Sélectionner .

• Formes des zones sensibles : Rectangle , Ellipse , Polygone , Polygone à main 
levée .

• Éditer les points , Déplacer des points , Insérer des points  et Supprimer des 
points  : outils d’édition détaillée pour manipuler la forme d’une zone sensible polygonale.
Sélectionnez Éditer les points pour activer les autres.

• Défaire  et Refaire .

• Actif  : alterne l’état de la zone sensible sélectionnée entre actif et inactif.

• Macro  : associe une macro à la zone sensible au lieu de simplement lui associer un 
hyperlien.

• Propriétés  : définit les propriétés de l’hyperlien et lui ajoute l’attribut Name.

• Adresse : saisissez ici l’adresse pointée par l’hyperlien. Vous pouvez aussi pointer vers une 
ancre dans un document.
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• Texte : saisissez ici le texte que vous voulez voir affiché quand le pointeur de la souris 
survole la zone sensible.

• Cadre définit l’endroit où la cible de l’hyperlien va s’ouvrir (_self ouvre la cible dans la fenêtre
active du navigateur).

Fontwork

Avec Fontwork vous pouvez créer des objets graphiques de texte artistique qui rendront votre 
travail plus attrayant. Ils offrent un grand choix de paramètres différents (ligne, remplissage, 
position, taille, etc.).

Fontwork est aussi disponible avec les modules Writer, Calc et Impress, mais vous noterez de 
petites différences dans la façon dont chacun l’affiche.

Créer un objet de Fontwork

 1) Cliquez sur l’icône Fontwork  dans la barre d’outils Dessin ou la barre d’outils Standard, 
ou sélectionnez Insertion > Fontwork dans la barre de menu pour ouvrir la boîte de 
dialogue Galerie Fontwork (Figure 261).

 2) Sélectionnez un style dans la Galerie Fontwork et cliquez sur OK. L’objet apparaît dans votre
dessin et la boîte de dialogue se referme.

 3) Faites un double-clic sur le mot Fontwork pour passer en mode édition.
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Figure 261 : La galerie Fontwork

 4) Tapez le texte qui doit remplacer le mot Fontwork ; il apparaît en noir au-dessus de celui-ci 
comme sur la Figure 262.

Figure 262 : Éditer le texte d’un objet de Fontwork

 5) Appuyez sur la touche Échap ou cliquez hors du rectangle de sélection et votre texte prend 
la place du mot Fontwork.
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Figure 263 : Objet Fontwork après édition du texte

La barre d’outils Fontwork

La barre d’outils Fontwork (Figure 264) apparaît dans l’espace de travail quand vous sélectionnez 
un objet Fontwork. Si ce n’est pas le cas, sélectionnez Affichage > Barres d’outils > Fontwork 
dans la barre de menu.

Style Fontwork Forme Fontwork
Hauteur identique pour les 
lettres Fontwork

Alignement Fontwork
Espacement des 
caractères Fontwork

(Dés)activer l’extrusion

Figure 264 : La barre d’outils Fontwork

La barre d’outils Fontwork offre les outils suivants :

Style Fontwork 
Ouvre la boîte de dialogue Galerie Fontwork (Figure 261).

Forme Fontwork 
Ouvre la palette Forme Fontwork, transformable en barre d’outils (Figure 265) où vous 
pouvez changer la forme de l’objet sélectionné.

Figure 265 : La barre d’outils Forme Fontwork

Hauteur identique pour les lettres Fontwork 
Alterne entre une hauteur normale, où les caractères ont des hauteurs différentes, et une 
hauteur identique pour tous les caractères du texte.

Alignement Fontwork 
Spécifie l’alignement du texte à l’intérieur du cadre. Les choix possibles sont Aligner à 
gauche, Centrer, Aligner à droite, Mots justifiés et Étirement justifié. Les effets ne sont 
visibles que si le texte est réparti sur deux lignes ou plus. Dans le mode Étirement justifié, 
toutes les lignes sont entièrement remplies.

242 | Chapitre 9 Ajouter et formater des textes



Espacement des caractères Fontwork 
Choisissez l’espacement entre les caractères et si les paires de crénage doivent être 
utilisées. Les options proposées sont Très serré, Serré, Normal, Large, Très large et 
Personnalisé. Pour l’espacement personnalisé, saisissez une valeur en pourcentage : 100 %
correspond à l’espacement normal, moins de 100 % pour des caractères plus serrés et plus 
de 100 % pour des caractères plus espacés.

(Dés)activer l’extrusion 
Cette icône permet de convertir l’objet Fontwork en une séquence 3D par extrusion. Voir le 
chapitre 7, Manipuler les objets 3D, page 167, pour plus d’informations.

Modifier les objets Fontwork

Un objet Fontwork peut être traité comme tout autre objet dans Draw : ses dimensions peuvent 
être modifiés, il peut être pivoté, déformé, incliné, retourné, etc. Pour plus d’informations sur la 
modification d’un objet Fontwork, voyez le chapitre 3, Manipuler les objets et les points des objets, 
le chapitre 4, Modifier les attributs d'un objet, et le chapitre 5, Combiner plusieurs objets.

Il est possible de traiter un texte Fontwork comme un objet et de lui appliquer tous les formatages 
qui ont été décrits dans ce chapitre. N’affectez des propriétés de ligne qu’aux objets Fontwork qui 
n’ont pas d’effet 3D, sinon les changements ne seront pas visibles.

Il est possible de modifier certaines formes de Fontwork comme on modifie les angles des formes 
de base trapèze et parallélogramme en déplaçant le point qui s’affiche avec les poignées de 
sélection.
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6.4

Chapitre 10
Imprimer, exporter et envoyer 
par e-mail





Imprimer

Impression rapide
Pour imprimer rapidement un document ou un dessin, cliquez sur l’icône Imprimer directement (

) dans la barre d’outils Standard pour envoyer le document entier à l’imprimante par défaut 
définie pour votre ordinateur.

Remarque

Si l’icône Imprimer directement n’est pas visible dans la barre d’outils Standard, faites un 
clic droit sur une icône et choisissez Boutons visibles dans le menu contextuel puis 
sélectionnez Imprimer directement dans la liste déroulante pour ajouter son icône à la 
barre d’outils.

Remarque

Vous pouvez changer l’action de l’icône Imprimer directement pour envoyer un document 
à l’imprimante définie pour celui-ci au lieu de l’imprimante par défaut de l’ordinateur. 
Sélectionnez Outils > Options dans la barre de menu, ouvrez la page Chargement/
enregistrement – Général de la boîte de dialogue Options et cochez l’option Charger les 
paramètres d’impression avec le document.

Impression contrôlée

Pour un meilleur contrôle de l’impression, ouvrez la boîte de dialogue Imprimer (Figure 266) par 
l’une des méthodes suivantes :

• sélectionnez Fichier > Imprimer dans la barre de menu,

• appuyez sur les touches Ctrl+P,

• cliquez sur l’icône Imprimer ( ) dans la barre d’outils Standard.

Remarque

Selon les réglages de l’ordinateur et le système d’exploitation qu’il utilise, la boîte de 
dialogue Imprimer peut avoir une apparence différente de celle de la Figure 266. 
Cependant, les options d’impression disponibles dans LibreOffice restent les mêmes.

Remarque

Les options choisies dans la boîte de dialogue Imprimer ne s’appliquent qu’à l’impression du
document actuellement ouvert dans Draw. Pour définir des paramètres d’impression pour 
LibreOffice, sélectionnez Outils > Options dans la barre de menu et ouvrez la page 
LibreOffice – Impression dans la boîte de dialogue Options.
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Figure 266 : La boîte de dialogue Imprimer, onglet Standard

Options générales

Les options suivantes représentent un exemple de ce que vous pouvez trouver dans l’onglet 
Standard de la boîte de dialogue Imprimer.

Imprimante
Sélectionnez l’imprimante à utiliser parmi les choix proposés dans la liste déroulante.

Plage et exemplaires
– Pages à imprimer, faites votre choix parmi les options suivantes : Toutes les pages, 

Pages (sélectionnez les numéros de pages), Pages paires, Pages impaires et Sélection.

Cliquez sur plus d’options si les choix suivants n’apparaissent pas.

– Côtés du papier : utilisez la liste déroulante pour choisir d’imprimer d’un seul côté, des 
deux côtés avec une reliure du côté long ou court.

– Nombre d’exemplaires : saisissez le nombre de copies du document à imprimer.

– Assembler : cochez cette option pour que toutes les pages d’un document soient 
imprimées à la suite les unes des autres avant de passer à la copie suivante (sinon toutes
les copies d’une page sont imprimées avant de passer à la page suivante).

– Imprimer dans l’ordre inverse : cochez cette option pour commencer l’impression par la 
dernière page (et obtenir la première page au-dessus des autres dans le bac de sortie).
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Mise en page
– Taille du papier : faites votre choix dans la liste déroulante.

– Orientation : les choix possibles sont Automatique, Portrait ou Paysage.

Cliquez sur plus d’options si les choix suivants n’apparaissent pas.

– Pages par feuille  : choisissez le nombre de pages imprimées sur chaque feuille

– Ordre  : sélectionnez l’ordre d’impression des pages sur chaque feuille (si plusieurs pages 
sont imprimées sur une feuille).

– Dessiner une bordure autour de chaque page

– Brochure  : cochez cette option pour imprimer le document de façon à pouvoir plier les 
pages pour constituer un livret.

Options de l’onglet LibreOffice Draw

Dans la page LibreOffice Draw de la boîte de dialogue Imprimer (Figure 267), vous pouvez définir 
les paramètres propres au type de document courant.

Figure 267 : La boîte de dialogue Imprimer, onglet LibreOffice Draw

Contenu
Cochez les options voulues pour imprimer le nom de la page ou la date et l’heure sur le 
dessin.

Couleur
Choisissez d’imprimer le dessin dans ses couleurs d’origine, en niveaux de gris ou en noir et 
blanc.

Taille
Cette section propose plusieurs choix de taille pour le dessin imprimé :

– Taille d’origine,
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– Adapter à la page imprimable,

– Répartir sur plusieurs feuilles de papier permet d’imprimer un dessin trop grand pour la 
taille de feuille utilisée,

– Remplir la feuille de papier avec des pages répétées permet d’imprimer plusieurs copies 
d’un dessin sur la même page.

Remarque

Les instructions d’impression qui suivent ne sont que des exemples. La méthode 
d’impression qu’il faut effectivement employer dépend du système d’exploitation, du 
paramétrage de l’ordinateur et de l’imprimante utilisée.

Imprimer plusieurs pages sur une seule feuille

Pour imprimer plusieurs pages d’un document sur une seule feuille de papier :

 6) Ouvrez la boîte de dialogue Imprimer (Figure 266, page 248) grâce à une des méthodes 
suivantes :

– sélectionnez Fichier > Imprimer dans la barre de menu,

– appuyez sur les touches Ctrl+P,

– cliquez sur l’icône Imprimer ( ) dans la barre d’outils Standard.

 7) Dans la section Mise en page, sélectionnez dans la liste déroulante Pages par feuille le 
nombre de pages à imprimer sur une feuille (si elle n’est pas visible, cliquez sur plus 
d’options sous Orientation). Une petite zone d’aperçu un peu plus bas à droite montre la 
disposition des pages dans le document imprimé.

 8) Dans la liste déroulante Ordre sous la précédente, choisissez l’ordre d’impression des pages
sur la feuille.

 9) Pour distinguer chaque page sur la feuille, cochez l’option Dessiner une bordure autour de 
chaque page.

 10) Cliquez sur OK pour imprimer le document et refermer la boîte de dialogue.

Sélectionner les pages à imprimer

En plus d’imprimer un document entier, vous pouvez choisir d’imprimer des pages individuelles, 
une plage de pages ou une partie sélectionnée d’un document.

Imprimer une page

 1) Ouvrez la boîte de dialogue Imprimer (Figure 266, page 248) grâce à une des méthodes 
suivantes :

– sélectionnez Fichier > Imprimer dans la barre de menu,

– appuyez sur les touches Ctrl+P,

– cliquez sur l’icône Imprimer ( ) dans la barre d’outils Standard.

 2) Dans la section Plage et exemplaires, cochez l’option Pages.
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 3) Saisissez le numéro de la page à imprimer.

 4) Cliquez sur OK pour imprimer le document et refermer la boîte de dialogue.

Imprimer une plage de pages

 1) Ouvrez la boîte de dialogue Imprimer (Figure 266, page 248) grâce à une des méthodes 
suivantes :

– sélectionnez Fichier > Imprimer dans la barre de menu,

– appuyez sur les touches Ctrl+P,

– cliquez sur l’icône Imprimer ( ) dans la barre d’outils Standard.

 2) Dans la section Plage et exemplaires, cochez l’option Pages.

 3) Saisissez les numéros des pages à imprimer (par exemple, 1-4 ou 1,3,7,11 ou une 
combinaison des deux formes : 1-4,7-9,11).

 4) Cliquez sur OK pour imprimer le document et refermer la boîte de dialogue.

Imprimer la sélection

 1) Ouvrez la boîte de dialogue Imprimer (Figure 266, page 248) grâce à une des méthodes 
suivantes :

– sélectionnez Fichier > Imprimer dans la barre de menu,

– appuyez sur les touches Ctrl+P,

– cliquez sur l’icône Imprimer ( ) dans la barre d’outils Standard.

 2) Dans la section Plage et exemplaires, cochez l’option Sélection.

 3) Cliquez sur OK pour imprimer le document et refermer la boîte de dialogue.

Imprimer une brochure ou un livret

Dans Writer, Impress et Draw, vous pouvez imprimer un document avec deux pages de chaque 
côté de la feuille de papier, disposées de telle manière que, une fois les feuilles imprimées pliées 
en deux, les pages sont dans le bon ordre pour former un livret ou une brochure.

Conseil

Préparez votre document pour qu’il ait une apparence satisfaisante une fois imprimé à 
l’échelle réduite : prévoyez des marges, des tailles de polices, etc. appropriées. Il faudra 
peut-être faire quelques essais.

L’imprimante n’imprime que d’un seul côté

Pour imprimer une brochure ou un livret sur une imprimante qui n’est capable d’imprimer que d’un 
seul côté de la feuille :

 1) Ouvrez la boîte de dialogue Imprimer (Figure 266, page 248) grâce à une des méthodes 
suivantes :

– sélectionnez Fichier > Imprimer dans la barre de menu,
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– appuyez sur les touches Ctrl+P,

– cliquez sur l’icône Imprimer ( ) dans la barre d’outils Standard.

 2) Choisissez l’imprimante que vous voulez utiliser si plusieurs sont connectées à votre 
ordinateur.

 3) Cliquez sur le bouton Propriétés pour ouvrir la boîte de dialogue des propriétés de 
l’imprimante sélectionnée.

 4) Vérifiez que l’orientation de l’impression (portrait ou paysage) est la même que celle 
spécifiée pour l’orientation de la page du document. Ordinairement, ce réglage est sans 
importance, mais pas pour les brochures et les livrets.

 5) Cliquez sur OK pour revenir à la boîte de dialogue Imprimer.

 6) Cochez l’option Brochure dans la section Mise en page (si elle n’est pas visible, cliquez sur 
plus d’options sous Orientation).

 7) Cochez Pages paires ou Pages impaires dans la section Plage et exemplaires.

 8) Cliquez sur OK pour imprimer les pages sélectionnées.

 9) Sortez les pages imprimées du bac de réception, retournez la pile et replacez-la dans 
l’imprimante dans le sens correct pour imprimer le côté vierge. Il faudra peut-être quelques 
essais pour trouver la disposition correcte pour votre imprimante.

 10) Cochez Pages impaires (si vous aviez coché Pages paires à l’étape 7) ou Pages paires (si 
vous aviez coché Page impaires à l’étape 7) dans la section Plage et exemplaires.

 11) Cliquez sur OK pour achever l’impression du document.

L’imprimante imprime recto-verso

Pour imprimer une brochure ou un livret sur une imprimante qui est capable d’imprimer sur les 
deux faces de la feuille :

 1) Ouvrez la boîte de dialogue Imprimer (Figure 266, page 248) grâce à une des méthodes 
suivantes :

– sélectionnez Fichier > Imprimer dans la barre de menu,

– appuyez sur les touches Ctrl+P,

– cliquez sur l’icône Imprimer ( ) dans la barre d’outils Standard.

 2) Choisissez l’imprimante que vous voulez utiliser si plusieurs sont connectées à votre 
ordinateur.

 3) Cliquez sur le bouton Propriétés pour ouvrir la boîte de dialogue des propriétés de 
l’imprimante sélectionnée.

 4) Vérifiez que l’orientation de l’impression (portrait ou paysage) est la même que celle 
spécifiée pour l’orientation de la page du document. Ordinairement, ce réglage est sans 
importance, hormis pour les brochures et les livrets.

 5) Cliquez sur OK pour revenir à la boîte de dialogue Imprimer.

 6) Dans l’option Côtés du papier, sélectionnez Impression recto-verso (bord long) dans la liste 
déroulante (cliquez sur plus d’options sous Sélection si ce choix n’apparaît pas). Les options 
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effectivement disponibles pour l’impression recto-verso dépendent du modèle de 
l’imprimante et du système utilisé sur l’ordinateur.

 7) Cochez l’option Brochure dans la section Mise en page (si elle n’est pas visible, cliquez sur 
plus d’options sous Orientation).

 8) Cochez Toutes les pages dans la section Plage et exemplaires.

 9) Cliquez sur OK pour imprimer le document.

Imprimer en noir et blanc ou en niveaux de gris

Vous pouvez parfois souhaiter imprimer des documents en noir et blanc ou en niveaux de gris sur 
une imprimante en couleurs. Cependant, certaines imprimantes ne vous permettront peut-être que 
d’imprimer en couleurs quel que soit le réglage choisi. Les détails supplémentaires se trouvent 
dans la documentation fournie avec votre imprimante.

Paramétrage de l’imprimante

 1) Ouvrez la boîte de dialogue Imprimer (Figure 266, page 248) grâce à une des méthodes 
suivantes :

– sélectionnez Fichier > Imprimer dans la barre de menu,

– appuyez sur les touches Ctrl+P,

– cliquez sur l’icône Imprimer ( ) dans la barre d’outils Standard.

 2) Choisissez l’imprimante que vous voulez utiliser si plusieurs sont connectées à votre 
ordinateur.

 3) Cliquez sur le bouton Propriétés pour ouvrir la boîte de dialogue des propriétés de 
l’imprimante sélectionnée. Les choix disponibles dépendent du modèle d’imprimante et du 
système d’exploitation de l’ordinateur, mais vous devriez trouver facilement les options pour 
le réglage des couleurs. La Figure 268 vous donne un exemple de ce que vous pouvez 
trouver.

 4) Recherchez et sélectionnez l’option pour imprimer en niveaux de gris ou en noir et blanc.

 5) Cliquez sur OK pour refermer cette boîte de dialogue et revenir à la boîte de dialogue 
Imprimer.

 6) Cliquez sur OK pour imprimer le document et refermer la boîte de dialogue.

Conseil

Si votre document comporte des textes ou des dessins colorés, le meilleur choix est 
d’imprimer en niveaux de gris. Les couleurs apparaîtront comme des nuances de gris qui 
offriront plus de détails. En imprimant des objets colorés en noir et blanc, certains de ces 
détails seraient perdus.
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Figure 268 : Exemple de boîte de dialogue Propriétés d’une imprimante

Paramétrage de LibreOffice

Pour changer les réglages de LibreOffice dans le but d’imprimer tous les textes et images colorés 
en niveaux de gris :

 1) Sélectionnez Outils > Options dans la barre de menu puis ouvrez la page LibreOffice – 
Impression dans la boîte de dialogue Options.

 2) Dans la section Par défaut, cochez l’option Convertir les couleurs en niveaux de gris.

 3) Cliquez sur OK pour enregistrer les modifications et refermer la boîte de dialogue.

 4) Ouvrez la boîte de dialogue Imprimer (Figure 266, page 248) grâce à une des méthodes 
suivantes :

– sélectionnez Fichier > Imprimer dans la barre de menu,

– appuyez sur les touches Ctrl+P,

– cliquez sur l’icône Imprimer ( ) dans la barre d’outils Standard.

 5) Cliquez sur OK pour imprimer le document et refermer la boîte de dialogue.

Paramétrage de Draw

Pour changer les réglages de Draw dans le but d’imprimer tous les textes et images colorés soit en
noir et blanc, soit en niveaux de gris :
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 1) Sélectionnez Outils > Options dans la barre de menu puis ouvrez la page LibreOffice Draw 
– Imprimer dans la boîte de dialogue Options.

 2) Dans la section Qualité, cochez l’option Niveaux de gris ou Noir et blanc.

 3) Cliquez sur OK pour enregistrer les modifications et refermer la boîte de dialogue.

 4) Ouvrez la boîte de dialogue Imprimer (Figure 266, page 248) grâce à une des méthodes 
suivantes :

– sélectionnez Fichier > Imprimer dans la barre de menu,

– appuyez sur les touches Ctrl+P,

– cliquez sur l’icône Imprimer ( ) dans la barre d’outils Standard.

 5) Cliquez sur OK pour imprimer le document et refermer la boîte de dialogue.

Exporter

LibreOffice peut exporter les documents au format PDF (Portable Document Format). Ce format de
fichier est un standard industriel idéal pour envoyer un fichier à quelqu’un qui pourra le lire à l’aide 
d’Adobe Reader ou d’autres lecteurs de PDF. Le processus et les boîtes de dialogue sont les 
mêmes dans Writer, Calc, Impress et Draw, avec quelques différences mineures mentionnées 
dans cette section.

Exportation directe en PDF

Cliquez sur l’icône Export direct au format PDF  de la barre d’outils Standard pour exporter le 
document entier en utilisant vos paramètres d’exportation PDF par défaut. Il vous est demandé de 
saisir le nom et l’emplacement du fichier PDF, mais vous ne pouvez pas choisir la plage de pages 
à exporter, le taux de compression des images ni aucune autre option.

Contrôler le contenu et la qualité du PDF

Pour un meilleur contrôle du contenu et de la qualité du fichier PDF obtenu, il faut utiliser la 
fonction Exporter au format PDF. Pour plus d’informations sur les options disponibles, voyez le 
Guide du débutant.

 1) Sélectionnez Fichier > Exporter vers > Exporter au format PDF dans la barre de menu 
pour ouvrir la boîte de dialogue Options PDF (Figure 269).

 2) Faites votre choix parmi les options des pages Général, Vue initiale, Interface utilisateur, 
Liens, Sécurité et Signatures numériques de cette boîte de dialogue.

 3) Quand vous avez sélectionné les options appropriées, cliquez sur Exporter.

 4) Saisissez l’emplacement et le nom du fichier dans la boîte de dialogue qui s’ouvre alors.

 5) Cliquez sur Enregistrer pour enregistrer le fichier au format PDF.
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Figure 269 : La boîte de dialogue Options PDF

Autres formats

LibreOffice utilise le terme « exporter » pour des opérations sur des fichiers qui impliquent un 
changement de type. Si vous ne trouvez pas ce que vous cherchez dans Fichier > Enregistrer 
sous, regarder dans Fichier > Exporter. LibreOffice peut exporter les fichiers dans divers formats 
que vous trouverez dans la liste déroulante des formats de fichiers. Voyez le chapitre 6, Éditer des
images, page 140, de ce guide pour plus d’information sur l’exportation d’images.

Pour exporter un fichier dans un autre format :

 1) Sélectionnez Fichier > Exporter dans la barre de menu pour ouvrir la boîte de dialogue 
Exporter (Figure 270).

Figure 270 : La boîte de dialogue Exporter
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 2) Recherchez le dossier où vous voulez exporter votre dessin

 3) Dans le champ Nom du fichier, saisissez un nom de fichier pour le document exporté.

 4) Sélectionnez le format souhaité dans la liste déroulante Type.

 5) Cliquez sur Enregistrer pour exporter le fichier et refermer la boîte de dialogue.

Remarque

Si aucun élément de la page n’est sélectionné, la page entière est exportée. Si des objets 
sont sélectionnés et si l’option Sélection est cochée dans la boîte de dialogue Exporter, 
seuls ces objets sont exportés dans le fichier. Pour la plupart des formats d’exportation, 
seule l’image de la page courante est exportée.

Pages web

Pour exporter un document Draw possédant plusieurs pages en une série de pages web, 
sélectionnez Ficher > Exporter dans la barre de menu et choisissez Document HTML comme 
type de fichier pour ouvrir la boîte de dialogue Export HTML. Suivez les indications. Si nécessaire, 
une aide à la navigation peut être générée pour faciliter le déplacement d’une page à l’autre. Pour 
plus d’informations, voyez le chapitre 12, Créer des pages web, du Guide du débutant.

Envoyer des documents par courriel

LibreOffice offre plusieurs façons pour envoyer rapidement et facilement des documents, au format
OpenDocument (le format par défaut de LibreOffice) ou au format PDF, en pièce jointe à un 
courriel. Vous pouvez envoyer un document à plusieurs destinataires. Pour plus d’informations, 
voir le chapitre 10, Impression, exportation, envoi par courriel et signature des documents, du 
Guide du débutant.

Remarque

Des documents ne peuvent être envoyés depuis le menu de LibreOffice que si un profil de 
courrier électronique a été défini.

Envoi en format OpenDocument

Pour envoyer le document courant en format OpenDocument :

 1) Sélectionnez Fichier > Envoyer > Envoyer le document par courriel dans la barre de 
menu. LibreOffice ouvre votre programme de courrier électronique par défaut avec le 
document en pièce jointe.

 2) Dans ce programme, saisissez le destinataire, le sujet et ajoutez le texte que vous voulez 
puis envoyez le courriel.

Envoi en format PDF

Pour envoyer le document courant en format PDF :
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 1) Sélectionnez Fichier > Envoyer > Envoyer par courriel en PDF dans la barre de menu. 
LibreOffice crée un fichier PDF en utilisant les réglages par défaut puis ouvre votre 
programme de courrier électronique par défaut avec le fichier PDF en pièce jointe.

 2) Dans ce programme, saisissez le destinataire, le sujet et ajoutez le texte que vous voulez 
puis envoyez le courriel.
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Chapitre 11
Techniques avancées





Documents multi-pages

Les documents Draw, comme les documents de présentation Impress, peuvent contenir plusieurs 
pages. Cela vous permet de créer un dessin qui comporte plusieurs parties, mais qui est stocké 
dans un seul fichier.

Lorsque des pages sont insérées dans un document Draw, elles sont automatiquement nommées 
Page 1, Page 2, et ainsi de suite. Si vous modifiez l’ordre des pages, leurs noms changent en 
conséquence. Par conséquent, si vous voulez facilement identifier chaque page, il est 
recommandé de les renommer en leur donnant un nom significatif.

Utiliser le volet page

Par défaut, le volet page apparaît ancré à gauche de l’espace de travail lorsque vous ouvrez Draw 
et affiche chaque page du document sous forme d’aperçu. Si le volet n’apparaît pas, sélectionnez 
Affichage > Volet page dans la barre de menu.

Remarque

Le volet page est appelé Pages lorsqu’il est ancré à gauche de l’espace de travail.

Volet Pages Espace de travail

Barre de menu Barre d’outils Standard

Volet latéral

Onglets des couchesBarre d’état

Barre d’outils Dessin

Barre d’outils Ligne et remplissage

Fermeture des volets

Figure 271 : L’espace de travail de LibreOffice Draw

Les actions suivantes sont possibles dans le volet page :

• Sélectionnez une page grâce à une des méthodes suivantes pour qu’elle apparaisse dans 
l’espace de travail où vous pourrez la modifier :

– cliquez sur l’aperçu d’une page dans le volet page ;
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– appuyez sur la touche F5 ou sélectionnez Affichage > Navigateur dans la barre de menu
pour ouvrir le navigateur (Figure 272) puis cliquez sur le nom d’une page ;

– ouvrez l’onglet Navigateur dans le volet latéral (Figure 273) en cliquant sur son icône (
) et cliquez sur le nom de la page.

Figure 272 : Le navigateur dans Draw

Figure 273 : L’onglet Navigateur 
dans le volet latéral

• Cliquez sur l’aperçu d’une page et faites-le glisser pour modifier l’ordre des pages dans le 
document.

• Cliquez sur la ligne de séparation entre le volet page et l’espace de travail et faites-la glisser 
pour modifier la largeur du volet page.

• Cliquez sur le bouton au milieu de la ligne de séparation (encadrés dans la Figure 271) pour 
masquer ou afficher le volet page.

• Maintenez appuyée la touche Ctrl et faites un double-clic sur le titre du volet page pour 
faire flotter ou ancrer le volet. Vous pouvez aussi cliquer sur sa barre de titre et la faire 
glisser.

• Faites un clic droit sur l’aperçu d’une page et utilisez les commandes du menu contextuel 
pour insérer (Page suivante), supprimer, renommer, couper, copier et coller une page.

• Cliquez sur Page dans la barre de menu pour réaliser une des actions proposées par le 
sous-menu déroulant :

– choisissez Page suivante pour insérer une page après la page courante et la 
sélectionner,

– choisissez Dupliquer la page pour insérer un double de la page sélectionnée dans le 
volet page,

– choisissez Insérer une page à partir d’un fichier pour ouvrir la boîte de dialogue Insérer
un fichier où vous pourrez rechercher le fichier souhaité et l’insérer en cliquant sur le 
bouton Ouvrir,

– choisissez Renommer la page pour changer le nom de la page sélectionnée dans le 
volet page,

– choisissez Supprimer la page pour supprimer la page sélectionnée dans le volet page,
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– choisissez Déplacer puis Au début, Vers le haut, Vers le bas ou À la fin dans le menu 
déroulant pour déplacer la page sélectionnée dans le volet page,

– choisissez Naviguer puis À la première page, À la page précédente, À la page 
suivante ou À la dernière page pour sélectionner une autre page dans le volet page.

Pages maîtresses

Une page maîtresse est une page qui va être utilisée comme point de départ pour les autres pages
de votre document. C’est une notion similaire à celle de style de page qui se trouve dans Writer et 
elle contrôle le formatage de base de toutes les pages qui sont basées sur elle. Vous pouvez 
définir plusieurs pages maîtresses et les assigner librement aux différentes pages de votre 
document et leur donner un aspect différent, par exemple en concevant une page maîtresse pour 
le titre et un autre pour le contenu.

Une page maîtresse va apporter aux pages auxquelles elle est attribuée un certain nombre de 
caractéristiques. Elle va définir des attributs de formatage, comme la couleur, l’image ou le 
dégradé d’arrière-plan de la page et le format par défaut des textes. Il va également définir des 
objets qui s’afficheront en arrière-plan, comme un logo, des lignes décoratives ou d’autres 
éléments graphiques, des blocs de texte standard ou un champ représentant le numéro de la 
page, la date d’ouverture du document ou le nom du fichier, par exemple.

Remarque

LibreOffice utilise plusieurs termes pour un même concept : masque de diapo, ébauche de 
diapo, diapositive maîtresse ou page maîtresse sont équivalents. Tous font référence à une 
page utilisée pour créer d’autres pages. Il peut être nécessaire d’utiliser ces différents 
termes dans l’Aide pour trouver l’information recherchée.

Affichage de la page maîtresse

Pour ajouter du texte, des objets ou des champs à une page maîtresse, choisissez Affichage > 
Masque dans la barre de menu pour passer en mode d’affichage masque de page. La barre 
d’outils Mode Maître (Figure 3) s’ouvre. Si ce n’est pas le cas, sélectionnez Affichage > Barre 
d’outils > Mode maître dans la barre de menu. Le volet page affiche l’aperçu des différents 
masques de page définis, à la place des pages du document.

Pour retourner au mode d’affichage normal, cliquez sur Fermer le mode maître ( ) dans la barre
d’outils ou choisissez Affichage > Normal dans la barre de menu.

Nouvelle diapo maîtresse Supprimer le masque Renommer le masque

Fermer le mode maître

Figure 274 : La barre d’outils Mode maître

Le formatage et l’insertion d’objets et de champs s’effectuent de la même façon que dans une 
page normale : voir les autres chapitres du Guide Draw pour plus d’informations.
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Créer une page maîtresse

Chaque dessin que vous créez comporte une page maîtresse par défaut, mais vous pouvez en 
créer d’autres pour modifier l’apparence de certaines pages particulières de votre document.

 3) Passez en mode maître en sélectionnant Affichage > Masque dans la barre de menu.

 4) Cliquez sur l’icône Nouvelle diapo maîtresse  de la barre d’outils Mode maître.

La nouvelle page maîtresse est automatiquement sélectionnée pour vous permettre d’y ajouter de 
nouveaux éléments afin de donner un nouvel aspect à vos pages.

Renommer une page maîtresse

Chaque masque de page créé a comme nom par défaut Standard 1, Standard 2, et ainsi de suite. 
Il est recommandé de les renommer pour leur donner un nom plus significatif. Vous pouvez 
également renommer la page maîtresse créée avec le document, qui a par défaut le nom 
Standard.

 1) Passez en mode maître en sélectionnant Affichage > Masque dans la barre de menu.

 2) Cliquez sur l’icône Renommer le masque  de la barre d’outils Mode maître, ou faites un 
clic droit sur l’aperçu dans le volet page et choisissez Renommer le masque dans le menu 
contextuel. La boîte de dialogue Renommer la diapo maîtresse s’ouvre (Figure 275).

 3) Saisissez le nouveau nom et cliquez sur OK pour enregistrer le nouveau nom et refermer la 
boîte de dialogue.

Figure 275 : La boîte de dialogue Renommer la diapo maîtresse

Supprimer une page maîtresse

L’entrée Supprimer le masque du menu contextuel et l’icône correspondante  de la barre 
d’outils Mode maître ne sont actives qui si votre dessin comporte plus d’une page maîtresse. Il 
n’est pas possible de supprimer la page maîtresse par défaut qui a été créée avec votre dessin.

 1) Passez en mode maître en sélectionnant Affichage > Masque dans la barre de menu.

 2) Sélectionnez la page maîtresse que vous voulez supprimer dans le volet page. Cliquez sur 
l’icône Supprimer le masque  de la barre d’outils Mode Masque, ou faites un clic droit 
sur l’aperçu dans le volet page et choisissez Supprimer le masque dans le menu 
contextuel.

Insérer des champs

Vous pouvez insérer des champs sur une page maîtresse en sélectionnant Insertion > Champ 
dans la barre de menu puis en choisissant un type de champ dans le menu déroulant. Les champs
suivants peuvent être insérés dans une page maîtresse.

• Date (fixe) : insère la date courante dans la page maîtresse en tant que valeur fixe. La date 
n’est pas mise à jour automatiquement.
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• Date (variable) : insère la date courante dans la page maîtresse en tant que valeur variable. 
La date est mise à jour automatiquement à l’ouverture du fichier.

• Heure (fixe) : insère l’heure courante dans la page maîtresse en tant que valeur fixe. L’heure 
n’est pas mise à jour automatiquement.

• Heure (variable) : insère l’heure courante dans la page maîtresse en tant que valeur variable.
L’heure est mise à jour automatiquement à l’ouverture du fichier.

• Auteur : insère le nom et le prénom de l’auteur du document. Cette information provient de 
Outils > Options > LibreOffice > Données d’identité où vous pouvez la saisir ou la 
modifier

• Numéro de page : insère le numéro de la page où le champ est placé. Pour modifier le 
format de la numérotation :

 a) Sélectionnez Page > Propriétés dans la barre de menu pour ouvrir la boîte de dialogue 
Mise en page (Figure 276). 

 b) Cliquez sur l’onglet Page et choisissez un format de numérotation dans la liste déroulante 
Numéros de page de la section Paramètres de mise en page.

Figure 276 : La boîte de dialogue Mise en page

• Titre de la page : insère le nom de la page. Sélectionnez Page > Renommer dans la vue 
Normale pour changer le nom par défaut dans la boîte de dialogue Renommer la diapo 
(Figure 277).

Figure 277 : La boîte de dialogue Renommer la diapo

• Nombre de pages : insère le nombre total de pages de votre dessin.
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• Nom de fichier : insère le nom du fichier contenant le dessin. Il n’apparaît qu’après 
enregistrement du document.

Éditer le format d’un champ

Le format des champs Date, Heure, Auteur et Nom de fichier peut être édité de la manière 
suivante dans une page maîtresse :

 1) Cliquez sur le champ pour le sélectionner.

 2) Sélectionnez son contenu.

 3) Choisissez Édition > Champ dans la barre de menu pour ouvrir la boîte de dialogue Éditer 
le champ (Figure 278).

 4) Choisissez une option dans les listes déroulantes Langue et Format.

 5) Cliquez sur OK pour enregistrer les modifications et refermer la boîte de dialogue.

Figure 278 : La boîte de dialogue Éditer le champ

Attribuer des pages maîtresses

Lorsque votre dessin comporte plusieurs pages maîtresses, vous pouvez attribuer une page 
maîtresse différente à chaque page du dessin.

 1) Assurez-vous que vous êtes en mode d’affichage normal (Affichage > Normal dans la barre
de menu) et sélectionnez la page à laquelle vous voulez attribuer une nouvelle page 
maîtresse.

 2) Faites alors un clic droit dans l’espace de travail et choisissez Changer de diapo maîtresse 
dans le menu contextuel. La boîte de dialogue Diapos maîtresses disponibles s’ouvre 
(Figure 279).

 3) Si nécessaire, l’option Échanger la page d’arrière-plan permet d’attribuer la page maîtresse 
sélectionnée à toutes les pages du document.

 4) Si nécessaire, l’option Supprimer les arrière-plans inutilisés permet de supprimer de la boîte 
de dialogue toutes les pages maîtresses qui n’ont pas été attribuées à une page du 
document.

 5) Dans le cas où le masque figure dans les choix proposés, sélectionnez-le, puis validez par 
OK.
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Figure 279 : La boîte de dialogue Diapos maîtresses disponibles

Charger des pages maîtresses depuis les modèles

Il est possible d’utiliser des pages maîtresses qui sont définies dans des modèles disponibles dans
LibreOffice. Toutes les pages maîtresses chargées dans votre dessin sont adaptées à la taille de la
page utilisée par celui-ci. De ce fait, certaines images peuvent être étirées pour s’y adapter.

 1) Passez en mode maître en sélectionnant Affichage > Masque dans la barre de menu.

 2) Faites un clic droit sur la page maîtresse affichée dans votre dessin et choisissez Changer 
de diapo maîtresse dans le menu contextuel pour ouvrir la boîte de dialogue Diapos 
maîtresses disponibles (Figure 279).

 3) Cliquez sur le bouton Charger pour ouvrir la boîte de dialogue Charger la diapo maîtresse 
(Figure 280).

 4) Choisissez une catégorie de modèles dans la liste Catégories.

 5) Sélectionnez une page maîtresse dans la liste Modèles. Un aperçu de celle-ci s’affiche sous 
les deux listes.

 6) Cliquez sur OK pour refermer la boîte de dialogue Charger la diapo maîtresse. Les pages 
maîtresses du modèle choisi s’affichent dans la boîte de dialogue Diapos maîtresses 
disponibles.

 7) Choisissez la page maîtresse que vous voulez utiliser dans la section Sélectionnez une 
ébauche de diapo.
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Figure 280 : La boîte de dialogue Charger la diapo maîtresse

 8) Si nécessaire, l’option Échanger la page d’arrière-plan permet d’attribuer la page maîtresse 
sélectionnée à toutes les pages du document.

 9) Si nécessaire, l’option Supprimer les arrière-plans inutilisés permet de supprimer de la boîte 
de dialogue toutes les pages maîtresses qui n’ont pas été attribuées à une page du 
document.

 10) Cliquez sur OK pour affecter la page maîtresse choisie à la page de votre dessin et refermer 
la boîte de dialogue.

Modèles

Un modèle est un prototype que vous utilisez pour créer d’autres documents. Par exemple, vous 
pouvez créer un modèle pour des dessins professionnels avec le logo et le nom de votre société 
sur la première page et les suivantes avec seulement le nom.

Les modèles peuvent contenir tout ce qu’un document ordinaire peut comporter, par exemple du 
texte, des images, un ensemble de styles et des informations de paramétrage propres à 
l’utilisateur telles que des unités de mesure, une langue, l’imprimante par défaut et une 
personnalisation des barres d’outils et des menus.

• Vous pouvez créer un modèle particulier pour chaque type de document (texte, classeur, 
dessin ou présentation).

268 | Chapitre 11 Techniques avancées



• Si vous ne spécifiez pas de modèle quand vous commencez un nouveau dessin ou un 
nouveau document, celui-ci sera basé sur un ensemble de propriétés incorporées par défaut 
à LibreOffice.

• Vous pouvez créer un modèle par défaut pour vos dessins. Voir « Modèle par défaut », 
page 272 pour plus d’informations.

• Pour plus d’informations sur les modèles et les autres sources de modèles, voir le chapitre 3,
Styles et Modèles, du Guide du débutant.

Créer des modèles

 1) Ouvrez le dessin que vous voulez utiliser comme modèle ou ouvrez et modifiez un modèle 
dont vous souhaitez vous servir comme base pour le nouveau modèle.

 2) Ajoutez un contenu et des styles supplémentaires ou modifiez ceux qui existent.

 3) Pour enregistrer votre modèle, ouvrez la boîte de dialogue Enregistrer comme modèle 
(Figure 281) par une des méthodes suivantes :

Figure 281 : La boîte de dialogue Enregistrer comme modèle

– sélectionnez Fichier > Modèles > Enregistrer comme modèle dans la barre de menu ;

– cliquez sur le petit triangle à droite de l’icône Enregistrer ▼ dans la barre d’outils 
Standard et choisissez Enregistrer comme modèle dans le menu déroulant.

 4) Saisissez le nom de votre modèle dans le champ Nom du modèle.

 5) Sélectionnez une catégorie où vous souhaitez enregistrer votre modèle dans la liste 
correspondante.

 6) Si vous voulez utiliser ce modèle comme modèle par défaut dans Draw, cochez l’option 
Définir comme modèle par défaut.

 7) Cliquez sur Enregistrer pour enregistrer votre modèle et refermer la boîte de dialogue.

Vous pouvez aussi utiliser la boîte de dialogue Enregistrer sous (Figure 282) pour enregistrer votre
modèle :
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Figure 282 : La boîte de dialogue Enregistrer sous

 1) Ouvrez la boîte de dialogue Enregistrer sous par l’une des méthodes suivantes :

– sélectionnez Fichier > Enregistrer sous dans la barre de menu ;

– cliquez sur le petit triangle à droite de l’icône Enregistrer ▼ dans la barre d’outils 
Standard et choisissez Enregistrer sous dans le menu déroulant.

 2) Recherchez le dossier où sont enregistrés les modèles de LibreOffice. Celui-ci dépend du 
système d’exploitation de votre ordinateur et de son paramétrage.

! Attention

Quand vous utilisez la boîte de dialogue Enregistrer sous, vous devez placer vos modèles 
dans le dossier des modèles de LibreOffice pour que la boîte de dialogue Modèles les 
reconnaisse et les retrouve.

 3) Dans la liste déroulante Type, choisissez Modèle de dessin ODF (*.otg).

 4) Saisissez le nom du fichier avec l’extension .otg dans le champ Nom du fichier.

 5) Cliquez sur OK pour enregistrer votre modèle et refermer la boîte de dialogue.
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Utiliser les modèles

Avec le centre de démarrage

Si LibreOffice n’est pas ouvert, ouvrez-le et choisissez un modèle parmi tous les modèles 
disponibles pour tous les modules (en cliquant sur Modèles) ou uniquement parmi ceux qui sont 
disponibles pour Draw (en cliquant sur la flèche à droite de Modèles pour en sélectionnant 
Modèles Draw dans la liste déroulante).

Avec la boîte de dialogue Modèles

Si Draw est déjà ouvert, au lieu d’utiliser les paramètres par défaut pour créer un nouveau dessin, 
partez d’un modèle :

 1) Ouvrez la boîte de dialogue Modèles (Figure 283) grâce à une des méthodes suivantes :

– sélectionnez Fichier > Nouveau > Modèles dans la barre de menu,

– sélectionnez Fichier > Modèles > Gérer les modèles dans la barre de menu,

– appuyez sur les touches Maj+Ctrl+N.

Figure 283 : La boîte de dialogue Modèles

 2) Utilisez les listes Filtres pour sélectionner les modèles du module Draw (Dessins) et une 
catégorie de modèle.

 3) Cliquez sur ouvrir pour créer le nouveau dessin dans Draw et refermer la boîte de dialogue.

Avec la boîte de dialogue d’ouverture de fichier

Si vous connaissez le dossier qui contient le modèle que vous voulez utiliser pour un nouveau 
dessin, procédez comme ceci :

 1) Sélectionnez Fichier > Modèles > Ouvrir un modèle dans la barre de menu pour ouvrir la 
boîte de dialogue Ouvrir (Figure 284).
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Figure 284 : La boîte de dialogue Ouvrir

 2) Recherchez le dossier où se situe le modèle.

 3) Sélectionnez le modèle que vous souhaitez utiliser.

 4) Cliquez sur Ouvrir pour ouvrir le modèle dans Draw et refermer la boîte de dialogue.

 5) Sélectionnez Fichier > Enregistrer sous dans la barre de menu pour ouvrir la boîte de 
dialogue Enregistrer sous (Figure 282, page 270).

 6) Dans la liste Type, sélectionnez Dessin ODF (*.odg) comme type de fichier.

 7) Saisissez un nom de fichier avec l’extension .odg dans le champ Nom du fichier.

 8) Cliquez sur Enregistrer pour sauvegarder votre nouveau dessin et refermer la boîte de 
dialogue.

Modèle par défaut

Si vous créez un nouveau dessin sans choisir de modèle, LibreOffice utilise un ensemble de 
propriétés qui sont incorporées au logiciel. Mais vous pouvez définir n’importe quel modèle comme
modèle par défaut, même un modèle que vous avez créé, du moment qu’il est situé dans une 
catégorie affichée dans la boîte de dialogue Modèles (Figure 283, page 271).

Définir un modèle par défaut

Pour définir le modèle par défaut utilisé pour vos nouveaux dessins, procédez comme ceci :

 1) Ouvrez la boîte de dialogue Modèles (Figure 283, page 271) grâce à une des méthodes 
suivantes :

– sélectionnez Fichier > Nouveau > Modèles dans la barre de menu,
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– sélectionnez Fichier > Modèles > Gérer les modèles dans la barre de menu,

– appuyez sur les touches Maj+Ctrl+N.

 2) Utilisez les listes Filtres pour sélectionner les modèles du module Draw (Dessins) et une 
catégorie de modèle.

 3) Sélectionnez un modèle

 4) Faites un clic droit sur le modèle sélectionné et choisissez Définir par défaut dans le menu 
contextuel. Aucune confirmation n’apparaît et le modèle choisi devient le modèle par défaut 
pour les nouveaux dessins. Le modèle par défaut est indiqué par une marque en haut à 
gauche de son icône (Figure 285).

Figure 285 : Le modèle par défaut dans la boîte de dialogue Modèles

 5) Cliquez sur Annuler pour refermer la boîte de dialogue. Le prochain dessin que vous 
créerez sera basé sur le nouveau modèle par défaut.

Remarque

Si vous avez créé un nouveau dessin que vous voulez utiliser comme modèle par défaut, 
vous devez d’abord l’enregistrer comme modèle avant de pouvoir l’utiliser comme modèle 
par défaut. Voir « Créer des modèles », page 269, pour plus d’informations.

Rétablir le modèle par défaut d’origine

Pour rétablir les propriétés par défaut pour la création de nouveaux dessins :

 1) Ouvrez la boîte de dialogue Modèles (Figure 283, page 271) grâce à une des méthodes 
suivantes :

– sélectionnez Fichier > Nouveau > Modèles dans la barre de menu,

– sélectionnez Fichier > Modèles > Gérer les modèles dans la barre de menu,

– appuyez sur les touches Maj+Ctrl+N.

 2) Faites un clic droit sur le modèle par défaut qui est indiqué par une marque en haut à gauche
de son icône (Figure 285).

 3) Sélectionnez Enlever par défaut dans le menu contextuel. Les propriétés par défaut de 
Draw pour la création de nouveaux dessins sont rétablies sans confirmation.

 4) Cliquez sur Annuler pour refermer la boîte de dialogue. Le prochain dessin que vous 
créerez sera basé sur les propriétés par défaut intégrées à Draw.
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Éditer les modèles

Vous pouvez modifier les styles et le contenu des modèles, puis, si vous le désirez, appliquer de 
nouveau les styles modifiés du modèle aux dessins qui ont été créés en le prenant pour base.

Remarque

Vous ne pouvez réappliquer que les styles, pas le contenu du modèle.

Édition

 1) Ouvrez la boîte de dialogue Modèles (Figure 283, page 271) grâce à une des méthodes 
suivantes :

– sélectionnez Fichier > Nouveau > Modèles dans la barre de menu,

– sélectionnez Fichier > Modèles > Gérer les modèles dans la barre de menu,

– appuyez sur les touches Maj+Ctrl+N.

 2) Retrouvez le modèle que vous voulez modifier et sélectionnez-le.

 3) Faites un clic droit sur le modèle sélectionné et choisissez Éditer dans le menu contextuel.

 4) Modifier le modèle comme vous le feriez pour n’importe quel dessin.

 5) Sélectionnez Fichier > Enregistrer dans la barre de menu ou appuyez sur les touches 
Ctrl+S pour enregistrer le modèle.

 6) Pour enregistrer le modèle modifié sous un nouveau nom, voyez « Créer des modèles », 
page 269 pour plus d’informations.

Mise à jour des documents créés à partir du modèle modifié

Quand vous ouvrez de nouveau pour la première fois un dessin qui a été créé à partir du modèle 
modifié, il vous est demandé de confirmer si vous voulez actualiser les styles utilisés dans votre 
dessin ou conserver les anciens styles (Figure 286).

Figure 286 : La boîte de dialogue de confirmation après modification d’un modèle

• Cliquez sur Actualiser les styles pour mettre à jour dans le document tous les styles qui ont
été modifiés dans le modèle et refermer la boîte de dialogue.

• Cliquez sur Conserver les anciens styles si vous ne voulez pas modifier les styles du 
document qui ont été modifiés dans le modèle et refermer la boîte de dialogue.
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Remarque

Si vous choisissez Conserver les anciens styles, la boîte de dialogue de confirmation 
n’apparaîtra plus aux ouvertures suivantes du document après modification du modèle sur 
lequel il est basé. Vous n’aurez pas d’autre occasion de mettre à jour les styles à partir du 
modèle.

Organiser les modèles

LibreOffice ne peut utiliser que les modèles qui sont dans ses dossiers de modèles (catégories). 
Vous pouvez créer de nouveaux dossiers de modèles (catégories) et les utiliser pour organiser vos
modèles. Par exemple, créer des catégories différentes pour différents projets ou différents clients.
Vous pouvez aussi importer et exporter des modèles.

Conseil

L’emplacement des dossiers de modèles de LibreOffice varie avec le système d’exploitation 
de votre ordinateur. Pour savoir où les dossiers des modèles sont stockés dans votre 
ordinateur, sélectionnez Outils > Options dans la barre de menu puis ouvrez la page 
LibreOffice – Chemins de la boîte de dialogue Options.

Créer des dossiers de modèles

 1) Ouvrez la boîte de dialogue Modèles (Figure 283, page 271) grâce à une des méthodes 
suivantes :

– sélectionnez Fichier > Nouveau > Modèles dans la barre de menu,

– sélectionnez Fichier > Modèles > Gérer les modèles dans la barre de menu,

– appuyez sur les touches Maj+Ctrl+N.

 2) Utilisez les listes Filtres pour sélectionner les modèles du module Draw (Dessins).

 3) Cliquez sur le bouton Paramètres et sélectionnez Nouvelle catégorie dans le menu 
déroulant (Figure 287).

Figure 287 : Menu déroulant du bouton Paramètres

 4) Saisissez le nom de la nouvelle catégorie dans la boîte de dialogue qui s’ouvre.

 5) Cliquez sur OK pour enregistrer la nouvelle catégorie (dossier) dans LibreOffice et refermer 
la boîte de dialogue.
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Remarque

Il n’est pas possible de créer une nouvelle sous-catégorie à l’intérieur des catégories 
existantes de LibreOffice. Toute catégorie de modèles créée est ajoutée à la liste des 
catégories dans la boîte de dialogue Modèles.

Renommer une catégorie

Il est recommandé de ne renommer que les catégories (dossiers) de modèles que vous avez 
créées. Renommer les dossiers de modèles de LibreOffice pourrait provoquer des problèmes avec
les autres modules.

 1) Ouvrez la boîte de dialogue Modèles (Figure 283, page 271) grâce à une des méthodes 
suivantes :

– sélectionnez Fichier > Nouveau > Modèles dans la barre de menu,

– sélectionnez Fichier > Modèles > Gérer les modèles dans la barre de menu,

– appuyez sur les touches Maj+Ctrl+N.

 2) Utilisez les listes Filtres pour sélectionner les modèles du module Draw (Dessins) et la 
catégorie que vous voulez renommer.

 3) Cliquez sur le bouton Paramètres et sélectionnez Renommer la catégorie dans le menu 
déroulant (Figure 287).

 4) Saisissez le nouveau nom de la catégorie dans la boîte de dialogue qui s’ouvre.

 5) Cliquez sur OK pour enregistrer la nouvelle catégorie (dossier) dans LibreOffice et refermer 
la boîte de dialogue.

Supprimer des dossiers de modèles

Il n’est pas possible de supprimer les dossiers de modèles fournis avec LibreOffice ou installés 
grâce au gestionnaire des extensions. Vous ne pouvez supprimer que les dossiers que vous avez 
créés.

 1) Ouvrez la boîte de dialogue Modèles (Figure 283, page 271) grâce à une des méthodes 
suivantes :

– sélectionnez Fichier > Nouveau > Modèles dans la barre de menu,

– sélectionnez Fichier > Modèles > Gérer les modèles dans la barre de menu,

– appuyez sur les touches Maj+Ctrl+N.

 2) Utilisez les listes Filtres pour sélectionner les modèles du module Draw (Dessins) et la 
catégorie que vous voulez renommer.

 3) Cliquez sur le bouton Paramètres et sélectionnez Supprimer la catégorie dans le menu 
déroulant (Figure 287).

 4) Sélectionnez la catégorie que vous voulez supprimer dans la boîte de dialogue qui s’ouvre 
(Figure 288).

 5) Cliquez sur OK pour supprimer la catégorie et refermer la boîte de dialogue.

 6) Cliquez sur Oui pour confirmer la suppression du dossier.
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Figure 288 : La boîte de dialogue Supprimer une catégorie

Déplacer des modèles

Pour déplacer un modèle d’un dossier de modèles à un autre :

 1) Ouvrez la boîte de dialogue Modèles (Figure 283, page 271) grâce à une des méthodes 
suivantes :

– sélectionnez Fichier > Nouveau > Modèles dans la barre de menu,

– sélectionnez Fichier > Modèles > Gérer les modèles dans la barre de menu,

– appuyez sur les touches Maj+Ctrl+N.

 2) Utilisez les listes Filtres pour sélectionner les modèles du module Draw (Dessins) et la 
catégorie que vous voulez déplacer.

 3) Cliquez sur le bouton Déplacer (Figure 283, page 271) et la boîte de dialogue Choisir une 
catégorie (Figure 289) s’ouvre.

Figure 289 : La boîte de dialogue Choisir une catégorie

 4) Faites votre choix parmi les catégories existantes ou créez une nouvelle catégorie en 
saisissant son nom dans le champ prévu à cet effet.

 5) Cliquez sur OK pour déplacer le modèle et refermer la boîte de dialogue.
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Supprimer des modèles

Il n’est pas possible de supprimer les modèles fournis avec LibreOffice ou installés grâce au 
gestionnaire des extensions. Vous ne pouvez supprimer que les dossiers que vous avez créés ou 
importés. Cependant, les administrateurs du système peuvent supprimer ou ajouter manuellement 
des modèles dans le dossier d’installation de LibreOffice.

 1) Ouvrez la boîte de dialogue Modèles (Figure 283, page 271) grâce à une des méthodes 
suivantes :

– sélectionnez Fichier > Nouveau > Modèles dans la barre de menu,

– sélectionnez Fichier > Modèles > Gérer les modèles dans la barre de menu,

– appuyez sur les touches Maj+Ctrl+N.

 2) Utilisez les listes Filtres pour sélectionner les modèles du module Draw (Dessins) et la 
catégorie où se trouve le modèle.

 3) Faites un clic droit sur le modèle que vous voulez effacer et choisissez Supprimer dans le 
menu contextuel.

 4) Cliquez sur Oui pour confirmer la suppression du modèle et refermer la boîte de dialogue.

 5) Cliquez sur Annuler pour refermer la boîte de dialogue Modèles.

Importer des modèles

Si le modèle que vous désirez utiliser est situé à un emplacement différent, vous devez l’importer 
dans un dossier de modèles de LibreOffice.

 1) Ouvrez la boîte de dialogue Modèles (Figure 283, page 271) grâce à une des méthodes 
suivantes :

– sélectionnez Fichier > Nouveau > Modèles dans la barre de menu,

– sélectionnez Fichier > Modèles > Gérer les modèles dans la barre de menu,

– appuyez sur les touches Maj+Ctrl+N.

 2) Cliquez sur le bouton Importer et la boîte de dialogue Choisir une catégorie (Figure 289) 
s’ouvre.

 3) Faites votre choix parmi les catégories existantes ou créez une nouvelle catégorie en 
saisissant son nom dans le champ prévu à cet effet.

 4) Cliquez sur OK et une boîte de dialogue d’ouverture standard s’ouvre.

 5) Recherchez le modèle que vous voulez importer et cliquez sur Ouvrir. La boîte de dialogue 
se referme et le modèle apparaît dans la catégorie choisie.

Vous pouvez aussi cliquer sur le bouton Parcourir les modèles en ligne  pour ouvrir votre 
navigateur à la page des modèles de LibreOffice où vous pourrez télécharger celui que vous 
souhaitez dans un dossier de votre ordinateur. Appliquez ensuite la procédure précédente pour 
importer ce modèle dans LibreOffice.
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Remarque

Le gestionnaire des extensions offre un moyen simple pour importer et installer des 
collections de modèles qui ont été empaquetés comme extensions. Pour plus d’informations
sur le gestionnaire des extensions, voir le Guide du débutant.

Exporter des modèles

 1) Ouvrez la boîte de dialogue Modèles (Figure 283, page 271) grâce à une des méthodes 
suivantes :

– sélectionnez Fichier > Nouveau > Modèles dans la barre de menu,

– sélectionnez Fichier > Modèles > Gérer les modèles dans la barre de menu,

– appuyez sur les touches Maj+Ctrl+N.

 2) Utilisez les listes Filtres pour sélectionner les modèles du module Draw (Dessins) et la 
catégorie où se trouve le modèle.

 3) Sélectionnez le modèle que vous voulez exporter et cliquez sur le bouton Exporter. Une 
boîte de dialogue de sélection de dossiers s’ouvre.

 4) Recherchez le dossier où vous voulez exporter le modèle et cliquez sur Sélectionner un 
dossier. La boîte de dialogue se referme et le modèle apparaît dans le dossier choisi.

 5) Cliquez sur OK pour refermer la boîte de dialogue d’information.

Couches multiples

Les couches de LibreOffice Draw vous permettent d’assembler dans une page de dessin des 
éléments qui sont liés. Vous pouvez considérer les couches comme des espaces de travail 
individuels que vous pouvez masquer à l’affichage, masquer à l’impression ou verrouiller.

Les couches ne déterminent pas l’ordre d’empilement des objets dans votre dessin, sauf pour les 
objets de la couche Contrôles qui sont toujours placés devant ceux des autres couches. L’ordre 
d’empilement des objets de votre page de dessin est déterminé par l’ordre de leur création. Vous 
pouvez le modifier en sélectionnant Forme > Disposition dans la barre de menu. Pour gérer les 
empilements d’objets, voir le chapitre 5, Combiner plusieurs objets, page 128.

Les couches apparaissent sous forme d’onglets en bas de l’espace de travail, au-dessus de la 
barre d’état. Cliquez sur un onglet pour sélectionner la couche correspondante. Des boutons de 
navigation sont disponibles si nécessaire à gauche de ces onglets. La Figure 290 montre la 
couche Mise en page sélectionnée.

Figure 290 : Les onglets des couches
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Remarque

Il est possible de verrouiller une couche pour protéger son contenu ou de la masquer à 
l’affichage ou à l’impression. Une couche, au moment de sa création, est ajoutée à toutes 
les pages de votre document. Cependant, lorsque vous ajoutez un objet à une couche, il 
n’est ajouté qu’à la page en cours.

Si vous voulez qu’un objet apparaisse sur toutes les pages (le logo d’une société par 
exemple), ajoutez-le à la page maîtresse en sélectionnant Affichage > Masque dans la 
barre de menu. Pour revenir à votre dessin, choisissez Affichage > Normal (voir « Pages 
maîtresses » page 263).

Couches par défaut

LibreOffice Draw dispose par défaut de trois couches qui ne peuvent être ni supprimées, ni 
renommées.

• Mise en page est l’espace de travail par défaut et détermine l’emplacement de l’ensemble 
des objets de votre dessin.

• Contrôles est utilisée pour les contrôles de formulaire auxquels vous associez une action, 
mais que vous ne voulez pas voir apparaître à l’impression. Modifiez alors cette couche pour
qu’elle ne soit pas imprimable. Les objets de cette couche sont toujours situés à l’avant des 
objets des autres couches.

• Lignes de cote est la couche où les lignes de cote sont dessinées. En modifiant les attributs 
de cette couche, vous pouvez facilement faire apparaître ou masquer ces lignes de cote.

En mode d’affichage Masque, la couche Objets d’arrière-plan est celle où vous pouvez placer les 
objets que vous voulez voir apparaître sur toutes les pages de votre dessin, par exemple la date, 
le numéro de page, le titre du dessin, etc.

Insérer une couche

 1) Sélectionnez Insertion > Couche dans la barre de menu, ou faites un clic droit en bas de 
l’espace de travail (où se trouvent les onglets des couches ou à leur droite) et choisissez 
Insérer une couche dans le menu contextuel pour ouvrir la boîte de dialogue Insérer une 
couche (Figure 291).

 2) Saisissez, dans le champ Nom, un nom de couche plus significatif que le nom par défaut. 
Vous pouvez saisir, dans les champs correspondants, un titre et une description pour faciliter
la compréhension de votre dessin.

 3) Cochez l’option Visible pour que les objets de cette couche soient visibles à l’écran. Si cette 
option n’est pas cochée, le nom de la couche apparaît en bleu sur son onglet.

 4) Cochez l’option Imprimable pour que les objets de cette couche soient imprimés lors d’une 
impression. Rendre une couche non imprimable est utile si vous voulez disposer d’une 
couche qui comprend des objets utiles à l’élaboration de votre dessin, comme des guides ou 
des annotations, mais que vous ne voulez pas voir apparaître à l’impression. Le nom de la 
couche est souligné dans son onglet si l’option Imprimable n’est pas cochée.

 5) Cochez l’option Verrouillée pour que les objets de cette couche ne puissent pas être 
supprimés, modifiés ou déplacés. Il peut être utile, par exemple, de protéger un plan de base
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et d’utiliser une nouvelle couche pour ajouter des détails supplémentaires. Le nom d’une 
couche verrouillée est écrit en italique dans son onglet.

 6) Cliquez sur OK pour refermer la boîte de dialogue. La nouvelle couche est automatiquement 
active.

Figure 291 : La boîte de dialogue Insérer une couche

Modifier une couche

 1) Sélectionnez Format > Couche dans la barre de menu ou faites un clic droit sur l’onglet de 
la couche et choisissez Modifier la couche dans le menu contextuel pour ouvrir la boîte de 
dialogue Modifier la couche, qui est identique à celle de la Figure 291.

 2) Apportez les modifications voulues à la couche puis cliquez sur OK pour enregistrer les 
changements et refermer la boîte de dialogue.

Gérer les couches

Sélectionner une couche

Pour sélectionner une couche, cliquez sur son onglet en bas de l’espace de travail. Quand une 
couche est sélectionnée, les objets ajoutés à votre dessin ne le sont que dans celle-ci. Les 
contrôles de formulaire sont automatiquement ajoutés à la couche Contrôles et les lignes de cote à
la couche du même nom.

Si votre dessin comporte plusieurs couches, certaines ne peuvent pas être visibles dans la barre 
d’onglets. Utilisez les flèches de navigation à la droite de celle-ci pour atteindre la couche que vous
souhaitez utiliser ou modifier.

Masquer une couche

 1) Sélectionnez Format > Couche dans la barre de menu, faites un clic droit sur l’onglet de la 
couche et choisissez Modifier la couche dans le menu contextuel ou faites simplement un 
double-clic sur l’onglet de la couche pour ouvrir la boîte de dialogue Modifier la couche.
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 2) Décochez l’option Visible et cliquez sur OK. Le nom de la couche apparaît en bleu sur son 
onglet. Les objets de cette couche ne sont alors plus visibles.

Vous pouvez également cliquer sur l’onglet d’une couche en maintenant appuyée la touche Maj 
pour la masquer.

Afficher une couche masquée

 1) Sélectionnez Format > Couche dans la barre de menu, faites un clic droit sur l’onglet de la 
couche et choisissez Modifier la couche dans le menu contextuel ou faites simplement un 
double-clic sur l’onglet de la couche pour ouvrir la boîte de dialogue Modifier la couche.

 2) Cochez l’option Visible et cliquez sur OK. Le nom de la couche reprend alors sa couleur par 
défaut. Les objets de cette couche sont alors visibles.

Vous pouvez également cliquer sur l’onglet d’une couche en maintenant appuyée la touche Maj 
masquée pour l’afficher à nouveau.

Verrouiller une couche

 1) Sélectionnez Format > Couche dans la barre de menu, faites un clic droit sur l’onglet de la 
couche et choisissez Modifier la couche dans le menu contextuel ou faites simplement un 
double-clic sur l’onglet de la couche pour ouvrir la boîte de dialogue Modifier la couche.

 2) Cochez l’option Verrouillée et cliquez sur OK. Le nom de la couche est alors souligné dans 
son onglet. Verrouiller une couche empêche toute modification dans celle-ci.

Vous pouvez également cliquer sur l’onglet d’une couche en maintenant appuyée la touche Ctrl 
masquée pour la verrouiller.

Déverrouiller une couche

 1) Sélectionnez Format > Couche dans la barre de menu, faites un clic droit sur l’onglet de la 
couche et choisissez Modifier la couche dans le menu contextuel ou faites simplement un 
double-clic sur l’onglet de la couche pour ouvrir la boîte de dialogue Modifier la couche.

 2) Décochez l’option Verrouillée et cliquez sur OK. Le nom de la couche n’est plus souligné 
dans son onglet.

Vous pouvez également cliquer sur l’onglet d’une couche en maintenant appuyée la touche Ctrl 
verrouillée pour la verrouiller.

Renommer une couche

Faites un clic droit sur l’onglet de la couche et choisissez Renommer la couche dans le menu 
contextuel pour que le nom de l’onglet soit modifiable. Saisissez alors le nouveau nom et cliquez 
hors de l’onglet pour enregistrer la modification.

Vous pouvez renommer directement une couche en maintenant appuyée la touche Alt pendant 
que vous cliquez sur son nom dans l’onglet.

Vous pouvez également renommer une couche en utilisant la boîte de dialogue de modification : 
voir « Modifier une couche » page 281.
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Supprimer une couche

Faites un clic droit sur l’onglet de la couche et choisissez Supprimer la couche dans le menu 
contextuel. Un message apparaît vous demandant de confirmer la suppression. Cliquez sur Oui 
pour supprimer la couche et tous les objets qu’elle contient.

Remarque

Vous ne pouvez supprimer ou renommer que les couches que vous avez créées. Les 
couches par défaut Mise en page, Contrôles et Lignes de cote ne peuvent pas être 
supprimées.

Déplacer des objets d’une couche à une autre

Si un objet ou un groupe d’objets est sélectionné, la couche où il est situé est indiquée à 
l’extrémité gauche de la barre d’état (Figure 290, page 279). Déplacer un objet ou un groupe 
d’objets d’une couche à une autre en utilisant une des méthodes suivantes :

• Cliquez sur l’objet et maintenez le bouton de la souris enfoncé jusqu’à ce que la forme du 
pointeur change. Si le changement n’intervient pas, déplacez légèrement la souris. Sans 
relâcher le bouton, faites glisser la souris sur l’onglet affichant le nom de la couche dans 
laquelle vous souhaitez le placer. Relâchez le bouton. La position de l’objet ne change pas, 
mais la barre d’état affiche la nouvelle couche qui le contient.

Pour annuler l’opération sans déplacer l’objet, appuyez sur la touche Échap.

• Sélectionnez Édition > Couper dans la barre de menu ou faites un clic droit sur l’objet et 
choisissez Couper dans le menu contextuel. Cliquez sur l’onglet de la couche de destination
pour le rendre actif puis sélectionnez Édition > Coller dans la barre de menu ou faites un 
clic droit dans l’espace de travail et choisissez Coller dans le menu contextuel. La position 
de l’objet ne change pas, mais la barre d’état affiche la nouvelle couche qui le contient.

Cotations

Draw vous permet de dimensionner des objets (voir « Dessiner à l’échelle » page 288) et 
d’afficher ces dimensions au moyen de lignes de cote, afin que votre document ait l’aspect d’un 
dessin industriel. Lorsque vous créez des lignes de cote, elles sont automatiquement placées dans
la couche Lignes de cote : voir « Couches par défaut » page 280.

Configurer les lignes de cote

Deux méthodes permettent d’accéder aux options pour configurer les lignes de cote. Les deux 
méthodes utilisent une boîte de dialogue semblable où vous pouvez modifier la longueur, le 
système de mesures et les propriétés des lignes d’attache d’une ligne de cote.

Grâce aux styles de dessin

 1) Utilisez l’une des méthodes suivantes pour accéder à vos styles de dessin afin d’ouvrir la 
boîte de dialogue Styles pour objets graphiques (Figure 292) :

– sélectionnez Format > Styles > Éditer le style dans la barre de menu,

– ouvrez l’onglet Styles et formatage du volet latéral en cliquant sur l’icône Styles et 
formatage  dans le volet latéral ou dans la barre d’outils Ligne et remplissage, ou en 
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appuyant sur la touche F11, puis faites un clic droit sur un style et choisissez Modifier 
dans le menu contextuel.

 2) Ouvrez la page Cotation en cliquant sur son onglet.

 3) Effectuez les modifications souhaitées dans les diverses options des sections Ligne et 
Légende de la page Cotation.

 4) Cliquez sur OK pour enregistrer les changements et refermer la boîte de dialogue.

Pour redonner aux options de cotation les valeurs standard du modèle, ouvrez la boîte de dialogue
Styles pour objets graphiques comme indiqué ci-dessus et cliquez sur le bouton Standard.

Figure 292 : L’onglet Cotation de la boîte de dialogue Styles pour objets graphiques

Pour configurer une ligne de cote, faites un clic droit sur celle-ci et choisissez Cotations dans le 
menu contextuel. La boîte de dialogue Cotation s’ouvre (Figure 293). Un aperçu en bas de la boîte
permet de voir l’effet des paramétrages effectués.

Grâce à la boîte de dialogue Cotations

 1) Dessiner une ligne de cote. Voir « Créer une ligne de cote », page 287, pour plus 
d’informations.

 2) Faites un clic droit sur la ligne de cote et sélectionnez Cotations dans le menu contextuel 
pour ouvrir la boîte de dialogue Cotation (Figure 293).

 3) Effectuez les modifications souhaitées dans les diverses options de cette boîte de dialogue. 
Ces options sont les mêmes que celles de l’onglet Cotation de la boîte de dialogue Styles 
pour objets graphiques.
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 4) Cliquez sur OK pour enregistrer les changements et refermer la boîte de dialogue.

Figure 293 : La boîte de dialogue Cotation

Options applicables aux lignes de cote

Les options de paramétrage des lignes de cote proposées par l’onglet Cotation de la boîte de 
dialogue Styles pour objets graphiques (Figure 292) et par la boîte de dialogue Cotation (Figure 
293) sont présentées ci-dessous. Chaque boîte de dialogue offre un aperçu qui se modifie selon 
les choix effectués pour vous montrer comment la ligne de cote apparaîtra dans votre dessin. Un 
exemple de ligne de cote est proposé à la Figure 294.

Ligne de base
(non visible)Ligne de cote

Marqueurs de la ligne de base

Poignées inférieures de 
sélection de ligne d’attache

Ligne 
d’attache
gauche

Ligne 
d’attache
droite

Poignées supérieures de 
sélection de ligne d’attache

Figure 294 : Exemple de ligne de cote

Ligne
Cette section définit les distances entre la ligne de cote et les lignes d’attache, la ligne de 
base et l’objet. La ligne de base n’est pas visible dans le dessin, mais elle est indiquée par 
des points sur les lignes d’attache quand la ligne de cote est sélectionnée.
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– Distance de la ligne : ce champ indique la distance entre la ligne de cote et l’objet ou la 
ligne de base. Vous pouvez saisir une distance comprise entre −1 cm et 1 cm. Plus la 
valeur est proche de zéro, plus la ligne de cote est proche de l’objet ou de la ligne de 
base.

– Dépassement des repères  : ce champ indique la longueur des lignes d’attache gauche et 
droite au-dessus de la ligne de cote. Vous pouvez saisir une longueur entre −1 cm et 
1 cm. Une valeur positive étend les lignes d’attache au-dessus de la ligne de cote, tandis 
qu’une valeur négative laisse un espace entre les lignes d’attache et la ligne de cote.

– Écart des repères  : ce champ indique la distance entre le début des lignes d’attache 
gauche et droite et la ligne de base. Vous pouvez saisir une longueur entre −1 cm et 
1 cm. Une valeur positive laisse un espace entre le début des lignes d’attache et la ligne 
de base, tandis qu’une valeur négative étend les lignes d’attache au-delà de la ligne de 
base.

– Repère gauche  : ce champ indique un déplacement du début de la ligne d’attache gauche
par rapport à la ligne de base. Une valeur positive allonge la ligne d’attache vers la ligne 
de base, tandis qu’une valeur négative raccourcit la ligne d’attache.

– Repère droit  : ce champ indique un déplacement du début de la ligne d’attache droite par 
rapport à la ligne de base. Une valeur positive allonge la ligne d’attache vers la ligne de 
base, tandis qu’une valeur négative raccourcit la ligne d’attache.

– Mesurer en dessous de l’objet : cochez cette option pour déplacer le texte, les lignes de 
cote et d’attache en position symétrique par rapport à la ligne de base. Le texte reste 
affiché dans le sens lisible (il n’est pas « symétrisé »).

– Décimales : ce champ indique le nombre de décimales utilisé pour afficher la longueur de 
la ligne de cote.

Légende
Cette section définit les propriétés du texte de la cote.

– Position du texte : ce champ détermine la position du texte par rapport à la ligne de cote 
et aux lignes d’attache. Les options VerticalAuto et HorizontalAuto doivent être 
désactivées pour pouvoir modifier cette position.

– VerticalAuto : cochez cette option pour que Draw détermine automatiquement la position 
verticale optimale du texte de la ligne de cote.

– HorizontalAuto : cochez cette option pour que Draw détermine automatiquement la 
position horizontale optimale du texte de la ligne de cote.

– Parallèle à la ligne : si cette option est cochée, le texte est parallèle à la ligne de cote, 
sinon il est perpendiculaire à la ligne de cote.

– Afficher l’unité de mesure : si cette option est cochée, l’unité de mesure est affichée dans 
le texte de la ligne de cote. La liste déroulante permet de spécifier l’unité de mesure ou 
d’indiquer qu’elle est Automatique, c’est-à-dire qu’elle correspond à l’unité choisie dans 
Outils > Options > LibreOffice Draw > Général.
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Remarque

Les options de cotation sont toujours liées à la page de travail courante et stockées avec 
elle. Toutes les modifications que vous faites ne s’appliquent qu’à ce document. Les 
nouveaux documents commencent avec les propriétés standard de Draw. Si vous désirez 
utiliser ces options de cotation dans de futurs dessins, enregistrez celui-ci comme modèle.

Les poignées de sélection des lignes d’attache

Les poignées de sélection en haut et en bas des lignes d’attache servent à les prolonger au-delà 
de la limite de −1 à 1 cm imposée par les boîtes de dialogue décrites ci-dessus.

Les poignées de sélection des lignes d’attache (voir Figure 294, page 285) s’utilisent comme ceci :

• Poignées supérieures de sélection de ligne d’attache : sélectionnez une des poignées et 
tirez-la pour augmenter ou diminuer la distance entre la ligne de cote et la ligne de base 
(champ Distance de la ligne).

• Poignées inférieures de sélection de ligne d’attache : sélectionnez une des poignées et tirez-
la pour augmenter ou diminuer la distance entre le début de la ligne d’attache du côté choisi 
et la ligne de base (champ Repère gauche ou Repère droit).

Conseil

Pour dessiner les lignes de cote d’un objet, il est recommandé d’utiliser la fonction zoom, les
lignes guide et les fonctions de capture pour pouvoir les positionner avec précision sur 
l’objet. Voyez le chapitre 3, Travailler avec les objets et les points des objets, page 56, pour 
plus d’informations.

Créer une ligne de cote

Pour tracer une ligne de cote :

 1) Cliquez sur le petit triangle à droite de l’icône Lignes et flèches (initialement ▼) de la 
barre d’outils Dessin pour ouvrir la palette Lignes et flèches (Figure 295) ou ouvrez l’onglet 
Forme du volet latéral.

Remarque

L’icône de la barre d’outils Lignes et flèches changent en fonction du dernier outil utilisé. De 
plus, vous pouvez la transformer en barre d’outils en cliquant en haut de la palette et en 
tirant celle-ci dans l’espace de travail.

 2) Cliquez sur l’icône Ligne de cote ( ) et le pointeur de la souris prend alors normalement la
forme d’une croix, mais celle-ci peut changer selon le système d’exploitation de votre 
ordinateur.

Figure 295 : La barre d’outils Lignes et flèches
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 3) Cliquez à l’endroit où vous voulez que la ligne de cote débute et tirez le pointeur jusqu’à 
l’endroit où vous voulez que la ligne se termine. Relâchez le bouton de la souris : la ligne de 
cote est alors créée (Figure 296) dans la couche Lignes de cote. Voir « Couches par 
défaut », page 280, pour plus d’informations.

4,5 cm

3 
cm

Figure 296 : Exemple de cotation

Si vous maintenez la touche Maj appuyée durant le tracé de la ligne, cela restreint son angle
à un multiple de 45 degrés (0, 45, 90, 135, etc.).

! Attention

Ceci est le comportement par défaut de la touche Maj. Cependant, si l’option Lors de la 
création ou du déplacement des objets de la section Contraindre les objets de la page 
LibreOffice Draw – Grille est cochée dans la boîte de dialogue Options (Outils > Options), 
l’action de la touche Maj est inversée. Les lignes seront automatiquement tracées avec un 
angle multiple de 45 degrés, à moins que la touche Maj ne soit appuyée.

Lors du dessin d’une ligne de cote, il faut distinguer le tracé de la ligne de cote et sa ligne de 
base (Figure 294, page 285). Le début et la fin de la ligne de base correspondent aux 
endroits où vous avez cliqué et où vous avez relâché le bouton de la souris. Le tracé de la 
ligne de cote s’éloigne de la ligne de base de la distance indiquée par le champ Distance de 
la ligne : voir « Configurer les lignes de cote » page 283.

Pour modifier le texte de la dimension, faites un double-clic sur une ligne de cote non sélectionnée 
pour mettre le texte en mode d’édition puis effectuez les changements voulus. Cliquez hors de la 
ligne de cote pour enregistrer ces modifications.

Vous pouvez également formater la ligne de cote comme n’importe quelle autre ligne, en utilisant 
l’outil Ligne de la barre d’outils Ligne et remplissage par exemple.

Pour configurer la ligne de cote, voir « Configurer les lignes de cote » page 283, pour plus 
d’informations.

Dessiner à l’échelle

Le dessin dans Draw s’effectue sur une page au format défini, A4 par exemple. Cependant, la taille
des objets que vous voulez dessiner ne correspond pas forcément à ce format. Vous pouvez alors 
utiliser une échelle (1:10 ou 2:1 par exemple) pour réduire ou agrandir votre dessin.

Vous pouvez spécifier une valeur d’échelle en ouvrant la page LibreOffice Draw – Général de la 
boîte de dialogue Options (Outils > Options) et en sélectionnant une valeur dans la liste 
déroulante Échelle de dessin (Figure 297). La valeur par défaut de cette option est 1:1 ; elle 
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correspond à un dessin en taille réelle. Une modification de la valeur d’échelle se répercute dans 
les règles en haut et à gauche de votre dessin.

Figure 297 : La page LibreOffice Draw – Général de la boîte de dialogue Options

Une modification d’échelle n’a pas d’effet sur les opérations de dessin de base. Draw recalcule 
automatiquement les valeurs nécessaires. L’espacement des points de la grille est indépendant de
l’échelle, la grille étant une aide visuelle et non un élément de dessin.

Une une échelle plus petite que 1 (1:4 par exemple) vous permet de dessiner des objets qui ne 
tiendraient pas dans votre feuille. Une échelle plus grande que 1 (4:1 par exemple) vous permet de
dessiner des petits objets plus précisément et de les restituer avec de plus grandes dimensions, 
afin qu’ils soient plus facilement compréhensibles. La Figure 298 illustre ces possibilités.

   
Figure 298 : Exemple d’une figure à 3 échelles différentes

Vues

Vous pouvez afficher plusieurs vues du même document. Elles peuvent avoir des réglages 
différents des couches visibles, imprimables ou verrouillées, des facteurs de zoom différents, des 
origines différentes et vous pouvez même utiliser une page maîtresse et une page normale en 
même temps. Comme le format du document ne peut contenir qu’une seule vue, assurez-vous que
la vue que vous voulez enregistrer est bien la vue active à ce moment-là.
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Pour ouvrir une nouvelle vue, sélectionnez Fenêtre > Nouvelle fenêtre dans la barre de menu. 
Disposez les fenêtres comme votre système d’exploitation le permet. Les fenêtres agissent sur le 
même document : une modification de celui-ci dans une fenêtre est immédiatement reflété dans 
les autres.

La galerie

Draw offre plusieurs images dans la galerie. Elles sont groupées par thèmes (par exemple, 
Flèches, Puces, Ordinateurs, Diagrammes, Environnement, etc.). L’onglet Galerie du volet latéral 
(Figure 299) liste des thèmes proposés. Cliquez sur un thème pour afficher ses images sous la 
liste.

Figure 299 : L’onglet Galerie dans le volet latéral

Vous pouvez créer des thèmes et ajouter des images aux nouveaux thèmes de la galerie. Pour 
plus d’informations sur la création de thèmes et l’ajout d’images, voir « Créer des thèmes et 
ajouter des images », page 291.

Vous pouvez aussi supprimer des images et des thèmes de la galerie. Pour plus d’informations sur
la suppression de thèmes et d’images, voir « Supprimer des thèmes et des images de la 
galerie », page 292.

Remarque

Il est recommandé de ne pas supprimer les images et les thèmes faisant partie de 
l’installation par défaut de LibreOffice. Leur suppression pourrait poser des problèmes dans 
d’autres modules où les thèmes et images par défaut de la galerie ont été utilisés.

Utiliser la galerie

 1) Utilisez une des méthodes suivantes pour ouvrir l’onglet Galerie du volet latéral (Figure 
299) :

– cliquez sur l’icône de la galerie  dans le volet latéral,

– sélectionnez Insertion > Média > Galerie dans la barre de menu.

 2) Choisissez un thème dans la liste en haut de l’onglet Galerie.
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 3) Utilisez une des méthodes suivantes pour insérer une image dans votre dessin :

– cliquez sur une image dans l’onglet Galerie et tirez-la dans votre dessin ;

– faites un clic droit sur une image et choisissez Insérer dans le menu contextuel : l’image 
est placée au centre de votre dessin ;

– faites un clic droit sur une image et choisissez Copier dans le menu contextuel puis collez
le contenu du presse-papiers : l’image est placée au centre de l’espace de travail.

 4) Modifiez l’image de la galerie à votre convenance. Pour plus d’informations sur l’édition des 
images, voir le chapitre 6, Éditer des images, page 133.

Créer des thèmes et ajouter des images

 1) Utilisez une des méthodes suivantes pour ouvrir l’onglet Galerie du volet latéral (Figure 299, 
page 290) :

– cliquez sur l’icône de la galerie  dans le volet latéral,

– sélectionnez Insertion > Média > Galerie dans la barre de menu.

 2) Cliquez sur Nouveau thème en haut de l’onglet Galerie pour ouvrir la boîte de dialogue 
Propriétés de « Nouveau thème » (Figure 300).

Figure 300 : La boîte de dialogue Propriétés de « Nouveau thème ».

 3) Tapez un nom significatif dans le champ de saisie à la place de Nouveau thème.

 4) Cliquez sur OK pour enregistrer le nouveau thème et refermer la boîte de dialogue.

 5) Faites un clic droit sur le nouveau nom que vous venez de créer et sélectionnez Propriétés 
dans le menu contextuel pour ouvrir de nouveau la boîte de dialogue Propriétés du thème, 
puis cliquez sur l’onglet Fichiers pour ouvrir la page correspondante (Figure 301).

 6) Cliquez sur le bouton Rechercher des fichiers pour ouvrir une boîte de dialogue qui vous 
permet de choisir un dossier.

 7) Recherchez le dossier qui contient les images que vous souhaitez utiliser puis cliquez sur 
Sélectionner un dossier.

La boîte de dialogue Sélectionner un dossier se referme et la liste des fichiers contenue 
dans le dossier choisi s’inscrit dans la boîte de dialogue Propriétés du thème.

 8) Choisissez les fichiers que vous voulez voir dans la galerie et cliquez sur Ajouter. Les 
fichiers sélectionnés disparaissent de la liste et leurs images apparaissent dans la galerie.
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Si vous voulez ajouter tous les fichiers de la liste, cliquez sur Ajouter tout. Tous les fichiers 
disparaissent de la liste et leurs images apparaissent dans la galerie.

 9) Cliquez sur OK quand vous avez terminé pour refermer la boîte de dialogue Propriétés du 
thème.

Figure 301 : L’onglet Fichiers de la boîte de dialogue Propriété du thème.

Supprimer des thèmes et des images de la galerie

 1) Faites un clic droit sur un thème ou une image de la galerie.

 2) Sélectionnez Supprimer dans le menu contextuel.

 3) Cliquez sur Oui dans le message de confirmation qui apparaît et l’image ou le thème est 
supprimé.

Remarque

L’image est un lien vers un fichier et seul ce lien est supprimé de la galerie. Le fichier 
contenant l’image vers lequel il pointait reste présent.

Mettre à jour la galerie

Toutes les images de la galerie sont des fichiers liés. De temps en temps, il peut être utile de 
mettre à jour un thème que vous avez créé pour vous assurer que tous les fichiers sont toujours 
présents. Pour cela, faites un clic droit sur le thème que vous avez créé et auquel vous avez ajouté
au moins un fichier et sélectionnez Actualiser dans le menu contextuel.
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Renommer des thèmes

Pour renommer un thème que vous avez créé, faites un clic droit sur son nom et sélectionnez 
Renommer dans le menu contextuel.

Remarque

Il est recommandé de ne pas renommer les thèmes ou les images qui font partie de 
l’installation par défaut de LibreOffice. Un changement de nom pourrait poser des problèmes
aux autres modules qui utiliseraient ces thèmes ou ces images par défaut.

Utiliser des objets de dessin avec la galerie

Il est possible d’ajouter des objets de dessin à la galerie aussi bien que des images :

 1) Sélectionnez le thème dans lequel vous voulez ajouter l’objet de dessin ou créez-en un 
nouveau.

 2) Cliquez sur l’objet de dessin que vous avez créé et tirez-le sur le thème choisi puis relâchez 
le bouton de la souris. Ces objets sont stockés dans un dossier de votre répertoire 
d’utilisateur.

Une fois ajouté à la galerie, l’objet de dessin perd tout lien avec les styles de dessin et toutes ses 
propriétés sont définies par formatage direct. Il peut être inséré dans de nouveaux documents de 
Draw et utilisé dans les autres modules de LibreOffice de la même manière que les autres objets 
de la galerie.

Ajouter des thèmes complets

Il existe deux façons d’ajouter un thème complet à la galerie :

• S’il existe un dossier contenant des thèmes, vous pouvez ajouter un chemin vers celui-ci 
dans le champ Galerie de la page LibreOffice – Chemins de la boîte de dialogue Options 
(Outils > Options) et sélectionnez le dossier qui contient les thèmes. L’inconvénient de cette
méthode est que vous devez avoir des thèmes déjà installés. Il n’est pas possible de 
supprimer un thème unique de ce dossier dans votre galerie, mais vous devez effacer tout 
l’ensemble des thèmes en supprimant le chemin vers le dossier.

• Les thèmes de la galerie peuvent être installés sous forme d’extensions. Recherchez-les à 
https://extensions.libreoffice.org/.

Les couleurs

Draw (comme tous les modules de LibreOffice) utilise des palettes de couleurs pour représenter 
celles-ci. Vous pouvez créer des couleurs et des palettes de couleurs qui correspondent à vos 
besoins en modifiant les couleurs d’une palette, en y ajoutant des couleurs supplémentaires ou en 
composant des palettes de couleurs personnalisées.

Remarque

Tous les modules de LibreOffice utilisent le modèle de couleur RVB (Rouge, Vert, Bleu) pour
l’impression. Les contrôles CMJN (Cyan, Magenta, Jaune, Noir) ne sont proposés que pour 
faciliter la saisie de valeurs de couleur utilisant cette notation.
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• Le modèle RVB (pour Rouge, Vert, Bleu) s’appuie sur le modèle de synthèse additive des 
couleurs et est conçu pour les écrans électroniques et les ordinateurs. Cela signifie que plus 
vous ajoutez de couleur, plus vous vous rapprochez du blanc. RVB utilise des échelles de 0 
à 255, si bien que le noir correspond à R = 0, V = 0 et B = 0 tandis que le blanc correspond à
R = 255, V = 255 et B = 255.

• Le modèle CMJN (pour Cyan, Magenta, Jaune, Noir) est un modèle soustractif de couleurs 
où chaque couche d’encre absorbe une partie de la lumière pour obtenir du noir. Il est 
surtout utilisé pour l’impression, c’est pourquoi les encres des imprimantes ont ces couleurs. 
CMJN utilise une échelle de 0 à 100. Si C = 100, M = 100, J = 100 et N = 100, on obtient une
couleur noire, mais si les quatre valeurs sont nulles, on obtient un blanc parfait.

• Le modèle HSB (ou TSL, pour Hue : Teinte, Saturation, Brightness : Luminosité) est une 
représentation alternative du modèle RVB conçue pour être plus proche de la façon dont la 
vision humaine perçoit les couleurs. Vous pouvez utiliser les valeurs HSB pour affiner les 
couleurs que vous avez créées.

Conseil

Vous trouverez plus d’informations sur les modèles et les valeurs de couleurs à https://
fr.wikipedia.org/wiki/Modèle_colorimétrique

Modifier les couleurs

Pour modifier la couleur des objets, vous utilisez des palettes de couleurs. Celles-ci sont installées 
avec LibreOffice et utilisées par tous les modules. Leur utilisation est la même pour tous les types 
d’objets, mais la façon d’y accéder varie avec le type d’objet sélectionné.

La barre de couleurs

Bien que LibreOffice offre des outils qui permettent de spécifier une couleur avec précision, il 
propose aussi une barre de couleurs qui vous donne la possibilité de changer rapidement la 
couleur d’un objet dans votre dessin. Par défaut, les couleurs disponibles dans la barre de 
couleurs sont celles de la palette Standard.

Remarque

Si vous avez changé la palette de couleurs dans les boîtes de dialogue Remplissage ou 
Ligne, la barre de couleurs affichera les couleurs actualisées de cette palette.

 1) Sélectionnez l’objet de votre dessin dont vous souhaitez modifier rapidement la couleur.

 2) Choisissez Affichage > Barre de couleurs dans la barre de menu pour ouvrir la barre de 
couleurs (Figure 302).

 3) Faites un clic gauche sur une couleur de la barre pour changer la couleur de remplissage de 
l’objet sélectionné et un clic droit pour changer sa couleur de contour.

 4) Pour supprimer la couleur de l’objet, cliquez sur la case en bas à gauche de la barre de 
couleur (case blanche avec un X) : clic gauche pour supprimer la couleur de remplissage et 
droit pour la couleur de contour.

 5) Pour refermer la barre de couleurs, choisissez Affichage > Barre de couleurs dans la barre
de menu.
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Figure 302 : La barre de couleurs

Couleurs de remplissage

Utilisez la boîte de dialogue Remplissage comme ceci :

 1) Sélectionnez un objet qui possède une surface de remplissage, par exemple un carré ou un 
triangle.

 2) Ouvrez la boîte de dialogue Remplissage grâce à l’une des méthodes suivantes :

– sélectionnez Format > Remplissage dans la barre de menu,

– faites un clic droit sur l’objet et sélectionnez Remplissage dans le menu contextuel,

– cliquez sur l’icône Remplissage  dans la barre d’outils Lignes et remplissage.

 3) Cliquez sur le bouton Couleur pour ouvrir la page correspondante (Figure 303).

Figure 303 : Palette de couleurs dans la boîte de dialogue Remplissage
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 4) Sélectionnez la palette de couleurs utilisée dans la liste déroulante de la section Couleurs.

 5) Cliquez sur une des couleurs affichées dans la palette ou parmi les couleurs récemment 
utilisées sous celle-ci.

 6) Cliquez sur OK pour enregistrer les modifications et refermer la boîte de dialogue. L’objet 
sélectionné est rempli par la couleur choisie.

Utilisez la section Zone de l’onglet Propriétés du volet latéral (Figure 304) de la façon suivante :

 1) Sélectionnez un objet qui possède une surface de remplissage, par exemple un carré ou un 
triangle.

 2) Vérifiez que l’onglet Propriétés du volet latéral est visible et la section Zone déployée.

 3) Sélectionnez Couleur dans la liste déroulante Remplir.

 4) Cliquez sur le petit triangle ▼ à droite du bouton coloré Sélectionner la couleur à 
appliquer pour ouvrir la palette Couleur de remplissage.

Figure 304 : Palette Couleur de remplissage dans la section Zone 
de l’onglet Propriétés du volet latéral

 5) Sélectionnez la palette de couleurs à utiliser parmi celles qui sont proposées dans la liste 
déroulante.

 6) Cliquez sur une des couleurs affichées dans la palette ou parmi les couleurs récemment 
utilisées sous celle-ci.

 7) La palette se referme et l’objet sélectionné est rempli par la couleur choisie.
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Utilisez la palette Couleur de remplissage des barres d’outils Ligne et remplissage ( ) et 
Dessin ( ) comme ceci :

 1) Sélectionnez un objet qui possède une surface de remplissage, par exemple un carré ou un 
triangle.

 2) Cliquez sur le petit triangle ▼ à droite du bouton coloré Couleur de remplissage pour ouvrir
la palette Couleur de remplissage.

 3) Sélectionnez la palette de couleurs à utiliser parmi celles qui sont proposées dans la liste 
déroulante.

 4) Cliquez sur une des couleurs affichées dans la palette ou parmi les couleurs récemment 
utilisées sous celle-ci.

 5) La palette se referme et l’objet sélectionné est rempli par la couleur choisie.

Couleurs de lignes ou de bordures

Les palettes de couleurs pour les lignes et les bordures ont la même apparence et s’utilisent de la 
même manière que les palettes de couleurs de remplissage.

Utilisez la boîte de dialogue Ligne (Figure 305) de la façon suivante :

Figure 305 : Palette de couleur dans la boîte de dialogue Ligne

 1) Sélectionnez une ligne ou un objet dans votre dessin.

 2) Ouvrez la boîte de dialogue Ligne grâce à l’une des méthodes suivantes :

– sélectionnez Format > Ligne dans la barre de menu ;

– faites un clic droit sur la ligne ou l’objet et choisissez Ligne dans le menu contextuel ;
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– cliquez sur le bouton Ligne ( ) dans la barre d’outils Ligne et remplissage.

 3) Sélectionnez la palette de couleurs utilisée dans la liste déroulante Couleur de la section 
Propriétés de ligne.

 4) Cliquez sur une des couleurs affichées dans la palette ou parmi les couleurs récemment 
utilisées sous celle-ci.

 5) Cliquez sur OK pour enregistrer les modifications et refermer la boîte de dialogue. La ligne 
ou la bordure de l’objet sélectionné prend la couleur choisie.

Utilisez la section Ligne de l’onglet Propriétés du volet latéral de la manière suivante :

 1) Sélectionnez une ligne ou un objet dans votre dessin.

 2) Vérifiez que l’onglet Propriétés du volet latéral est visible et la section Ligne déployée.

 3) Cliquez sur le petit triangle ▼ à droite du bouton coloré Sélectionner la couleur de la ligne 
pour ouvrir la palette Couleur de Ligne.

Figure 306 : Palette Couleur de ligne dans la section Ligne 
de l’onglet Propriétés du volet latéral

 4) Sélectionnez la palette de couleurs utilisée dans la liste déroulante Couleur de la section 
Propriétés de ligne.

 5) Cliquez sur une des couleurs affichées dans la palette ou parmi les couleurs récemment 
utilisées sous celle-ci.

 6) La palette se referme et la ligne ou la bordure de l’objet sélectionné prend la couleur choisie

Utilisez la palette Couleur de ligne des barres d’outils Ligne et remplissage et Dessin ( ) comme 
ceci :

 1) Sélectionnez une ligne ou un objet dans votre dessin.
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 2) Cliquez sur le petit triangle à droite du bouton coloré Couleur de ligne ▼ pour ouvrir la 
palette Couleur de ligne.

 3) Sélectionnez la palette de couleurs à utiliser parmi celles qui sont proposées dans la liste 
déroulante.

 4) Cliquez sur une des couleurs affichées dans la palette ou parmi les couleurs récemment 
utilisées sous celle-ci.

 5) La palette se referme et la ligne ou la bordure de l’objet sélectionné prend la couleur choisie.

Couleur des textes

On accède à la palette Couleur de police (Figure 307) grâce au bouton du même nom  dans la 
section Caractère de l’onglet Propriétés du volet latéral ou dans la barre d’outils Formatage du 
texte. Son apparence et son utilisation sont identiques à celles des palettes Couleur de 
remplissage et Couleur de ligne décrites ci-dessus.

Figure 307 : Palette Couleur de police dans la section Caractère
de l’onglet Propriétés du volet latéral

Remarque

La barre d’outils Formatage du texte remplace automatiquement la barre d’outils Ligne et 
remplissage quand un texte est sélectionné dans votre dessin. Si elle n’apparaît pas, 
sélectionnez Affichage > Barres d’outils > Formatage du texte dans la barre de menu.
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 1) Sélectionnez du texte dans un cadre de texte ou un objet de votre dessin.

 2) Cliquez sur le petit triangle à droite du bouton Couleur de police ▼ dans la section 
Caractère de l’onglet Propriétés du volet latéral (Figure 307) ou dans la barre d’outils 
Formatage du texte. La palette Couleur de police s’ouvre.

 3) Sélectionnez la palette de couleurs à utiliser parmi celles qui sont proposées dans la liste 
déroulante.

 4) Cliquez sur une des couleurs affichées dans la palette ou parmi les couleurs récemment 
utilisées sous celle-ci.

 5) La palette se referme et le texte sélectionné prend la couleur choisie.

Créer des couleurs

Toutes les couleurs que vous créez sont automatiquement placées dans la palette Personnalisé 
qui est disponible dans tous les modules de LibreOffice.

Remarque

LibreOffice n’utilise que le modèle de couleurs RVB pour l’impression en couleurs. Les 
valeurs des trois composantes de ce modèle sont affichées sous les zones d’aperçu (dans 
la boîte de dialogue Remplissage, voir Figure 303, page 295).

Pour créer une couleur personnalisée à l’aide de la boîte de dialogue Remplissage (Figure 303, 
page 295), procédez de la façon suivante :

 1) Ouvrez la boîte de dialogue Remplissage grâce à l’une des méthodes suivantes :

– sélectionnez Format > Remplissage dans la barre de menu,

– faites un clic droit sur l’objet et sélectionnez Remplissage dans le menu contextuel,

– cliquez sur l’icône Remplissage  dans la barre d’outils Lignes et remplissage.

 2) Cliquez sur le bouton Couleur pour ouvrir la page correspondante.

 3) Sélectionnez dans la liste déroulante une palette de couleurs prédéfinie qui contient une 
couleur proche de celle que vous voulez définir.

 4) Choisissez dans la palette une couleur voisine de celle que vous voulez créer. Elle apparaît 
dans zone d’aperçu Nouveau.

 5) Si vous connaissez les valeurs des composantes rouge, verte et bleue de la couleur que 
vous voulez obtenir, saisissez-les dans les champs correspondants sous la zone d’aperçu 
Nouveau, dont la couleur change en fonction des valeurs saisies.

 6) Si vous ne les connaissez pas, créez votre couleur personnalisée de la manière suivante :

 a) Cliquez sur le bouton Choisir une couleur pour ouvrir la boîte de dialogue de même nom
(Figure 308).

 b) Sélectionnez une teinte dans la barre verticale puis cliquez sur le petit cercle dans le carré
en haut à droite de la boîte de dialogue et tirez-le jusqu’à l’emplacement de la couleur que
vous recherchez. Notez que les valeurs des champs des sections RVB, HSB et CMJN 
changent pour refléter la couleur à l’intérieur du cercle.
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Vous pouvez aussi modifier, si vous les connaissez, les valeurs dans les champs des 
sections RVB, HSB ou CMJN. Les valeurs des champs des autres sections, ainsi que la 
position du cercle et la teinte sélectionnée dans la barre verticale s’adaptent en 
conséquence.

Figure 308 : La boîte de dialogue Choisir une couleur

 c) Cliquez sur OK pour refermer la boîte de dialogue Choisir une couleur. La couleur que 
vous avez choisie apparaît dans la zone d’aperçu Nouveau de la boîte de dialogue 
Remplissage.

 7) Dans la boîte de dialogue Remplissage, cliquez sur le bouton Ajouter sous Palette 
personnalisée dans la section Couleur. Une boîte de dialogue Nom (Figure 309) s’ouvre.

Figure 309 : La boîte de dialogue Nom

 8) Saisissez un nom significatif pour votre couleur puis cliquez sur OK pour refermer cette boîte
de dialogue et la boîte de dialogue Remplissage. La couleur que vous avez choisie est 
ajoutée à la palette Personnalisé.
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Remarque

Il est important de donner un nom significatif à la couleur que vous enregistrez dans la 
palette Personnalisé pour pouvoir la retrouver facilement. Si vous ne le faites pas, il recevra 
un  numéro hexadécimal qui rendra son identification plus difficile quand vous aurez 
plusieurs couleurs personnalisées.

Supprimer des couleurs

Seules les couleurs que vous avez créées dans la palette Personnalisé peuvent être supprimées. 
Procédez comme ceci.

 1) Ouvrez la boîte de dialogue Remplissage grâce à l’une des méthodes suivantes :

– sélectionnez Format > Remplissage dans la barre de menu,

– faites un clic droit sur l’objet et sélectionnez Remplissage dans le menu contextuel,

– cliquez sur l’icône Remplissage  dans la barre d’outils Lignes et remplissage.

 2) Cliquez sur le bouton Couleur pour ouvrir la page correspondante.

 3) Sélectionnez la palette Personnalisé dans la liste déroulante.

 4) Sélectionnez la couleur que vous voulez supprimer.

 5) Cliquez sur le bouton Supprimer sous Palette personnalisée dans la section Couleur.

 6) Cliquez sur OK pour refermer la boîte de dialogue Remplissage.

Les courbes de Bézier

LibreOffice vous offre la possibilité d’utiliser des courbes de Bezier8 dans votre dessin. Une courbe
de Bézier est définie au moyen d’un point de départ, d’un point final et, si nécessaire, de points de 
contrôle. Les termes nœuds et ancres sont souvent utilisés pour les points de la courbe. Vous 
trouverez plus d’explication sur les fondements mathématiques des courbes de Bézier à https://
fr.wikipedia.org/wiki/Courbe_de_Bézier.

Les courbes de Bézier sont très utiles pour obtenir expérimentalement la forme de la courbe 
désirée. En mode d’édition de points, vous pouvez la modeler en tirant les points avec la souris. 
Dans l’exemple de la Figure 310, la courbe part du point P0 dans la direction du premier point de 
contrôle P1 et arrive au point P3 en venant de la direction du deuxième point de contrôle P2. Plus 
un point de contrôle est éloigné d’un point de la courbe, plus la courbure en ce point est faible. Si 
un point de contrôle occupe la même position qu’un point de la courbe, il n’a aucune influence sur 
celui-ci.

8 Les courbes de Bézier ont été inventées par Pierre Béziers, ingénieur à la Régie Nationale des Usines Renault dans 
les années 1960 dans le but de modéliser plus facilement les surfaces de carrosserie des véhicules.
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Figure 310 : Exemple de courbe de Bézier

Tracer des courbes de Bézier

 1) Cliquez sur l’icône Courbe  dans la section Courbes et polygones de l’onglet Forme du 
volet latéral ou dans la barre d’outils Dessin.

 2) Cliquez au point de départ de la courbe et, sans relâcher le bouton de la souris, tirez le 
pointeur jusqu’à ce que la ligne ait la longueur désirée.

 3) Relâchez le bouton de la souris et déplacez le pointeur et le point final de la courbe jusqu’à 
la position souhaitée.

 4) Faites un double-clic pour terminer le tracé de la courbe.

Éditer une courbe de Bézier

 1) Cliquez une fois sur la courbe pour afficher les points de départ et d’arrivée. Le point de 
départ est légèrement plus grand que le point d’arrivée.

 2) Placez le pointeur au-dessus d’un des deux points, cliquez et tirez. Si le point de contrôle 
n’est pas visible (cas du point d’arrivée juste après la création de la courbe), c’est lui que 
vous déplacez, sinon c’est l’extrémité de la courbe. Les points de contrôle sont représentés 
par des poignées rondes à l’extrémité d’une ligne en tirets qui part d’un point de la courbe 
(Figure 310 et Figure 311).

 3) Déplacez le pointeur en tirant le point de la courbe ou le point de contrôle jusqu’à obtenir la 
position ou la forme souhaitée

 4) Quand vous avez obtenu la forme souhaitée, cliquez dans l’espace de travail pour 
désélectionner la courbe et quitter le mode d’édition.

Figure 311 : Points de contrôle d’une courbe de Bézier
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Outils d’édition des points

Cliquez sur l’icône Points  de la barre d’outils Standard ou appuyez sur F8. Tant que cette 
fonction est active, la barre d’outils Éditer les points apparaîtra chaque fois qu’une courbe ou un 
polygone (créé directement ou obtenu en convertissant une forme) sera sélectionné et se 
refermera quand il sera désélectionné. Les outils disponibles dans cette barre d’outils dépendent 
de l’objet sélectionné et du point en cours d’édition.

La Figure 312 montre les outils de la barre Éditer les points qui vous permettent de modifier la 
forme d’une courbe de Bézier et qui sont présentés ci-dessous.

Points Déplacer des points Insérer des points

Supprimer des points Convertir en courbe Fermer la courbe

Scinder la courbe Point d’inflexion Jonction lisse

Jonction symétrique Réduire les points

Figure 312 : La barre d’outils Éditer les points

Points 
Ce bouton vous permet d’activer ou désactiver le mode d’édition des courbes de Bézier. 
Dans le mode d’édition, chaque point de l’objet peut être sélectionné.

Déplacer les points 
Ce bouton active un mode dans lequel les points peuvent être déplacés. Cliquez sur un point
de la courbe et tirez-le à un autre emplacement. La courbe suit le mouvement des deux 
côtés du point et les sections de part et d’autre du point changent de forme. Cliquez entre 
deux points ou à l’intérieur d’une courbe fermée et pleine pour déplacer la courbe tout 
entière sans la déformer.

Insérer des points 
Ce bouton active un mode dans lequel vous pouvez insérer des points. Les points peuvent 
aussi être déplacés comme dans le mode précédent, mais si vous cliquez sur la courbe 
entre deux points et déplacez un peu le pointeur en maintenant le bouton appuyé, vous 
insérez un nouveau point. Le point inséré est un point lisse, dont les points de contrôle sont 
alignés avec le point créé et le reste quand vous les déplacez. Si vous souhaitez créer un 
point d’inflexion vous devez le convertir après l’avoir inséré en utilisant l’outil Point 
d’inflexion (page 305).

Supprimer des points 
Cliquez sur ce bouton pour supprimer les points sélectionnés. Pour sélectionner plusieurs 
points, appuyez sur la touche Maj et cliquez sur ceux-ci sans relâcher la touche, puis cliquez
sur le bouton Supprimer des points ou appuyez sur la touche Suppr.

Convertir en courbe 
Ce bouton permet de convertir une portion de courbe en segment de droite et inversement. 
Dans une courbe de Bézier, la partie de la courbe qui suit le point sélectionné (dans l’ordre 
de création) est transformée en segment. Si le point sélectionné est l’extrémité d’un 
segment, ce point et l’autre extrémité du segment reçoivent des poignées de contrôle (la 
forme ne change pas, mais vous pouvez déplacer les poignées pour courber le segment). Si 
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nécessaire, le point est converti en point d’inflexion. Les extrémités de la ligne ont, au 
maximum, un point de contrôle.

Fermer la courbe 
Cliquez sur ce bouton pour fermer une courbe de Bézier ou un polygone en joignant le 
dernier point au premier par un segment. Le premier point possède une poignée légèrement 
plus grande que les autres.

Scinder la courbe 
Après avoir sélectionné les points de coupure, cliquez sur ce bouton pour scinder la courbe 
en deux éléments distincts ou plus.

Point d’inflexion 
Cliquez sur ce bouton pour convertir les points sélectionnés en points d’inflexion (Figure 
313). Les deux points de contrôle d’un point d’inflexion sont indépendants l’un de l’autre. Si 
les trois points ne sont pas alignés, la courbe change de direction au point d’inflexion et 
forme un angle.

Figure 313 : Point d’inflexion

Jonction lisse 
Cliquez sur ce bouton pour convertir un point d’inflexion ou une jonction symétrique en 
jonction lisse (Figure 314). Dans une jonction lisse, le point de la courbe et ses points de 
contrôle sont alignés et le restent quand l’un d’eux est déplacé, mais les points de contrôle 
peuvent ne pas être à la même distance du point de la courbe, ce qui permet d’avoir des 
rayons de courbure différents de part et d’autre de ce point.

Figure 314 : Jonction lisse

Jonction symétrique 
Cliquez sur ce bouton pour convertir un point d’inflexion ou une jonction lisse en jonction 
symétrique (Figure 315). Dans une jonction symétrique, les points de contrôle sont 
symétriques l’un de l’autre par rapport au point de la courbe : les trois points restent alignés 
et le point de la courbe est au milieu des points de contrôle, ce qui donne le même rayon de 
courbure de chaque côté de celui-ci.
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Figure 315 : Jonction symétrique

Réduire les points 
L’angle à partir duquel la réduction de points doit se produire peut être défini dans le champ 
Réduction de point de la page LibreOffice Draw – Grille de la boîte de dialogue Options 
(Outils > Options).

Ajouter des commentaires à un dessin

Vous pouvez ajouter des commentaires à votre dessin Draw, comme vous pouvez le faire dans 
Writer ou dans Calc. Pour ajouter un commentaire :

 1) Sélectionnez Insertion > Commentaire dans la barre de menu. Une zone de commentaire 
apparaît, accompagnée d’une ancre contenant vos initiales, qui est située dans le coin 
supérieur gauche de votre dessin. Draw ajoute automatiquement votre nom et la date en bas
de la zone.

 2) Saisissez alors ou collez le texte dans la zone de commentaire (Figure 316).

Figure 316 : Commentaire dans un dessin

 3) Pour appliquer un formatage élémentaire au texte sélectionné, faites un clic droit et 
choisissez l’option correspondante dans le menu contextuel.

 4) Pour supprimer un commentaire, faites un clic droit dans la zone de commentaire ou sur son 
ancre, ou cliquez sur le petit triangle noir ▼ dans le coin inférieur droit, et choisissez une 
option de suppression dans le menu contextuel.

 5) Pour déplacer un commentaire, cliquez et faites glisser son ancre (contenant vos initiales) 
jusqu’à l’endroit souhaité de votre dessin.

Si vous cliquez en dehors de la zone de commentaire, cette zone n’est plus visible, et seule reste 
affichée l’ancre du commentaire. Cliquez alors sur cette ancre pour que la zone de commentaire 
s’affiche à nouveau.
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Si le commentaire a été écrit par un autre auteur, vous pouvez faire un clic droit et utiliser la 
commande Répondre dans le menu contextuel. Votre texte va s’ajouter en dessous du texte de 
commentaire précédent, mais l’ensemble ne constitue qu’un seul commentaire, avec une seule 
ancre.

Vous pouvez utiliser Affichage > Commentaires dans la barre de menu pour afficher ou masquer 
les commentaires du dessin.

Remarque

Pour que votre nom et vos initiales apparaissent dans un commentaire, vous devez saisir 
vos données d’identité en allant dans Outils > Options > LibreOffice > Données 
d’identité et en remplissant les champs nécessaires. Si plusieurs personnes éditent le 
document, une couleur différente sera allouée à chaque auteur de commentaires.

Connecter et fractionner des lignes

Dans Draw, il est possible de connecter des éléments de lignes séparés pour en faire une ligne 
unique ou de fractionner une ligne composée en éléments séparés.

• Pour connecter des lignes, sélectionnez-les puis choisissez Forme > Connecter dans la 
barre de menu. Le point final d’une ligne est relié au premier point de la suivante par un 
segment. Le résultat est une ligne polygonale ouverte, mais pas une forme fermée.

• Pour fractionner une ligne composée en éléments séparés, sélectionnez-la puis choisissez 
Forme > Fractionner dans la barre de menu. Après avoir cliqué dans l’espace de travail, 
vous pouvez sélectionner chaque élément, indiqué par un point de départ et un point final, et
le déplacer à un nouvel emplacement.

Système de coordonnées

Axes des abscisses et des ordonnées

L’abscisse est la position horizontale d’un objet et l’ordonnée sa position verticale. Les règles 
n’affichent pas les signes moins (-)si la coordonnée est négative, mais il apparaît bien dans le 
champ qui indique la position dans la barre d’état et dans les champs de la boîte de dialogue 
Position et taille.

L’espace de travail

L’espace de travail est plus grand que la page de dessin. Il s’étend de la largeur d’une page à 
droite et à gauche de celle-ci et d’une demi-page au-dessus et en dessous. La taille de la partie 
imprimable de la page de dessin est indiquée par les parties plus claires des règles horizontales et
verticales.

Vous pouvez dessiner des objets totalement ou partiellement à l’extérieur de la page de dessin. 
Cependant, quand la page est imprimée, toute partie d’un objet qui n’est pas dans la zone 
imprimable n’est ni imprimée, ni enregistrée, ni exportée. Cela permet d’utiliser les zones qui 
entourent la page comme brouillons pour la création des objets.
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Position d’un objet

Les coordonnées des objets et des guides de capture sont relatives à l’origine.
L’origine par défaut des coordonnées (la position (0,00 ; 0,00)) est le coin supérieur
gauche de la partie imprimable de la page de dessin (le point d’intersection de la
marge supérieure et de la marge gauche). Vous pouvez déplacer l’origine par
défaut, en cliquant sur l’intersection des règles et en la tirant jusqu’à la position
souhaitée. Des lignes guide apparaissent pendant le déplacement pour vous aider
à placer l’origine. Cette position ne s’applique qu’à la vue courante et n’est pas enregistrée avec le 
document.

La zone à l’intérieur de l’origine par défaut est utilisée pour la grille quand les options Aligner sur la 
grille et Afficher la grille sont activées.

Pour remplacer l’origine à son emplacement par défaut dans le coin supérieur gauche de la page, 
il suffit de faire un double-clic à l’intersection des règles où vous avez initié le déplacement.

Précision

Draw utilise de manière interne des valeurs entières en 1/100 mm. Il n’est donc pas possible de 
définir une position exacte en 1/8 de pouce. De plus, de nombreux champs sont limités à deux 
décimales.

Pour travailler avec un maximum de précision, ouvrez la page LibreOffice Draw – Général de la 
boîte de dialogue Options (Outils > Options) et sélectionnez le millimètre dans le champ Unité de
mesure. Les règles affichent aussi les unités métriques, mais, pour utiliser votre unité de mesure 
préférée, faites un clic droit sur la règle et sélectionnez cette unité dans le menu contextuel.
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6.4

Annexe A
Raccourcis clavier





Introduction

Il est possible d’utiliser LibreOffice sans dispositif de pointage tel qu’une souris ou un trackball, en 
utilisant ses combinaisons de touches de raccourci natives. Des tâches aussi diverses et 
complexes que l’ancrage et la libération des barres d’outils et des fenêtres, de même que la 
modification de taille ou de position des objets peuvent toutes être réalisées uniquement avec le 
clavier. Bien que LibreOffice offre un ensemble de raccourcis étendu, chaque module possède les 
siennes qui sont spécifiques aux tâches qu’il permet de réaliser.

Pour une aide sur les raccourcis clavier de LibreOffice ou son utilisation uniquement avec le 
clavier, recherchez les mots-clés « raccourci » et « accessibilité » dans l’aide.

En plus des raccourcis proposés d’origine par LibreOffice (décrits dans cette annexe), vous 
pouvez aussi définir les vôtres. Vous pouvez affecter des raccourcis aux fonctions standard de 
Draw ou à vos macros et les enregistrer de façon à pouvoir les utiliser avec Draw seul ou avec 
toute la suite LibreOffice.

Pour adapter les touches de raccourcis à vos besoins, utilisez la boîte de dialogue Personnaliser 
décrite dans le chapitre 14, Personnaliser LibreOffice, du Guide du débutant.

Conseils sur l’utilisation sous macOS

Sous macOS, certaines touches et certains éléments de menu sont différents de ceux utilisés sous
Windows ou Linux. Le tableau ci-dessous donne quelques substitutions courantes pour les 
instructions de ce chapitre. Pour une liste plus détaillée, voyez l’Aide de l’application.

Windows ou Linux Équivalent Mac Effet

Sélection du menu 
Outils > Options

LibreOffice > Préférences Accès aux options de configuration

Clic droit
Control+clic ou clic droit 
selon la configuration de l’ordinateur

Ouvre un menu contextuel

Ctrl (Control) ⌘ (Command) Utilisé avec d’autres touches

F5 Shift+⌘+F5 Ouvre le navigateur

F11 ⌘+T Ouvre l’onglet Styles du volet latéral

Remarque

Certaines touches de raccourcis décrites dans cette annexe peuvent être affectées à votre 
système. Elles ne sont pas disponibles pour LibreOffice. Essayez d’affecter des touches 
différentes soit dans LibreOffice grâce à la page Clavier de la boîte de dialogue 
Personnaliser (Outils > Personnaliser), soit dans votre système d’exploitation. Pour 
plus d’information sur la personnalisation de LibreOffice, voir le chapitre 14, Personnaliser 
LibreOffice, du Guide du débutant.
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Touches de fonctions et raccourcis propres à Draw

Touches de fonction

Touches Effets

F1 Ouvre l’aide de LibreOffice Draw.

F2 Entre en mode texte pour ajouter ou éditer du texte.

F3 Entre dans un groupe pour en modifier individuellement les objets.

Maj+F3 Ouvre la boîte de dialogue Dupliquer.

Ctrl+F3 Sort du groupe.

F4 Ouvre la boîte de dialogue Position et taille.

F5 Ouvre le navigateur.

F7 Vérifie l’orthographe.

Ctrl+F7 Ouvre le dictionnaire des synonymes.

F8 Active ou désactive le mode d’édition de points.

Maj+Ctrl+F8 Adapte le cadre au texte.

Maj+F10 Ouvre le menu contextuel de l’objet sélectionné.

F11 Ouvre l’onglet Styles et formatage du volet latéral.

Raccourcis clavier pour les dessins

Touches Effets

+ (pavé numérique) Augmente le facteur de zoom.

- (pavé numérique) Diminue le facteur de zoom.

* (pavé numérique) Règle le facteur de zoom pour afficher la page entière.

/ (pavé numérique) Zoome sur la sélection courante.

Maj+Ctrl+G Groupe les objets sélectionnés.

Maj+Ctrl+Alt+G Dégroupe les objets du groupe sélectionné.

Maj+Ctrl+K Combine les objets sélectionnés.

Maj+Ctrl+Alt+K Scinde l’objet combiné sélectionné en plusieurs objets.

Maj+Ctrl++ (pavé 
numérique)

Envoie l’objet sélectionné au premier plan.

Ctrl++ (pavé numérique) Envoie l’objet sélectionné vers l’avant.

Maj+Ctrl+- (pavé 
numérique)

Envoie l’objet sélectionné à l’arrière-plan.

Ctrl+- (pavé numérique) Envoie l’objet sélectionné vers l’arrière.

Page Haut Passe à la page précédente.

Page Bas Passe à la page suivante.
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Ctrl+Page Haut Active la couche précédente.

Ctrl+Page Bas Active la couche suivante.

Touches fléchées Déplacent l’objet sélectionné dans la direction de la flèche.

Ctrl+Touches fléchées Déplacent la vue de la page dans la direction de la flèche.

Ctrl+Clic (en tirant un 
objet)

Crée une copie de l’objet en cours de déplacement quand le 
bouton de la souris est relâchée. Notez que ce raccourci ne 
fonctionne que si l’option Copier lors du déplacement est cochée 
dans la page LibreOffice Draw – Général de la boîte de dialogue 
Options (Outils > Options).

Ctrl+Entrée avec la 
focalisation du clavier (F6) 
sur l’icône d’un objet de 
dessin dans la barre d’outils.

Insère un objet de dessin de la taille par défaut au centre de la vue 
courante.

Maj+F10 Ouvre le menu contextuel de l’objet sélectionné.

F2 Entre en mode texte pour ajouter ou éditer du texte.

Entrée Entre en mode texte si un objet texte est sélectionné.

Ctrl+Entrée
Entre en mode texte si un objet texte est sélectionné. S’il n’y a 
aucun objet texte ou si vous avez parcouru tous les objets textes 
sur la page, une nouvelle page est insérée.

Alt
Appuyez sur la touche Alt et tirez avec la souris pour dessiner ou 
modifier les dimensions d’un objet à partir de son centre.

Alt+Clic sur un objet Sélectionne l’objet derrière l’objet actuellement sélectionné.

Maj+Alt+Clic sur un objet Sélectionne l’objet devant l’objet actuellement sélectionné.

Maj pendant la sélection 
d’un objet

Ajoute ou enlève l’objet de l’ensemble des objets sélectionnés.

Maj pendant le déplacement
d’un objet

Limite la direction du mouvement de l’objet sélectionné à un 
multiple de 45°.

Tab Parcourt les objets de la page dans l’ordre de leur création.

Maj+Tab Parcourt les objets de la page dans l’ordre inverse de leur création.

Échap Quitte le mode courant.

Navigation dans le volet Pages

Touches Effets

Début / Fin Active la première / dernière page.

Gauche / Droite ou Page 
Haut / Page Bas Active la page précédente / suivante.

Entrée Crée une nouvelle page.

Touches de fonctions et raccourcis propres à Draw | 313



Touches de fonctions et raccourcis clavier généraux

Ouverture et éléments de menus

Touches Effets

Alt+lettre

Ouvre le menu où lettre est soulignée. Par exemple, Alt+F ouvre 
le menu Fichier.
Une fois le menu ouvert, les entrées du menu ont aussi des 
caractères soulignés. Pour accéder directement à ces entrées, il 
suffit d’appuyer sur la touche de ce caractère souligné. Si plusieurs
entrées possèdent le même caractère souligné, appuyez sur la 
même touche pour passer de l’un à l’autre.
Si une entrée n’a pas de caractère souligné, il faut cliquer 
directement sur elle.

Échap Ferme le menu ouvert.

F6

Appuyer plusieurs fois sur F6 pour activer successivement les 
objets suivants :
• la barre de menu,
• les barres d’outils de haut en bas et de gauche à droite,
• les fenêtres libres de gauche à droite,
• le document.

Maj+F6 Active les objets dans l’ordre inverse.

Ctrl+F6 Active le document.

F10 ou Alt Active la barre de menu ou réactive ce qui l’était auparavant.

Commandes du menu

Appuyez sur Alt, F6 ou F10 pour sélectionner la première entrée de la barre de menu (le menu 
Fichier). Appuyez sur la flèche Droite pour sélectionner la suivante et sur la flèche Gauche pour 
sélectionner la précédente. Les touches Début et Fin sélectionnent la première et la dernière 
entrée du menu.

Un premier appui sur la flèche Bas ouvre le menu sélectionné. Les appuis suivants sur les flèches 
Bas et Haut déplacent la sélection dans les entrées du menu. La flèche Droite ouvre un 
éventuel sous-menu.

Appuyez sur Entrée pour exécuter la commande associée à l’entrée sélectionnée.

Commandes des barres d’outils

Appuyez plusieurs fois sur F6 jusqu’à ce que la première icône de la barre d’outils soit 
sélectionnée. Utilisez les flèches Droite et Gauche pour sélectionner une icône sur une barre 
d’outils horizontale et les flèches Bas et Haut pour une barre d’outils verticale. Les touches 
Début et Fin sélectionnent la première ou la dernière icône de la barre d’outils.

Appuyez sur Entrée pour activer l’icône sélectionnée. Si celle-ci demande normalement une action
avec la souris, comme pour insérer un rectangle, appuyer sur Entrée ne suffit pas : dans ce cas, 
appuyez sur Ctrl+Entrée.
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• Appuyez sur Ctrl+Entrée sur une icône pour créer un objet de dessin. Celui-ci sera placé 
au centre de la vue et aura des dimensions prédéfinies.

• Appuyez sur Ctrl+Entrée sur l’outil de sélection pour sélectionner le premier objet de 
dessin du document. Si vous voulez l’éditer, modifier ses dimensions ou le déplacer, 
commencez par appuyer sur Ctrl+F6 pour déplacer l’activation sur le document.

Navigation et sélection avec le clavier

Il est possible de naviguer dans un document et d’y faire des sélections avec le clavier.

• Pour déplacer le curseur, appuyez sur la touche ou combinaison de touches indiquée dans le
tableau suivant.

• Pour sélectionner les caractères sous le curseur en déplacement, maintenez en plus la 
touche Maj en déplaçant le curseur.

Touche Fonction Fonction avec la touche Ctrl

Flèches Droite et Gauche
Déplace le curseur d’un 
caractère vers la droite ou la 
gauche.

Déplace le curseur d’un mot vers
la droite ou la gauche.

Flèches Haut et Bas Déplace le curseur d’une ligne 
vers le haut ou le bas.

(Ctrl+Alt) Déplace le 
paragraphe courant vers le haut 
ou le bas.

Début Déplace le curseur au début de 
la ligne courante.

Déplace le curseur au début du 
document.

Fin Déplace le curseur à la fin de la 
ligne courante.

Déplace le curseur à la fin du 
document.

Page Haut Fait défiler l’écran d’une page 
vers le haut.

Déplace le curseur dans l’en-
tête.

Page Bas Fait défiler l’écran d’une page 
vers le bas.

Déplace le curseur dans le pied 
de page.

Contrôler les boîtes de dialogue

Quand vous ouvrez une boîte de dialogue, un élément (un bouton, un champ, une entrée d’une 
liste ou une case à cocher, par exemple) est mis en évidence ou indiqué par un cadre pointillé (s’il 
s’agit d’un champ ou d’un bouton). On dit que cet élément est actif.

Touche Résultat

Entrée Active le bouton sélectionné. Dans la plupart des cas, quand aucun
bouton n’est sélectionné, Entrée équivaut à cliquer sur OK.

Échap

Referme la boîte de dialogue sans enregistrer les modifications 
effectuées pendant qu’elle était ouverte. Échap équivaut à cliquer 
sur Annuler. Quand une liste déroulante est ouverte, Échap 
referme la liste.

Espace Coche une case non cochée. Vide une case cochée.
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Touche Résultat

Flèches Haut et Bas
Déplace vers le haut ou le bas l’activation d’un élément dans une 
liste ou une section de la boîte de dialogue ; augmente ou diminue 
la valeur d’une variable.

Flèches Droite et Gauche Déplace horizontalement l’activation d’un élément dans une section
de la boîte de dialogue.

Tab Déplace l’activation à la section ou à l’élément suivant de la boîte 
de dialogue.

Maj+Tab Ramène l’activation à la section ou à l’élément précédent de la 
boîte de dialogue.

Alt+Flèche Bas Affiche les éléments d’une liste déroulante.

Obtenir de l’aide

Touche Résultat

F1 Ouvre l’aide de LibreOffice dans votre navigateur par défaut.

Maj+F1 Active la fonction Qu’est-ce que c’est ? du menu d’aide qui affiche
un infoballon quand le pointeur survole un élément de l’interface.

Maj+F2 Affiche une infobulle pour un élément sélectionné.

Échap Dans l’aide le LibreOffice : remonte d’un niveau

Gérer les documents

Touche Résultat

Ctrl+F4 ou Alt+F4 Ferme document courant. Ferme LibreOffice en même temps que 
le dernier document.

Ctrl+O Affiche la boîte de dialogue Ouvrir pour ouvrir un document.

Ctrl+S Enregistre le document courant. Si celui-ci n’a encore jamais été 
enregistré, la boîte de dialogue Enregistrer sous est ouverte.

Ctrl+N Crée un nouveau document.

Maj+Ctrl+N Ouvre la boîte de dialogue Modèles.

Ctrl+P Ouvre la boîte de dialogue Imprimer pour imprimer le document.

Ctrl+Q Ferme LibreOffice.

Suppr
Dans les boîtes de dialogue Enregistrer et Ouvrir, efface les fichiers
ou dossiers sélectionnés. Il est possible de les retrouver dans la 
corbeille.

Maj+Suppr
Dans les boîtes de dialogue Enregistrer et Ouvrir, efface 
définitivement les fichiers ou dossiers sélectionnés. Il n’est pas 
possible de les retrouver dans la corbeille.

Retour arrière Dans les boîtes de dialogue Enregistrer et Ouvrir, affiche le 
contenu du dossier parent du dossier courant.
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Édition

Touche Résultat

Ctrl+X Coupe les éléments sélectionnés dans le presse-papiers.

Ctrl+C Copie les éléments sélectionnés dans le presse-papiers.

Ctrl+V Colle les éléments contenus dans le presse-papiers.

Maj+Ctrl+V Ouvre la boîte de dialogue Collage spécial.

Ctrl+A Sélectionne tous les éléments du dessin.

Ctrl+Z Annule la dernière action.

Ctrl+Y Retablit la dernière action annulée.

Maj+Ctrl+Y Répète la dernière commande.

Ctrl+F Ouvre la barre d’outils Rechercher.

Ctrl+H Ouvre la boîte de dialogue Rechercher et remplacer.

Maj+Ctrl+F Recherche le dernier terme recherché.

Maj+Ctrl+R Rafraîchit (redessine) la vue du document.

Maj+Ctrl+I Affiche ou cache le curseur dans le texte en lecture seule.

Sélection des lignes ou des colonnes d’un tableau

Touche Résultat

Espace Sélectionne ou désélectionne une ligne, sauf quand elle est en 
mode d’édition.

Ctrl+Espace Sélectionne ou désélectionne une ligne.

Maj+Espace Sélectionne la colonne courante.

Ctrl+Page Haut Déplace le curseur à la première ligne.

Ctrl+Page Bas Déplace le curseur à la dernière ligne.

Définir des raccourcis clavier

En plus des raccourcis proposés d’origine par LibreOffice (décrits dans cette annexe), vous 
pouvez aussi définir les vôtres.

Pour adapter les touches de raccourcis à vos besoins, utilisez la boîte de dialogue Personnaliser 
décrite dans le chapitre 14, Personnaliser LibreOffice, du Guide du débutant.

Lectures supplémentaires

Pour une aide sur les raccourcis clavier de LibreOffice ou son utilisation uniquement avec le 
clavier, recherchez les mots-clés « raccourci » et « accessibilité » dans l’aide.
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